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Welcome to the IBM Control Desk wiki

The IBM Control Desk wiki is a collaborative repository of technical information.

IBM Control Desk is an integrated service management solution that helps you manage a comprehensive range of IT
processes, services, and assets.

Spotlight on IBM Control Desk V7.6.1

IBM Control Desk V7.6.1 is now available. Here are resources to help you get started:

¢ Read about What's New in Version 7.6.1.1

e Read about What's New in Version 7.6.1

¢ IBM Control Desk system requirements

e Cognos reports: Learn about Cognos reporting features

Featured: Using the Control Desk mobile app

Quick links

e Process Automation forum

e Process Automation community in Service Management Connect

e Process Automation blog

e Control Desk support: Get the latest fixes, find various troubleshooting resources, and search for tech notes.

Product documentation

You can find documentation for each IBM Control Desk product edition in IBM Knowledge Center. On the main
page, click the menu to find your version.

« |IBM Control Desk
o |IBM Control Desk for Service Providers

IBM Control Desk was formerly known as IBM SmartCloud Control Desk.

Comments

There are no comments.
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Before installing IBM Control Desk, review the System Requirements.

Obtain the project image. See the download document for your release to learn how to download images. For links to
download documents for Control Desk releases, see Recent Releases.

Review the Planning for Deployment and Installing IBM Control Desk sections of the documentation in IBM Knowledge
Center. Links to documentation for Control Desk are available on the Installation resources page.

For more information, see the following pages:
Installation resources
Upgrade resources

Recent Releases

IMPORTANT NOTICES

Running prerequisite checks for IBM Control Desk 7.6

Before you begin your installation of IBM Control Desk 7.6, you can run prerequisite check scripts to determine
whether your environment is set up correctly. These scripts are available in the Process Automation community:
icd_76_pre-req check scripts.zip.

Note: When IBM Control Desk 7.6 is installed, the prerequisite check tooling is included. The installation program
uses this tooling to determine whether prerequisites are met. After you run the installation program, the scripts are in
the directory where InstallationManager files are located. For example, on a Linux server:

/var/ibm/InstallationManager/bundles/plugins/com.ibm.tivoli.pae.prereq 7.5.1.20141126-
0950/com/ibm/tivoli/pae/prereq/SystemRequirements/

Documentation

For information about running the scripts, see Verifying prerequisites from the command line in the IBM
Control Desk installation documentation.

Note that the rxa parameter specified in the documentation is valid for Windows only. It is not a valid
parameter when using tpae req check.sh on a Linux or Unix system.

Correction for Documentation

In the initial publication of Verifying prerequisites from the command line, one parameter for the -component
option is omitted. You can specify the was parameter to have the prerequisite verification utility check for
prerequisites that are required for WebSphere Application Server. For example,

tpae req check.sh [ -component [db2][,was][,asset mgt][,asset mgt upgrade]

[,performance]]
[ —input <path-to-tpae.properties> ]
[ -mode interactive|silent ]

[ —trace none|normal|verbose ]
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Compatibility issue when installing Integration Composer and Deployer's
Workbench on Windows Server 2012

To resolve compatibility issues that prevent installation of Integration Composer or Deployer's Workbench for IBM
Control Desk 7.6, see Installing Integration Composer 7.6 and Deployer's Workbench on Windows Server 2012.

Deferring database updates when installing Control Desk 7.5.x

When using Control Desk 7.5.0.1, 7.5.0.2, 7.5.0.3, 7.5.0.4, and 7.5.1 installation programs, if you choose to defer the
database update operation during the installation, the installation programs will automatically stop the Maximo
application server even if you choose to defer database update operation. An interim fix is available from Fix Central.
After you apply this fix, you can start the installation and defer the database update operation without shutting down
the Maximo application.

Preserving customizations

If you made modifications to the application user interface, be sure to use the following document to assess what you
need to do to preserve these modifications when you upgrade to Control Desk v7.5:
Control Desk 7.5 Upgrade Impact on Application User Interface Modifications.

More resources

Rebase files for Tivoli Service Manager Quick Install: This zip file contains files that enable you to rebase the Tivoli
Service Manager Quick Install user interface to a level that can be properly upgraded to IBM SmartCloud Control Desk
version 7.5. For instructions, see the SmartCloud Control Desk Version 7.5 Upgrade Guide.

Installing and upgrading multi-product stacks: This document provides installation and upgrade scenarios for various
combinations of version 7.1.x, 7.2.x, and 7.5.x products. Each scenario lists the recommended installation order for a multi-
product stack, and provides any workarounds needed to complete the installation. This document also provides information
about planning your deployment, post-installation activities, backup recommendations, and other information.

Autonomic Deployment Engine: View best practice information and frequently asked questions about the Autonomic
Deployment Engine, usually referred as just Deployment Engine (DE), a common technology that is shared by IBM products
to manage the life-cycles and relationships of their components installed on a machine.

Reconfiguration Tool for Administrative Workstations: A utility is available that facilitates updating installation parameters
in existing environments. You can use this utility with products that are based on Tivoli's process automation engine.

Cloning a Maximo Asset Management 7.5 environment: Download this document to learn how to copy SmartCloud
Control Desk 7.5.x deployments into multiple environments. You can use the duplicate environments for purposes of
development, testing, and prototyping. You can refine your processes in the development and test environments and then
apply best practices to the production environment.
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This page provides information that can help you install IBM Control Desk.

Documentation

Documentation for installing IBM Control Desk can be found in IBM Knowledge Center at the following links.

e Version 7.6.1
e \ersion 7.6

e \ersion 7.5.3
e Version 7.5.1
e Version 7.5.0

Additional resources

Known issues related to installing IBM Control Desk Version 7.6.0

IBM Control Desk 7.6.0.1 fix pack has been released on 19 Feb 2016: This blog entry provides useful information about the release
and provides step-by-step instructions for installing the fix pack on IBM Control Desk for Service Providers.

IBM Installation Manager Version 1.8 crashes when installing IBM Control Desk Version 7.6.0 and later on Red Hat Linux operating_systems:
When installing or upgrading IBM Control Desk on Red Hat Linux operating systems with IBM Installation Manager 1.8.0, the

installation fails with a core dump. This article explains how to resolve this problem by updating the IBM Installation Manager

launcher.ini file or by installing with IBM Installation Manager Version 1.8.2 or later.

Issues starting or running IBM Installation Manager: This article describes known issues that occur when running IBM Installation
Manager on different operating systems.

Installing IBM Control Desk 7.6 and Maximo Asset Management 7.6 Together: This document describes how to install both products
in your environment.

Installation Manager crashes when updating Maximo Anywhere: When updating Maximo Anywhere from 7.5.1t0 7.5.1.1 or 7.5.1.2
the Installation Manager may crash and produce a java error. This article explains how to resolve that issue.

How to install IBM Control Desk Version 7.5.3 with WebSphere Application Server 8.5.5 and IBM DB2 version 10.5: Control Desk
Version 7.5.3 is deployed using WebSphere Application Server Network Deployment v. 7.0 and IBM DB2 v. 9.7. This article explains
how to deploy using the more recent release.

Maximo Language Files and Tables - Demystified: This blog entry provides useful information about how the translations in Maximo
work. The content describes Maximo Asset Management, but it also applies to IBM Control Desk.

Comments

There are no comments.
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Installation documentation is provided in HTML format in the IBM Control Desk documentation in the

IBM Knowledge Center.

The IBM Knowledge Center provides translated content and offers the ability to create guides in PDF format directly from

Knowledge Center.

In addition to the documentation provided in the IBM Knowledge Center, for Control Desk v7.6.0, installation
documentation in PDF format is available in the following table:

Language NL code WebSphere Application Server Oracle WebLogic Server
English en 7.6.0 7.6.0
Portuguese Brazilian pt_br 7.6.0 7.6.0
Chinese--Taiwan zh_TW not available not available
Chinese-Mainland zh_CN 7.6.0 7.6.0
Dutch nl not available not available
French fr 7.6.0 7.6.0
German de 7.6.0 7.6.0
Japanese ja 7.6.0 7.6.0
Korean ko not available not available
Spanish es 7.6.0 7.6.0
Czech cs 7.6.0 7.6.0
Hungarian hu 7.6.0 7.6.0
Polish pl 7.6.0 7.6.0
Russian ru 7.6.0 7.6.0
Swedish sV not available not available
Arabic ar not available not available
Croatian hr not available not available
Slovak sk not available not available
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This page provides information that can help you upgrade IBM Control Desk.

Documentation

Documentation for upgrading to a newer version of the product can be found at the following links.

e \ersion 7.6.1 upgrade documentation is provided in the IBM Knowledge Center and is translated.

e Version 7.6.0 upgrade documentation is provided in the IBM Knowledge Center and is translated. You can
download the guide in PDF format from the PDF upgrade guides page.

e \ersion 7.5.3 Upgrade Guide - Download the guide in PDF format

e Version 7.5.1 Upgrade Guide - Download the guide in PDF format

e Version 7.5 Upgrade Guide - Download the guide in PDF format

Additional Resources

For upgrading to IBM Control Desk version 7.5.x, review the following presentations:

1. SCCD Upgrade Overview

2. SCCD Upgrading_ - General Information
3. SCCD Upgrading - ITIC and DW

4. SCCD Upgrading - TAMIT functions

5

. SCCD Upgrading - Service Provider

Maximo Upgrade Tips: Decreasing the downtime when upgrading Maximo 7.5.0.8 to Maximo 7.6.0.1: See this blog entry
for useful tips that can be applied to upgrading products that are based on Tivoli's process automation engine (TPAE),
including IBM Control Desk.

Upgrading Maximo 7.5 to Maximo 7.6 (part 1) - This blog entry describes how to upgrade an Oracle database.

Upgrading Maximo 7.5 to Maximo 7.6 (part 2) - This blog entry describes how to use the Configuration Tool to configure
the database.

Comments

There are no comments.
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You are in: IBM Control Desk > Installing, Migrating, and Upgrading > Upgrade resources > PDF upgrade guides

PDF upgrade guides

E Like | Updated November 19, 2018 by Laura.Cunniffe.Aricent | Tags: None

Installation and upgrade documentation is provided in HTML format in the IBM Control Desk documentation in the
IBM Knowledge Center.

This wiki page provides links to upgrade documentation for IBM Control Desk v7.6.0 and earlier in PDF format.

For upgrade information for version 7.6.1 or later, see the IBM Knowledge Center.

You can create guides in PDF format directly from Knowledge Center. For your convenience, upgrade guides for v7.6.0 in
PDF format are also provided here.

NOTE: Upgrade guides for product versions earlier than 7.6 are available only in English and are not published in IBM
Knowledge Center.

To download a PDF version of an upgrade guide, click the appropriate language and version for your organization.

Language NL code Click the version that you
want to upgrade to

English en 7.6.0

7.5.3

7.51

7.5
Portuguese Brazilian pt_br 7.6.0
Chinese--Taiwan zh TW not available
Chinese-Mainland zh CN 7.6.0
Dutch nl not available
French fr 7.6.0
German de 7.6.0
Japanese ja 7.6.0
Korean ko not available
Spanish es 7.6.0
Czech cs 7.6.0
Hungarian hu 7.6.0
Polish pl 7.6.0
Russian ru 7.6.0
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Swedish sV not available
Arabic ar not available
Croatian hr not available
Slovak sk not available
Slovenian sl not available
Turkish tr not available
Comments

There are no comments.
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You are in: IBM Control Desk > Overview and Planning

Overview and Planning
E Like | Updated December 12, 2014 by Fidelma_Frahill | Tags: None

This section of the wiki includes overview and planning information for IBM Control Desk (formerly IBM SmartCloud
Control Desk).

e System Requirements

Product Compatibility

e Product Database Release Enhancements
¢ JRE Support

Comments

There are no comments.
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You are in: IBM Control Desk > Overview and Planning > System Requirements

System Requirements
E Like | Updated 12/9/19 at 4:27 PM by BhratPatel | Tags: None

Select the version of the product for which you want to view system requirements.

e Version 7.6.1 and higher
e \ersion 7.6.0

JRE Support: Java Runtime Environment (JRE) compatibility for IBM Control Desk, IBM Change and Configuration
Management Database, IBM Tivoli Service Request Manager, and IBM Tivoli Asset Management for IT is determined by
the version of Tivoli's process automation engine (TPAE) that is used for the product. See this article for detailed
information about JRE support for various product releases.

Comments

There are no comments.
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o The comment was deleted.

You are in: IBM Control Desk > Overview and Planning > System Requirements > Version 7.6.0

Version 7.6.0

E 1 Like | Updated August 28, 2017 by LauraCunniffe | Tags: None

The following system requirements apply to IBM Control Desk Version 7.6.0 and to IBM Control Desk, Service Provider Edition, Version 7.6.0.

Review each of the tables for the prerequisite hardware and software and ensure that your environment meets the minimum standards before you perform the installation.
Contents

o Application Performance

o Port availability

¢ Hardware (stand-alone topology)
o Hardware (distributed topology)
e Browser

o File systems

e Middleware installation program
¢ Product installation program

e Database

e J2EE application server

e HTTP server

e Directory server

e Control Desk Everyplace device and viewport support

The IBM Control Desk installation and middleware installation programs install and configure IBM products that make up the Control Desk architecture. Previously installed IBM products can be configured to be part of the
Control Desk system. These existing resources must meet minimum release level requirements. In some cases, the Control Desk installation programs can configure previously deployed products from other vendors to be
used with Control Desk. Prerequisites listed for non-IBM products were valid at the time this document was created. For the most up-to-date information about non-IBM product prerequisites, see the product documentation
for each individual product.

Notes:

¢ While Control Desk itself supports the Turkish language, the installation program does not support Turkish. Furthermore, the administrative workstation must not be set to the Turkish locale before or after installing
Control Desk. After Control Desk has been installed successfully, Turkish can be deployed as either the base or as an additional language using the language pack installation program. The administrative
workstation must remain set to a non-Turkish locale to accommodate future product deployment actions.

o Control Desk supports deployment in IPv6 networks. The middleware and product installers can be used in a pure IPv6 environment, provided all the deployment systems support IPv6. An administrative workstation
that does not support IPv6 by default, for example, Microsoft Windows XP, requires an IPv4 environment.

Application Performance
For optimal application performance, plan on one JVM for every CPU with 6-8 GB RAM configured for each JVM. Each JVM should support 50 -75 users.

The installation program sets maximum memory to 4 Gb for 64-bit platforms if automatic configuration for middleware is selected.
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Port availability

Ensure that the ports relevant for your deployment are open in support of the installation and deployment.

| Port | Use

22 lssH

‘80 ”HTTPServer

‘9080 ”WebSphere Application Server virtual host port number, in the JVM.
|389 ”Directory server port

|636 ”Directory server secure port

‘1433 ”Microsoft SQL Server (default)

‘1 521 ”Oracle (default)

‘3538 ”Directory server admin daemon port

l8879 ISOAP port to IBM WebSphere Application Server Network Deployment

‘9043, 9044||IBM WebSphere Application Server Network Deployment administrative console secure port

‘9060, 9061 ”IBM WebSphere Application Server Network Deployment administrative console

|
|
|
|
{
|
|
|
|3539 ”Directory server admin daemon secure port ’
%
|
|
|
|
|
|
|

‘9430 ”Web server port

|9443 ”IBM WebSphere Application Server Network Deployment SSL port
|7001 ”Oracle WebLogic Server host port number

139 IThis port is used if SMB is configured to run on NetBIOS over TCP/IP.
50000  ||IBM DB2 database port for directory server

50005  ||IBM DB2 database instance port

A PING command issued from the administrative workstation must receive a response from each server used in the deployment. Ensure that each middleware host server is configured to respond to PING requests.

Back to the top

Hardware (stand-alone topology)

Stand-alone deployment hardware prerequisites: This table contains hardware information for IBM middleware components. If you use non-IBM middleware components, see the documentation provided with the product.

| Software | Hardware
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| Software | Hardware |
o Administrative workstation e 2 GHz processor
o IBM DB2 (alternative database can be used) + 60 GB disk space
o IBM WebSphere Application Server Network Deployment (alternative J2EE can be used) « 8 GB RAM
o |BM Tivoli Directory Server (optional component)

Notes

¢ Running a production server on a 32-bit system is not supported.

Back to the top

Hardware (distributed topology)

Distributed deployment hardware prerequisites: This table contains hardware information for IBM middleware components. If you use non-IBM middleware components, see the documentation provided with the product.

| Software

Hardware

Administrative workstation

2-6 GHz processor (minimum)

8 GB RAM (minimum)

10 Mbit/s network connection between administrative workstation and middleware servers
(minimum)

11 GB disk space

You must have a minimum of 11 GB disk space available for a fresh installation. Ensure 7 GB of disk
space is available if you are performing an upgrade.

An additional 6 GB of disk space must be available in the TEMP directory of the administrative
workstation during the installation.

Consider future process managers you might install when determining your disk space needs.

‘IBM DB2 (alternative database can be used)

HMinimum 60 GB disk space.

IBM WebSphere Application Server Network Deployment
(alternative J2EE server can be used)

2-6 GHz processor
60 GB disk space
8 GB RAM

Oracle WebLogic Server (alternative J2EE server can be used)

2-6 GHz processor
60 GB disk space
8 GB RAM

IBM Tivoli Directory Server (optional component)

Linux and UNIX systems require 1 GB of space available in the /opt directory.

Notes

e Running a production server on a 32-bit system is not supported.

For hardware requirements for software not listed here, see the product documentation provided with that product.

Back to the top
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Browser

Applicable

Browser oS Notes

Apple Mac OS X ||For information about downloading and enabling Java for the Safari browser, see this Apple support topic.
Safari 7.0
Google All For information about downloading and enabling Java for the Chrome browser, see this page.
Chrome 36||Applicable

oS
Microsoft [[All A subset of process automation engine applications require Java Runtime Environment (JRE), version 1.7 be installed on the client. All client
Internet  |[APPlicable |lsystems that access these applications must have the Java Runtime Environment (JRE), version 1.7, from IBM or Oracle installed. The IBM
Explorer 0s JRE 1.7 can be downloaded at the following Web site: http://www.ibm.com/developerworks/java/jdk/. Instruct your users to download and
11.0 install the JRE before they start using the product.
and The Java bit version must match your browser's bit version. If your browser is 32-bit, your Java must be 32-bit. If your browser is 64-bit, your
Internet Java must be 64-bit. If you have a 32-bit browser and 64-bit Java, or a 64-bit browser and 32-bit Java, applets will not load.
E)(;plorer Adobe Flash Player 10 must also be present on the system for IBM Maximo Linear Asset Manager.

ge If using Internet Explorer, you need to install Microsoft Silverlight on the client machine in order to see the status bar in Self Service Center
My Requests pod and View Service Requests dialog.
I\/!ozilla All ) A subset of process automation engine applications require Java Runtime Environment (JRE), version 1.7 be installed on the client. All client
Firefox Applicable |systems that access these applications must have the Java Runtime Environment (JRE), version 1.7, from Oracle, installed. Instruct your
ESR 52 Os users to download and install the JRE before they start using the product.
Adobe Flash Player 10 must also be present on the system for IBM Maximo Linear Asset Manager.

Chrome 60||All This support is applicable to Service Portal.
or later Applicable

oS
Apple All This support is applicable to Service Portal.
Safari 10 ||Applicable
or later oS

For supported browser environments, IBM Remote Technical Support will provide the same level of support as when Maximo or SmartCloud Control Desk operates in certified browser environments. IBM Remote Technical

Support will accept usage-related and defect-related service requests. As with operating system and vitalization environments, if IBM support cannot recreate the issue in our lab, we may ask the client to recreate the

problem on a certified browser version in order to determine if a product defect exists. Defects will not be accepted for cosmetic differences between browsers or browser versions that do not affect the functional behavior of

the product. If a problem is identified in Maximo or SmartCloud Control Desk, defects will be accepted. If a problem is identified with the browser, IBM will investigate potential solutions or workarounds that the client may
implement until a permanent solution becomes available.

Back to the top

File systems

The following table lists the disk space to allocate to each directory for the installation process. These directories do not exist before installation. Ensure that the parent directory of those directories have sufficient space

available for the installation.
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The middleware installation program does not support linked file systems on Linux or UNIX systems. The middleware installation program renames directories during the installation process. For example, if the directory
Jopt/IBM/db2/V10.5 is a file system link, errors occur during middleware installation of DB2. The middleware installation program is not able to rename the directory. Create file system links in a parent directory such as
/opt/IBM/db2, /opt/IBM or /opt.

Windows file system disk space prerequisites

Product and components File system Available Sp;lc;)Required (in Og;le;?;irr':g
IbB2 |c:\Program Files\IBM\SQLLIB 1500 MB windows (64-bit) |
IBM Tivoli Directory Server |C:\Program Files\IBM\LDAP\V6.3 800 MB |Windows (64-bit) |
IBM Tivoli Directory Server |C\idslap-idsccmdb 1049 MB |Windows (64-bit) |
|WebSphere Application Server “C:\Program Files\IBM\WebSphere\AppServer ”1700 MB HWindows(64-bit) |
WebSphere Application Server Update C:\Program Files\IBM\WebSphere\Updatelnstaller 500 MB Windows (64-bit)
Installer
IBM HTTP Server lc:\Program Files\IBM\HTTPServer 1074 MB |Windows (64-bit) |
Installation programs Temporary space designated for use by the middleware installation {1049 MB Windows (64-bit)
program.
‘Middleware installation program HWorkspace directory ”512 MB HWindows (64-bit) |
|Various HSystem temporary directory ”450 MB HWindows (64-bit) |
lVarious “User temporary directory ”615 MB HWindows (64-Dbit) |
Deployment engine C:\ibmi\tivoli\mwi\workspace750\system\DE 180 MB Windows (64-bit)
Install_DinCTG_DE

UNIX file system disk space prerequisites

Available
Product and . Space .
components File system Required Operating System
(in MB)
DB2 /opt/IBM/db2/V10.5 2208 MB ||AIX

The mount point for this path must
be defined as /opt/IBM/db2

IBM Tivoli /opt/IBM/LDAP/V6.3 900 MB AlX

ggfvtgfry The mount point for this path must
be defined as /opt/ibm/LDAP
IBM Tivoli /home/idsccmdb 1049 AIX
Directory
Server
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Available
Product and . Space .
components File system Required Operating System
(in MB)
WebSphere /usr/IBM/WebSphere/AppServer 2420 MB  ||AIX
Application
Server
\WebSphere /usr/IBM/WebSphere/Updatelnstaller||[500 MB  ||AIX
Application
Server Update
Installer
IBM HTTP /usr/IBM/HTTPServer 1074 MB ||AIX
Server
Installation Temporary space designated for use |[2098 MB ||AIX
programs by the middleware installation
program.
Middleware Workspace directory 512 MB  |AIX
installation
program
\arious System temporary directory 615MB |AIX
The /tmp directory must have 1 GB of space available during installation if the installation program
deploys application EAR files automatically to WebSphere Application Server. If you have assigned
another directory to serve as the system temporary directory, the /tmp directory must still have 1
GB of space available.
DB2 /opt/ibm/db2/V10.5 2208 MB ||Linux
The mount point for this path must SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
be defined as /opt/ibm/db2
DB2 /home/ctginst1 175 MB Linux
SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
WebSphere /opt/IBM/WebSphere/AppServer 2420 MB  ||Linux
éppllcatlon SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
erver
WebSphere /opt/IBM/WebSphere/Updatelnstaller||500 MB  ||Linux
Application SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
Server Update
Installer
IBM HTTP /opt/IBM/HTTPServer 1074 MB ||Linux
Server

SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
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Available
Product and . Space .
components File system Required Operating System
(in MB)
Installation Temporary space designated for use [[2098 MB ||Linux
programs by the middleware installation
program.
SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.

Middleware Workspace directory 512 MB  ||Linux
installation SUSE Linux Enterprise Server v11, and Red Hat Enterprise Linux v6 and v7.
program

Back to the top

Middleware installation program

The middleware installation program can be run on the following systems.

Middleware Installation

Deployment Role:
Server, Agent/End-
point

Operating System Attributes Applicable Notes
Component
|AIX Platform listing of supported OS
AIX 7.1 POWER System and future OS fix Bitness: 64 Bit Middleware ||a|x 7.1 SP1
packs Tolerate Installation
Deployment Role:
Server, Agent/End-
point
Hardware platform:
POWER System
|Linux Platform listing of supported OS
Red Hat Enterprise Linux (RHEL) Server 6 Bitness: 64 Bit Middleware ||To ensure that you are using the right version of Linux for your Power Systems server,
POWER System and future OS fix packs Exploit installation ||see the Linux on Power Systems documentation:

e For POWER 6 and POWER 7, see http://www-

01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm

o For POWER 8, see http://www-

01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
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Operating System Attributes Applicable Notes
Component
Red Hat Enterprise Linux (RHEL) Server 6 Bitness: 64 Bit Middleware |[To ensure that you are using the right version of Linux for your Power Systems server,
Update 5 POWER System and future OS fix Exploit installation |isee the Linux on Power Systems documentation:
packs )
Deployment Role: « For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point « For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Red Hat Enterprise Linux (RHEL) Server 6 IBM |[Bitness: 64 Bit Middleware ||To ensure that you are using the right version of Linux for your Power Systems server,
System z and future OS fix packs Exploit Installation |[see the Linux on Power Systems documentation:
Deployment Role: e For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point e For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Hardware platform:
System z
Red Hat Enterprise Linux (RHEL) Server 6 x86- ||Bitness: 64 Bit Middleware ||To ensure that you are using the right version of Linux for your Power Systems server,
64 and future OS fix packs Exploit Installation ||see the Linux on Power Systems documentation:
Deployment Role: ¢ For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point e For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Hardware platform:
x86-64
Red Hat Enterprise Linux (RHEL) Server 7 Bitness: 64 Bit Middleware | To ensure that you are using the right version of Linux for your Power Systems
POWER System and future OS fix packs Exploit Installation |lserver, see the Linux on Power Systems documentation:
Deployment Role: o For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point « For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Red Hat Enterprise Linux (RHEL) Server 7 Bitness: 64 Bit Middleware | To ensure that you are using the right version of Linux for your Power Systems
System z and future OS fix packs Exploit Installation

Deployment Role:
Server, Agent/End-
point

Hardware platform:
System z

server, see the Linux on Power Systems documentation:

e For POWER 6 and POWER 7, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm

e For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
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Operating System Attributes Applicable Notes
Component
Red Hat Enterprise Linux (RHEL) Server 7 x86- Bitness: 64 Bit Middleware || 1o ensure that you are using the right version of Linux for your Power Systems
64 and future OS fix packs Exploit Installation ||server, see the Linux on Power Systems documentation:
Deployment Role: o For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point o For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Hardware platform:
x86-64
SUSE Linux Enterprise Server (SLES) 11 Bitness: 64 Bit Middleware ||To ensure that you are using the right version of Linux for your Power Systems server,
POWER System and future OS fix packs Exploit Installation |[see the Linux on Power Systems documentation:
Deployment Role: ¢ For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point o For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
SUSE Linux Enterprise Server (SLES) 11 SP3 ||Bitness: 64 Bit Middleware |[To ensure that you are using the right version of Linux for your Power Systems server,
POWER System and future OS fix packs Exploit Installation |[see the Linux on Power Systems documentation:
Deployment Role: o For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point e For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
SUSE Linux Enterprise Server (SLES) 11 Bitness: 64 Bit Middleware |[To ensure that you are using the right version of Linux for your Power Systems server,
System z and future OS fix packs Exploit Installation ||see the Linux on Power Systems documentation:
Deployment Role: e For POWER 6 and POWER 7, see http://www-
Server, Agent/End- 01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm
point o For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
Hardware platform:
System z
SUSE Linux Enterprise Server (SLES) 11 x86- ||Bitness: 64 Bit Middleware |[To ensure that you are using the right version of Linux for your Power Systems server,
64 and future OS fix packs Exploit Installation ||see the Linux on Power Systems documentation:

Deployment Role:
Server, Agent/End-
point

Hardware platform:
x86-64

e For POWER 6 and POWER 7, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistrospower7.htm

o For POWER 8, see http://www-
01.ibm.com/support/knowledgecenter/linuxonibm/liaam/liaamdistros.htm
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Hardware platform:

x86-64

Operating System Attributes Applicable Notes
Component

|Windows Platform listing of supported OS

Windows 7 Enterprise Edition x86-64 Bitness: 64-Tolerate, ||[Middleware ||Client operating system only.
64-Exploit, 32 Installation
Hardware platform:
x86-64

\Windows 7 Professional Edition x86-64 Bitness: 64-Tolerate, ||[Middleware ||Client operating system only.
64-Exploit, 32 Installation
Hardware platform:
x86-64

Windows 8 Enterprise Edition x86-64 Bitness: 64-Tolerate, |Middleware |[Client operating system only.
64-Exploit, 32 Installation
Hardware platform:
x86-64

Windows 8 Professional Edition x86-64 Bitness: 64-Tolerate. |[Middleware |[Client operating system only.
64-Exploit, 32 " |linstallation
Hardware platform:
x86-64

Windows 8 Standard Edition x86-64 Bitness: 64-Tolerate. |[Middleware |[Client operating system only.
64-Exploit, 32 " |linstallation
Hardware platform:
x86-64

Windows 8.1 Enterprise x86-64 Bitness: 64-Tolerate. |[Middleware |[Client operating system only.
64-Exploit, 32 " |linstallation
Hardware platform:
x86-64

Windows 8.1 Professional Edition x86-64 Bitness: 64-Tolerate. |[Middleware |[Client operating system only.
64-Exploit, 32 " |linstallation
Hardware platform:
x86-64

Windows 8.1 Standard Edition x86-64 Bitness: 64-Tolerate. |[Middleware ||Client operating system only.
64-Exploit, 32 " |linstallation
Hardware platform:
x86-64

Windows Server 2012 Datacenter Edition x86- |Bjtness: 64-Exploit |[Middleware

64 Installation
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Operating System Attributes Applicable Notes
Component
Windows Server 2012 R2 Datacenter Edition ||Bjtness: 64-Exploit  |[Middleware
x86-64 ~|[Installation
Hardware platform:
x86-64
Windows Server 2012 Standard Edition x86-64 ||Bjtness: 64-Exploit  |[Middleware
~|[Installation
Hardware platform:
x86-64
Windows Server 2012 R2 Standard Edition Bitness: 64-Exploit |[Middleware
x86-64 ~|[Installation
Hardware platform:
x86-64

Back to the top

Product installation program

Windows

The following Windows systems can serve as the administrative workstation component of the product:

|

Operating System

Attributes

| Applicable Component |Notes|

|Windows Platform listing of supported OS

|

Windows Server 2012 Datacenter Edition x86-64

Bitness: 64-Exploit

Hardware platform: x86-64

Administrative Workstation

Windows Server 2012 R2 Datacenter Edition x86-64

Bitness: 64-Exploit

Hardware platform: x86-64

Administrative Workstation

Windows Server 2012 Standard Edition x86-64

Bitness: 64-Exploit

Hardware platform: x86-64

Administrative Workstation

Windows Server 2012 R2 Standard Edition x86-64

Bitness: 64-Exploit

Hardware platform: x86-64

Administrative Workstation

AIX and Linux

The following AlX and Linux systems can serve as the administrative workstation component of the product:

Operating System

Attributes

Applicable
Component

Notes

|AIX Platform listing of supported OS
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Operating System Attributes Applicable Notes
Component
AIX 6.1 POWER System and future OS |Bitness: 64 Bit Administrative||a|x 6.1 TL4
fix packs Tolerate Workstation

Deployment Role:
Server,
Agent/End-point

Hardware

platform: POWER

System
AIX 7.1 POWER System and future OS |Bitness: 64 Bit Administrative||p|x 7.1 SP1
fix packs Tolerate Workstation

Deployment Role:
Server,
Agent/End-point

Hardware
platform: POWER
System

[Linux Platform listing of supported OS

Red Hat Enterprise Linux (RHEL) 5 Bitness: 64 Bit Administrative
Advanced Platform System z and future ||[Exploit Workstation
OS fix packs

Deployment Role:
Server,
Agent/End-point

Hardware

platform: System z
Red Hat Enterprise Linux (RHEL) 5 Bitness: 32 Bit Administrative|[No support for production 32 bit Linux systems, only test and development systems are
Advanced Platform x86-32 and future Workstation ||supported. Installation through the Administrative Workstation program is not supported
OS fix packs Deployment Role: on 32 bit Linux platforms.

Server,

Agent/End-point

Hardware
platform: x86-32
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Operating System

Attributes

Applicable
Component

Notes

Red Hat Enterprise Linux (RHEL) 5
Advanced Platform x86-64 and future
OS fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-64

Administrative
Workstation

Red Hat Enterprise Linux (RHEL) 5
Server POWER System and future OS
fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Administrative
Workstation

Red Hat Enterprise Linux (RHEL)
Server 6 POWER System and future
OS fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Administrative
Workstation

Red Hat Enterprise Linux (RHEL)
Server 6 System z and future OS fix
packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: System z

Administrative
Workstation

Red Hat Enterprise Linux (RHEL)
Server 6 x86-32 and future OS fix packs

Bitness: 32 Bit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-32

Administrative
Workstation

No support for production 32 bit Linux systems, only test and development systems are
supported. Installation through the Administrative Workstation program is not supported

on 32 bit Linux platforms.

13/23



11/12/2019

IBM Control Desk : Version 7.6.0

Operating System

Attributes

Applicable
Component

Notes

Red Hat Enterprise Linux (RHEL)
Server 6 x86-64 and future OS fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-64

Administrative
Workstation

SUSE Linux Enterprise Server (SLES)
10 POWER System and future OS fix
packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Administrative
Workstation

SUSE Linux Enterprise Server (SLES)
10 System z and future OS fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: System z

Administrative
Workstation

SP2

SUSE Linux Enterprise Server (SLES)
10 x86-32 and future OS fix packs

Bitness: 32 Bit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-32

Administrative
Workstation

No support for production 32 bit Linux systems, only test and development systems are
supported. Installation through the Administrative Workstation program is not supported

on 32 bit Linux platforms.

SUSE Linux Enterprise Server (SLES)
10 x86-64 and future OS fix packs

Bitness: 64 Bit
Exploit

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-64

Administrative
Workstation

No support for production 32 bit Linux systems, only test and development systems are
supported. Installation through the Administrative Workstation program is not supported

on 32 bit Linux platforms.
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Operating System Attributes Applicable Notes
Component
SUSE Linux Enterprise Server (SLES) ||Bitness: 64 Bit Administrative
11 POWER System and future OS fix  ||[Exploit Workstation

packs
Deployment Role:
Server,
Agent/End-point

SUSE Linux Enterprise Server (SLES) ||Bitness: 64 Bit Administrative
11 System z and future OS fix packs Exploit Workstation

Deployment Role:
Server,
Agent/End-point

Hardware
platform: System z
SUSE Linux Enterprise Server (SLES) ||Bitness: 32 Bit Administrative|[No support for production 32 bit Linux systems, only test and development systems are
11 x86-32 and future OS fix packs Workstation ||supported. Installation through the Administrative Workstation program is not supported
Deployment Role: on 32 bit Linux platforms.
Server,

Agent/End-point

Hardware
platform: x86-32

SUSE Linux Enterprise Server (SLES) ||Bitness: 64 Bit Administrative
11 x86-64 and future OS fix packs Exploit Workstation

Deployment Role:
Server,
Agent/End-point

Hardware
platform: x86-64

Back to the top

Database

The product installation creates approximately 750 tables in the database. Ensure that the database server has sufficient disk space free to accommodate this number of new table entries.

The following products can serve as the database component of a Control Desk deployment.
Microsoft SQL Server

The following table shows the supported versions of Microsoft SQL Server.

[ Product [ Applicable OS ||
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Microsoft SQL ServePrathuptise Edition 2012

A pypibiablecasS

Microsoft SQL Server Enterprise Edition 2012 SP1||All Applicable OS

[Microsoft SQL Server Enterprise Edition 2014

|All Applicable OS]

[Microsoft SQL Server Standard Edition 2012

|All Applicable OS]

IMicrosoft SQL Server Standard Edition 2012 SP1 [|All Applicable OS|

IMicrosoft SQL Server Standard Edition 2014

|All Applicable OS]

Oracle

The following table shows the supported versions of Oracle Database.

| Product |

Applicable OS

Notes

Oracle Database 11g AlIX 7,

64,

POWER,

Standard Edition Release 2 |Red Hat Enterprise Linux 6 x86-64,
Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER,
SUSE Linux Enterprise Server (SLES) 11 x86-

SUSE Linux Enterprise Server (SLES) 11

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.

Oracle Database 11g AlX 7,

64,

POWER,

Enterprise Edition Release 2 ||[Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-

SUSE Linux Enterprise Server (SLES) 11

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.

Oracle Database 12¢c AIX 7,

64,

POWER,

Standard Edition Release 1 Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-

SUSE Linux Enterprise Server (SLES) 11

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.
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| Product

Applicable OS

Notes

Oracle Database 12c
Standard Edition One
Release 1

AIX 7,

Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-
64,

SUSE Linux Enterprise Server (SLES) 11
POWER,

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.

Oracle Database 12c¢
Enterprise Edition Release 1

AIX 7,

Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-
64,

SUSE Linux Enterprise Server (SLES) 11
POWER,

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.

Oracle Real Application
Clustering (Oracle 11g
Release 2)

AIX 7,

Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-
64,

SUSE Linux Enterprise Server (SLES) 11
POWER,

Windows Server 2012 and future fix packs
Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.

Oracle Real Application
Clustering (Oracle 12c
Release 1)

AIX 7,

Red Hat Enterprise Linux 6 x86-64,

Red Hat Enterprise Linux 6 System z,

Red Hat Enterprise Linux 6 POWER, SUSE
Linux Enterprise Server (SLES) 11 System z,
SUSE Linux Enterprise Server (SLES) 11 x86-
64,

SUSE Linux Enterprise Server (SLES) 11
POWER,

Windows Server 2012 and future fix packs

Windows Server 2012 R2 and future fix packs

As of December 12, 2014, Oracle supports Oracle Database on Red Hat Enterprise
Linux 6. For the latest support information, see the product configuration matrix.
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DB2

The following table shows the supported DB2 databases.
| Product | Applicable OS |

DB2 Enterprise Server Edition 10.1.0.2 and future fix packs [|AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

DB2 Enterprise Server Edition 10.5.0.4 and future fix packs ||AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

DB2 Workgroup Server Edition 10.1.0.2 and future fix packs||AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012
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| Product | Applicable OS |

DB2 Workgroup Server Edition 10.5.0.4 and future fix packs||AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

IBM DB2 pureScale Feature 10.1 and future fix packs AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

IBM DB2 pureScale Feature 10.5 and future fix packs AIX 7.1 64-bit

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

Back to the top

J2EE application server
The following products can serve as the J2EE application server component of a Maximo Asset Management deployment. The J2EE application server hosts the Maximo Asset Management application.
Oracle WebLogic Application Server

The hardware requirements for WebLogic Application Server are as follows:
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Hardware | Applicable OS
Disk Space|go GB disk space
Memory [ GB RAM |

|Processor ”2-6 GHz processor‘

The following operating systems are compatible with the supported versions of WebLogic Application Server.

Product Applicable [[Notes
(015
. All As of December 12, 2014, Oracle supports Oracle WebLogic Server on Red Hat Enterprise Linux 6. For the latest support

Oracle WebLogic Server . : . . . .

Applicable |linformation, see the product configuration matrix.
12¢ (12.0) oS
Oracle WebLogic Server All As of December 12, 2014, Oracle supports Oracle WebLogic Server on Red Hat Enterprise Linux 6. For the latest support
12cR1 (12.1.1) Applicable |linformation, see the product configuration matrix.

0S
Oracle WebLogic Server All As of December 12, 2014, Oracle supports Oracle WebLogic Server on Red Hat Enterprise Linux 6. For the latest support
12¢cR2 (12.1.2) Applicable |information, see the product configuration matrix.

0S

WebSphere Application Server
The hardware requirements for WebSphere Application Server are as follows:
| Group |Applicable Component|
lDiSk Space||60 GB disk space |
Memory |l5 Gg RAM |

‘Processor ”2-6 GHz processor |

The following operating systems are compatible with WebSphere Application Server.

| Product | Applicable OS
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| Product | Applicable OS |

WebSphere Application Server Network Deployment 8.5 and future fixpacks AIX 7.1 POWER System

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 Datacenter Edition
Windows Server 2012 Standard Edition
Windows Server 2012 R2 Datacenter Edition
Windows Server 2012 R2 Standard Edition

WebSphere Application Server Network Deployment 8.5.5.3 and future fixpacks AIX 7.1 POWER System

(not currently compatible with WebSphere Application Server Network Deployment 8.5.5.4)||Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 Datacenter Edition
Windows Server 2012 Standard Edition
Windows Server 2012 R2 Datacenter Edition
Windows Server 2012 R2 Standard Edition

Back to the top

HTTP server

The following product can serve as the HTTP server component.

| Product | Applicable OS Notes|
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| Product

| Applicable OS

|Notes|

IBM HTTP Server 8.5.5 and future fix packs (overview) (support)

Red Hat Enterprise Linux Server 6 x86-64
Red Hat Enterprise Linux Server 6 POWER
Red Hat Enterprise Linux Server 6 System z
Red Hat Enterprise Linux Server 7 x86-64
Red Hat Enterprise Linux Server 7 POWER
Red Hat Enterprise Linux Server 7 System z
SuSE Enterprise Linux 11 x86-64

SuSE Enterprise Linux 11 POWER

SuSE Enterprise Linux 11 System z
Windows Server 2012 R2

Windows Server 2012

Back to the top

Directory server

The following products can serve as the directory server component of a Maximo Asset
Tivoli Directory Server/IBM Security Directory Server

Hardware requirements

Management deployment.

To install the directory server, Linux and Unix systems require at least 1 GB free space in /opt.

Operating system requirements

The following operating systems are supported.

| Product |Operating System|| Notes |

IBM Security Directory Server 6.4 (overview)
Detailed System Requirements for Tivoli Directory Server

Tivoli Directory Server 6.3 and future fix packs (overview)||All Applicable OS |[Maximo Application Server

Microsoft Active Directory

Microsoft Active Directory 2012 or 2012 R2 can be used as the directory server compon
Hardware requirements

Refer to product documentation for Microsoft Active Directory hardware requirements.
Operating system requirements

All applicable operating systems are supported with Microsoft Active Directory 2012 and

ent of the deployment.

2012 R2.
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Control Desk Everyplace device and viewport support

Supported devices

You can access IBM Control Desk Everyplace from the standard browsers on the following devices:

e iPhone
¢ iPod Touch
e iPad

Android 2.1 or higher
Blackberry devices running Blackberry OS version 6 or higher

Supported viewports

A viewport defines the viewable screen area on a mobile device at a specific screen resolution.
The following viewports are supported in the Application Designer:

o Default: 1041 x 600 pixels
e iPhone: 320 x 416 pixels
¢ iPhone wide: 480 x 268 pixels

You can add more viewports in the Domains application. The following viewport sizes are appropriate for other supported devices:

e iPad: 716 x 874 pixels (or higher)

o iPad wide: 954 x 636 pixels (or higher)

e Android: 320 x 533 pixels (or higher)

¢ Android wide: 533 x 320 pixels (or higher)
o Blackberry PlayBook: 1024x600 pixels

Because Android devices are produced by different manufacturers, it can be necessary to make slight adjustments to the viewport settings to match a specific device.
Supported browsers

o Native browser on iOS devices (iPhone, iPod touch, and iPad) for Everyplace only
o Native browser on devices running Android 2.1+, for Everyplace only

Back to the top

Comments

There are no comments.
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You are in: IBM Control Desk > Overview and Planning > System Requirements > Version 7.6.1

Version 7.6.1

E Like | Updated 12/9/19 at 5:08 PM by BhratPatel | Tags: None

For Control Desk version 7.6.1 system requirements, see the system requirements for Maximo Asset Management
software product compatibility reports and in the product configuration matrix.

o |IBM Software Product Compatibility Report: Provides detailed system requirements including supported
operating systems, hypervisors, prerequisites, supported software, and hardware.

Comments

There are no comments.
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You are in: IBM Control Desk > Overview and Planning > Product Compatibility

Product Compatibility

E Like | Updated today at 4:31 PM by BhratPatel | Tags: None

Software Product Compatibility Reports: Use this web site to find detailed system requirements information. On this
site you can dynamically generate operating system, prerequisite, server virtualization environment, translation, end-of-
service, and detailed system requirement reports for your specific product, release, and operating system.

Product Configuration Matrix: A configuration matrix for products based on Tivoli's process automation engine. New
product versions are released and tested on an ongoing basis. We do our best to keep this matrix up to date, but please
note the last updated date.

Coexistence Matrix 7.6.x: This coexistence matrix shows which Tivoli Process Automation Engine (TPAE) product
versions are formally supported together for 7.6.x. New product versions are released and tested on an ongoing basis.
We do our best to keep this matrix up to date, but please note the last updated date in the file description.

Comments

There are no comments.
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You are in: IBM Control Desk > Overview and Planning > What's New

What's New

E Like | Updated 12/9/19 at 5:14 PM by BhratPatel | Tags: itsm, sccd, smartcloud

New features and capabilities in each version of Control Desk can help your organization achieve greater efficiency.

Click your version to see what's new:

New in V7.6.1.1
New in V7.6.1

New in V7.6.0.4
New in V7.6.0.3
New in V7.6.0.2
New in V7.6.0.1
New in V7.6.0

Comments

There are no comments.

1/1


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Overview%20and%20Planning?lang=en
javascript:;
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=itsm
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=sccd
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=smartcloud
javascript:;

09/12/2019 IBM Control Desk : New in V7.6.1.1

You are in: IBM Control Desk > Overview and Planning > What's New > New in V7.6.1.1

New in V7.6.1.1

E Like | Updated 8/13/19 by Laura.Cunniffe.Aricent | Tags: None

IBM Control Desk Version 7.6.1.1

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's New in Control Desk v7.6.1.1 in the IBM Knowledge Center.

System Requirements

You can find system requirements for IBM Control Desk here.

Release Notes

The installation-related release notes contain information to review before beginning the installation process. The known
issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues, and other key

product information.

Download document for IBM Control Desk v7.6.1.1

IBM Control Desk on IBM Support

Product Documentation

IBM Knowledge Center

You can find documentation for IBM Control Desk on the internet in IBM Knowledge Center. For information about
how to use IBM Knowledge Center, see IBM Knowledge Center. You can find IBM Control Desk documentation at
the following links:

e |IBM Control Desk
o |IBM Control Desk for Service Providers

Information Center: Locally installed information centers are no longer included in IBM Control Desk starting in version 7.6.0.2.
Product help now links directly to the IBM Knowledge Center. The IBM Control Desk on Cloud documentation has been sunsetted. See
the main Control Desk documentation in the IBM Knowledge Center at the links above.

Comments
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New in V7.6.1

E Like | Updated 8/13/19 by Laura.Cunniffe.Aricent | Tags: None

IBM Control Desk Version 7.6.1

Contents

o What's New

e System Requirements
e Release notes
Product documentation

What's New

For details, see What's New in Control Desk v7.6.1 in the IBM Knowledge Center.

System Requirements

You can find system requirements for IBM Control Desk here.

Release Notes

The installation-related release notes contain information to review before beginning the installation process. The known
issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues, and other key

product information.
Download document for IBM Control Desk v7.6.1

IBM Control Desk on IBM Support

Product Documentation

IBM Knowledge Center

You can find documentation for IBM Control Desk on the internet in IBM Knowledge Center. For information about
how to use IBM Knowledge Center, see IBM Knowledge Center. You can find IBM Control Desk documentation at
the following links:

e |IBM Control Desk
e |IBM Control Desk for Service Providers
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IBM Control Desk Fix Pack 7.6.0.4

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's new in IBM Control Desk 7.6.0.4 in IBM Knowledge Center.

System Requirements

You can find system requirements for IBM Control Desk 7.6.0 here.

Release Notes

The installation-related release notes contain information to review before beginning the installation process. The known
issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues, and other key
product information.

IBM Control Desk on IBM Support

Product Documentation

Information Center

Locally installed information centers are no longer included in IBM Control Desk starting in version 7.6.0.2. Product
help now links directly to the IBM Knowledge Center.

IBM Knowledge Center

You can find documentation for IBM Control Desk on the internet in IBM Knowledge Center. For information about

how to use IBM Knowledge Center, see IBM Knowledge Center. You can find IBM Control Desk documentation at
the following links:

e |BM Control Desk
e |IBM Control Desk for Service Providers
e |BM Control Desk on Cloud
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IBM Control Desk Fix Pack 7.6.0.3

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's new in IBM Control Desk 7.6.0.3 in IBM Knowledge Center.

System Requirements

You can find system requirements for IBM Control Desk 7.6.0 here.

Release Notes

The installation-related release notes contain information to review before beginning the installation process. The known
issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues, and other key
product information.

IBM Control Desk on IBM Support

Product Documentation

Information Center

Locally installed information centers are no longer included in IBM Control Desk starting in version 7.6.0.2. Product
help now links directly to the IBM Knowledge Center.

IBM Knowledge Center

You can find documentation for IBM Control Desk on the internet in IBM Knowledge Center. For information about
how to use IBM Knowledge Center, see IBM Knowledge Center. You can find IBM Control Desk documentation at
the following links:

e |BM Control Desk
e |IBM Control Desk for Service Providers
e |BM Control Desk on Cloud

Comments

There are no comments.

12


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Overview%20and%20Planning?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/What's%20New?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/What's%20New?lang=en&section=whatsnew
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/What's%20New?lang=en&section=sysreqs
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/What's%20New?lang=en&section=releasenotes
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/What's%20New?lang=en&section=productdoc
https://www.ibm.com/support/knowledgecenter/SSWT9A_7.6.0.3/com.ibm.sccd.doc/whats_new/c_ctr_whats_new_7603_top.html
https://www.ibm.com/support/home/product/J413280G46302R03/Control_Desk
http://www-01.ibm.com/support/knowledgecenter/
https://www.ibm.com/support/knowledgecenter/SSWT9A
https://www-03preprod.ibm.com/support/knowledgecenter/SSANHD
http://www-01.ibm.com/support/knowledgecenter/SSZRHJ/com.ibm.sccd-saas.doc/sccd_kc_welcome_cloud.html
javascript:;
javascript:;

09/12/2019 IBM Control Desk : New in V7.6.0.3

22



09/12/2019 IBM Control Desk : New in V7.6.0.2

You are in: IBM Control Desk > Overview and Planning > What's New > New in V7.6.0.2

New in V7.6.0.2
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IBM Control Desk Fix Pack 7.6.0.2

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's new in IBM Control Desk 7.6.0.2 in IBM Knowledge Center.

System Requirements

You can find system requirements for IBM Control Desk 7.6.0 here.

Release Notes

The installation-related release notes contain information to review before beginning the installation process. The known
issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues, and other key
product information.

Release notes for fix pack 7.6.0.2
Installation-related release notes for version 7.6.0

Release notes for known issues for version 7.6.0

Product Documentation
Information Center

Locally installed information centers are no longer included in IBM Control Desk starting in version 7.6.0.2. Product
help now links directly to the IBM Knowledge Center.

IBM Knowledge Center

You can find documentation for IBM Control Desk on the internet in IBM Knowledge Center. For information about

how to use IBM Knowledge Center, see IBM Knowledge Center. You can find IBM Control Desk documentation at
the following links:

e |IBM Control Desk
e |IBM Control Desk for Service Providers
e |IBM Control Desk on Cloud
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There are no comments.

2/2



09/12/2019 IBM Control Desk : New in V7.6.0.1

You are in: IBM Control Desk > Overview and Planning > What's New > New in V7.6.0.1

New in V7.6.0.1
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IBM Control Desk Fix Pack 7.6.0.1

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's new in IBM Control Desk 7.6.0.1 in the Control Desk documentation in IBM Knowledge Center.

System Requirements

System requirements for IBM Control Desk 7.6.0 can be found here.

Release Notes

The install-related release notes contain information that you should review before beginning the installation process.
The known issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues,
and other key product information.

Release notes for fix pack 7.6.0.1

Install-related release notes for version 7.6.0

Release notes for known issues for version 7.6.0

Product Documentation
Information Center

Locally installed help is available in an information center, which includes new and updated topics for Control Desk
7.60.1.

Knowledge Center

Documentation for IBM Control Desk can also be found on the internet in IBM Knowledge Center. Knowledge

Center provides easy access to IBM documentation for many products, and it can be customized to give you
access to the collections that you are most interested in. For more information about how to use Knowledge
Center, see I1BM Knowledge Center.

IBM Control Desk documentation can be found at the following links:

e |IBM Control Desk
e |IBM Control Desk for Service Providers
e |IBM Control Desk on Cloud
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Translated documentation plug-ins
Translated documentation for locally installed help is available on Fix Central. There are 2 translation packages:

e 7.6.0.1-TIV-ICDDOC-IC-FP0001.zip

Translated documentation for German, Spanish, French, Hungarian, Japanese, Korean, Dutch, Polish, Brazilian
Portuguese, Russian, Swedish, Czech, and Simplified Chinese.

e 7.6.0.1-TIV-ICDDOC-IC-FP0002.zip

Translated documentation for Slovenian, Slovakian, and Croatian.

To install the translation package, use the instructions that are provided in the readme file in the package instead of using
the instructions that are included in version 7.6 of the IBM Control Desk installation guide.

Comments

There are no comments.
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New in V7.6.0

E Like | Updated 8/13/19 by Laura.Cunniffe.Aricent | Tags: None

IBM Control Desk 7.6.0

Contents

o What's New

e System Requirements
e Release notes

e Product documentation

What's New

For details, see What's new in IBM Control Desk 7.6 in the Control Desk documentation in IBM Knowledge Center.

System Requirements

System requirements for IBM Control Desk 7.6.0 can be found here.

Release Notes

The install-related release notes contain information that you should review before beginning the installation process.
The known issues release notes are comprised of known issues, troubleshooting tips for possible configuration issues,

and other key product information.
Install-related release notes

Release notes for known issues

Product Documentation

Information Center

Locally installed help is available in an information center, which includes new and updated topics for Control Desk
7.6.0.

Knowledge Center

Documentation for IBM Control Desk can also be found on the internet in IBM Knowledge Center. Knowledge

Center provides easy access to IBM documentation for many products, and it can be customized to give you
access to the collections that you are most interested in. For more information about how to use Knowledge
Center, see IBM Knowledge Center.

IBM Control Desk documentation can be found at the following links:

e |IBM Control Desk
e |IBM Control Desk for Service Providers
e IBM Control Desk on Cloud

Translated Documentation
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Translated documentation for locally installed infocenters is available in the 7.6.0.0-TIV-ICDDOC-IC-FP0001.zip file on
Fix Central.

To install the translation package, use the instructions that are provided in the readme file in the package instead of using
the instructions that are included in version 7.6 of the IBM Control Desk installation guide.

Comments

There are no comments.
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Recent Releases
E 5  Like | Updated 12/9/19 at 5:19 PM by BhratPatel | Tags: None

IBM Control Desk : Recent Releases

This page provides information about recent releases and fix packs for IBM Control Desk (formerly IBM SmartCloud Control Desk).

The following table provides links to release information for IBM Control Desk.

Version

Release date

Download requirements

System
requirements

What's new

TPAE version

Control Desk

7.6.0

76.1.1 June 2019 Download document \Version 7.6.1 What's new in IBM Control Desk 7.6.1.1 TPAE 7.6.1

?%r?}rol Desk lz\lgqlgmber Download document \ersion 7.6.1 \What's new in IBM Control Desk 7.6.1 TPAE 7.6.1

?_‘g’_‘g‘j’ Desk  lvay 2018 |Download document Version 7.6.0 What's new in IBM Control Desk 7.6.0.4 TPAE 7.6.0.9
Gontrol Desk |September Inownioad document Version 7.6.0 What's new in IBM Control Desk 7.6.0.3 TPAE 7.6.0.8
Gontro Desk  IMarch 2017 |Download document Version 7.6.0 What's new in IBM Control Desk 7.6.0.2 TPAE 7.6.0.6
Contral Desk  |lPebiuany Iownioad document Version 7.6.0 What's new in IBM Control Desk 7.6.0.1 TPAE 7.6.0.3
Control Desk July 2015 Download Document Version 7.6.0 \What's new in IBM Control Desk 7.6 TPAE 7.6.0.1

Comments

There are no comments.
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You are in: IBM Control Desk > Performance and Tuning

Performance and Tuning
E 1 Like | Updated February 1, 2017 by charglen | Tags: None

System Properties Used by Actual Cl Promotion: The behavior of Actual Cl promotion can be configured via promotion
scopes (which define what will be promoted and how it will be represented in the authorized space), relation rules (which
determine what related ActCls will be processed during promotion) and classifications (which determine what attributes
will be created on the authorized ClI).

Performance Analyst Tool: Learn how to use the Performance Analyst Tool to manage performance analysis.

System Performance Monitoring and Diagnosis using ITCAM Products describes how Composite Application Manager for
Transactions and Composite Application Manager for Application Diagnostics work with IBM Tivoli service management
products to:

e Provide a highly scalable environment with optimized performance

o Diagnose performance and scalability related issues more efficiently and effectively

¢ Provide definitive performance information for capacity planning, including hardware and system recommendation
e Provide quicker turnaround on performance issues

ITCAM for AD Request Mapper for IBM Tivoli service management products contains the Java archive file referenced in
the System Performance Monitoring and Diagnosis using ITCAM Products white paper. The ITCAM Request Mapper for
IBM Tivoli service management products can be used to to align the action from IBM Tivoli service management products
to transactions shown in the ITCAM for AD console. Unzip the zip file to a folder on your system and refer to the
readme.txt file for information on enabling the request mapper.

Best Practices for Integration Composer Performance

Base Services Performance and Tuning

Performance Test Best Practices With HP LoadRunner. This white paper provides guidelines for performance testing
process automation engine products using HP LoadRunner.

Performance Tuning Best Practices for Version 7.5x This covers Websphere Version 7 and DB2 9.7 tuning information
along with other tuning recommendations for Tivoli's process automation engine.

Understanding how to size an environment for performance: This technote provides information about TPAE architecture
and explains how to properly size an environment to support the load requirements.

Using System Instance Properties to Control Cron Tasks: This technote describes how to control which instances of the
application (JVMs) cron tasks will execute in.

Diagnosing JVM Memory problems with Maximo application technote
Using multiple JVMs to support users

Various technotes about performance issues

Performance tools

Performance Monitor:This tool can be used to aid in troubleshooting performance issues. It will help pinpoint SQL with
performance issues related to a specific event on the Ul.

Middleware Performance and Tuning
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Improving WebSphere Performance technote
Improving WebSphere Performance and reducing hung threads:WebSphere Application Servers (WAS) are designed to
recover from catastrophic failure. To do this, temp and transaction files are maintained at all times. If files are not cleared

at deployment time they can cause hung threads and failures in deployment.

DB2 Query Tuning and Index Creation illustrates how tools can be used to perform SQL query tuning and to create
indexes against a DB2 database in order to obtain maximum performance from IBM Tivoli service management products.

Understanding and Tuning Oracle PGA describes how to monitor and manage the Program Global Area (PGA) on Oracle
databases.

Tuning and Indexing Oracle Databases describes how to use the Oracle ADDM and AWR Reports along with the
Enterprise Management Console to perform SQL and index tuning for products based on Tivoli's process automation
engine.

SQL Server 7 and 2000 Performance: Index Tuning

SQL Server Turning off Page Locking

SQL Server Row versioning

SQL Server Improving Performance

Tuning IHS: Describes how to tune the HTTP server.

Enabling data compression on the IBM HTTP Server: You can use the Apache mod_deflate module can be used to
improve response time in environments that have low bandwidth and high latency.

Tuning WebSphere:Number of Whitepapers on tuning WebSphere.
DB2 Snapshot Format Tool: A Perl script that reads a DB2 snapshot file and produces a semicolon-delimited text file. You

can load this file into a spreadsheet to assist with identifying slow-performing SQL queries. Unzip the DB2 snapshot
format tool to a folder on your system and read the readme.txt for prerequisite and usage information.

Performance fixes

DB2 OOM issues 1268122: DB2 3.53.70 JCC NOT CLEANING LOGWRITERS IN CASE OF CONNECTION FAILURE.
LATER JCC REQUIRED

Database connections are growing 1286562 DATABASE SESSIONS GROW WITH ROUTES IN WORKORDER ON
CLUSTERED ENV

Comments

There are no comments.
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The behavior of Actual Cl promotion can be configured via promotion scopes (which define what will be promoted and
how it will be represented in the authorized space), relation rules (which determine what related ActCls will be processed
during promotion) and classifications (which determine what attributes will be created on the authorized Cl). The
promotion dialog has some options that enable you to specify how a particular promotion will behave, but there are also
some system properties and maxvars that affect the behavior of all promotions.

System Properties

System Properties can be modified via the System Properties application (Go To > System Configuration > Platform
Configuration > System Properties). The following System Properties impact the processing that occurs during Actual CI
Promotion:

cci.promotion.keepallblanks

This property is available in SmartCloud Control Desk 7.5. This boolean property defines whether promotion should create
attributes even if the effective value is blank. The default is 0, which means an attribute will only be created by promotion
if it has a non-blank value. If the value is set to 1, promotion will create attributes (CISPECs) even if the value is blank.
This property applies to all attributes for all classifications. If the value of this property is 0, exceptions can be made for
individual classifications by configuring the system property cci.promotion.keepblanks.classstructureid.

Something to consider when deciding how to configure this property is performance. It is not uncommon for there to be
many attributes that have blank values. Creating all of these attributes uses more memory and can increase the amount
of time it takes for promotion to complete. If you don't care about blank values, and you sometimes promote large
numbers of ActCls at one time, you probably want to keep the default value of 0.

cci.promotion.keepblanks.classstructureid

This property is available in SmartCloud Control Desk 7.5. This property is used in conjunction with
cci.promotion.keepallblanks and is specific to the classstructureid that is part of its name. It provides a way to configure
the list of attributes that should be created for this classification even if their value is blank. The value for this property is a
colon (: ) separated list of the names of the attributes that should be created for Cls of this classification even if the value
is null or blank. This property is used if the value of cci.promotion.keepallblanks is 0 and ignored if the value is 1.

cipromotionemail.details.on

This property is available in SmartCloud Control Desk 7.5. Controls whether individual results for each created and
updated CI are attached to the email that is optionally sent when promotion completes. The default value is 0, which
means that only a count of the number of Cls that are created and updated is included in the email, not individual results.
When this property is set to 1, individual results are included as an attachment to the email, subject to the property
cipromotiondetail.filelocation, discussed next.

cipromotiondetail.filelocation

This property is available in SmartCloud Control Desk 7.5. This property specifies the location of a file which contains the
detailed results of the promotion. If cipromotionemail.details.on has a value of 1 and cipromotiondetail.filelocation has a
non-null value and the user requested email on the promotion dialog, the detailed results will be sent in the promotion
results email as an attachment. The files are named PromotionStatusddmmyyyyhhmmss.ixt. There is no default value, so
by default no details are included in the promotion results email. The files in this location are not automatically deleted and
must be deleted manually.

mxe.db.fetchResultStopLimit. ACTCI

This property defines the number of Actual Configuration Items that can be fetched at one time (for example from the List
tab of the Actual Configuration ltems application). The default fetch limit for business objects is 5000. However some
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customers have many more than 5000 ActCls that they want to manage with a single operation. For example they might
want to promote more than 5000 ActCls at one time. This property defines a fetch limit that is specific to ActCls. In Smart
Cloud Control Desk 7.5 the default value is 50000. Note that your system must have sufficient resources, specifically
memory, to handle the specified number of objects.

mxe.db.fetchResultStopLimit.CI

This property is similar to the previous one, except that it defines the number of Configuration Items that can be
processed at one time.

MAXVARS

In addition to these system properties there is a table called MAXVARS that contains some variables used during Actual
Cl promotion. It is very unlikely that these would need to be modified, so there is no Ul to update them. However they can
be modified using database commands. The following maxvars are used by Actual Cl promotion:

CCIACTCICOPYCUST

CCIACTCICOPYCUST affects how customers are propagated to related ActCls during promotion on Service Provider
systems. For any related ActCls that promotion encounters, if there are no associated customers and this maxvar has a
varvalue of 1, promotion will copy the set of customers associated with the initial ActCl to the related ActCI. This happens
before promotion checks if a new Cl needs to be created, so it happens even if no Cl is created. 1 is the default value. If
the value is set to 0, no customers are propagated from the top level ActCl to child ActCls.

The customer on the Actual Cl is used not only to determine who can access the Actual Cl, but it is also used by
promotion when it is creating a new Cl. The primary customer on the Actual Cl is used to determine whether the mapped
authorized classification in the promotion scope and its attributes are customer-appropriate. If a primary customer is
specified on the Actual Cl, a Cl will be created if the mapped classification is a global classification or is associated with
primary customer. If the Actual Cl has no primary customer, a Cl will only be created if the mapped classification is global,
or is not global but has no associated customers.

Sample SQL to update this variable:
update maximo.maxvars set varvalue='0' where varname like 'CCIACTCICOPYCUST%'

This maxvar is available in SmartCloud Control Desk 7.5.
CCICIGENCLASS

This maxvar identifies the classification that is used on generic Cls and is available in SmartCloud Control Desk 7.5.
When the classification on an asset is set to one that is configured to automatically create a generic Cl, the classification
specified on this maxvar is used on the Cl that gets created. During promotion, if an Actual Cl gets linked to an existing Cl
with this generic classification, promotion will re-classify the Cl to the authorized classification in the promotion scope.

The value of this maxvar is the classstructureid of the classification. Note that the classificationid is typically displayed in
the Ul, not the classstructureid.

Here is a sample SQL command to set the value of this maxvar to the classification whose classificationid is
CI.GENERIC_COMPUTERSYSTEM:

update maximo.maxvars set varvalue=(select classstructureid from maximo.classstructure where
classificationid="CI.GENERIC_COMPUTERSYSTEM') where varname = 'CCICIGENCLASS'

Comments

There are no comments.
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The Performance Analyst is a tool that helps you manage performance analysis. The tool includes the following features:

o Ability to import performance data for analysis, for example, DB2 snapshot, Java verbose GC ouput, Java thread
dumps.

o Ability to import software/middleware configuration for analysis and checking, for example, configuration data of
DB2, Oracle, WebSphere, and operating systems.

o Spreadsheet-like interface for easy access and manipulation of imported data.

¢ Rule engine for defining alerts to detect symptoms from the imported data. A predefined set of rules based on
common performance best practices for supported software and middleware is included.

For more information about Performance Analyst, see the IBM Performance Analyst group on Service Management
Connect.

From the IBM Performance Analyst group, you can download the following files:

« documentation zip file that contains documentation for Performance Analyst. Note, however, that the
documentation is also provided within each of the tool downloads. This file is mainly a convenience for users who
want to review the documentation before installing the tool.

o compressed file for Performance Analyst on Windows that contains the tool that you download for the Windows
platform.

e compressed file for Performance Analyst on Linux that contains the tool that you download for the Linux platform.

o compressed file for Performance Analyst on Macintosh OSX that contains the tool that you download for the
Macintosh OSX platform.

e change log that describes the change history from release to release, for example new features and fixes.

Comments

There are no comments.
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The information below was prepared by Yue Xin (Zach) Zhang from Tivoli's Integrated Performance Group.

What's Oracle PGA?

When you use a dedicated server type of Oracle database, the Program Global Area (PGA) is a private memory region
containing data and control information for dedicated server process, for example, runtime area of cursors. Each time a
cursor is executed, a new runtime area is created for that cursor in the PGA memory region. For complex queries (for
example, some SR/OFFERING-related queries are always complex and have many JOINs among base tables), a big
portion of the runtime area is required because these queries always contain several kinds of memory-intensive
operators, such as the following:

Sort-based operators, such as ORDER BY, GROUP BY, ROLLUP, and window functions
e Hash-join

o Bitmap related operations

o Write buffers used by bulk load operations

How does PGA sizing affect your application's performance?

For example, a sort operator uses a work area (also called sort area) to perform the in-memory sort of a set of rows. And
a hash-join operator uses a work area (also called the hash area) to build an intermediate hash table. If the amount of
data to be processed by these kinds of operators does not fit into a work area, the input data is divided into smaller
pieces. Then some data pieces are processed in memory while the rest are spilled to temporary disk. Of course, the in-
memory operations run much faster than temporary disk assistant operations. Oracle allows users to control and tune the
size of work areas. Starting from the 10g release, Oracle automatically tunes work area sizes by default.

Why is PGA allocation important to Maximo applications?

Maximo applications use many JOINs and "ORDER BY"s to fulfill various user requirements. In one case, a customer
used a very small PGA size and ran out of system resources from time to time because of the large number of queries.
After enlarging their memory components, the database cache hit rate increased and system resources were released
more efficiently. Consequently, the response time for the whole system improved.

Generally, bigger work areas can significantly improve the performance of a particular operator at the cost of higher
memory consumption. Optimally, the size of a work area is big enough to accommodate the input data. If not, response
time increases because part of the input data must be spilled to temporary disk storage. In extreme cases, if the size of a
work area is far too small for the amount of data to be processed, multiple passes over the data pieces must be
performed. This can dramatically increase the response time of the operator and result in bad performance.

Configuration

Automatic PGA Memory Management

With automatic PGA memory management, you set a target size only for the total instance PGA
PGA_AGGREGATE_TARGET). The database then tunes the size of the instance PGA to your target, and dynamically
tunes the sizes of individual PGAs.

Manual PGA Memory Management

Previous releases of Oracle Database required the DBA to manually specify the maximum work area size for each type of
SQL operator (such as sort or hash-join). This proved to be very difficult and inefficient. Although the current release of
Oracle Database supports this manual PGA memory management method, we seldom use this method (for example, we
use this method to force the database to use a small workarea to simulate one client's database behavior).

When running under the automatic PGA memory management mode, sizing of work areas for all sessions is controlled by
Oracle automatically. The *_AREA_SIZE parameters are ignored. At any given time, the total amount of PGA memory
available to active work areas in the instance is automatically derived from the PGA_AGGREGATE_TARGET initialization
parameter. This amount is set to the value of PGA_AGGREGATE_TARGET minus the amount of PGA memory allocated
by other components of the system (for example, PGA memory allocated by sessions). The resulting PGA memory is then
assigned to individual active work areas, based on their specific memory requirements.

NOTE: Manual management of PGA memory is not recommended.
Monitoring and tuning

We can use several dynamic performance views to monitor the PGA status. By leveraging the information collected by
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Oracle underway, we can assess the performance of the Program Global Area:

VSPGA_TARGET_ADVICE - This view provides information about how the statistics cache-hit percentage and
over-allocation count are affected if we change the value of PGA_AGGREGATE_TARGET.

VSPGA_TARGET_ADVICE_HISTOGRAM - This view provides estimated information of a group of the
performance statistics if we change the value of PGA_AGGREGATE_TARGET.

V$PGASTAT - This view provides information about instance-level statistics on the PGA memory usage and the
automatic PGA memory manager.

V$PROCESS - This view provides information for each process connected to the instance.

V$PROCESS_MEMORY - This view provides dynamic PGA memory usage by named component categories for
each process.

V$SQL_WORKAREA_HISTOGRAM - This view shows the number of work areas executed with optimal memory
size, one-pass memory size, and multi-pass memory size.

V$SQL_WORKAREA_ACTIVE - This view can be used to display the work areas that are active (or executing)
and to determine whether these active work areas spill to a temporary segment.

V$SQL_WORKAREA - This view can be used to cumulative work area statistics for each loaded cursor whose
execution plan uses one or more work areas.

AWR report also provides straightforward information in the PGA Memory Advisory section.

Comments

There are no comments.
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The Apache mod_deflate module can be used to improve response time in environments that have low bandwidth and

high latency. The Apache mod_deflate module compresses output from your server before the data is sent to the client
over the network. You can set the compression level to 3 or 6 to improve response time.

Before you begin

The mod_deflate module is only available in Apache server version 2.0 and higher. To verify the server version, use the
apachectl -V command.

Procedure

1. Stop the server by running the following command:
apachect| stop

2. Create a copy of the httpd.conf file.
3. Open the httpd.conf file in a text editor.
4. Locate the KeepAliveTimeout 10 line and change to line to KeepAliveTimeout 60.

5. Uncomment the LoadModule deflate module modules/mod_deflate.so line. If you cannot find the LoadModule
deflate module modules/mod deflate.so line, in the # Dynamic Shared Object (DSO) Support Section, immediately
after the # LoadModule foo module modules/mod foo.so comment, add the line for the module.

6. Locate the section in the file for adding filters. Immediately under the #addoutputFilter INCLUDES .shtml
comment, add the following lines:

AddOutputFilterByType DEFLATE text/html text/plain text/xmlBrowserMatch "Mozilla/4 gzip-only-text/html
BrowserMatch "Mozilla/4 gzip-only-text/html

BrowserMatch "Mozilla/4\.0[678] no-gzip

BrowserMatch \bMSIE !no-gzip !gzip-only-text/html

#Highest 9 - Lowest 1

DeflateCompressionLevel 3

The compression level is now set to 3, which provides minimal CPU usage and a decent benefit from the compression.
You can also set the compression level to 6, which provides even more compression benefit with a small CPU overhead.

For more information on the mod_deflate module, see the Apache documentation on mod_deflate.

Comments

There are no comments.
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Intro

Introduction to IBM Control Desk: This 12-video series provides an introduction and overview of IBM Control Desk,
including Asset Management, Change and Configuration Management, and Service Request Management. Each video
focuses on one aspect of the product, providing a concise synopsis. The individual units also describe and explain Tivoli
Process Automation Engine and the design and function of the user interface.

Planning and configuring

Project Start - Focus on Planning an IBM Control Desk Implementation: This workbook will guide you through the
planning tasks necessary to implement IBM Control Desk on Cloud. This workbook can also be used for an on-premises
implementation of IBM Control Desk. Using this workbook with the Project Configure workbook provides a great starting
point.

Project Configure - IBM Control Desk Configuration Guide: Use this workbook directly to begin configuring an IBM
Control Desk instance. It can be used in collaboration with Project Start.

Job Aid - Service Desk Automation or Manual Processes: Use this document to help you determine whether to use

workflows or manual processes when implementing a service desk function.

Job Aid - Where to Start with Configuration or Change Management: Use this document to assist you in determining
where or how to start with configuration or change management when implementing IBM Control Desk.

Job Aid - Multi-organization and Multi-site Setup Considerations: Use this document to help guide your organization in
determining when implementing IBM Control Desk if you need multiple organizations or multiple sites within the product.
Job Aid - Where to Start for Establishing a Service Catalog: Use this document to help you determine where and how to
start constructing a service catalog with offerings.

Job Aid: Priority Matrix — How to Use As-is or Change: Use this document to determine how to use or change the priority
matrix, which sets up internal priorities for service requests, incidents, and problems.

Job: Aid: Determining what Tickets to Work with for Asset Management: Use this document to help you think through your
design and approach on managing assets with work orders and or service requests in IBM Control Desk.

Software License Management in IBM Control Desk: This document provides an overview of the value of Software Asset
Management to an organization, with emphasis on Software License Management. The focus on how License

Management is handled in IBM Control Desk, including planning considerations and step-by-step instructions on how to
perform the various License Management tasks within IBM Control Desk.

Configuring the user interface

Ul Best Practices for Products Built on Tivoli's Process Automation Engine: This document describes the screen layout
features, Ul style and details, and accessibility features that result in an optimally usable product Ul. Following the best
practices provided in this document ensures that the Ul remains consistent, accessible, and easy to navigate and use.

Creating assets

Job Aid - Hardware asset management data foundation: This document assists first time users of IBM Control Desk in
getting started with IT asset data for their IBM Control Desk implementation. It is a collaborative document to the Project
Start and Configuration documentation.
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Job Aid: Using Locations vs. Storerooms Application in Asset Management: Use this aid to help you determine if
Storerooms or locations will better align with your business processes with IBM Control Desk.

Designing your ITIL processes for Control desk implementation

IBM Control Desk Service Design Workshop: Use this slide deck to facilitate a workshop that guides your organization as
you implement the Service Desk features in IBM Control Desk.

Control Desk HW-SW Design Workshop: Use this slide deck to conduct a workshop focused on hardware and software
asset management processes when implementing IBM Control Desk

IBM Control Desk Release Management Design Workshop: Use this slide deck to conduct a workshop focused on release
management processes when implementing IBM Control Desk. This workshop material works directly with the change
and configuration process workshops.

IBM Control Desk Change Management Design Workshop: Use this slide deck conduct a workshop focused on change
management processes when implementing IBM Control Desk. This workshop material works directly with the
configuration and release management workshops.

IBM Control Desk Configuration Management Design Workshop: Use this slide deck to conduct a workshop focused on
configuration management processes when implementing IBM Control Desk. This workshop material works directly with
the change and release process workshops.

Using classifications across processes

Job Aid - Establishing a Classification Structure: Classifications need careful consideration as part of any IBM Control
Desk deployment. This document provides key considerations for creating classifications that saves labor and maximizes
value. This document is supportive of Project Start and Configuration documentation.

Workflows

Formatting the Out-of-the-Box Communication Templates: This document provides instructions for editing and locating
communication templates used in workflows.

Integrating solutions with IBM Control Desk

IBM Integrated Service Management Library: The ISM contains solutions that integrate with IBM Control Desk as well as
other IBM products.

Best Practices for Integration Composer Performance: Integration Composer aggregates, integrates and normalizes data
from disparate systems into one central repository, streamlining enterprise IT mgmt reporting and decision support
functions. Use this document to ensure ideal Integration Composer performance.

Automating notifications for failed escalations

You can configure IBM Control Desk to automatically notify you when an escalation fails without looking through the log
files.

When an escalation executes, an entry is made to the ESCSTATUS table. One of the attributes of each ESCSTATUS row
is the status of the escalation result. The valid escalation status values are SUCCESS and ERROR. You can set up
notification for escalations based on these status values.

1. Create a communication template for the escalation. For example, create a template that includes the details of
the escalation that failed, when it failed, and the reason for the failure.

2. Create an escalation against the ESCSTATUS table that looks for ESCSTATUS rows with a STATUS of 'ERROR'".

3. Associate the communication template with the escalation point notification.

When the escalation point is triggered, (in other words, when the escalation finds an ESCSTATUS row with a staus of
'ERROR’), the communication is sent to the role specified in the communication template.
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Cl Data Filtering

o Cl classification and attribute filtering - Integration Composer has filters to exclude Cls based on classifications in
the authorized space, or based on a list of classifications to exclude. These filters prevent Cls not needed in the
authorized ClI space from being processed by the TADDM Actual Cl adapter, which increases Integration
Composer performance. For more information on this, see the Integration Composer Filtering Best Practices page.

o Activate subclasses instead of super classes when possible. A super class may contain subclasses that you do
not care about. For example: If you want to bring over WebLogic data, and don't care about WebSphere data or
any other AppServer - activate WebLogicServer instead of AppServer.

Integration Composer Platform

¢ Install and run Integration Composer on a separate machine. Do not install Integration Composer on the same
machine as TADDM or SmartCloud Control Desk.

e Run Integration Composer on a multi-processor machine. Multiple processors/cores enable efficient garbage
collection.

e For large environments increase machine and Integration Composer JVM memory.
Memory - Physical and JVM

For environments with a large number of Cls, increase the amount of memory available on the physical machine and
Integration Composer's JVM.

32 Bit Environments

Maximum physical memory is 4GB for 32 bit platforms. With this amount of memory you can increase the Integration
Composer JVM heap size to 1664 M. Do this by editing the executeMapping or commandLine scripts. Alter the -Xmx java
parameter. An example is: -Xmx1664M

64 Bit Environments

To allocate more memory to the Integration Composer JVM, a 64 bit OS must be installed. In addition you must install a
64 bit JVM. When these two conditions are met, you can increase the size of the Integration Composer JVM utilizing the -
Xmx parameter.

For extremely large environments we have seen optimal results with 8GB of physical memory and 6 GB allocated to the
Integration Composer JVM.

How to determine how much memory you need

If you get Java out of memory exceptions in the Integration Composer logs or you machine hangs, you need more
memory. Another indication is extremely slow ITIC performance. This is usually caused by excessive garbage collection
due to lack of memory for the Integration Composer JVM.

For out of memory condition you need to add more physical memory and/or increase the Integration Composer JVM
heap.

To determine if you have excess garbage collection, add an option to the java command to collect garbage collection (GC)
statistics. Here is an example of the option:
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-Xverbosegclog:c:\ITIC-verbosegc.log
The logging data will be stored in the specified file. At the end of the run, process the log through an analysis tool.

There are many tools available to analyze verbose GC logs. The IBM support assistant tool has a plug-in for verbose GC.
On IBM alpha works you can find another tool called: Pattern Modeling and Analysis Tool for IBM® Java™ Garbage
Collector (PMAT).

Analyze the GC log file. The percent of time the program was paused for garbage collection should ideally be 6% or less.

If your percentage is higher than 6%, you need to increase the size of the Integration Composer JVM heap. Add physical
memory if needed to be able to increase the heap allocation for the Integration Composer JVM. Then adjust the
Integration Composer JVM heap using the -Xmx parameter in the executeMapping or commandLine script file.

Once satisfied with the memory configuration, remove the verbose GC log switch
(-Xverbosegclog) from the java command.

Databases

e If you use Oracle as your SmartCloud Control Desk DB, run the following SQL commands to improve an index
used in the TADDM Actual Cl adapter. This will help with Actual Cl data loading. The SQL is:

drop index maximo.actci ndx3;

create index maximo.actci ndx3 on maximo.actci (guid, actciid);

insert into maxsyskeys (changed, ixname, ordering, colseq, colname, maxsyskeysid)
values ('N', 'ACTCI NDX3', 'A', 2, 'ACTCIID', MAXSYSKEYSSEQ.nextval);

commit;

analyze index maximo.actci ndx3 compute statistics;
Operational Best Practices

¢ Do not execute an Integration Composer mapping at the same time any other performance heavy actions are
occurring on the TADDM server or database. This includes discoveries, bulk loads, database backups, large
queries, etc.

e Schedule the execution of a mapping to occur when machine and network activity are very low (in most cases this
is the middle of the night or on the weekends).

e The initial run of the Integration Composer TADDM Actual Cl Adapter takes the longest. Delta runs are much
quicker. Ensure you plan for extra time the first time this adapter is ran.

Other Recommendations

e For Cl data, if you activate a superclass, like AppServer, do not activate its subclasses. That will make Integration
Composer traverse the same data more than once.

Comments

There are no comments.
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Integration Composer Filtering Best Practices for Cl data

IBM® best practices are reviewed and maintained by IBM.

There are two filtering options provided to improve performance of the TADDM Actual Cl adapter in Integration Composer
7.5.

By default, Authorized space and promotion scope filtering is enabled. This allows you to import only the actual Cl data
that you plan to manage in your authorized space. This is the recommended filtering setting in the Integration Composer
Actual Cl adapter for optimal performance.

Another filtering option is Classification filtering. This allows you to provide a list of actual CI classifications that you do not
want to be imported from TADDM.

Authorized space and promotion scope filtering

In SmartCloud Control Desk 7.5, there is a set of Simple Best Practices authorized CI classifications and promotion
scopes installed with the product. This can be modified to fit your needs with Deployer's Workbench 7.5. This Integration
Composer filtering option will import only the actual Cl classifications that match the classifications and promotion scopes
in your authorized CI space. For more information on this, see the Authorized space and promotion filtering document in
the InfoCenter.

How to apply to new environments

By default, this filtering option is enabled in Integration Composer 7.5.

How to apply to existing environments

Update the ccmdb.properties file prior to running the Integration Composer Actual Cl adapter. In the properties file, first
set ccmdb.actualci filtering.level to 2.

In existing environments, it is important to be aware that filtering by authorized CI space will cause any newly discovered
items outside of that space to be skipped. However, any items with outside of that space that were previously imported will
remain in the CCMDB database and no longer be udpated.

Classification filtering

The following classifications are typically not needed in the authorized CI space. Filtering these classifications will improve
the run time of the TADDM Actual Cl adapter since significantly less data is imported.

o APP.CONFIGFILE

« APP.DB.DB2.DB2DATABASECONFIGVALUE
 APP.DB.DB2.DB2INSTANCECONFIGVALUE
 APP.DB.DB2.DB2SYSTEMCONFIGVALUE
o APP.PROCESSPOOL

o CORE.LOGICALCONTENT

e DEV.DISKPARTITION

« DEV.MEDIAACCESSDEVICE

o DEV.STORAGEVOLUME

e SYS.AIXSOFTWARECOMPONENT

e SYS.DATAFILE

e SYS.SOFTWARECOMPONENT
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e SYS.WINDOWS.WINDOWSSERVICE
e SYS.ZOS.ZREPORTFILE

How to apply to new environments

To filter out the classifications above, update the ccmdb.properties file prior to running the Integration Composer Actual Cl
adapter. In the properties file, first set ccmdb.actualci filtering.level to 0. Then uncomment the lines containing the
classifications above and set their depth value to -1. For more detailed information on this, see the Depth and filtering of
Cl data document in the InfoCenter.

To further improve performance, examine the complete list of classifications in the ccmdb.properties file and enable
filtering for any additional classifications that are not needed in the authorized space. To achieve optimal performance, it is
best to import only those classifications that are needed in the authorized space.

As the environment changes or grows, these filters can be disabled if it is determined that a classification is needed. To
disable a filter, comment the line containing the classification and rerun the Integration Composer Actual Cl adapter.

How to apply to existing environments

The same filtering should be applied in existing environments as explained above. In addition, the existing actual Cl space
should be analyzed to find other classifications that may not be needed. To see how many actual Cls exist for each
classification, the following query can be run against the CCMDB database:

DB2, Oracle, or SQL Server:

select c.classificationid, count(c.classificationid) from actci a
join classstructure ¢ on a.classstructureid = c.classstructureid

group by c.classificationid

Examine the classifications with the greatest number of Cls and determine if those classifications are really needed. Some
criteria would be:

e Are these used in the authorized space? If they are used in the authorized space, they should not be filtered.

o Are these a large percentage of the actual Cls? If they account for a large percentage of the Actual Cls, filtering
them will result in a performance increase.

¢ s keeping the information worth the performance trade off? Importing all Actual Cl data may seem straightforward,
but performance will drop off if this is done. It is best to spend some time deciding which classifications are
important and which ones are not, and to import only those classifications that are needed in the authorized space.

Any additional classifications that meet the criteria for filtering should also be updated using the Integration Composer
ccmdb.properties file as described above. A filter can always be disabled if it is determined that a classification is needed
in the future.

In existing environments, it is important to be aware that filtering classifications will cause any newly discovered items
with those classifications to not be imported. However, any items with those classifications that were previously imported
will remain in the CCMDB database and no longer be updated.

Comments

There are no comments.
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Process Content Packs are packages that consist of artifacts and configurations that can be installed in IBM Control Desk
after the product is installed. The packages are not required for the product applications to operate properly, but they
provide significant value either as samples or as templates that you can refine to meet your specific business needs.

The following resources provide information about using process content packs.

PCP Data Included and To Be Gathered: This presentation describes the data that is provided in the IBM Process
Content Packs and provides a short list of data sets that customers must load to use the content packs.

Content Packages for Development Systems: This documentation in IBM Knowledge Center describes both optional
content packages, which are installed when the product is installed, and process content packs, which can be added after
installation using the Content Installer application. It provides use cases for each type of content.

Comments

There are no comments.
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Change management hints and tips

Capturing the Hostname on a Ticket: You can configure Control Desk to automatically store the hostname or IP of a user's
workstation in a ticket when the ticket is created.

Creating collections of assets, Cls or locations: You can group assets, configuration items or locations into a collection to
make it easier to add them to change or service requests.

Using Content Installer behind a firewall

Reassigning a Change Management workflow task

How Search Works in Control Desk 7.5.1

Using the e-mail listener to create Service Request tickets
Using the e-mail listener to update Service Request tickets

SCCD751 Automated Cl Promotion and Synchronization

Comments

There are no comments.
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You can configure the SmartCloud Control Desk to automatically store the hostname/IP of a user's workstation (client
machine or machine connection to SmartCloud Control Desk) in a ticket (Service Request, Incident or Problem) when the
ticket is created by following these steps.

1. Add new field to TICKET named CREATEDBYHOST
2. Set the default value of CREATEDBYHOST to 127.0.0.1
3. Create a relationship named 'CREATEDBY" on object SR (of INCIDENT, PROBLEM) with child object: PERSON
where clause: personid=:createdby)
4. Create a crossover domain named SESSION2TKT on object MAXSESSION
from field CLIENTHOST to field CREATEDBYHOST and
validation where clause:userid=:CREATEDBY.USER.MAXSESSION.userid
list where clause:userid=:CREATEDBY.USER.MAXSESSION.userid
5. Associate the SESSION2TKT domain with CREATEDBYHOST
6. Save all changes and run configdb

In order to capture the hostname of the user's workstation (client machine) and not just the IP address, your web server
must be configured to perform reverse DNS lookups.

To enable reverse DNS lookups in the IBM HTTP Server do the following:

1. Edit the httpd.conf file (located in Program Files\IBM\HTTPServer\conf\httpd.conf on Windows
2. Find the line that says: HostnameLookups off

3. Change the line to say: HostnameLookups on

4. Save the file and restart the web server

Comments

There are no comments.
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Do you have a set of assets, configuration items or locations that you usually target in a single change or service request?
Did you know that you can group these into a collection to make it easier to add them to the request?

To do so, go to the IT Infrastructure > Collections application and create a collection that includes the assets, Cls or
locations that you typically target together. Give the collection a name that will help you remember what it contains. Then,
when you are adding targets to a request, you can use the button to Select > From Collections and filter on the
collection that you created. You will be presented with a list of the things in that collection and you can select them
individually by checking each one that you want to include on the request, or check a box at the top to include them all.

Comments

There are no comments.
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Even if you cannot access the internet, you can still install Smartcloud Control Desk content packs using using Content
Installer. However, you must first download the content pack remotely and then copy it to your SCCD server.

To install content packs from behind a firewall, complete the following steps.

1. Create an XML file called ContentSource.xml in the C:\temp directory on your Smartcloud Control Desk server
system that contains the following text:
<?xml version="1.0" encoding="UTF-8"?>
<catalog infourl="" lastModified="" owner=""

xmlins:tns="http://www.ibm.com/tivoli/tpae/ContentCatalog"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:schemalocation="ContentCatalog.xsd">
<catalogltem>
<version>Enter the version number of the Content Installer pack, for example 7.5.1</version>
<type>mriu</type>
<name>Enter the name of package</name>
<description>Enter a description of the package here</description>
<homepage/>
<licenseurl/>
<category>Describe the category of the content</category>
<url>file:////C:\temp\TestPackage.zip</url>
</catalogltem>
</catalog>

2. Edit the name and description and the category according to the content that you are installing. Change the file

name in the URL to the name of the content pack zip file.

. Save the file.

. Copy the content pack zip file to the C:\temp directory on the server.

. Go to the ISM Content Installer application: System Configuration>IBM Content Installer.

. Click the New icon.

N o o~ W

. Enter the location of the ContentSource.xml that you created in step 1 and a description. The file name in our
example is: file:////c:\temp\ContentSource.xml

8. Click Save.

. Click the newly created content source.

10. Click the download link to install the content.

©

Comments

1-2 of 2 Previous = Next
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Does the file:/// applies also for Linux? How the URL should be formatted?
7MUR_lulian_Ene commented on November 16, 2015 Permalink
Hi Daniel ,

You can use the same syntax also for linux : file:///tmp/Contentinstaller.xml
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The Change Management process in SmartCloud Control Desk contains many workflow task assignments. Workflow tasks are
used to assign work to someone or to get their approval. Sometimes a task is assigned to the wrong person, or the owner of an
urgent task is out of the office. In these situations, the task needs to be assigned to someone else so the process can move
forward.

Starting in the SmartCloud Control Desk 7.5 release, Change Management workflow task assignments are displayed in the Current
Work Items list on the Change tab of the Changes application. For example, in the screen shot below, there is an Approve or Reject
Change CM1150 workflow task assignment active for Change CM1150. The & icon shown next to the task indicates that the

task is not assigned to the logged on user.

- Changes
(]| — 4 y ' =
| Frachnss @ 1w - HELeP RO~ (DS
Change Assessments Impacis Authorization Schedule Workplan Map

CM1150 Reset Payroll Server

1
~ Owner: LUCY Change Typs:  Mormal =

Owener Group: Authorization Decision: B

I N N

Accept & ABRERS Schedule Authorize Implement In Progress Cc
Categorize

Current Work ltems

&:) Approve or Reject Change CM1150 (Jackson)

When you click on the task, the View Workflow Assignments dialog opens. This dialog shows information about the task, such as
the fact that it is assigned to Jackson. If Jackson is not available to complete the task, the @, icon on the right side of the row can

be used to reassign the task to someone else.

View Workflow Assignments

“fou gelected an assignment that you do not own. Details for the selected assignment are shown below.
If you have been granted the authority, you can reassign an assignment by clicking on the Reassign Assignment icon in the
desired row.

Workflow Assignments b Fiter > 1-10f1 o =
Assigned Person Code = Name Description Priority Time Limit Start Date Due Date
X Approve or Reject Change CM1150 ) i
JACKSON » Jackson e 0:00 G273 145728 @,
Close
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If you click on the @, icon, the dialog below will appear to allow the task to be reassigned. In this example, we will reassign the
task to Cindy and enter an explanation in the memo field. It's that easy!

Reassign

“ou have chosen to reassign this task to someone elze. Please choose a person and optionally enter a
mema. To send a notification that this assignment has been reassigned, enter notifications.
Reassign to:

i
Persan:
CIND™ O\\, Cindy IncidentAnahyst =+
Mema:
Cindy is handling Jackson's work while he is out
Notifications > 0-00f0 =
Communication Template Send To Subject

...No rows to display...

New Row

OK Cancel

the assignment in the Current Work Items list to indicate it can be completed by her.
&

Cindy will see the task assignment in her inbox and when she goes to the Changes application, she will see the &;ﬁ icon next to
e

Changes

@ v

|All Records

& =] y: L8 s =
- AELe@P RO~ B
Change Assessments Impacis Authorization Schedule Workplan Map
CM1150 Reset Payroll Server
¢ Owner;  LUCY i Change Typs:  Mormal F
Dwner Group: Authorization Decision: Sched
! I K
Accept & Azzesg Schedule Authorize Implement In Progress i
Categorize
Current Work Iltems
&- Approve or Reject Change CM1150 (Jackson}
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When Cindy clicks on the task, the resulting dialog includes the memo entered when the reassignment was done so she

understands why she is receiving this assignment.

IBM Control Desk : Reassigning a Change Management workflow task

Complete Workflow Assignment

Task:
Approve or Reject Change CM1150 (Jackson)

Action:
@ | Authorize the Change.
| Reject the Change.

Memo:

OK

Earlier Memos b Fiter > &
Memo Person Transaction Date =
EJ;‘:: "fehi:'ﬂ';"g s L MAXADMIN /27013 14:31:51

Cancel

Of course, you might not want everyone to be able to assign their work to other people, so the icon is only shown if a user has been

granted the corresponding privilege (as shown below).

Description = Grant Access?
Reas=ign another user's workflow v

|> assignments

The workflow task list and reassign feature is also available in the Service Requests application, though it is only displayed when

the service request being viewed was created from a catalog offering.

So now you know how easy it is to reassign a workflow task!

Comments

There are no comments.
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Using the e-mail listener to create Service Request tickets
E Like | Updated November 22, 2013 by alucches | Tags: None

E-mail Listener with your own SMTP server: Creating tickets. This article describes how to set up a free SMTP server,
and configure the process automation engine and use the e-mail listener feature to create Service Request (SR) tickets.

The instructions are split into separate sections so that you can configure the SMTP server, process automation engine,
and the E-mail Listener.

Comments

There are no comments.
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You are in: IBM Control Desk > Hints and Tips > Using the e-mail listener to update Service Request tickets

Using the e-mail listener to update Service Request tickets
E Like | Updated November 22, 2013 by alucches | Tags: None

E-mail Listener with your own SMTP server: Updating tickets. This article describes how to use the e-mail listener
and workflows to update Service Request (SR) tickets.

Comments

There are no comments.
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You are in: IBM Control Desk > Hints and Tips > How to Determine Parent and Child in a Cl Relationship

How to Determine Parent and Child in a Cl Relationship
E Like | Updated March 25, 2014 by sfw | Tags: None

When working with Configuration ltems (Cls), sometimes you want to know which is the parent Cl and which is the child
Clin a Cl relationship. This can be important; for example, when you change the status of a Cl, the status of contained
child Cls is also changed. And when you delete a Cl, its contained child Cls are also deleted. But how can you tell, from
looking at a Cl relationship, which is the parent in the relationship and which is the child?

The answer lies in the Relationship Rules.

Each CI Relationship has a Source Cl, a Target Cl, and a RelationNum. To determine which is the parent and which is the
child, you need to determine the classification of the Source Cl and the classification of the Target CI. This information is
available on the Related Cls tab of the Configuration Items application.

From the Detail Menu next to the Relation field on the ClI relationship, you can select Go To Relationships. If you follow
that link to the Relationships application, the Relation record from the Cl Relationship is displayed. Filter the Source
Classification column by specifying the classification of the Source Cl, and filter the Target Classification column using the
classification of the Target CI.

In the resulting Relationship Rule you will see a checkbox called "Is Target Parent?" If this box is NOT checked, then the
Source Cl is the parent in the relationship, and the Target Cl is the child. If this box IS checked, then the Target Cl is the
parent in the relationship and the Source Cl is the child.

Note that this Relationship Rule also lets you know whether the relationship is one of Containment. Remember that when
changing the status of a parent Cl, the status is also changed for child Cls whose relationship to the parent is one of
Containment. And when deleting Cls, child Cls are also deleted if they are in a Containment relationship with their parent.

Comments

There are no comments.
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You are in: IBM Control Desk > Hints and Tips > Change management hints and tips

Change management hints and tips
E Like | Updated June 20, 2014 by charglen | Tags: None

Managing proposed changes

In some enterprises, you might want to allow users to propose changes that you can review and approve before they are
processed. To manage change proposals, you can create a flag that identifies a change record as a proposal. Change
records that are flagged as proposals can be submitted, analyzed, reviewed, and approved as needed.

To flag a record as a change, you can add a check box to the Changes tab in the Changes application, as shown in the
following example:
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Clrnt oo .
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Users who want to propose a change can select the check box, and you can process the change proposal as required by
your business rules.

For information about adding check boxes to the user interface, see the following documentation in the SmartCloud
Control Desk Knowledge Center:

Check box control properties

Developing applications using the Application Designer application

If you specify changes as proposals, you can create job plans that define values appropriate to your change proposal
process, as shown in the following example:
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For information about creating workflows, see the following documentation in the SmartCloud Control Desk Knowledge

Center:

Advanced workflow components

Specifying targets for changes

Change targets are user-defined. On the Change tab in the Changes application, you can specify targets in the fields in

the Primary Target section or in the Additional Targets table. For example, configuration items and assets can be targets.
You can also specify targets in the description field of the Primary Target and Additional Targets sections, as shown in the
following example.

2/3


http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.5.1/com.ibm.sccd.doc/workflow_adv/c_workflow.html

10/12/2019

IBM Control Desk : Change management hints and tips

Primary Target

Q The target that is the main focus of this Change Regquest
Configuration tem;

» §

Configuration tem Name:

Cl Business mpact:

p
4

Outage:

\ Target Description;

|xyz process - see attachements for URL &

Additional Targets I Fier ° +

Assel

-—

» g

Location:

»

Asset/Location Priorty:

1-30of3

(@ Additional targets affected by this Change Request

Asset Configuration ltem Hame

Configuration ltem Number Taraet Description

% log analysis ool

Comments

There are no comments.
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Automated Cl Promotion and Synchronization
E Like | Updated yesterday at 10:38 AM by BhratPatel | Tags: None

This article provides a solution to automate the promotion of actual Cls and the synchronization of
authorized Cls in an IBM SmartCloud Control Desk V7.5.1 environment using automation scripts.

As of August 31, 2016, the scripts have been tested and verified to work in a IBM Control Desk v7.6.01
environment.

Many organizations have expressed the desire to be able to automate the actual Cl promotion process
in order to be able to create authorized Cls without human intervention. In essence, this solution
automates some of the work normally performed by the Configuration Librarian, and by automating the
promotion process the fundamental ITIL principal regarding traceability and auditability are violated.
However, in its current implementation, this automation is invoked trough escalations and this allows you
to specify the exact conditions under which the automated promotion and synchronization occurs. By
applying conditions and escalation points you can consider the automated promotion similar to
preapproved changes: Trivial, reoccurring tasks that can be performed without specific approval
because of their specific characteristics and benign nature.

Among the benefits of automating the promotion and synchronization of Cls are:

1. Automatically start management of discovered, non-managed resources (actual Cls) based on
custom policies (escalations)

2. Ensurance that authorized Cl information matches the discovered configurations

3. Speed up the promotion process through automation, and free Configuration Librarians from
having to perform trivial manual tasks

Attached to this article you will find jython based automation scripts for promotion and synchronization, as well as
the necessary documentation that will help you implement, customize, test, and debug the scripts. The

documentation also includes extensive guidance on general automation script implementation and debugging.
To download the material, simply click on any of the following links:

o PromoteActCl.py

e SynchronizeCl.py

e SCCD751 Automated CI Promotion and Synchronization_V1.0.pdf

Comments
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Previous = Next

waxia commented on April 4, 2015 Permalink

| use the script on auto promotions but i received this error any help, BMXAA7837E- An error occured that
prevented the XXXXXX script for the XXXXX launch point from running. NameError: name 'actci' is not
defined in <script> at line number 409

MGouma commented on April 8, 2015 Permalink

This error lies in line 409: the actci variable is not instantiated. The line seems to be used for logging
purposes: print "\t--- Processing actualCl: "™ + str(actci) + ™"

If you replace this with:

print "\t--- Processing actualCl: " + mbo.getString("ACTCINUM") + "

it should work.

Seanie commented on February 12, 2016 Permalink

Morten, I'm impressed by this great piece of work. It appears to be just what I've been looking for for an
initiative called Configuration Management 'Lite' that | am trying to get off the ground for GTS Europe.
Please do not hesitate to contact me if you'd like to know more about that initiative and where your piece of
work could be used to enable it.

25 | 50 items per page Previous = Next
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How Search Works
E Like | Updated December 11, 2014 by Fidelma_Frahill | Tags: None

Using Search in IBM Control Desk?

Contributed by: Vijay Aggarwal (aggarwav@us.ibm.com)
Date: October 2013

This article provides an overview of how search works so that customers understand search behavior and various search
configuration options that are available to them.

Background

Historically, there were two different mechanisms for searching. The first mechanism is Database Search and the second
mechanism is Lucene Search. The Lucene Search mechanism creates and maintains its own search index (i.e., it does
not use database index).

Lucene Search was introduced in Tivoli Service Request Manager 7.1 for the following reasons:

o Database Search does not support searching attachments. Therefore, Lucene Search was used to index and
search ticket and solution attachments.

o At the time, some databases did not support Text Search. Hence, there was no efficient and effective way to
search long descriptions in those databases. Use cases that required searching long descriptions (e.g., searching
solutions) were not very efficient with those databases. Hence, Lucene Search was also employed to provide an
efficient search mechanism for searching some of the data in the database--solutions, tickets, catalog requests,
catalog offerings, catalogs and ticket templates.

Prior to the release of Control Desk 7.5.1, Lucene Search was used in the following scenarios for searching both data in
the database and attachments:

| Applications I Scenario
Service Requests,

Incidents, Global Search
Problems,

Solutions

|Global Search |All scenarios

Self Service Center,
Offering Catalog, Search
Self Service Global Search

In all other scenarios, only Database Search was employed. Please note that some applications (e.g., ticketing apps)
used Database Search in one scenario (e.g., Search Solutions) and Lucene Search in another scenario (e.g., Global
Search).

Issues with use of Lucene Search in Control Desk

Customers reported the following issues with use of applications that used Lucene Search:

e Lucene indexing crontask PmObjSearchCron took a long time to run, affecting upgrade windows.

o Global Search functionality proved to be too complex for many customers. It seems that only a few customers
were using this functionality.

e Customers reported performance issues with Lucene search.

e Users were unsure why a certain result was returned.

e Lucene search syntax was different from Maximo search syntax. This resulted in more complexity.
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o Some applications, for example. Solutions, ended up having multiple search mechanisms. This led to some
confusion; Most customers simply never used the Global Search function.

Changes in Control Desk

Now that vendors for all supported databases provide Text Search, the direction is to use Database Search for searching
all data in the database. Lucene Search is used only for searching attachments.

In the Control Desk, all applications (except Self Service Center and Self Service Global Search applications) use only
Database Search for searching data in the database. The applications for self service users will be updated in the

upcoming releases.

The following table describes how the search function works in applications.

| Application

| Scenario

| Implementation

Service Requests,
Incidents,
Problems,
Solutions

The Global Search
function has been
replaced with Search
for Tickets and
Search for Solutions

Uses Database
Search for data in the
database and uses
Lucene Search only
for searching
attachments.

Global Search

All scenarios

Uses Database
Search for data in the
database and uses
Lucene Search only
for searching
attachments

Self Service Center,
Offering Catalog,
Self Service Global
Search

Search

No change from
previous release. This
function continues to
use Lucene Search for
both data in the
database and
attachments.

Ramifications

1. Customers who use DB2 should enable the DB2 Text Search feature that is available starting with DB2 9.7.5.
Instructions for enabling this feature are provided in the Upgrade Guide.

Unless the Text Search feature is enabled in DB2, Search for Solutions, Search for Tickets and Global Search
features are slow and can return inaccurate results.

2. A customer can optimize the time taken for building a Lucene index if the following conditions are true:

a. The customer does not need to search attachments while searching for tickets.

b. The customer is not using the Self Service Global Search application.

The basic idea is to disable indexing of Service Requests, Incidents, Problems and Catalog Requests by Lucene

Search.

e Shut down the Maximo Server where the PmObjSearchCron crontask runs.
e Find the value of the Maximo System Property LUCENEOBJINDEX. Delete all files in that directory. This
will delete all the current Lucene index files.
e Unzip the empty_lucene_indexing.zip file in a temporary folder.
o Copy the contents of the new empty_lucene_indexing.zip file in the folder specified in the
LUCENEOBUJINDEX system property.
e Restart Maximo Server.
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3. All applications except for the Self Service Center, Offering Catalog and Self Service Global Search applications
use Maximo search syntax. This syntax is documented here: http://www.ibm.com/support/docview.wss?
uid=swg21375684.

Comments

There are no comments.
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Automating linking of authorized and actual Cls in IBM Control Desk
E Like | Updated December 24, 2015 by MortenMoeller | Tags: None

In IBM Control Desk linking authorized and actual CIs is a critical activity that enables the most
important Configuration Management activities such as CI Audit, and CI Synchronization. In
addition, by linking authorized and actual CIs, you enable automated linking of CIs and Assets, and
thereby the automated synchronization of resource meta data such as ownership, site, location, and

common specification attributes.

The association between authorized and actual CIs is also support many integration and launch-in-

context features that interact with Operational Management Products such as TADDM, and BigFix.

Associating authorized and actual CIs is but ITIL considered an authorized process, which requires
that it is performed by a Configuration Manager or a Configuration Librarian. However, many
organizations have expressed the desire to automate the process, so that pre-authorized types of CIs

are linked automatically.

By automating the linking of authorized and actual CIs, the following benefits are achieved:

« Reliance on manual tasks is eliminated
« Linking is performed in timely fashion
« Automating related tasks such as CI synchronization and Cl audit is enabled

In the attachments tab you will find an automation script (ZZ-LINKCI.py) that facilitates automated
linking as well as documentation (ICD753 Automating authorized and actual Cl linking.pdf) that
provides a description of the solution and implementation guidance. Both deliverables can be
downloaded by clicking on their respective links, or from the Attachments tab.

Comments

There are no comments.
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Configuring and Customizing
E 1 Like | Updated November 8, 2018 by Laura.Cunniffe.Aricent | Tags: None

Use this information to configure your deployment of Control Desk.

e Learn about how you can configure and log on to the Control Desk mobile app

e Making long description a text field: Tivoli's process automation engine version 7.5 added the ability to use a rich
text editor for the long descriptions. If you prefer, you can configure the product to use the text area for long
descriptions again. This article describes how to do that and provides some warnings and caveats to consider if
you decide to implement the change.

e Filtering Relationship Rules by Classification

e Using a Custom Class to Link Cls to Actual Cls

e Configuring Live Chat in a Clustered Environment

e Closing Service Requests opened from Live Chat automatically

e Configuring Live Chat for Service Providers

e Configuring the User Interface

¢ Enabling the launch-in-context feature

¢ Scheduling Availability of Live Chat Queues

e Deleting attached documents with automated scripting

Entity Relationship Diagrams for Maximo 7.6.0.3

Comments

There are no comments.
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Mobile app

E Like | Updated 7/23/19 by Laura.Cunniffe.Aricent | Tags: app, mobile

Using the Control Desk mobile app, agents, users, and managers can perform several Control Desk functions directly from a mobile device.

Depending on your permissions as an agent or manager, you can see and work with tickets and approvals. You can use the filter and search options to quickly and easily find tickets and
approval requests. As a user, you can create and keep track of your tickets, following their resolution. You can also browse solutions and company bulletins.

Agents Managers End users

Click the Tickets panel to work with tickets. Click the Approval panel to work with approvals. Create new ticket for yourself or on behalf c
someone else.

View, edit, update, or close a ticket. Select an approval from the list. View, request for update, confirm resolution

cancel a ticket.

Approve, reject, or reassign requests to another
person.

View or add ticket comments. Browse solutions and company news

MAXADMIN
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The mobile app is supported for IBM Control Desk version 7.6.0.4 and higher.

Download the app for iOS on the App Store. Download the app for Android on Google Play.

Logging_on to the app

Backend configuration and administration

For support for the mobile app, see the Control Desk mobile app page in the IBM Knowledge Center.

Google Play and the Google Play logo are trademarks of Google LLC. Android is a trademark of Google LLC.

Comments

There are no comments.
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Logging on to the app

E Like | Updated November 8, 2018 by Laura.Cunniffe.Aricent | Tags: None

When you open the mobile app for the first time, you are prompted to enter a server URL. The server URL must be
provided by your system administrator.

Alternatively, you can access the server URL from the Service Portal interface. To access the server URL, in Service
Portal, click the Help icon in the upper right and click Go Mobile! A dialog appears with the server URL and a QR code.
On your mobile device, you can manually enter the URL or scan the QR code. To scan the QR code, click the icon to the
right of the server address field on your mobile device and scan the code. The URL is automatically saved to your device.
For help or more information, contact your Control Desk administrator.

Note: You can use either an HTTP or HTTPS protocol. If you are using an HTTPS protocol, your server must have a valid
certificate. See your system administrator for information.

Click Connect to Server and accept the IBM® terms and conditions. You are then prompted for credentials. Enter your
Control Desk login credentials.

Comments

There are no comments.
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Backend configuration and administration
E Like | Updated 6/27/19 by Laura.Cunniffe.Aricent | Tags: None

A Control Desk backend administrator must configure the server for the Control Desk mobile app.

When a user opens the mobile app for the first time, they are prompted to enter a server URL.

The server URL is the URL that includes the context root and the rest context root of the Control Desk server, with no
trailing forward slash, and separated only by the ampersand symbol (&).

This URL often looks as follows:

https://<Control_Desk_server>:<port>/maximo&maxrest

Note: Users can use either an HTTP or HTTPS protocol. If they are using an HTTPS protocol, the server must have a
valid certificate.

Users can access the server URL from the Service Portal interface. To access the server URL, in Service Portal, the user
clicks the Help icon in the upper right and clicks Go Mobile! A dialog appears with the server URL and a QR code. On the
mobile device, the user can manually enter the URL or scan the QR code. To scan the QR code, the user clicks the icon
to the right of the server address field on the mobile device and scans the code. The URL is automatically saved to the
device. An administrator can also use an online QR code creator to easily send the server address to users via email or
other methods.

Starting in the mobile app version 2.0, new system properties have been defined. For more information, see:

System properties used by the mobile app

There are two main scenarios to consider:
Optional content packages are installed

Optional content packages are NOT installed

For information about content packages, see Content packages for development systems.

Note: In the current version of the mobile app, the Control Desk server no longer needs a specific configuration for cross-
origin resource sharing (CORS). If your administrator previously configured the server to support CORS, they can cancel
these modifications and restore the previous values.

Comments

There are no comments.
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System properties used by the mobile app

E Like | Updated 7/16/19 by Laura.Cunniffe.Aricent | Tags: None

You can configure the actions allowed and the display of tickets with following system properties. Two system properties have been defined to allow users to get in touch with
the company IT support team for urgent issues.

System properties

System properties can be modified via the System Properties application (Go To > System Configuration > Platform Configuration > System Properties). The following system

properties impact the mobile app:

mobile.disable.requpdate

This property is available in Control Desk v7.6.1.1. The default value is 0, which means that users are allowed to request updates on their
tickets from the ticket detail view in end user application. When this property is set to 1, the feature is disabled.

mobile.disable.commlog

This property is available in Control Desk v7.6.1.1. The default value is 0, which means that users can see
the communication log of their tickets in the ticket detail view in end user application. When this property is
set to 1, the feature is disabled.

mobile.support.phone

This property is available in Control Desk v7.6.1.1. The default value is null, which means that users
cannot request any further IT support in the “Contact support” view in the end user application. The
company must provide a valid telephone number to allow users access to this feature. If this property or
mobile.support.email are not null, users can see the option enabled in the “Contact support” view.

mobile.support.email

This property is available in Control Desk v7.6.1.1. The default value is null, which means that users
cannot request any further IT support in the “Contact support” view in the end user application. The

company must provide a valid email address to allow users access to this feature. If this property or
mobile.support.phone are not null, users can see the option enabled in “Contact support” view.

For Control Desk versions earlier than v7.6.1, the system properties listed here are not found by default in the list. Instead, you have to add them manually.

Comments

There are no comments.
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Optional content packs are installed
E Like | Updated 7/9/19 by Laura.Cunniffe.Aricent | Tags: None

Configure the mobile app server for situations where Control Desk optional content packs are installed. These packages
provide a number of samples and templates that are carefully designed to meet many different business requirements.

Tickets

To manage tickets with the mobile app, a user must have the Agent role. Agents belong to the following groups. Users
that belong to these groups are able to use the mobile app to manage tickets.

MAXEVERYONE

SDAAGENT

SDASELFSERV

Approvals

To manage approvals with the mobile app, a user must have the Manager or equivalent role. The following groups include
the required permissions. Users that belong to these groups are able to use the mobile app to manage approvals, for
example, workflow assignments.

MAXEVERYONE

PMSCOA

Note: Some of the required APIs might not be enabled. If you are a manager experiencing issues, run the Security
Groups app and open the group PMSCOA. In the Object Structures tab, select MXAPIWFASSIGNMENT. Make sure that
all options (Delete, Insert, Read, Save) are checked. Remember that the Read option for APl MXAPIPERUSER is
required for every role.

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Mobile app > Backend configuration and administration >
Optional content packs are NOT installed

Optional content packs are NOT installed
E Like | Updated 7/9/19 by Laura.Cunniffe.Aricent | Tags: None

Configure the mobile app server for situations where Control Desk optional content packs are not installed.

When optional content packages are not installed, you must manually configure the required privileges. There might be
hundreds of settings related to a specific role, but there are certain settings, which are described here, that have an
immediate effect on the mobile app.

There are some differences in the configuration between different versions. For specific instructions, choose your Control
Desk version:

e \ersion 7.6.0.4
e Version 7.6.1 and higher

Version 7.6.0.4

Tickets

To manage tickets with the mobile app, a user must have write access to the relevant data (for example, Incident,
Problem, and so on) and read access to some related information (for example, Ticket Templates, Users, and so on). In
the Security Groups app, create a new group or open an existing group. Select the Applications tab. Make sure that the
following applications are granted the listed options. Assign this group to users that need to manage Tickets in the mobile

app.

|Application |Required options |
lIncident |Delete, New, Read, Save |
lIncidents (SP) |Delete, New, Read, Save |
|Problems |Delete, New, Read, Save |
[Problems (SP) |Delete, New, Read, Save |
[Service Requests |Delete, New, Read, Save |
[Service Requests (SP) |Delete, New, Read, Save |
|Assets |Read |
|Assets (SP) |Read |
[Classifications |Read |
[Classifications (SP) |Read |
[Configuration Items |Read |
[Configuration Items (SP) |Read |
[Locations |Read |
[Locations (SP) |Read |
[People |Read |
[People (SP) |Read |
[Person Groups |Read |
[Service Level Agreements (SP) [Read |
|Service Groups IRead |
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“Ticket Templates |Read ||

In the Object Structures tab, select MXAPIPERUSER and make sure that the Read option is checked.

Approvals

Approvals in the mobile app correspond to Workflow Assignments, so a user must have the corresponding privileges. In
the Security Groups app, create a new group or open an existing group. Select the Applications tab. Make sure that the
following applications are granted the listed options. Assign this group to users that need to manage Approvals in the

mobile app.

|Application |Required options |
|Activities and Tasks |Delete, Read, Save |
|Activities and Tasks (SP) |Delete, Read, Save |
|Assignment Manager |Read, Save |
[Escalations |Delete, New, Read, Save |
[Escalations (SP) |Delete, New, Read, Save |
Inbox/Assignments Setup |[Read/Modify |
[People |Read |
[People (SP) |Read |
|Workflow Administration |Read |

In the Object Structures tab, select MXAPIWFASSIGNMENT and make sure that all options (Delete, Insert, Read, Save)
are checked.

Then, select MXAPIPERUSER and make sure that the Read option is checked.

End users

To open new tickets with the mobile app, an end user must have write access to Service Request and read access to
some related information, for example, Ticket Templates, Users, and so on. In the Security Groups app, create a new
group or open an existing group. Select the Applications tab. Make sure that the following applications are granted the
listed options. Assign this group to all users that can create ticket and access company miscellanea such as bulletin
board, news, and technical support.

Grant permissions as seen in the tables below.

|Application |Required options |
[Bulletin Board |Read |
[Self Service Center |Delete, New, Read, Save |
[Solutions |Read |
|Object Structure |Required options |
|[CDUISRMBULLETIN |Read |
|[CDUIGETSYSPROP |Read |
IMXAPIPERUSER |Read |

For older versions of Control Desk backend, the attribute PMTCOSHOWAS must be included to the Object Structure
CDUISRMBULLETIN to enhance all features regarding the bulletin board on the mobile app. In version 7.6.1.1, bulletins
are supported by default.
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Version 7.6.1 and higher

For Control Desk version 7.6.1 and higher, you can find the complete required option list in the knowledge center Security
groups configuration page: Configuring_security groups for user access

Tickets

To manage tickets with the mobile app, a user must have write access to the relevant data (for example, Incident,
Problem, and so on) and read access to some related information (for example, Ticket Templates, Users, and so on). In
the Security Groups app, create a new group or open an existing group. Select the Applications tab. Make sure that the
following applications are granted the listed options. Assign this group to users that need to manage Tickets in the mobile

app.

Application Required options
CDUIATTACH_A Delete, Read, Save
CDUIGETSYSPROP_A Read
CDUIINCIDENT_A Delete, Read, Save
CDUIINCIDENTLOG_A Delete, Read, Save
CDUIPROBLEM_A Delete, Read, Save
CDUISLA_A Delete, Read, Save
CDUIALNDOMAIN_A Read
CDUINUMDOMAIN_A Read
CDUISYNDOMAIN_A Read
CDUIGETPERSONGROUP_A | Read

CDUISR_A Delete, Read, Save
CDUIASSET_A Read
CDUIWORKLOG_A Delete, Read, Save, Insert
CDUITICKET_A Delete, Read, Save

In the Object Structures tab, select MXAPIPERUSER and make sure that the Read option is checked.

Approvals

Approvals in the mobile app correspond to Workflow Assignments, so a user must have the corresponding privileges. In
the Security Groups app, create a new group or open an existing group. Select the Applications tab. Make sure that the
following applications are granted the listed options. Assign this group to users that need to manage Approvals in the
mobile app.

In the Object Structures tab, select MXAPIWFASSIGNMENT and make sure that all options (Delete, Insert, Read, Save)
are checked.

Then, select MXAPIPERUSER and make sure that the Read option is checked.

End users

To open new tickets with the mobile app, an end user must have write access to Service Request and read access to
some related information, for example, Ticket Templates, Users, and so on. In the Security Groups app, create a new
group or open an existing group. Select the Applications tab. Make sure that the following applications are granted the
listed options. Assign this group to all users that can create ticket and access company miscellanea such as bulletin
board, news, and technical support.
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Grant permissions as seen in the tables below.

Application Required options
CDUIATTACH_A Delete, Read, Save
CDUIGETSYSPROP_A | Read
CDUIINCIDENTLOG_A | Delete, Read, Save
CDUIALNDOMAIN_A Read
CDUINUMDOMAIN_A Read
CDUISYNDOMAIN_A Read
CDUIMYSR_A Delete, Read, Save
CDUIMYWORKLOG_A Delete, Read, Save, Insert
CDUITKTEMPLATE_A Read
CDUISRMBULLETIN_A | Read, Delete, Save
CDUISRMSOLUTION_A | Read
CDUIMYTICKET_A Delete, Read, Save

In the Object Structures tab, select MXAPIPERUSER and make sure that the Read option is checked.

For older versions of Control Desk backend, the attribute PMTCOSHOWAS must be included to the Object Structure
CDUISRMBULLETIN to enhance all features regarding the bulletin board on the mobile app. In version 7.6.1.1, bulletins
are supported by default.

Comments

There are no comments.
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Making long description a text field
E Like | Updated March 8, 2013 by alucches | Tags: None

Tivoli's process automation engine version 7.5 added the ability to use a Rich Text Editor for the long descriptions. If you prefer, you can configure the product to use the text
area for long descriptions again. This article describes how to do that and provides some warnings and caveats to consider if you decide to implement the change.

Important Warnings:

o The instructions provided here switch out the rich text editor for a text area. This process works; however, it has not been tested across all applications to determine
whether there any issues (though it should generally work).

« The file that you change in the process described below can be updated by any subsequent hot fix or fix pack release. Whenever a hot fix or fix pack is installed, the
control-registry.xml should be checked to see if it has changed. If it has changed, then the modification described in the following steps should be made again to the new
control-registry.xml. Do not copy the old file that you modified and allow it to overwrite the file that was updated by the hot fix or fix pack. If you overwrite the file updated
by the hot fix or fix pack, you risk losing important updates.

« The following instructions change only the control used for editing. Any existing records must be cleaned up and stripped of any embedded html.

« There are some applications that also use the richtexteditor control directly on some attributes; they have to be altered in the application designer (this change does not
affect them).

Instructions for configuring long descriptions to use a text area instead of Rich Text Editor

1) Make a backup copy of the control-registry.xml file that is in <product_home>/applications/maximo/properties.
2) Open the file in an editor like notepad (or notepad++).

3) Find the text: <control-descriptor name="longdescription"

4) Once found, scroll a little farther down. Within that control descriptor block, there will be a section that looks like:

<component-list>

<components id="${name}_ components_v" layout="vertical">

<components nowrap="false" id="${name}_ components_hl" layout="horizontal" makevertical="true">

<label id="${name} label" labelcss="@{labelcss}" title="@{label}" dataattribute="@{dataattribute}"

instance-class="psdi.webclient.components.LongDescriptionTitle" wraptext="true" textcss="@{textcss}"

wraplength="@{wraplength}" labelfor="${name} richtexteditor, ${name}_ richtextviewer, ${name} textarea"/>

</components>

<components id="${name}_components_h2" layout="horizontal">

<required-indicator id="${name} required_indicator" dataattribute="@{dataattribute}" />

</components>

<components id="${name} components_h3" layout="horizontal">

<richtexteditor id="${name} richtexteditor" dataattribute="@{dataattribute}" inputmode="@{inputmode}"
width="@{width}" height="@{height}"

plugins="€{plugins}" extra_plugins="@{extra_plugins}" dojo_require="@{dojo_require}" load css="@{load_css}"
dojo_type="@{dojo_type}" hidewhen="{mobile}==true" />

<richtextviewer id="${name} richtextviewer" dataattribute="@{dataattribute}" width="@{width}" height="@€{height}"
hidewhen="{mobile}==false or {rendertextarea}==true" />

<textarea id="${name}_ textarea" dataattribute="@{dataattribute}" width="@{width}" height="€{height}"
inputmode="@{inputmode}" hidewhen="{mobile}==false or {rendertextarea}==false" />

</components>

<children id="${name}_children" layout="none" />

</components>

</component-list>
5) Add the following text (in bold and blue, note the <!-- and --> that are added):

<component-list>
<components id="${name} components v" layout="vertical">
<components nowrap="false" id="${name}_ components_hl" layout="horizontal" makevertical="true">
<label id="${name} label" labelcss="@{labelcss}" title="@{label}" dataattribute="@{dataattribute}"
instance-class="psdi.webclient.components.LongDescriptionTitle" wraptext="true" textcss="@{textcss}"
wraplength="@{wraplength}" labelfor="${name}_ richtexteditor, ${name}_richtextviewer, ${name}_ textarea"/>
</components>
<components id="${name} components_h2" layout="horizontal">
<required-indicator id="${name} required indicator" dataattribute="@{dataattribute}" />
</components>

<components id="${name}_ components_h3" layout="horizontal">

<!--
<richtexteditor id="${name}_ richtexteditor" dataattribute="@{dataattribute}" inputmode="@{inputmode}"
width="@{width}" height="@{height}"
plugins="@{plugins}" extra plugins="€{extra plugins}"
dojo_require="@{dojo_require}" load css="@{load css}" dojo_type="@{dojo_type}" hidewhen="{mobile}==true" />
<richtextviewer id="${name} richtextviewer" dataattribute="@{dataattribute}" width="@{width}" height="@€{height}"
hidewhen="{mobile}==false or {rendertextarea}==true" />
<textarea id="${name}_ textarea" dataattribute="@{dataattribute}" width="@{width}" height="@{height}"
inputmode="@{inputmode}" hidewhen="{mobile}==false or {rendertextarea}==false" />
-=>

<textarea id="${name)_textarea" dataattribute="@{dataattribute}" width="@{width}" height="@{height}" inputmode="@{inputmode}" />
</components>

<children id="${name}_children" layout="none" />

</components>

</component-list>
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6) Rebuild and redeploy the maximo.ear file.

Comments

There are no comments.
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Filtering Relationship Rules by Classification
E Like | Updated March 20, 2013 by charglen | Tags: None

In SmartCloud Control Desk 7.5, it is not possible to filter Relationship Rules in the Relationships application by source
classification or target classification. Because some relationships have many relationship rules, this can be inconvenient.

You can modify the presentation for the Relationships application to enable filtering by following these steps.

1. From the SmartCloud Control Desk user interface, navigate to System Configuration > Platform Configuration
> Application Designer.

2. Type “relation” in the Application filter and press Enter. You should see an application called RELATION. Select it.

3. Click Export Presentation Definition. Save the presentation xml that is displayed in the resulting browser window
to a file called relation.xml. On Firefox you could use File > Save Page As to do this.

4. Make a copy of the file for backup purposes.

5. Open the original copy of the relation.xml file. Search for the following string:
id="main_relation_details_tablebody_ 2"
The line that contains that tag and the one below it will look like the following:
<tablecol applink="assetcat" dataattribute="SOURCECLASS.HIERARCHYPATH"
id="main relation details tablebody 2" label="Source Classification"

menutype="sourceclassification"/>

<tablecol applink="assetcat" dataattribute="TARGETCLASS.HIERARCHYPATH"
id="main relation details tablebody 5" label="Target Classification"
menutype="targetclassification"/>

6. Change those lines to match the following two lines:
<tablecol dataattribute="SOURCECLASS.CLASSIFICATIONID"

id="main relation details tablebody 2" inputmode="READONLY" label="Source Classification"
lookup="classification" menutype="normal"/>

<tablecol dataattribute="TARGETCLASS.CLASSIFICATIONID"
id="main relation details tablebody 5" inputmode="READONLY" label="Target Classification"

lookup="classification" menutype="normal"/>
7. Save the file.

8. Return to the Application Designer application.
9. Click Import Application Definition.
10. Click Browse to locate the relation.xml file that you modified. Select that file and click OK.

If there are no errors, the application is successfully updated. You should now be able to filter Relationship Rules by
source classification or target classification. You can import the backup copy to restore your system if you are not happy
with the new presentation.

If there are errors importing the file, compare the file you are importing with the backup copy to determine the cause of the
error.

Comments

There are no comments.
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Using a Custom Class to Link Cls to Actual Cls

E Like | Updated March 20, 2013 by charglen | Tags: None

The Link to Actual Cls action in the Configuration Items application uses naming rules that rely on attribute values and
relationships to find actual and authorized Cls that represent the same thing. You can modify the naming rules to change
which attributes and relationships are used to link each type of Cl. But sometimes that isn't enough for the linking engine
to link your Cls.

For example, sometimes an attribute value on the authorized Configuration Item has a different format from the value on
the actual Configuration Item, and the values need to be normalized before they can be compared. Suppose your
authorized Cl has an attribute value of 1 for the attribute OPERATINGSYSTEM_OSVERSION, whereas the attribute
value of that attribute on the actual Configuration ltem is 1.0. By default, the linking engine does not consider those equal,
but you want them to match.

To solve these kinds of problems, you can write your own custom Java class to change the behavior of the comparison.

The naming rule that you are customizing must be a naming rule that matches an attribute, rather than a relationship. This
means that the naming rule attempts to match the value of the attribute with the specified Attribute Name on the CI with
the value of the same named attribute on an actual CI. By default, two values are considered to match if the attribute
exists on both and the values are equal, ignoring the case of the values.

You can change that behavior by writing a Java class that implements the interface
com.ibm.ism.cci.app.namerules.NmrComparisonClassinterface. This interface has a single method that has to be
implemented:

public boolean matches (String ciAttributeValue, String actualAttributeValue, String

nmrCompareParam)

The first parameter on the method is a String representation of the Cl attribute value, regardless of whether the attribute is
an alphanumeric or numeric attribute.

The second parameter is a String representation of the actual Cl attribute value.

The third parameter is an optional String that is passed to the method during the comparison if there is a value specified in
the Naming Rule Comparison Parameter field of the naming rule.

The method should return true if the CI attribute value matches the actual Cl attribute value, and false otherwise.

Note that if the attribute doesn't exist on the Cl or actual Cl, the value passed to this method is <NO CISPEC>; and if the
attribute exists but has an empty/null value, the value passed to this method is <NO SPEC VAL>.

After you compile this method, you need to rebuild and re-deploy the application EAR file and restart the application to
make the class available to the linking engine.

Then you need to use the Integration Framework to add or update any naming rules that you want to use this new class.
Specifically, you need to set the NMRCOMPARECLASS to the fully qualified name of this class on the NMRATTR of any

attributes where you want this class to be used.

You can view the new naming rules by going to the Configuration Items application and selecting the View Naming Rules
action. It is recommended that you use preview mode to try your new rules before doing any actual linking.

Comments
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Comments

There are no comments.
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Simplifying existing applications

Reposition or remove fields

If you have small changes to out-of-the-box applications, you will probably just make the changes directly within the
application.

A best practice is not to remove entire sections or tabs, but rather to hide them with a Signature Option.

When new versions of the out-of-the-box application are released and this application is upgraded, preserving these old
sections and tabs allows for the upgrade process to add these new fields. You can then examine these applications after
upgrade to determine if you want to expose any of the new fields in your Ul. However, hiding these sections with a
Signature Option will have performance implications, so for major differences you might consider cloning the application
and modifying the cloned application. More information is available on the Asset Management blog. You can also use this
approach to hide sections of an application for certain security groups and show sections of the application to others.

Clone an existing application and edit the clone

You might want to clone an existing application if you want a user interface that is very different from the out-of-the-box
application. You might also decide that different users should see very different views of the application.

There is an enhanced maintenance cost to maintain this separate application.

Any additional changes that future versions of your products make to the out-of-the-box applications must be manually
merged into your cloned applications if you want these additional features. In addition, you will need to manage the
security groups and metadata of this new application separately from the original application. For instance, if the product
development team adds 3 new dialogs and 3 new menu options to launch these new dialogs in the original application,
you will need to manually add all of this metadata to your cloned application if you want your users to use those dialogs as
well. Steps on how to duplicate an application are listed in the Maximo Asset Management Information Center.

Conditionally modify fields based on the state of the record

Conditional Ul is a powerful tool that can change the behavior of your user interfaces based on the state of the current
record. You can highlight key data for your users based on a condition. For instance, you might choose to change the
color of the priority field in the list tab if a ticket has a priority value of 1. In the interests of progressive disclosure, you
might also choose to hide additional fields from your end users by default and only show them based on the values of
other fields. For instance, you might only prompt a user for a back-out plan for a change if it is a high risk change request.

Conditional Ul is not a replacement for business logic. For instance, using Conditional Ul to make a field required at
various aspects of your process is probably a poor decision, since this requirement is enforced only at the user interface
level.

Automation scripting, Java programming, or the workflow engine should be used to enforce business logic in your
objects. Because the conditional user interface logic is evaluated every time the user interface is rendered, it can be
expensive from a performance standpoint. The conditional user interface expressions are also executed each time the
value of a field is set by an end user. This can slow down the time it takes to traverse the page. For example, if you write
a SQL conditional expression that takes a half second to execute, then it will take 10 extra seconds for an end user to fill
in a page of 20 fields.

You should carefully consider the condition expressions you have written to make sure they execute against the MBO
data available in memory if possible and do not require additional database invocations to related records to determine
the result of the condition.

More information is available in the Maximo Asset Management Information Center.
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Enhancing Existing Applications
Sometimes out-of-the-box applications do not meet your business needs, and you need to add information to them.

Add existing fields to an application

It is possible that the data you want to show in your application view already exists in the database and you just need to
present it to your users in the user interface. Open the Database Configuration application for the MBO that is being
shown in the application. The data that you want to show might be already available as an attribute of this object. If this
is the case, adding this attribute to the application user interface is a relatively simple drag and drop operation in
Application Designer. Follow this tutorial.

If the data that you wish to show is available on a field on a related object and the parent and child objects are related in a
one-to-one relationship, you can follow a similar approach to the tutorial above and add this related field to the user
interface setting an attributename with this syntax:

RELATIONSHIPNAME.ATTRIBUTENAME.

You should not show these related fields in the list tab of your applications because they can cause an additional
database query to fire for every record that’s being shown to retrieve the related information. This process can cause
significant performance degradation; for instance if you're listing 200 records in the list tab, 200 extra SQL queries will fire.

You can modify the advanced search dialog for your application to allow searching on this related information using the
same related field syntax. When searching on these related fields, you can search on one-to-many relationships. For
instance, you can find any work order with a child task that’s assigned to you.

Add existing related information to an application

For instance you might add a table or dialog to the Person application to show the list of work orders this person currently
owns. This information already exists in the database and is accessible through a relationship. Refer to this document for
more information.

Add new fields to an application

It is a common scenario for customers to find that new types of data must be collected for their business processes. You
will need to first add the fields to the underlying MBO using the Database Configuration application.

e Add a new primitive field (for instance adding a new text attribute, or numerical attribute to the Ticket object).
The Maximo Asset Management Information Center provides a good example.

e Add a new field that relates to a different object (for instance a new field on the change work order that points to a
person). Here are some references: looking up the remote object.

Relate two existing objects in a new relationship

You might want to build a mapping table that relates existing objects in a new way. For instance you might add a list of
persons to a change work order. You will use the Database Configuration application to build a new mapping MBO that
captures this one-to-many relationship. This blog post captures how best to create a new child object. This new MBO will
have one set of fields that points to the primary keys of the parent object and one set of fields that point to the primary
keys of the child object. You will then add a new relationship between the parent MBO and the mapping MBO using the
Database Configuration application. You'll then add this relationship to a new table in the application using Application
Designer. In this table you will put a lookup to allow the end users to select the child object that they want to relate to the
parent object (see information on configuring a lookup above). You might also choose to write a dialog and Bean code to
allow them your end users to select multiple “child” objects to relate to the parent object at one time.

Create an entirely new application to capture business information

This is the most expensive option to develop and maintain. Make sure that another existing MBO doesn'’t already
represent the concept you're trying to map inside Tivoli's process automation engine. First you must create the new
underlying MBO representation in the Database Configuration application. You have to consider what kinds of business
logic and validation logic this MBO should apply through Automation Scripting or Java code. Make sure to follow best
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practices when writing the MBO code. Then you must go to the Application Designer and create a new application and
point it to your new MBO.

Comments

There are no comments.
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Configuring the 7.5.x User Interface
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Like | Updated August 9, 2013 by LeandroCassa | Tags: 7.5.0, 7.5.x, configure, control, desk, interface, modify, sccd, smartcloud, tpae, ui, user

Hi Everyone,

This post describes new system properties that you can use to modify the appearance of IBM Tivoli SmartCloud Control Desk. These instructions apply to all Tivoli Process
Automation based products. If you have just acquired SmartCloud Control Desk 7.5.x your start center should appear similar to the following example:
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And your applications probably look like this
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Changes MAXADMIN
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To find records, use the filter fields and then press Enter.
& o Acti For more search options, use the Advanced Search button.
8"" BRI RO To enter a new record, select the Insertican in the toolbar.
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ol rae late Channes

Mew Change

ol

4

Change Status

Q

~
&

Select Owner
Take Ownership
Create KPI

Create Report

YT

-, :
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Attachment Library/Folders [
Releaze Requests 3
Fun Reports

Cognos Reporting

You can modify some of the interface just by changing some properties under Go To > System Configuration > Platform Properties > System Properties.
Here is the list of properties we are going tweak. (You can filter the System Properties by mx.webclient to reduce the amount of properties being shown.)

mxe.webclient.hideOnNavbar [NEXT,PREVIOUS,NAVHISTORY] - Comma delimited list of events that are not allowed as navigation bar items. If you leave this property blank,
all events are allowed as navigation bar items.

mxe.webclient.showOnToolbar [INSERT,SAVE,CLEAR,PREVIOUS,NEXT,NAVHISTORY] - Comma delimited list of events that are allowed as toolbar icons. If you leave this
property blank, all events are allowed as navigation bar items.

mxe.webclient.searchMenubar [0] - Set to 0 to hide the application menu bar

mxe.webclient.showToolbar [1] - Set to 0 to hide toolbar in all applications

mxe.webclient.verticalLabels [1] - Makes base leaf level controls use labels above (vertical instead of horizontal)

mxe.webclient.ShowQueriesIinToolbar [1] - Set to 1 to always show the Queries dropdown menu in the toolbar

mxe.webclient.systemNavBar [1] - Use new system navigation bar

mxe.webclient.tabBreadCrumbs [1] - No tabs are shown when on the list tab and breadcrumbs are used instead of the list tab itself

Before changing things around, it is good to know that NavBar is this big bar on the left side of the screen that enables us to navigate around the system. Based on the default
setup, let's do some changes. Remember all the changes done here do not require you to restart the server or log in again (with some exceptions on login/logout). Just
remember to check the property you want to update and click on the "Live Refresh" button on the navigation bar or the select action menu.

1. mxe.webclient.hideOnNavbar: Adding new entries here causes the navigation bar to hide additional entries when looking inside a record. I'll use Changes application as
sample, notice that the property hideOnNavBar comes with the following default entries: NEXT,PREVIOUS,NAVHISTORY.

Here is the application before the change.
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1 - Changes
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j Go To Applications . Change Asca
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@ New Change L~ 1F
= M Current W

ﬁ Save Change =

i Clear Changes . There are no
':;_-' Change Status
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52 More Actions

Workflow , [«|| Change Details

Here is the application after adding the entry INSERT:

S R EELED[E
[_]Go To Applications Change Assessmel

D_.J Available Queries Log Service Address Map
All Records =
All Bookmarks 3 1151 edwl
All Changes in final state owner:  MAX
All Changes with conflicts Owner Group:
&|| active Changes =
o |
5,7 Common Actions - Accept & Asses
| Categorize
Save Change =}
4 Current Worle It
Clear Changes =

Change Status n There are no workfl

Select Owner

| @J: w,‘tf' ﬁ‘ S0

4]

Take Ownership

% More Actions

/4
Warkflaw + =l | Change Details
Irmmart Amshosis [ = -1

The "New Change" entry under the Common Actions panel is gone.
Now you should be asking yourself: Where do | find this name INSERT? Well, there are a few ways to do that. Here is a simple one: Hover over the icon that sits on the
navigation bar. On the status bar of your browser you'll see a javascript call and inside this big javascript call you'll find an attribute called mxevent: "<NAME YOU ARE

LOOKING FOR>"

Here is an example:

Catei;orize

g Current Worl Items

There are no workflow assignments.

&? Common Actions

T#| New Chi
J ew g;ge
E Sawe Change

ﬁ‘i Clear Changes

'-:_4 Change Status

B8 selact Ouner

4 (% More Actions_________________ |
javascript: topLevelMenus['mx211_MC'l.menuClick{{"image"."nav_icon_insertkey.gif","id

""0_INSERT_OPTION", "text™:"New Change”,"mxevent""INSERT" "target":"c

2. mxe.webclient.showOnToolbar: Removing entries from this comma separated list causes the icons on the toolbar to be hidden. So for example if you want actions to appear
on the navigation bar instead of the toolbar you can remove them from this property and add them to the previous property.
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Here is the toolbar before the change:
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Service Requests

v
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Find:
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Here is the toolbar after removing INSERT:
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Find:
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Notice that the icon on the toolbar to create a new record is gone.

3. Now let’s hide the toolbar and make the label horizontal (as in previous versions of Smartcloud Control Desk:)

In red, mxe.webclient.showToolbar turned on (1)

In green, mxe.webclient.verticalLabels turned on (1) - this is the only property that requires you to logout and then login.
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Owner Group:

y ]
—~ Accept & Assess Schedule
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g Current Work Items

There are no workflow assignments.

Change Details

Change:
S
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and the opposite

Hidden, mxe.webclient.showToolbar turned off (0)
Now the labels are horizontal, mxe.webclient.verticalLabels turned off (0)

& -~ Changes
[_]Go To Applications Change Assessments Impacts Autk
ﬂ__' Available Queries
All Records = 1151 edwl
All Bookmarks Owner: MAXADMIN
All Changes in final state Owner Group:
All Charges with conflicts 3
. |
All active Changes T Accept & Assess Schedule
Categorize

&l my active Changes
All my late Changes — $ Current Worlk Items

-

g/ Chmrnsn ACtians There are no workflow assignments.

| ¥

MNew Change

Save Change

“f & B @

Clear Changes = i
RSt Change Details
‘% Select Owner - Change: 1151

=h  Take Ownership

S

Summary::edwl

Start Timer

- T

=

% Mare Artinne

Notice that the toolbar is gone and the labels for the fields are no longer aligned vertically but horizontally.
4. Queries are available in both the navigation bar and toolbar, but that can be modified.
In green, mxe.webclient.ShowQueriesInToolbar turned on (1)

## T&- Changes

~ | Find: Q'@ﬁ@@i%’"[

[_]Go To Applications Change Assessments Impac
(7] Available Queries Log Service Address Map
All Records ol
All Bookmarks 1151 edwl
All Changes in final state 5 Owner:  MAXADMIN
All Changes with conflicts Owner Group:
All active Changes 0!
) 5 7 J |
All my active Changes || - Accept & Assess Schedu
hd Categorize

g C Acti
& S Aciians g Current Work Items

New Change

[v

There are no workflow assignments.
Save Change

e B G

Clear Changes

re
&

Change Status

Select Owner

Change Detaills

EIy

Take Ownership

Ak Change:
,’; More Actions T

5
Workflow 3 |E Summary:

and the opposite
Hidden, mxe.webclient.ShowQueriesInToolbar turned off (0)
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- Changes

Find: Q,@ﬁ@@|%@|-\l}@

j Go To Applications
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5. Let’s play with the navigation bar now, This change requires to you logout and then log back in.

In red, mxe.webclient.systemNavBar turned on (1)
In green, mxe.webclient.tabBreadCrumbs turned on (1)

# - Changes

Find: Q

-iRLeD S0~ B

j Go To Applications
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and the opposite. Notice that now you have a select action dropdown menu instead of the common actions in the navigation bar on the left

Hidden, mxe.webclient.systemNavBar turned off (0)
Hidden, mxe.webclient.tabBreadCrumbs turned off (0)

£
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- Changes
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Service Address Map
1151 edwl
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Owner Group: Authorization Decision:

1 1 J ]|
Accept & Assess Schedule Authorize Irr
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Current Worlk Items

There are no workflow assignments.
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Remember to carefully select what to show and hide. This may cause some confusion for your end users or even hide actions they are used to accessing. There are other
properties that modify the user interface as well, but those are the big ones | wanted to share from SmartCloud Control Desk 7.5.x.

Comments

There are no comments.

717



10/12/2019

You are in: IBM Control Desk > Configuring and Customizing > Configuring the User Interface > Displaying Live Chat Statistics in the Ul

Displaying Live Chat Statistics in the Ul

E 1 - Like | Updated August 27, 2013 by Lili Orozco | Tags: None

In SmartCloud Control Desk 7.5.1 there are no out of the box reports or start center graphs for Live Chat but all the data that is needed is stored in the database and start center portlets and

IBM Control Desk : Displaying Live Chat Statistics in the Ul

reports can be written and customized to get the data needed. All you need to know is where the data is stored.

Live Chat uses two main database tables: pmtcolivechat for waiting and in progress chat data and pmtcolivechatstats to store completed chat data. The table pmtcolivechatstats needs to

be treated as a historical table and should be periodically pruned to avoid taking up too much space.

The following tables describe the relevant columns for each of the database tables and the steps below describe how to create a start center template full of Live Chat data.

Live Chat Database Table: PMTCOLIVECHAT (Relevant Reporting Columns)

who accepted the chat
(null'if it has not been
accepted yet)

Column Description Type Relationship to other
DB Tables/Views
requesttime Time the chat was DATETIME
requested
accepttime Time the chat was DATETIME
accepted by an agent
(null'if it has not been
accepted yet)
userid User id of the user who | ALN (String) Maxuser (userid)
requested the chat
agentid User id of the agent ALN (String) Maxuser (userid)

chatqueueid

Person group id of the
chat queue the chat
request got routed to

UPPER
(Uppercased
string)

Persongroup
(persongroupid)

newsr

Whether a new SR
was created due to the
chat request (i.e the
user did not select an
existing SR when
starting the chat)

YORN (Boolean)

status

Status of the chat
request: WAITING if
the agent has not
accepted the chat yet
or CHATTING if the
agent has accepted it
already

UPPER
(Uppercased
string) - Domain

ticketuid

Ticket UID of the SR
the chat created or the
user selected before
starting the chat

BIGINT

Ticket, SR (ticketuid)

Live Chat Database Table: PMTCOLIVECHATSTATS (Relevan

t Reporting Columns)

who accepted the chat
(null'if it has not been
accepted yet)

Column Description Type Relationship to other
DB Tables/Views
requesttime Time the chat was DATETIME
requested
accepttime Time the chat was DATETIME
accepted by an agent
(null'if it has not been
accepted yet)
endtime Time the chat ended DATETIME
userid User id of the user who | ALN (String) Maxuser (userid)
requested the chat
agentid User id of the agent ALN (String) Maxuser (userid)

chatqueueid

Person group id of the
chat queue the chat
request got routed to

UPPER
(Uppercased String)

Persongroup
(persongroupid)

waittime

Time (in seconds) the
end user waited before
an agent accepted the
call or before exiting
the chat application

INTEGER

chattime

Time (in seconds) the
chat lasted before the
agent closed their chat
window.

INTEGER
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timedout Whether the chat timed | YORN (Boolean)
out due to inactivity
and was closed by chat
server
abandoned Whether the end user | YORN (Boolean)

closed the chat window
before an agent
accepted the chat

numofchatsagent Number of
simultaneous chat
windows the agent has
opened at chat end
time

INTEGER

ticketuid Ticket UID of the SR
the chat created or the
user selected before
starting the chat

BIGINT Ticket, SR (ticketuid)

Step 1: Create two applications, one for each of the database tables.

Step 2: Create queries for the newly created applications to be used

by the portlets in the new Live Chat start center template.

Step 3: Create KPI Graphs for Live Chat data to add them to the new Live Chat start center template.

Step 4 : Create a new start center template and add portlets with Live Chat data using the newly created queries and KPI graphs.

Step 1: Create two applications, one for each of

the database tables.

a. Go to System Configuration > Platform Configuration > Application Designer and click on the new icon to create a new application.

# i®m- Application Designer

v Find: (), v |sekct Action - E

W Fiter > @ = 0-00

fo =

Application » Description

Main Object Original Application

To find records, use the fiter fields and then press Enter.
For more search options, use the Advanced Search button.
To enter a new record, select the Insert icon in the toolbar.

Give it the following parameters.

Application: CHATRUN
Description: Live Chat Runtime
Main Object: PMTCOLIVECHAT
Key Attribute: USERID

« Module Name: SETUP

Select Power App as the type of application to create.

Create a New Application

Application:
;ICHATRUN '

. Description:
Live.Cﬁ a.t Ru n.time
Main Object:
PMTCOLIVECH|

Key Attribute:

|USERD Q

Module Name:

Select the type of app you wish to create.

Power App Single Page App Self Service App

Cancel

Click Save.

b. (Optional) Customize the table to show more data.

To change the title of the table, right click on the TABLE TITLE and choose Properties.
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Application:

| CHATRUN Live Chat Runtime

TABLE Filfelsmmas

w=|hy, Pro pertiesg

| List Main

x> Q 2
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Main Object:

PMTCOLIVECH

Jtablebody... R

i Cut
-2
E :Iﬁ Paste
i

Delete

Change the value of the Label property and click on the X button of the dialog to close the dialog.

Table Properties

Control ID:

resultz_showlist

a

el

General Advanced

Current Chats] |,

Readonly -
Select Mode:

| Multiple -

Bean Class:

Order By:

Data Source ID:

Add columns to the table by selecting a column, right clicking on it and then choosing Copy.

Main Obj

PMTCOL

Application:
CHATRUN [Live Chat Runtime
page... ' Prnpertiesg
tabgroup... . Cut
List Main| Capy
Pate
Current Chats 7 Fiter |X Delete <]
tablebody.. el
i i UseriD
e e e B Do o B e Dy D s G R e

Right click on the column again and choose Paste.

Application: Main Object:
[cHaTRUN [Live Chat Runtime PMTCOLIVECH
page...
tabgroup...
List Main
Current Chats ~ writer > O =
Tbebodv. ... . .
i i UseriD : Unique Id ! :
O e fleie i}

The new column will be added to the table.
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Appication; Hain Object

CHATRUN Live Chat Runtime: | PMTCOLNVECH

List Main

Current Chats ~ #rter > @ F~

To edit the column properties, right click on the second User ID column and choose Properties.

Application: Main Object
ECHM‘RUH Live Chat Runtime | | PMTCOLIVECH
page...
tabgroup...
e  List Main Copy
B Paste
Current Chats ~ writer > @ = (% Delete
AN, 7~ R s L S e T o T B e e e L B e
| User D i User 1D : Uni

Click on the magnifying glass next to Attribute to change the attribute of the column.

Table Column Properties %
General Advanced =
Control ID:

| results_showlist_column_link

Default Label:

! User ID
Label:

Adttribute:

1ISERD I éé |

Type:

|Link -
Sortable?

Turn Smart Fill Off?

Show Filter?

v

Fiterable?

m

Filter the Attributes by typing in PMTCOLIVECHAT in the Object text box and clicking Enter.
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Select Value

7 Fiter > O & 4 1-200f33 S OF =
Attribute Obiject

PMTCOLIVECH

TICKETUID PMTCOLIVECHAT
TICKETCLASS PMTCOLIVECHAT
TICKETID PMTCOLIVECHAT
NEWSR PMTCOLIVECHAT
USERCLIENTID PMTCOLIVECHAT
USERID PMTCOLIVECHAT
USERUISESSIONID PMTCOLIVECHAT
REQUESTTIME PMTCOLIVECHAT
ACCEPTTIME PMTCOLIVECHAT
AGENTID PMTCOLIVECHAT
AGENTCLENTID PMTCOLIVECHAT
AGENTUISESSIONID PMTCOLIVECHAT
CHATCHANNEL PMTCOLIVECHAT
CHATQUEUEID PMTCOLIVECHAT
STATUS PMTCOLIVECHAT
USERUUID PMTCOLIVECHAT
NODEURL PMTCOLIVECHAT
PMTCOLIVECHATID PMTCOLIVECHAT
HOSTURL PMTCOLVECHATOORT
PMTCOLIMECHATOORTID PMTCOLVECHATOORT

Choose another attribute, for example, REQUESTTIME. The label is automatically changed to the default label of the chosen attribute. Click on the X to close the dialog.

Repeat the steps to add others columns to the table. Remember to save frequently.

Current Chats " fher

e

c. (Optional) Delete the Main tab by clicking on it and clicking on the Delete Node icon. Save the application afterwards.

Application Designer

- L v seectacton DL e ED|= v:_:n- ik
L it v TR—

Appbcation Man Obyect

Live Crat Runtme

: Agentx

d. Create the second application by clicking on the new icon again in the Application Designer application.

Give it the following parameters:

« Application: CHATSTATS
o Description: Live Chat Statistics
« Main Object: PMTCOLIVECHATSTATS
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o Key Attribute: USERID
« Module Name: SETUP

IBM Control Desk : Displaying Live Chat Statistics in the Ul

Select Power App as the type of application to create.

Create a New Application

Application:
|cHATSTATS |

Description:

|Live Chat Statistics

Main Object:

|PHTCOLIVECH
Key Attribute:

|USERID
WModule Name:

E

Select the type of app you wish to create.

Power App Single Page App Self Service App Cancel

Click Save.

Modify the application the same way as the first one, modifying the table columns and deleting the Main tab. Remember to change the table name to PMTCOLIVECHATSTATS when looking
for attributes.

Apcaaten B Dbt

Live Chat Simtey

., § sl

Chat Stats ~ + taw % &
Pt —

e. Log out and back in.
f. To verify the new applications were added, Go to Administration in the App Menu. The two newly created applications should be there.

im - Welcome, MAXADMIN

My Recent Applications

=
Start Center . p inistrator

Administration 3 Sets

Azzets b Organizations

Change 3 Calendars

Contracts 3 Resources B
Financial b Bulletin Board

Integration b Communication Templates
Inventory » Reporting b

T Infrastructure

Planning

Service Desk

Service Level

Planning and Scheduling

Deployed Aszets

Reconciliation

2

2

Conditional Expression Manager

Organizations (SP)
Bulletin Board (SP)

View Documents

Purchasing Classifications

Release ClTypes

Security Work View

Self Service Survey Management 3

Service Provider (SP)

Service Request Catalog » Service Address
Map Manager

E} Tazk Management (3

i Work Orders 2

System Configuration 3

Live Chat Runtime E{b

Live Chat Statistics

[

g. Add the appropriate sigoptions to both applications by going to the Security > Security Groups application.

Look for the group maxadmin or whichever group the Live Chat managers belong to.

6/13



10/12/2019

Go to the Applications tab.

In the Applications, filter by description “Live Chat” and you should see the two new applications. Grant the following sigoptions to both applications.

IBM Control Desk : Displaying Live Chat Statistics in the Ul

. Read Access
. More Search Fields
. Save Current Query
. Sigoption to control the editability of the Clause field in the View/Manage Queries dialog
. View/Manage Queries
. Where Clause
[iye chat Runtme Live Chat
Live Chat Statmtics Live Chat Stabatcs.
Options for Live Chat Runtime b Fmer T=dofd b =
Grant Listed Diptions Sor This. Applcation
1 n » Grant Accesa? Condition
h Delete CHATRUH »
' ewe CHATRUN =
p Read Access o CHATRUN L4 »
b Save CHATRUN »
b e 4 V-9l o o
Description - - Grant Access? Condition
b Beckmaris »
¥ Dupicate CHATRUN ko
b Wore Search Fieids v »
P Sawe Currest Query v b
Sigoption to control the edtabiity of
b e Clnuse Seld in ViewMangpe Queres ] e
disiog
Sigoption to control the visibty of
b the Detad section in View/Manage - »
Queres daig
b View Search Tips »
b View/Manage Queries v »
3 Whetes Clause Cd kg

Log out and back in for the sigoptions to take effect.

Step 2: Create queries for the newly created applications to be used by the portlets in the new Live Chat start center

template.

In this example, two queries will be created. One for waiting chat requests and one for in progress chat requests. The queries needed will vary depending on business need.

a. Go to Administration > Live Chat Runtime application.

Filter Chat Session Status with the text “WAITING” and press Enter.

Click on Magnifying Glass next to Find: and choose Save Current Query

- Live Chat Runtime

w | Find:

(00, = | select Action

-

More Search Fields

Where Clause

5 " 3 4
Current Chats vie > Q & gave Current Query =latd
User D Reguest \J'.'.'.-’ldanage Queries Ac
WAMTING
..Norowst

Give it a name and description and click OK to save the query.
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ls
Save Current Query

Query Name:
VWaiting Chats ‘Waiting Chat Requests
Public?

™

Defaul?

OK Cancel

Repeat for CHATTING status to create a query for in progress chat requests.

8 0-0or0 : =

sLTime Chal Session Status Accept Time  Agent i) Chat Queus D Unigue i
CHATTING
No rowes o display.
Save Current Query
Quetry Hame:

Chats i progress Chats in progress
Pubic?

7]
Dufaue?

oK Canced

b. Go to the Administration > Live Chat Statistics application and create similar queries, for example, to query Abandoned Chat Requests, type Y in Abandoned? field, press Enter and
select to save the current query.

- Fe @ v soeaacme -
v 8 4 £ AT
Beousst Ting Adesi i) Chit Cetan 1) Timied cut? Abanoodd? VLM 0 B0hds  CRALES i SeC0ME  MUmbsL of chid)
ar a
- Mg rowen 15 Gy

Save Current Query
ey e

Anandsres (hals Apdrined Chal Respddn

vy

=

o Cancal

Step 3: Create KPI Graphs for Live Chat data to add them to the new Live Chat start center template.

a. Go to Administration > Reporting > KPI Manager and click on the New icon

# = - KPIManager

v Find: % w [Salect Action - m

[ NewkP1 CTF

KPls 7 Fiter @ = 0-00f0 =

KP1 Name Description Created Date

To find records, use the fiter fields and then press Enter.
For more search options, use the Advanced Search button
To enter a new record, select the Insert icon in the toolbar.
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Give it the following parameters:

KPI Name: WAITCHATS

Description: Live Chat Requests Waiting
Calculation Type: Decimal

Select: select count(*) from pmtcolivechat

Target: 5 (or 0)
Caution At: 25 (or other value that is appropriate)
Alert At: 50 (or other value that is appropriate)

- KPI Manager

v Fing: (L, |select Action

KPl | Historical Trends

IBM Control Desk : Displaying Live Chat Statistics in the Ul

Where: where status in (select value from synonymdomain where maxvalue in ('WAITING') and domainid="PMTCOCHATSTAT')

- 1B

KPI Name: Calculation Type:
[wamcHats | [Live Chat Requests Watting =8 Decimal v
Query Details
Select: Where:

=elect count(*) from pmtcolivechat

KPI Parameters

|where status in (select value from
|in (WAITING') and domainid="PMTC

= Graph Detail

Target: Is Active?
5.00 v
Caution At: ls Public?
25.00
Alert At: Created Date:
50 B23/13 06:28:08
Created By: Last Updated:

MAKADMIN

b. Repeat the steps to create the In Progress Chats KPI.

o Select: select count(*) from pmtcolivechat

o Where: where status in (select value from synonymdomain where maxvalue in (‘CHATTING') and domainid="PMTCOCHATSTAT')

KPI has not b
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KPI Manager

v  Find: ) = |setect Acton - T E& e»
m KPRl Historical Trends

KPI Name Caiculation Type:
INPROGCHATS Live Chats that are in progress = Decimal >
Query Details
Seleet Whare
seieet count(*) from pricobiechat wihere s181us in (select vaLIE from Synonymaomain whers maxvale

in (CHATTHG ) and domainid="PUTCOCHATSTAT)

KPI Parameters = Graph Details “
Target Is Acthe?
2500 o "
Caution At Is Publc?
s0.00
Adert AL Created Date
lDD|: 2313 08333
Created By Last Updated b

Step 4 : Create a new start center template and add portlets with Live Chat data using the newly created queries and
KPI graphs.

a. Go to the Start Center (Home icon) and click on the Create New Template icon

MAXADMIN

b. On the Left Column, add two KPI Graphs and Favorite Applications.
c. On the Right Column, add two result sets.

® Layout and Configuration

Layout: Description:

|Narrow-Wide e Template

Left Column > 4 1-30f3 8 =
Portlet Display Name = Order «
Favorite Applications | Fayorite Applications 3 “@
KPI Graph KPI Graph 2 ﬁ‘
KPl Graph KPI| Graph 4 QI

Select Content

Right Column > ¥ 1-20f2 o =

Portlet Display Hame = Order =

Result Set | Result Set x| ﬁ"

Result Set Result Set 1 &3
=

Select Content

Finished Cancel
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d. Click Finished to go back to the Start Center template.

& &* Welcome, MAXADMIN

KP| Graph

This. portlet has not bean st up. To set up. select the adkt icen *
portlat header

KP| Graph

This portlet has not bean set up. To set up. sedect the edt icon ©
portlet header.

Favorite Applications

This portlet has nct been et up. To set up, 3ekect the adt icon *
portlot header

e. Customize each of the portlets by clicking on the edit icon for each. Let’s start with the top left hand one (KPI Graph) and make it the Waiting Chats KPI. The Edit button is not visible

inthe

intha

in the

Result Set

IBM Control Desk : Displaying Live Chat Statistics in the Ul

Thes portlat has ot beem set up. To sat up, select the edi icon * in the portlet header

Result Set

Thes poeilet has reot been set up. To sat up, select the e icon * in the portlet header

until you take your mouse and hover over the header area.

KPI Graph

This portlet has not been set up. To set up, select the edit icon 7 ||

portlet header.

KPI Graph

__x =

Edit Portlet | T

Re

T

This portlet has not been set up. To set up, select the edit icon 7 in the

portlet header.

f. Set Display Name to something like “Waiting Chats”. Click on Select KPIs button to select the Waiting Chats KPI that was created in an earlier step. Click OK to dismiss the Select

KPlIs dialog and then Finished on the KPI Graph Setup to go back to the Start Center template.

Select KPls

Available KPls ~ +Ffiter > @

&

1-10f1 e 3 =

|v] KPIName Description
WA

%WAI‘I’CHATS Waiting Reguests

Calculation Type

DECIMAL

OK Cancel

g. Edit the second KPI Graph and select the In Progress Chats KPI. Display Name can be something like “In Progress Chats”.

KPI Graph Setup

Display Hame:

I Progress Chats]

KPls P Eiter 1-10f1 e 2 =

KP1 Description Calculation Type

NPROGCHATS Chats in progress DECMAL —;‘
Finished Cancel Select KPis

h. Next, edit the Favorite Applications portlet and add the Person Groups and Service Request applications to it. Click Select Applications to search for and add the applications and then

click Finished.
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Favorite Applications Setup

Partiet

Applications b Frer
Application
SR

PERSONGR

i. For the first result set on the top right corner, let's view the waiting chats per chat queue. Click the Edit button on that portlet. In the Available Queries tab, look for the Waiting Chat
Requests and click on it to choose it. In the Column Display tab, choose the columns to display, like REQUESTTIME and CHATQUEUEID. In the Chart Options tab, check Show
Chart by Default? and make sure Chart Type: is set to BAR. Set Display By to CHATQUEUEID. Click Finished to return to the Start Center template. Remember to change the

Display Name:

Favorite Apphcations.

4 1-20f2 o4 =
Description Order
Service Requests W
=
Person Groups oy
Finished Cancal Select Appications

Display Name to something more descriptive, like “Waiting Chats Per Queue”. Click Finished.

Result Set Setup

Portiet Dissplay Hame: Rows To Display-
Re Resull Set 10
Available Quenes Column Display Display Options Charnl Options

Cusrent Query

Queries wmw > Q& 11001 [ =

Query Hame » Description Application

|z J

Wading Chat Requests Wiaiting Chat Requests. Live Chat Runtime

Finished Save Cancel

j. For the last portlet in this example, let's set it to the Query of Abandoned Chats per Chat Queue. Click the Edit button on that portlet. In the Available Queries tab, look for the
Abandoned Chats query and click on it to choose it. In the Column Display tab, choose the columns to display, like REQUESTTIME, WAITTIME and CHATQUEUEID. In the Chart
Options tab, check Show Chart by Default? and make sure Chart Type: is set to PIE. Set Display By to CHATQUEUEID. Click Finished to return to the Start Center template.

Remember to change the Display Name to something more descriptive, like “Abandoned Chats”. Click Finished.

Result Set Setup

Portiet Daplay Name Rows To Dsplay
Abandoned Chats 10
Available Queries Column Display Display Op Chart Options
Current Query

Show Chart by Defaut?
W

Chart Type:

E -
Despiay By
CHATOUELED

Lagand Attrituts Tt

Legend Value Titie

hats - Abandened Chat Requests

Finished Save Cancel

k. Voila! The Start Center template is complete!
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Waiting Chats Waiting Chats Per Queue | Eiter - @
Last Run: 8/23/13 11:18:15 Update Chart Type: BAR
Status Last Reading Actual  Target Variance Waiting Chat Requests (By Chat Queue ID)
1t 0 12 0 12 #]
Waiting Reguests
e
20 25. .3:0 35
15 L 40 .
10 . 45
5 50 &

In Progress Chats
Last Run: 8723013 11:18:18

Uuos‘

LNy 43aa

Update
Status Last Reading Actual Target ‘fariance
M . . - 4 List View
Chats in progress
50 60
40 70 R =
an I Abandoned Chats | fiter @
& 5 Chart Type: PE )
20 b - 20 Abandoned Chat Requests (By Chat Queue D)
10 i 100
o 0
. . o a8
Favorite Applications

Person Groups
Service Reguests

Save the template by clicking on the Save icon.

MAXADMIN

View By: Chat Queue ID

m. Last but not least.... Assign the template to the correct groups. For example, to add it to the maxadmin group, go to Security > Security Groups and look for maxadmin group. In the
Group tab, click on the magnifying glass next to Start Center Template and choose the template you just saved to add it.

Comments

1-10f 1 Previous = Next

VivianeBrasil commented on September 2, 2013 Permalink
Great and useful information! Thank you for provide it!!

Show 10 ' 25 = 50 items per page Previous = Next
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You are in: IBM Control Desk > Configuring and Customizing > Configuring the User Interface > White-label
Customization

White-label Customization
E Like | Updated March 24, 2015 by charglen | Tags: None

Contributor: Dan Wiegand

You can rebrand or "white label" IBM Control Desk to suit your business needs. White Labeling Control Desk affects 3
main components:

¢ login/welcome screen
e logout screen
e application toolbar

This article describes how to white label those components.

IBM Control Desk on Cloud: Since access to the operating system and administrative workstation is not granted in
Cloud deployments, only updates to messages are available for IBM Control Desk on Cloud users.

If you are adding logos in multiple places, you only need to rebuild and redploy the EAR after the last image is added.

Note: Some product upgrades can overwrite these customizations, and they must be recreated.

White Labeling the Login/Welcome Screen

The Login/Welcome screen contains an icon and text that can easily be modified. The following image illustrates the
current out-of-the-box screen.

Modifying the text

The text can be modified using the running server.

1. Using the go to menu, Go To > System Configuration > Platform Configuration > Database Configuration.
2. Under More Actions, select Messages.
3. Filter on login as the message group.
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4. The preceding window contains all the messages for the login screen. The labels for ‘Welcome’, ‘Sign In’, ‘User
name’, etc., can all be modified in this window.

5. COPYRIGHT: If you white label the product, leave the copyright as is or update the copyright value for the
message key ‘copyright’ in the above dialog. The updated copyright must read:

© Copyright [INSERT NAME OF OEM/PARTNER] and others 2007-2014.

Modifying the image

The image icon must be modified on the server.

The image icon can be modified in one of two ways, modifying the JSP that loads the image or modifying the image
directly.

To modify the JSP:

1. On the Administrative Workstation, navigate to the
<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login/images directory.

2. Add the new icon to this location. The default icons are in png format. For example, mx_icon.png is the default.

3. OPTIONAL: If you are using a mobile login, you must also add an image named in the format: <name from
step2>_ev.<image type>. For example, mx_icon_ev.png is the default.

4. Navigate to the <maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login

directory.
. Open login.jsp with a text editor.
. Search for ‘mx_icon’.
. Replace ‘mx_icon’ with the image name you added in step 2.
. Save the JSP.
. Rebuild and redeploy the EAR file.*

© 0o N O O

To modify the image without modifying the source:

1. On the Administrative Workstation, navigate to the
<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login/images directory.

2. Rename mx_icon.png to mx_icon.png.original.

3. Add the new icon to this location. The filename must be mx_icon.png.

4. OPTIONAL: If you are using a mobile login, you must also rename mx_icon_ev.png to mx_icon_ev.png.original

add an image named mx_icon_ev.png.
5. Rebuild and redeploy the EAR file.*

White Labeling the Logout Screen

The IBM logo and message text can be modified in the logout screen. The following image contains the out of the box
logout screen.
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To modify the text:

Follow the same procedure that you used for the login page. The only change is to filter on ‘logout’ for the Message
Group.

To modify the JSP:

1. On the Administrative Workstation, navigate to the
<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login/images directory.

. Add the new icon to this location. The default icon is in gif format. For example, ibm-logo-white.gif is the default.

. Navigate to the <maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login
directory.

. Open exit.jsp with a text editor.

. Search for ‘ibm-logo-white.gif .

. Replace ‘ibm-logo-white.gif’ with the image name you added in step 2.

. Save the JSP.

. Rebuild and redeploy the EAR file.*

w N

o N o o

To modify the image without modifying the source:

1. On the Administrative Workstation, navigate to the
<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/login/images directory.

2. Rename ibm-logo-white.gif to ibm-logo-white.gif.original.

3. Add the new icon to this location. The filename must be ibm-logo-white.gif.

4. Rebuild and redeploy the EAR file.*

White Labeling the Toolbar

The IBM Logo can be changed on the main application tool bar. The following image is an example of the toolbar.

ﬂ - |_|.l

maximo\applications\maximo\maximouiweb\webmodule\webclient\skins\tivoli13\images

To modify the CSS:

1. On the Administrative Workstation, navigate to the
<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/skins/tivoli13/images
directory.

2. Add the new icon to this location. The default icon is in png format. For example, ibm_logo_grey.png is the
default.

3. Navigate to the

<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/skins/tivoli13/css directory.

. Open maximo.css with a text editor.

. Search for ‘ibm_logo_grey.png’, it should be in the .titlelogo section.

. Replace ‘ibm_logo_grey.png’ with the image name you added in step 2.

. Save the CSS.

. Rebuild and redeploy the EAR file.*

o N o oM
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To modify the image without modifying the source:

1. On the Administrative Workstation, navigate to the

<maximo_home>/maximo/applications/maximo/maximouiweb/webmodule/webclient/skins/tivoli13/images
directory.

2. Rename ibm_logo_grey.png to ibm_logo_grey.png.original.
3. Add the new icon to this location. The filename must be ibm_logo_grey.png.
4. Rebuild and redeploy the EAR file.*

*For information about building EAR files, see Building and deploying EAR files for basic configurations.

Comments

There are no comments.
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Deleting attached documents with automated scripting

E Like | Updated November 14, 2016 by charglen | Tags: attached_documents, automation

Contributors: Steve Hauptman, Ted Lyons, Mike Sielian, John Cook, Melody Bienfang

Introduction

This article describes a technical solution that gives users the flexibility to delete attached documents (DOCLINKS) seamlessly and with ease. By leveraging existing functionality in IBM
Control Desk, namely Escalations and Automation Scripting, you can purge attached documents from the location where the document physically lives. A selection criteria should be defined
in an Escalation (e.g. STATUS ='CLOSED"') along with an Action that invokes a Python script (described in this post) that physically deletes the document from the server.

The Python script provided in this post is generic and can be applied to any object (Workorder, Incident, SR, etc). Although we recommend this script be used with an Escalation and an
Action launch point, it can be used with other launch points as well. In addition to deleting the document from the server, the script also cleans up the entries in the Doclinks and other related
tables. No "orphaned" records will remain after the file is physically deleted. The script addresses direct attachments as well as attachments uploaded via Communication Templates and
CommLog.

Disclaimer

Note: Before you deploy this solution directly into a production environment, test and make sure it fits your use case. The script does not contain any business rules or any sort of validation. It
simply deletes the file and cleans the Doclink table. It is up to you to decide when to invoke the script by defining the appropriate escalation criteria and frequency.

Python Code

The following python code can be used for the script:

from psdi.common.action import ActionCustomClass

from java.io import File

from java.rmi import RemoteException

from psdi.mbo import *

from psdi.mbo import MboConstants

from psdi.util import MXException

from psdi.app.doclink import Docinfo

from psdi.app.doclink import DocinfoSet

from psdi.app.doclink import DocinfoSetRemote
from psdi.app.doclink import DoclinksSetRemote
from java.lang import SecurityException

from psdi.server import MXServer

import sys

# COMMENT: function to check if the doclink owner is a commlog or the main mbo.
def isCommLogOwner (doclink) :
ownertable = doclink.getString ("OWNERTABLE")
print ('**** OWNERTABLE... '+ownertable)
if (ownertable) == "COMMLOG":
return True

return False

# COMMENT: function to delete the commlog doc physical file from the server.

def deletecommlogfilefromserver (docinfo) :

docinfoid = docinfo.getString ("DOCINFOID"

commlogdocsSet = MXServer.getMXServer () .getMboSet ("COMMLOGDOCS", docinfo.getUserInfo())
commlogdocsSet.setWhere ("DOCINFOID = '"+docinfoid+"'")

commlogdocsSet.reset ()

print ('**** DOCINFOID... '+docinfoid)

k=0
commlogdoc = commlogdocsSet.getMbo (k)
while (commlogdoc is not None) :
urlname = commlogdoc.getString ("URLNAME")
deleteCfile = File (urlname)
if (deleteCfile.exists()):
deleteCfile.delete();
k = k+1
commlogdoc.delete (MboConstants.NOACCESSCHECK)
commlogdoc = commlogdocsSet.getMbo (k) ;
#commlogdocsSet.deleteAll (MboConstants.NOACCESSCHECK)
commlogdocsSet.save (MboConstants.NOACCESSCHECK)

# COMMENT: function to delete the physical file from the server.
def deletefilefromserver (docinfo) :

urlname = docinfo.getString ("URLNAME")

deletefile = File (urlname)

if (deletefile.exists()):

print ('**** Deleting file... '+urlname)
deletefile.delete ()
print ('**** File Deleted... '+urlname)
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print 'Starting doclink delete .....

# COMMENT: from the Action MBO get the associated DoclinksSet based on the

doclinksSet = mbo.getMboSet ("DOCLINKS")

if doclinksSet is not None:

i=0
doclink = doclinksSet.getMbo (i)
while (doclink != None):

docinfoSet = doclink.getMboSet ("DOCINFO")

if (docinfoSet is not None):

=0

docinfo = docinfoSet.getMbo (j)

while (docinfo != None):
if (isCommLogOwner (doclink)) :
deletecommlogfilefromserver (docinfo)
else:
print ('**** deletefilefromserver... ')
deletefilefromserver (docinfo)
docinfo.delete (MboConstants.NOACCESSCHECK)
doclink.delete (MboConstants.NOACCESSCHECK)
=341
docinfo = docinfoSet.getMbo (j);

i=i+l

doclink = doclinksSet.getMbo (i) ;

'DOCLINKS'

1. Log in to IBM Control Desk and go to System Configuration > Platform Configuration > Automation Scripts.

2. From the More Actions menu, select Create > Script with Action Launch Point.

w

# & - Automation Scripts

[y

L)

R 1-5of5

All Records - Find: q -
J 'Go To Applications
8;_)/ Common Actions Sc ripts ML B Q
'{;;ﬂ Change Status Script
]l Create KPI
7’ More Actions DOCLINKS
Create [3 Script

Cognos Reporting Script with Object Launch Point
Script with Attribute Launch Point

Script with Action Launch Point

Script with Custom Condition Launch Peint

Description

Script to Delete

Deleting Incident Doclinks
Agsign ticket to an available
Reset automatic assignment

Deleting of SR Doclinks

In Step 1 of the automation scripts wizard, specify a Launch Point and an Object. Note the name that you specify in the Action field; you use this name when you define the action
for the script in the next window. In the Object field specify the object that you want the script to address.

Automation Scripts

Create Script with Action Launch Point : Step 1 of 3

script creation process. More information
Launch Point:

SROCCLINKS Deleting SR attachments.
Active?
o

Object: ,
SR &
Action:

SRDOCLINKS |Del&ting SR attachments|

@ New
Existing:  Script:

Cancel

Q Specify the object and an action that launch the script. You can reuse an existing script
or specify a new one. If you choose a new script, the wizard guides you through the

relationship.
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4. Click Next.
5. In step 2 of the wizard, specify the Script that you added in step 1 and specify Python in the Script Language field.

N o

Automation Scripts

Create Script with Action Launch Point - Step 2 of 3

For step 3 of the automation scripts wizard, copy the python code that is provided previously in this article and paste it into the Source Code field.

Launch Point: Object:
SRDOCLINKS Deleting SR attachments L:l
Script: K Status:
SROOCLINKS |Deleting SR attachments L:J' Draft
Script Language: Log Level:
pytnon ERROR @
Import =
Q “ou can import a script file that you created in another application or you can enter a script in the Source Code field in the next step.
No file selected. T
Variables [ Fiter > =
Variable Variable Type « Binding Type Override?
...No rows to display...
New Row
Cancel Previous Next
Click Next.

Automation Scripts

Create Script with Action Launch Point : Step 3 of 3

Q You can enter a script in the Scurce Code field, or you can import a script file in the previous step.

Launch Point:

SRDOCLINKS fD-eIeting SR attachments
Script:

SROOCLINKS

Source Code:

Deleting SR attachments =+

Object:

Status:

Diraft

from pggi common.action import ActionCustomClass

from java.ig import File

from java.rmi import RemoteException

from padi mbg import *

from psglmbg import WbaConstants

from pediutil import MXException

from pgdi.app.doclink import Doginfo

from psgi app dogink import DoginfoSst

from psgi app doglink import DocinfoSsiRemots
from psgi app dogink import DocinksSetRemote
from java.lang import SecurityException

from padiserver import MXSeryer

import gys

det Comm-paRuner(osing):

print("™*** QWNERTABLE .. '+

# COMMENT: function to check if the doclink owner is a commiog or the main mbo.

Qwnerable = docink oetaiting COWNERTARBLE")
ounertabls)

|

T —

Cancel

B ¥

Previous

Create

8. Click Create.

Define an Action in the Actions Application

1. In to IBM Control Desk, go to System Configuration > Platform Configuration > Actions.

2. Create a new action as shown in the following image. In the Parameter/Attribute field, specify the same script name that you specified when creating the script in the wizard.
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Actions Charfotte Glenn
|All Records + | Find: l:éh - @ @0‘ Qﬂ @ | ‘&
[ ] 6o To Applications Action
L_L;J'I__'/ Common Actions
@ Nevr Ak Action: Value:
|7 EW Action S _ _l B _— —_—
CLINKS |Deleting SR Attachments = ;cum.ibm.t'n.ruli. maximo.gcript. SeriptAction »
Object: Parameter/Attribute:
& Clear Changss r o T
£ sr Q [pocLinks »
.} More Actions Type: Memo:
Duplicate Action st floss. ¥
Classification: P E
Delate Action Accessible From:
| | #
Add to Bookmarks L ! |ALL »
Class Description:
View Action Log .
&
Add/Modify Image
Members [p Fiter 0-Dofo
Action Description Object Type Value
| ...No rows to display...
il

Define the Escalation

Go to the Escalation Application and define an Escalation with the appropriate condition and reference points that fit your use case. For information about creating escalations,
see Managing escalations in the IBM Control Desk Knowledge Center. More information is also available in the following blog article: Maximo / SCCD Escalations - Your Friend and Mine.

Conclusion

This is a powerful solution for deleting DOCLINK attachments in IBM Control Desk. There is no need to deploy any compiled code or stop the server to take advantage of this solution.

Comments

1-10f 1 Previous = Next
Jeff7360 commented on September 22, 2015 Permalink
| am attempting to use this script to delete some linked .png files from emails sent to the listener. When the script is run on the SR object it sees the doclinks owner is the
commlog object and passes the docinfoid to the file deletion paortion of the script which fails giving a database error stating that the atatype charvar could not be converted to
bigint. MBO load failed.

If the script is run on an SR that is the owner of the doclinks the docinfo is passed, the file is deleted from the server, the docinfo entries (file path, etc) is removed, but the
doclinks record is left on the SR. | tried to modify the script to only delete these .png files, but | have the same issues with the unmodified source code as well. | am at a loss as
to why.

**EDIT 10/9/2015** Found the issue, the docinfoid was being passed as a string with commas in the text and for whatever reason the database could not convert this to an int.
Changed the code in the script to remove the commas from the text then pass the value to resolve the errors | had been getting. No clue why | would get this type of
conversion error using this script in out of the box apps.

Edited on October 9, 2015

Show 10 = 25

50 items per page Previous = Next
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Live Chat configurations
E 1 Like | Updated October 14, 2016 by charglen | Tags: None

The following pages provide information about how to configure Live Chat for IBM Control Desk.

Configuring Live Chat for Service Providers

Configuring Live Chat in a Clustered Environment

Scheduling Availability of Live Chat Queues

Closing Service Requests opened from Live Chat automatically
Displaying Live Chat Statistics in the Ul

Configuring browser settings for chat focus

Comments

There are no comments.
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Configuring Live Chat in a Clustered Environment
E 1 - Like | Updated April 1, 2013 by Lili Orozco | Tags: chat, cluster, live, livechat

To enable Live Chat to work in a clustered environment:

1. Each Java Virtual Machine instance in the cluster needs a unique name defined via the mxe.name parameter. The configuration for this is done via the WebSphere Admin Console.

2. An instance value needs to be defined for each instance for property sccd.livechat.instanceJVMAddress with the unique URL to the instance. The configuration for this is done via
the SmartCloud Control Desk.

Disclaimer: The following is an example of configuration on WebSphere. Different versions of WebSphere and different types of clustered deployments will vary in
procedure.

Step 0: Find out information about the Cluster Members needed for Step 1 and 2

Before diving into Step 1, let's find out the URL to each of the cluster members. To find information about the topology, login to the WebSphere Admin Console and navigate to:

Servers > Clusters > Cluster topology

Integrated Solutions Console Welcome wasadmin

View: A..III tasi—;ﬁ - |
welcome Cluster Topology

Guided Activities

Cluster Topology

5
B Servers Use this page to view a list of WebSphere application sen

Mew server e —|
Server Types Lecal Topology |

B Clusters

webSphere application server clusters

Cell
= % MAXIMOCLUSTER
B (@ Nodes
B [§ ctaliode0! (D 7.0.0.17)
B (@ Cluster members
% cluster member 1
[ Applications = @ tsrmvmwi4Nodedl (ND 7.0.0.17)
= @ Cluster members
% cluster member 2

Proxy server clusters
Generic server clusters
B Cluster topelogy
DataPower
Core Groups

Services

Rescurces

Security

In this example, we have a cluster called MAXIMOCLUSTER with two nodes, each with once instance. Click on one of the cluster members, for example, cluster_member_1.

In the Communications section, expand Ports to see which ports this instance is using:

Communications

& Borts
Port Name Part IDetaiIs
BOOTSTRAP_ADDRESS 9811
SOAP_CONNECTOR_ADDRESS 8881
ORB_LISTENER_ADDRESS 5103
SAS5_S55L_SERVERAUTH_LISTENER_ADDRESS 5407
CS5IVZ_S5L_SERVERAUTH_LISTEMER_ADDRESS | 5408
CS5IV2_SSL_MUTUALAUTH_LISTENER_ADDRESS | 9409
WC_adminhost 9062
WC_defaulthost 5081
DCS_UNICAST_ADDRESS 9355
WC_adminhost_secure 5045
WC_defaulthost_secure Sd44
SIP_DEFAULTHOST 5062
SIP_DEFAULTHOST_SECURE S063
IPC_CONNECTOR_ADDRESS 9634
SIB_ENDPOINT_ADDRESS 7278
SIB_ENDPOINT_SECURE_ADDRESS 7287
SIB_MQ ENDPOINT_ADDRESS 3559
SIB_MGQ _ENDPOINT_SECURE_ADDRESS [ 3579

This means my cluster_member_1 is running on port 9081. Do the same for the rest of the cluster members.

If you are unclear on which hosts these instances are running on, navigate to Servers > Clusters > Websphere application server clusters. Select the cluster and then click on Cluster
members. Make sure to click on the Cluster members link and not on the + sign which only displays a table with the cluster names.
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WebSphere application server clusters > MAXIMOCLUSTER

Use this page to change the configuration settings for a cluster. A server cluster consists of a group of application servers. If one of the

a member of the cluster fails, requests are routed to other members of the cluster.

General Properties

Runtime | Configuration | | Local Topolegy

# Cluster name

| MAXIMOCLUSTER

DefaultNodeGroup

Prefer local

Bounding node group name

I:l Enable failover of transaction log recovery

i Apply | i oK | | Reset i Cancel

Cluster messaging

Messaging engines

Additional Properties

Clustar members

Backup cluster
Endpeint listenars
Security domain

'WebSphere application server clusters

WebSphere application server clusters > MAXIMOCLUSTER > Cluster members

Use this page to view and manage application servars that belong to a cluster. ¥ou can also use this page to chan
servers. Learn more about this task in a guided activity. A guided activity provides a list of task steps and more ge
configuration of new cluster members is based on a server configuration template that is stored as part of the clus
cluster member and is used to create all subsequent cluster members. Modifications to the configuration of an indi

cluster member template.

Freferences

| New || Delete || Templates.,

| Start || Stop

. Restart ||

| Terminate | Make Idle

Select| Membear name

Node

Host Name

Version )

¥ou can administer the following resources:

D cluster member 1 ctghodeO1 tsrmymwi6.tivlab.raleigh.ibm.com | ND 7.0.0.17 2
D cluster member 2 tsrmvmwi4Node01l tsrmvmwid4.tivlab.raleigh.ibm.com | ND 7.0.0.17 2
Total 2

So in summary (in this example), the two instances hosts and ports are

tsrmvmwO06.tivlab.raleigh.ibm.com on port 9081
tsrmvmwO04 tivlab.raleigh.ibm.com on port 9081

If the default context root of maximo was not changed, the two URLSs that need to be registered to configure Live Chat in a clustered environment are:

http://tsrmvmw06.tivlab.raleigh.ibm.com:908 1/maximo
http://tsrmvmw04 tivlab.raleigh.ibm.com:908 1/maximo

If the context root was changed, replace it accordingly in the URLs above.

Step 1: Each Java Virtual Machine instance in the cluster needs a unique name defined via the mxe.name parameter.

To set the mxe.name parameter in each of the JVM (Java Virtual Machine) instances, in the WebSphere Admin Console, navigate to the Servers sections, expand Server Types, choose

WebSphere application servers and click on the server in the table.
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Integrated Solutions Console Welcome wasadmin

| Cell=ctgC

View: All tasks =
welcome Application servers

Guided Activities

Application servers

=
e Use this page to view a list of the application servers in your environment and the status of each of 1
New server status of a specific application server.
Bl SenvecTypes Preferences

webSphers application servers

WebSphere prosy servers | mew |! Delete || Templates... || Start |! Stop || Restart | ImmediateStop || Terminate |

Generic servers
Version 5 IMS servers
wWebSphers MQ servers
Web servers

| Node 2 | Host Name o |\.||'ersinr

You can administer the following resources:

Bl Clusters
wehSphere application server clusters £ M¥Server ctglode01 tsrmvmwi6.tivlab.raleigh.ibm.com | ND 7.0,
Proxy server clusters
W_ D cluster member 1 ctgNode0l termvmwi6.tiviab.raleigh.ibm.com | ND 7.0.
Generic server clusters
Cluster topology D cluster member 2 termvmwi4NodeOl tsrmvmwO4.tivlab.raleigh.ibm.com | ND 7.0,
DataPower
D serverl tsrmvmwi4Noded 1 tsrmvmwil4.tivlab.raleigh.ibm.com | ND 7.0.
Core Groups
Total 4

Applications

¥ Services

In this example, we will click on cluster_member_1. The same steps need to be repeated for all instances in the cluster.

In the Server Infrastructure section, expand Java and Process Management and click on Process Definition.

Messaging engines
Messaging engine inbound transports
WebSphere MQ link inbound transports.

SIB service

lass loader first |

Server Infrastructure

A Java and Process Management

ancel
Class loader

Process definition

Process execution

Monitoring policy
Administration

Communications

B Borts

Messaging

Performance

Performance Monitoring Infrastructure (PMI)

Performance and Diagnostic Advisor Configuration

In the Additional Properties section, click on Java Virtual Machine.

Additional Properties

Jawa Virtual Machine
Envircnment Entries
Process execution
Process Logs
Logging and tracing

In the Generic JVM arguments, add the following -Dmxe.name=clustermember1 to the end. You can choose any name other than clustermember1 but the name must be unique across
instances.
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Maximum heap size
1536 MB

E] Run Herof

HProf Arguments

IBM Control Desk : Configuring Live Chat in a Clustered Environment

[
= Debug Mode

Debug arguments

l-agentlib rjdwp=transport=dt_socket.server=y,suspend=n,address=7777

Generic JVM arguments

|-Xg:po|iw:gencon -Xdisableexplicitge -Xmn320m -Dmxe.name=clustermemberl

Executable JAR file name

D Disable JIT

Operating system name

|v:ind0vr=

| Apply | [ ok | | Reset | cancel

Click Apply and then Save to save the settings. Click OK and then Save to get out of the settings. Repeat for other instances in the cluster. Remember to give each instance a unique

name, do not copy and paste the same value.

Restart the instances to pick up the parameter values.

Step 2: Add an instance property for each URL instance in the cluster for property

sccd.livechat.instanceJVMAddress.

Login to SmartCloud Control Desk and navigate to the System Configuration > Platform Configuration > System Properties application.

In the Instance Properties section (bottom) click on New Row to add a new one.
ms

B cMSdbport CMS.db.port 50005 ﬁl
B CMSdbschema CMS db.schema maximo 04
New Row
3y Defaults
B Instance Properties [ Fiter > 4 1-8of 10 & o =
=7 Property Name Description Value
P mxe.comport (L, Comport ﬁ

Port used by RMI for communication; if
b mxe.rmi.port '_‘J“‘ left at 0, RMI will use any available
port on the system

Default Release start distribution

p pmreldistsoftware. workflow “L Workflow

e O il T I Default Release Get distribution
b pELD : ~4 Workflow

Default Release Test OMP Connection

ﬁ pmrel.testompconn.workflow Qﬁ Workfiow

b pmrel.distzoft.event [‘& Deploy Software Event

b prrel.getstatus.event Qﬂ Get Deployment Status Event
b pmrel.testconn.event _)c Test Connection to OMP Event

For Property Name:, either search for or type in

sccd.livechat.instanceJVMAddress

For Server:, type one of the mxe.name values you set up in the previous section. In this example, | will use clustermember1.

For Value:, type in the URL:

http://tsrmvmw06.tivlab.raleigh.ibm.com:9081/maximo

PMRELDSTSW

PMRELGETST

PMRELTSTST

DISTSOFT

GETSTATUS

TESTCONN

C'E[}

G

G E

?
2
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For Server Host, leave blank.

Instance Properties Detailz

Property Name: Server:
sced fivechat instancelVMAddress C& clustermember1 C*#
Description: Server Host:

Live chat internal shared key value
Value:

| hitpeiftsrmymw 06 tiviab.raleigh.ibm. com: 908 1/maximo

Click Save.
Click New Row again and repeat for every instance in the cluster. Make sure the Value is the correct unique URL with port to that instance.

Verify Live Chat is working!
And if it is not, try this!

Comments

#* Loading comments...
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat in a Clustered
Environment > Debug Live Chat Cluster Configuration

Debug Live Chat Cluster Configuration

E Like | Updated February 9, 2017 by Jim Yu | Tags: chat, cluster, livechat

Enable debug level log messages for Live Chat functionality

Login to SmartCloud Control Desk and navigate to the System Configuration > Platform Configuration > Logging application

In the Root Loggers top section, search for the tsrm. When the Loggers section below gets populated, search for livechat. Click on the
magnifying glass next to ERROR to change the level to DEBUG.

Logging

4
B &
ications
W Fiter > @ 124 0k
e Root Loggers Fitter n &
e Logger Log Level Key
ges tsrm l:{\,
ns -
b tzrm ERROR 21 logdjlogger.maximo.application.t
Root Logger
ers
rerties
Loggers T > @ & 1-10f1
t Folder Logaoer Loqg Level Key
lvechat b ':.;',
- = log4|. logger.maximo.applicatio
|} lrvechat > 4 echat

Save and then click on Apply Settings in the More Actions.

To verify the instance property was configured correctly

Login directly to one of the cluster nodes, like:

http://tsrmvmwO04.tivlab.raleigh.ibm.com:9081/maximo

Navigate to the System Configuration > Platform Configuration > System Properties application.

In the Properties section look for the sccd.livechat.instanceJVMAddress property. The value should be one of the values set, for
example:
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[[] " sccdlivechatinstancelVMAddress |Live chat internal shared key value

Global Properties Details

Property Name: File Override?

sced.livechat instance)VMAddress

Description: Global Onhy?
[Cive chat internal shared key valud
Globkal Value: Instance Only
4 http:#lecalhost: 20fmaximo v
Current Value: Online Chang
v

hitp:#tsrmymw 04 tiviab raleigh.ibm. com: 308 1/maximo

Maxime Default: Live Refresh?
http:iflocalhost: 20/maximo
Encrypted?

Note: the Current Value in Global Properties indicates the URL that the chat service connected to during start up. It's a read-only value.

When all else fails
If live chat does not work across clustered instances, make sure the URLs are set correctly in the instance properties. Make sure the
URLs are prefixed accordingly with http:// and the context root for maximo is set correctly and is included.

If several attempts have been made to provide a correct URL, you may need to clear the instances that have been previously registered
by making sure only the registered instances are in the database table PMTCOLIVECHATOORT.

You need to connect to the database and delete any obsolete or incorrect instances.

To delete entries in DB
> delete from maximo.PMTCOLIVECHATOORT <-- new entries get auto-generated and populate this table upon WAS startup

Below is a screenshot with only the two instances registered.

select * from PMTCOLIVECHATCOORT

select * from PMTCOLIVECHATOORT

e P P P T T P T P T e o e o o o o T o e T o T )

[ select*fomP | select”fromP | select*fromP |

Rows 2; aelect * from PMTCOLIVECHATOORT

Results rMetaData |/Infn rmerwew |

| HOSTURL PMTCOLINECHATOO...
hitp:itsrmvmw06 tiviab.raleigh.ibm.com:9081/maximao/cometd ] 290
hitp:iftsrmvmw4 tiviab raleigh ibm.com:8081/maximo/cometd Kl 290

At times, each of the instances will start up at the same time so they are unable to register themselves before the other instance starts up.
Try restarting one of the instances to attempt to reestablish the cloud. Attempt adding a delay to one of the instances to avoid this
problem in the future.

Alternatively, use the Ripplestart option to start the instances.

On WAS Console select Servers > Clusters > WebSphere App Server Clusters
Select the cluster node and click Ripplestart <-- this starts the servers one by one.
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Another item to check is to ensure that the system property mxe.int.dfltuser contains a correct value (for example MXINTADM).
In ICD, select System Configuration > Platform Configuration > Systemp Properties and enter "mxe.int.dfltuser" in the filter.

The user specified in mxe.int.dfltuser must be a valid integration user and must not be BLOCKED. By default, that value is MXINTADM.
In ICD, select Security > Users and find mxintadm
If MXINTADM is in BLOCKED status, unblock it by selecting Change Status and set New Status to ACTIVE.

As a last resort, you can enable DEBUG in the livechat logger and check for startup debug lines with “Oort URL”. The log statements
should be processing each of the registered URLs depending on their startup order.

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat in a
Clustered Environment > Verify Live Chat in Cluster Environment

Verify Live Chat in Cluster Environment
E Like | Updated April 1, 2013 by Lili Orozco | Tags: chat, livechat

To test live your live chat cluster configuration, log in to each of the instances individually. In the configuration example, |
loginto:

http://tsrmvmwO04.tivlab.raleigh.ibm.com:9081/maximo

and

http://tsrmvmw06.tivlab.raleigh.ibm.com:9081/maximo

Since | am using the same machine to test, | need to login using different browsers. | login as maxadmin which be default
is a chat agent and can request to chat.

From one browser, | go to the Self Service > Self Service Center application and request to chat as an end user.

The second browser where | am logged on to the second instance should immediately indicate that there is a chat waiting.

| can then accept the chat request with this browser and verify that messages can be exchanged back and forth.

If the indicator in the second browser does not blink with an incoming chat request or the messages are lost between the
chat windows, try debugging using these tips.

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat for
Service Providers

Configuring Live Chat for Service Providers
E Like | Updated today at 11:03 AM by BhratPatel | Tags: None

Live Chat was introduced in Control Desk 7.5.1.

If you are a service provider, how can you configure Live Chat for multiple customers? You might want a specific queue
and agent for each customer.

For information about how to configure Live Chat for IBM Control Desk for Service Providers, please see the following wiki
pages:

Live Chat for Service Providers 7.5.3.1 and higher

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat for
Service Providers > Live Chat for Service Providers 7.5.3.1 and higher

Live Chat for Service Providers 7.5.3.1 and higher

E Like | Updated December 22, 2015 by charglen | Tags: None

Live Chat was introduced in Control Desk 7.5.1. The live chat feature enables end users of the Service Desk and Self
Service Center to chat with Service Desk agents about issues or problems. Users can request a chat from the home page
of the Self Service Center (Contact Us pod) or from Browse Solutions.

If you are a service provider, how can you configure Live Chat for multiple customers? You might want a specific queue
and agent for each customer.

The following pages provide information about configuring Live Chat in IBM Control Desk for Service Providers Version
7.5.3.1 and higher.

Live Chat for the Contact Us pod in Service Providers 7.5.3.1 and higher

Live Chat for Browse Solutions in Service Provider 7.5.3.1 and higher

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat for Service Providers > Live Chat for Service Providers 7.5.3.1 and higher >
Live Chat for the Contact Us pod in Service Providers 7.5.3.1 and higher

Live Chat for the Contact Us pod in Service Providers 7.5.3.1 and higher

E Like | Updated December 22, 2015 by charglen | Tags: None

This page describes how to configure the Contact Us pod in Live Chat for IBM Control Desk for Service Providers Version 7.5.3.1 and higher.
Prerequisites
The following are prerequisites for the Contact Us pod configuration:

« |IBM Control Desk Version 7.5.3.1 or later or 7.6.0.1 or later is installed.
« Customers are already created.

« Users and groups for chat agents are created and configured.

Instructions

1. Login to Control Desk as an administrator.

2. Go to System Configuration > Platform Configuration > Application Designer.
3. Search for TKTEMPLATE and select it.

4. From the Template tab, add a new text field (You can drag and drop from Control Palette.).

#f = Application Designer

. Q [ HEd|ler | anEE@E%*RDE
Workspace

Application:
| TKTEMPLATE

Iz Mobile? Viewport: Edit Mode Enabled? Main Object:
I Default (1222x704) w

TKTEMPLATE

DI'ESEI'I[E[IU f...

ta T . ..

Bpecifications

e T LT e LT YN

5. Edit the new field as follows:

Attribute: PLUSPCUSTOMER
Lookup: PLUSPCUSTOMER
Menu Type: PLUSPCUSTASSOC
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6.

7.
8.
9.
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- =
Textbox Properties
General Advanced
Control ID:
A Select Value
.Default Label: W Filler 1-10of 1 =
Customer
I ftribute Olject
Label:
Customer | pluspcustomer tktemplate
Hide Label? LUSPCUSTOMER TKTEMPLATE
Turn Smart Fill Off?
Cancel

Attribute:

Data Source ID:

Lookup:
PLUSPCUSTOMER

Go To Applications:

Input Mode:

Menu Type:
PLUSPCUSTASSOC

Size:

lcon Menu I

Save the record.

At this point, the new field should be like this:
f& = Application Designer
- Q Y BE £ S EHERXXDD
I
Workspace

Application: Is Mobile? Viewport: Edit Mode Enabled? Main Object:
TKTEMPLATE |Ticket Templates | Default (1222x704) « | TKTEMPLATE

pI'ESEI'I[E[IDI'I...

Specifications

Status:

Lodisedadl oo

e

:isection... i isection. . i isection. . |
i 1 - )
¢+ Owner Group: E Service Group: E Classification: E
i » i » »
E i Owner: E Service: E Class Description: E
P » i » :
E E Internal Priority: E Vendor: : Customer:

Ha = 11

it & » &

i H H

¢+ Ticket Status: i % Automatic Assignment? ion: H
1 & ' '
‘i Q E = /
D TR S e e an s cat e e S S Y,

Go to System Configuration > Platform Configuration > System Properties.
Search for sccd.livechat.singlechattopictemplate.
Clear the Global Value, save the record, and run Live Refresh.
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10. Go to > Administration > Resources > People (SP) and select a chat agent.

11. In the ‘Workplace Information’ section, add the customer that the agent will work with, as shown in the following example:

CustVendor:

CUSTOMER_A| »» Customer A
Cust'Vend Type:

CUSTOMER @

12. Save the record.

13. Go to > Security > Security Groups (SP) and select the agent group.
14. Go to the Customers tab.

15. Select the level of the customer authorization. The goal is to ensure that the agent receives chat requests from a specific customer, as shown in the following example:

ff = Security Groups (SP)

- & v
L2 Group | Sites | Applications = Storerooms

Group:

SDADESKAGE Agent for Service Desk and Change Management

Customer Authorization

Labor

O @D

GL Components =~ Limits and Tolerances

Data Restrictions Customers S

Users

=

Authorize Group for All Customers?

Authorize Group only for Unrestricted Customer level information?
Authorize Group for Customer on User's Perzon record?
7

Authorize Group for Customers in User's Person Customer Access List?

Authorize Group for Customers listed below?

Q Select one level of customer authorization for users in this security group. All users can access unrestricted classifications and attributes, regardless off the customer authorization level of the group tt

16. Save the record.

17. Go to > Administration > Resources > Person Groups.

18. Create a person group, add the chat agent(s), and configure the group to be a chat queue, as shown in the following examples.

ff = Person Groups

m Person Group

Perscn Group:

Auto Assign Group Availability

Quser - Find Person Grouf Q - Select Action

- BRL | |B

Chat Queue

Attac hments

GROUP_A Chat queue for Customer A = :_6;2
People [ Fiter 1-10of1
Person = MName Use for Organization  Use for Site Group Default? Site Default? Organization Default? ]
[P AGENT_A % Agent Customer A = o @ [v]

| —

Person Groups

m Person Group

Auto Assign Group Availability

Perscn Group:

GROUP_A |Chat queue for Customer A

Is Chat Queue? Available to Chat?

] v

o Find Person Grour Cl S Sefect Action
Chat Queue

a Configure this person group as a live chat gueue and view chat queue activity. More information

=

19. Save the record.

20. To create chat topics, Go to > Service Desk > Ticket Templates and assign the ticket template to the person group created for each customer, as shown in the following example.
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ff = Ticket Templates

|
iQL.er-,- - Find Template Q iw

Select Action -

Zle9

%

mdlad| Template | Specifications

Template:

CHAT_CUST# [chat topic for Customer A |

Details =
Owner Group: Service Group: Classific ation:

leroups | » | | » | | »

Owner: Service: Class Drescription:

| | » | > | @

Internal Pricrity: “endor: Customer:

| || | | » |cusToMERs| B

Ticket Status: Seff Service Access?  Organization:

This Template Will Be Used In:
() Catalog Offering, Service Request and Quick Inserts
() Catalog Offering Only

(8 Chat Topic Only

At this point, Live Chat for Contact Us pod is configured for Service Providers. You should repeat the steps above for each customer. The chat request will be routed according to the
customer, as shown in the following example.

Chat with an Agent

Select a Chat Topic  Previous 1-1of1  Next

Description

te a new Service Request to report an Issue.

Chat topic for Customer A

% Ff.e‘ﬁuéht REQ'—"B’SE : : Opticnally, ¢hat about a previously opened Service Reguest:
Easy access to the services you most often request. l:l @

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Live Chat configurations > Configuring Live Chat for Service Providers > Live Chat for Service Providers 7.5.3.1 and higher >
Live Chat for Browse Solutions in Service Provider 7.5.3.1 and higher

Live Chat for Browse Solutions in Service Provider 7.5.3.1 and higher
E Like | Updated December 22, 2015 by charglen | Tags: None

This page describes how to configure Live Chat for Browse Solutions (Chat with Agent about this Solution) in IBM Control Desk for Service Providers Version 7.5.3.1 and higher.
Prerequisites

The following are prerequisites for the Contact Us pod configuration:

« |IBM Control Desk Version 7.5.3.1 or later or 7.6.0.1 or later is installed.
« Customers are already created.
« Users and groups for chat agents are created and configured.

Instructions
1. Login to Control Desk as an administrator.

2. Go to > Security > Security Groups (SP).
3. Select a group and grant access to the agent button in the solution dialog.

Welcome to Live Chat

Live Chat
Started at 4:17 PM EDT

You are chatting with agent: Agent Customer A Started at 4:13 PM EDT
Service Request 1024 Chatting with End User Customer A
Service Request 1023

T®

4

Agent Custo... Hello, how can | help you?
Agent Cust... Hello, how can | help you?

4. Because the user is from a specific customer, only objects associated with this customer are available in the Self Service Center. To ensure that your solutions are configured properly,
Select Go to > Service Desk > Solutions (SP).

#f = Security Groups (SP)

iz 4 =
- Q- - JRL| @D | |RB
| |
Group Sites Applications Storerooms Labor GL Components Limits and Tolerances Data Restrictions Users Customers ]

Group:
PMSCSRU |Service Requisition User =

Applications “riter > QA & 1-10f1 o =

Grant Listed Applications. + Revoke Listed Applications:

Iain Object/Table Original Application (if copied)

Description =

self service center

Self Service Center The SR view View Service Requests

Options for Self Service Center [ Fiter > ¥ 1= of:4 & 2 =

Grant Listed Options for This Application

Description = Grant Access? Condition
[ Delete a desktop shopping v _ | »
3 Mew Service Reguest [v »
& Read access to Self Service App J »
p Save Self Service App v »
= Fiter > &, & 1-10of1 o+ =
Description = Grant Access? Condition

solution dialog

| B Show chat with agent button in the solution dialog I . »

5. Go to > Administration > Resources > Person Groups , create a person group, add the chat agent(s), and configure the group to be a chat queue, as shown in the following examples.
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= Solutions (SP)

¥ Q ~ - WE S| e
Solution

Specifications

Salution: Self-Service Access? Attachments
1001 'ﬁeplace HD manualty = 7 I_&g
Classzification: Type: Status:

:21 V2101 210 b 'H‘N ACTIVE
Class Description: Customer:

IT lssue \ Hardware \ Desktop '-:J‘_

o
[

]
s
@

EYE

cUSTOMER_A| B

m Person Group

Chat Queue

Auto Assign

Group Availability

0 Configure this person g

snd wiew £ hat queus aclivity. More information
Peraon Group:

GROUP_A Chat queve for Customer A 12
Is Chat Queue?  Avalable to Chat?

v v

6. Save the record.

7. Go to > Service Level > Response Plan (SP) and create a response plan to route the end user to the correct queue:

=— Response Plans (SP)

a2 | | ey |
b Q » il .M | @ | e |
| |
Response Plan | Conditions =~ Locations | Assets = Configuration ltems = Response Actions
o Select the type of ticket, work order, or sales order to which this response plan applies, and assign a ranking.

If the criteria that you specify on the Conditions, Assets, and Locations tabs are met, this response plan will be applied in order of rank. You cannot medify the response plan if the status is Active.
Response Plan: Ranking: Attachments
R1001 Route solution to Customer A queue (=) 1 2
Status: Applies To:

ACTVE SR @
Status Date: Apply to Date:
10/28015 14:17:41 i25) Report Date a,
Response Plan Administrator:
» =
8. Fill in Assign Owner Group and Apply Solution fields.
Response
Apply Job Plan: Stop Response Plan if Job Plan or Ticket Template can not be applied?
» =
Job Plan Site/Org:
Assign Vendor:
Apply Ticket Template: > =
» = Assign Supervisor:
Assign Owner: » 3
» = Assign Crew:
Assign Owner Group: l:{‘
CUST_A Customer A queue =
= » H = Apply Solution:
Assign Work Group: 1001 % Replace HD manually (Customer A} =
»> =

9. Associate a customer with the response plan.
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Associate Customer

Associate customers with a response plan if you want the response plan to apply only to
9 tickets, work erders, or sales orders for these customers. If vou do not asscciate a customer

with a response plan, it can be applied to tickets, work orders, or sales orders for any
customer.

Responze Plan:

R1001 Route solution to Customer A gueue L:J.'
Customers [ Fiter > 1-10f1 o =
Customer Name Parent
B CUSTOMER_A 3 Customer A @
New Row
OK Cancel

10. Add a criteria if you need to route the chat request from a solution to different queues. Otherwise, the same response plan will be applied to all solutions.

= Response Plans (SP)

Response Plan | Conditions Locations Assets Configuration ltems Response Actions

@
L4 {‘

@

Response Plan:

Applies To:
R1001 Route solution to Customer A gueus = SR @
Status: Ranking:
ACTVE

Response Plan Criteria

YU

,,,,, and enter a priority value. If

a The response plan will be applied to a ticket, work order, or sales order if all of the conditions are met. More information

Classification:

Internal Priority:
2902101 2101

»» T lszue\ Hardware \ Desktop

11. Save and activate the response plan.

At this point, Live Chat in Browse Solutions is configured for Service Providers. You should repeat the steps above for each customer. The chat request will be routed according to the
customer.

Self Service Center

View Solution

2 =

I B Rate this solution
Solution:
1001 Replace HD manually (Customer A) L:J,
Did this solution help you resolve your issue? &S No - Create a Service Reguest MNo - Return to Solution Search Chat with Agent about this So
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Self Service Center

Search for Solutions, Offering and Quick Inserts

View Solution

2 8

e f g Rate this solution
Solution:
1001 Replace HD manually (Customer A} L:l
Did this solution help you resolve your issue? &S Mo - Create a Service Reguest Mo - Return to Solution Search Chat with Agent about this So

Comments

There are no comments.
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Closing Service Requests opened from Live Chat automatically
E‘ Like | Updated April 10, 2013 by HelenaCorelli | Tags: None

In IBM SmartCloud Control Desk 7.5.1, the end user can have any issue quickly resolved by using Live Chat. A service request is created automatically
when a chat request is opened, and the chat history is saved.

Depending on the demand, several service requests are created and you may want to have all those tickets close automatically. To automatically close
tickets created from a chat request, you can cre-ate an escalation that closes all the SR opened from chat requests.

1. Log in as the Administrator, and then select Go to — System Configuration — Platform Configuration — Actions.
2. Create an action to close service requests:

1

Find Achon Qv = || Seiect Acton -] é] i _£¢ é ¥

List | Acton
Action: SR CLOSED SR Closed Action 7] Value: CLOSED »
Object SR &8 Parameter/Anribute; »
* Type: Change Status ™ Memo:
Classification » » Accessibie From ALL »
Class Description: C&,

3. Select Go to — System Configuration — Platform Configuration — Escalations.
4. Create an escalation.
5. In the Condition field, add the following query:

externalsystem = 'CHAT' AND status in (select value from synonymdomain where do-mainid = 'SRSTATUS' and maxvalue in (RESOLVED')) AND
(current timestamp - STATUSDATE >=10)

This condition closes Service Requests that were generated from the Live Chat and that are in ‘Resolved’ state for more than 10 days. You can change the
condition by adding more criteria.

6. Create an escalation point, and add the same query in the Escalation Point Condition.
7. In the Actions section, click New Row, and select the action that you created in step 2.
8. Fill in the Schedule according to your needs.

9. Before you validate the escalation, ensure that it looks like this:
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Buletns: () Chot Quewe- (0) = GOTo Reports St

Fratscaston || @iw| | ]| Select Acton FUE & @® -
|vot [ eocomon | commmemoares |
Escalation: | 1080 Ciose SRS opensd from Live Chat sutomaticaly 1] St g Activer [
* Apples To: SR [ Organization: (=) # Schedule: 1h."0.%5%5 55
Cendiion: maemalsystem = ‘CHAT AND status in (select froen synonymdomain where Successtul Exacution Calendar Organization:
w-ﬁhﬂﬁ'ﬂmhﬁ%]ﬂ(ﬂm. e e Enl-y?P’ ol
STATUSDATE ==10) Last Run Tama: 21813 18:08:51 Calsridar: »
s @ o
shif: &

EscatonPont. 1
Elapsed Time Atirbute: | &

Escalabion Point Condition: externalsystem = 'CHAT AND (status = 'RESOLVED') AND (current timestamp -
STATUSDATE >=10)

B

0 Select Action Group or add individual actions by clicking New Row.

10. From the Select Action menu, select Validate and then Activate/Deactivate escalation.

Comments

There are no comments.
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Scheduling Availability of Live Chat Queues

E 1 Like | Updated September 4, 2013 by Lili Orozco | Tags: None

To manage the availability of a Chat Queue, the attribute Available to Chat needs to be turned on and off in the chat queue (person group).

To do this automatically, you need two actions and two escalations.

1. Go to System Configuration > Platform Configuration > Actions and click the New icon.
2. Specify the following values and save the record.
o Description: Turn off chat queue

o Object: PERSONGROUP
o Type: Set Value
o Value: 0
o Parameter/Attribute: pmtcoischatqgactive
& ~ Actigns
+ | Find: 'C'Q + | Select Action ~ & !@ ;% |
Action
Action: Value:
1003 [Furn off chat queud = 0 »
Object: Parameter/Attribute:
[PersonGroU CL pmicoischatgactive »
Type: Kemo:
o Accessible From: ALL |Sst Value v
assincaton: Accessible From:
L » [aLL 1 »
Class Description: 3 =
- ]
Members I Fiter > 0-00f0
Action Description Object Type Value

...No rows to display...

3. Click the New icon again to create a new action.

4. Specify the following values and save the record.
o Description: Turn on chat queue

Object: PERSONGROUP

Type: Set Value

Value: 1

o o o o

Parameter/Attribute: pmtcoischatgactive

o Accessible From: ALL
5. Go to System Configuration > Platform Configuration > Escalations and click the New icon.
6. Specify the following parameters.

o Description: Turn off all chat queues

o Applies To: PERSONGROUP

o Condition: pmtcoischatq = 1

o Set Schedule, for example, every day at 5 PM

i - Escalations

w | Find: C]% w Select Action 5 J .6’2 !@ @ |

List View Escalation Communication Log
Escalation: Site: Active?
1002 | Turn off all chat gueues L,_J' "-—L
Applies To: Organization: Schedule:
[PersoneRoU C Q 16,00,17 557557
Condition: Create Successful Execution Entry? talendar Organization:
o o = »
% Last Run Time: talendar: .
93113 07:50.04 [ »
Shift:
2

Validation Results
7. In the Escalations Points section, add a new row and in the Escalation Point Condition field, specify the same condition shown in the preceding screen capture: pmtcoischatq = 1
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8. Select the Repeat check box.

Validation Results

IBM Control Desk : Scheduling Availability of Live Chat Queues

Escalation Points P Fiter > 1-10f1
Escalation Point « Elapsed Time Attribute Elapsed Time Interval Interval Unit of Measure Organization Calendar Shif
v 1 | & 1 - | & Q
Details
Ezcalation Point: Elap=ed Time Interval:
I 1
Elapzed Time Attribute: Interval Unit of Measure:
x 18 = q
E'scalatinn Point Condition: P-.epeat?
% Organization:
8 &
Eaiénl.i-ar: )
_ a
Shift:

9. In the Actions section, set the action to Turn off chat queue.
1y

Actions Notifications

g Select Action Group or add individual actions by clicking New Row.  Action Group:

[1004 »
Actions B Fiter > 1-10f1 o =
Action Description Type Sequence
13 1003 » Turn off chat queue SETVALUE 10 ﬁ’-
New Row

10. Save the record.
11. Click the New Icon to create another escalation to Turn on all chat queues.
12. Similarly, specify the following parameters.

o Description: Turn on all chat queues

o Applies To: PERSONGROUP

o Condition: pmtcoischatq = 1

o Set Schedule, for example, every day at 8 AM

13. In the Escalations Points section, add a new row and in the Escalation Point Condition field, specify the same condition shown above: pmtcoischatq = 1

14. Select the Repeat check box.
15. In the Actions section, set the action to Turn on chat queue.
16. Save the record.

If different queues are at different schedules, you'll need to specify the name of the person group for each escalation. For example, the condition can be something like:

pmtcoischatqueue=1 and persongroup="name_of_chat_queue_here’

Comments

There are no comments.
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Configuring browser settings for chat focus
E| Like | Updated October 14, 2016 by charglen | Tags: None

Author: Melody Bienfang
Overview

By default, IBM Control Desk Self Service Center is configured to force browsers to focus on the chat window. However, each browser has specific
settings that determine whether or not a chat window comes to the forefront.

Because of the browser-specific settings, there are steps that each user can take to ensure that the chat window is prominently displayed when a new
chat is opened.

You can use the following instructions to enable chat window focus in your browser.

For Internet Explorer browsers

Basically for Internet Explorer it is necessary to make sure that you installed the Internet Explorer updates described in the following Microsoft
knowledge base articles: MS10-018 (KB 980182) and MS11-099 (KB 2618444).

To configure the Internet Explorer browser to focus on the chat window when a new chat is requested, complete the following steps:
NOTE: This procedure requires a PC reboot. Do this update when a reboot is easily done.

1. Install the most recent cumulative security update for Windows Internet Explorer.
2. Go to http://windowsupdate.microsoft.com. The web page should look like this:

Use your Start menu to check for updates

Windows Update 15 mncluded m Control Panel. To check for updates:

= Click the Start button. click All Programs. and then click Windows Update.

1 Windows Update

Accessones -
| ¥ All Programs 1 Back
| Search programs and files el | Search pragrams and files o

3. If you get a message at the bottom of the screen similar to the following image, be sure to click Allow. After you click Allow, give the browser
several moments to “refocus”.

The previous webpage wants to run the fellowing add-on: ‘Windows Update’ from ‘Micrasoft Windows',  What's the nsi? Allow | v

4. After the browser is refocused, click Start > All Programs > Windows Update. You will see a screen similar to the following image:
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ol - i i ol A -

,‘3 ¢ Control Panel ¥ Al Conitrol Panel lems ¢ Windows Update

A
Contrel Panel Home 5
Windows Update
Check for updates
Change settings o : .
i im

View ipdate history . Restart your computer to install important updates

; Windews can't update important files and services while the system is using
essose Rishdest Upniates them. Save any open files and restart the computes, and then try to check for
Updates: frequently asked new updates.

questions Restast now |

Find out more about free software fram (null). Chck hese for details.

If your system is at the most recent level, a message will be displayed to indicate “Your system is up to date.” If it does, you can complete the
following steps to verify it:

a. Go to add remove programs

b. Click view installed updates

c. Manually look for KB261844 in the Microsoft Windows section.
d. If it is there, no other action is required.

5. To apply updates, restart the computer.

For additional technical information about the most recent cumulative security update for Windows Internet Explorer, visit the following Microsoft Web
site:

http://www.microsoft.com/technet/security/current.aspx

Note This update was first included in security update 980182 (MS10-018). For more information, click the following article number to view the article
in the Microsoft Knowledge Base:

980182 MS10-018: Cumulative security update for Internet Explorer

For Firefox browsers

To configure the Firefox browser to focus on the chat window when a new chat is requested, complete the following steps:

1. Type about:config in the address bar of Firefox and press Enter.

2. A warning message will be displayed to indicate that this might void your warranty.

3. Click to confirm that you want to proceed.

4. Search for the variable dom.disable_window_flip.

5. To set the value to be false, double-click the actual variable row, or select the row and right-click and select the Toggle option.

€ ©) rirefox | about:config

Search:  dom.disable_window

Preference Name 4 Status Type Value
'dom.disable_window_flip user set boolean false
dom.disable_wind Toggle default boolean false
dom.disable_wind Copy default boolean false
dom.disable_wind Copy Name in default boolean true
dom.disable_wind Copy Value ar default boolean false
dom.disable_wind New y lzable default boolean falze
dom.disable_wind Reset zlbar default boolean false
dom.disable_window open TestUrETESIZab e default boolean true
dom.disable_window_open_feature.scrollbars default boolean false
Anm dicahle windmar anen featiire shatiie defanlt hanlean triie

6. After the variable is set to false, click X on the tab to close the config tab and close the browser.
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7. Restart the browser in a new window.

For Chrome browsers

It is not possible at this time to configure the Chrome browser to focus on the chat window when a new chat is requested.

There are NO instructions, since this is a known bug in the Chrome browser, for implementation of Java Script: Additional technical details are
available here:

https://code.google.com/p/chromium/issues/detail ?id=316519

Comments

There are no comments.
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You are in: IBM Control Desk > Configuring and Customizing > Restricting concurrent user counts in IBM Control Desk

Restricting concurrent user counts in IBM Control Desk
E | Updated September 8, 2016 by charglen | Tags: None

Contributor: Lee Zhang

Click the following link to download a copy of this article in PDF format: Restrict_icd_concurrent_user_9-8-16.pdf

Overview

This article discusses one method to restrict the IBM Control Desk (ICD) concurrent user count. You can change the methodology to fit your requirement.
Assumption of Use Case

There are two categories of ICD users, regular users and restricted users.

« Restricted users: A maximum two concurrent restricted users is allowed in the ICD system at any moment for discussion purposes.
o Regular users: There is no restriction to the regular user login.

Use Case

The following use case is used to demo the feature.

1. Log in as restricted user “gtsuser1” in an Internet Explorer browser.

2. Log in as restricted user “gtsuser2” in a Firefox browser (or log in from a different machine).

3. Attempt to log in as restricted user “gtsuser3” in a Chrome browser (or log in from a different machine). The login fails because a maximum of two concurrent restricted users can log
in at any moment into the ICD system.

See the following screen capture. The error message can't be modified as it's governed by the standard ICD login process.

BMXAA3851E - Connecting to the server has been temporarily
disabled.

Welcome

Figure 1: 3rd restricted user failed to log in to ICD system

4. Log in as regular user "bob" to show that a regular user can still log in.

5. Log out restricted user "gtsuser1" from the Internet Explorer browser.

6. Attempt to log in as restricted user "gtsuser3" in a Chrome browser (or log in from a different machine). This time, it works because only one restricted user is logged in to the ICD
system.

Configuring IBM Control Desk Users

There are different ways to configure regular users and restricted users. In this section, one method is discussed.
Configuring Regular Users

Regular users such as bob, fred and maxadmin are defined as User Type “Type 1" ICD user account.
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Users “rHier > & & & 4 ¥ 1 - 20 of 78 S > =

User = Person First Name Last Name Display Name Status Type
- |
ALY ALLY Alty SimpleView Ally ACTIVE TYPE1 :&
ARUN ARUN Financialanaiyst Arun ACTIVE TYPE1 E
BARRY BARRY Barry Simpson Bamy Simpson ACTIVE TYPE 1 \,\
508 B0B Enduser Bod ACTIVE TYPE 1 N
BRIAN BRIAN Brian ReleaseManager Brian ACTIVE TYPE1 j\
CHARLIE CHARLIE Change Reguester Charlie ACTIVE TYPE 1 &
CINDY CINDY Cindy IncidentAnalyst Cindy IncidentAnalyst ACTIVE TYPEA ‘J,‘
DISPATCH DISPATCH  Dispatch User Dispatch User ACTIVE TYPE1 &
ELMO ELMO Inventoryadmin Elmo ACTIVE TYPE 1 .&
EPADMIN1 EPADMINT  admini ep admini ep ACTIVE TYREA &
EPADMINZ EFPADMINZ  admin2 ep admin2 ep ACTIVE TYPE1 \h
EPANALYST1 EPANALYST1 analysti ep analyst ep ACTIVE TYFE 1 ,&
EPANALYST2 EPANALYST2 analyst2 ep analyst2 ep ACTIVE TYPE1 Q,‘
EPUSER1 EPUSER1 user ep userep ACTIVE TIEE] ,}\
EPUSERZ  EPUSERZ  user2 ep user2 ep ACTIVE TYPE 1 N
FRANKLIN FRANKLIN Change Manager Franklin ACTIVE TYPE 1 ,f&
FRED FRED Usermanager Fred ACTIVE TYPE 1 ,\
GTSUSER1 GTSUSER1 ACTIVE TYPE 2 .}‘
GTSUSER?  GTSUSER2 ACTIVE TYPE2 :~
GTSUSER3 GTSUSER3 ACTIVE TYPE2 .}\
| Select Records
Figure 2: Defining regular users as TYPE 1 user account
Configuring Restricted Users
Restricted users such as gtsuser1, gtsuser2 and gtsuser3 are defined as User Type “Type 2" ICD user account.

Users “EIer > @ & & ¥ 1-30f3 3 =
User = Person FirstName  Lasi Name Display Name Status Type
gis & @
GTSUSER1 GTSUSER1 ACTIVE TYPE2 :;Y‘
GTSUSERZ GTSUSER2 ACTIVE TYPE2 h
GTSUSER3 GTSUSER3 ACTIVE TPE2 .,\

|| Select Records

Figure 3: Defining restricted users as TYPE 2 user account

Defining New IBM Control Desk Message

A new ICD message is required in your automation script.
Creating a new IBM Control Desk Message

To create an ICD message record, complete the following steps:

1. Log in to ICD system. http://<ICD host>/maximo, maxadmin/<password>

2. Using the GoTo menu, select System Configuration -> Platform Configuration -> Database Configuration.
3. From the More Action menu, select Messages.

4. Click New Row.

5. Enter the values in the following table.

Table 1:  Creating IBM Control Desk Message Record

Field Value
Message Group CUST_MSG
[[Message Key CUST_LOGIN
[Display Method MSGBOX
[Message ID Prefix BMXZZ
[[Message ID Suffix E
[[Message ID BMXZZ0001E
(Display 1D? Yes
I

2/8



10/12/2019 IBM Control Desk : Restricting concurrent user counts in IBM Control Desk

Field Value
Restricted user concurrent login count is
Value
exceeded
Messages
Messages | Fiter > @ ¥ ¢ 2~ & of 11422 & =
Message Group = Message Key = Meszaae ID Value
13 INVENTORY HARDINVENTORY BMXAABDESH The current record requires a hard reservatio ﬁ
} INWOICE InvoicePOSitellRequired BMXAATTIS No value was specified for the Site ID field fo ﬁ'
13 INVUSE HARDINVENTORY BMXAABOESE! The inventory record referenced on the usag ﬁ[’
3+ LICENSE licenseSwAllocationsDeletedinfo BMXTO047! Software license allocations were removed s @‘
7 ECU ST_MSG ECUST_LDGIN |BMXZZO000ME ERestrictEd user concurrent login count is exci Li
Details
Message Group:
|CUST_MSG
Meszage Key:
|cUST_LOGIN
Dizplay Method:
|MsBBOX 8
Message ID Prefix:
|BuxzzZ @
Message ID Suffic
e @
.M ezzage ID:
BMXZZ0001E
Display ID?
%]
Value:
|Restricted user concurrent login count is exceeded
Buttons:
oK?
v
Close?
Cancel?
Yes?
No?
OK Cancel

Figure 4: Creating IBM Control Desk Message Record

6. Click OK.

Defining an Automation Script

In this section, you define a new automation script that contains the logic to restrict the maximum concurrent user count of the restricted users.
Creating the IBM Control Desk Automation Script

A new automation script is created to monitor and control the concurrent login count of “Type 2” user accounts.

1. Log in to the IBM Control Desk Ul.

2. Select Go To -> System Configuration -> Platform Configuration -> Automation Scripts.
3. Select More Options -> Create -> Script With Object Launch Point.

4. Enter data as shown in the following table.

Table 2: Creating automation script CUST_LOGIN, step 1 of 3

Field Value
Launch Point CUST_LOGIN
Description Ignrggprié% ?Ongc:ncgghrr?tl the restricted user
Active Checked
Object LOGINTRACKING
Event Save
Save Add
New Checked
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Automation Scripts

Create Script with Object Launch Point - Step 1 of 3 =

Specify the name of the launch peint and the cbject that it applies to. Select the event that
activates the launch point. Specify the event context, which determines when the
e automation script is executed. You can reuse an existing script or specify a new one. If
vou =elect a new script, the wizard guildes you through the script creation process.
More information
Launch Point:

CUST_LOGIN To monitor and control the restricted user concurrent login co
Active?
hd
Object:
LOGINTRACKI (T

Object Event Condition:

@
Events =

©) ntialize Value Save =

(™ Validate Application

e Add? (@ Before Save

(7 Allow Object Creation

() After Save
(™) Allow Object Deletion 7
! Update? () After Commit
Delete?
@ New
() Existing: Script:
a
Cancel Next
Figure 5: Creating automation script CUST_LOGIN, step 1 of 3
5. Click Next.
6. Enter data as shown in the following table.
Table 3: Creating automation script CUST_LOGIN, step 2 of 3
Field Value

Script CUST_LOGIN

I To monitor and control the restricted user
Description ]

concurrent login count

Script Language Python
Log Level Error
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Automation Scripts

Create Script with Object Launch Point . Step 2 of 3

Launch Point: Object:
CUST_LOGIN |Tn moeniter and control the restricted user concurrent login cn|| LOGINTRACKI
Script: Log Level:
|CUST_LOGIN | | o menitor and control the restricted user concurrent login c.l:l L.]' |ERROR | Q
Script Language:
|pﬁhnn | @
Import
9 “You can impoert a script file that you created in another application or you can enter a script in the Source Code field in the next step.
| Mo file selected. Import
Variables [ Fiter > 0-0of 0 =
Variable Variable Type = Binding Type Binding Value Override?
There are no rows to display.
New Row
Cancel Previous Next

Figure 6: Creating automation script CUST_LOGIN, step 2 of 3

Click Next.
Enter the following script into the Source Code field.

from psdi.common.context import UIContext

from java.lang import Exception as javaException
from java.lang import System as javaSystem

from java.lang import String

from psdi.util import MXApplicationException;

from psdi.util import MXException;

from psdi.util.logging import MXLogger

from psdi.util.logging import MXLoggerFactory

from psdi.app.ci import CIRemote;

from psdi.mbo import Mbo, MboRemote,MboSet, MboSetRemote, MboConstants, SglFormat;
from psdi.server import MXServer

from java.io import IOException as javalIOException

from com.ibm.json.java import JSONArray, JSONObject;

if UIContext.getCurrentContext () is not None:
# retrieve the current login user type

login_user_type = mbo.getString("MAXUSER.TYPE")

# Counting the current Type 2 user login count

type2 = 0

if login_user_type=='TYPE 2':
# retrieve MAXSESSION table
maxsessionSet = MXServer.getMXServer () .getMboSet ("MAXSESSION", mbo.getUserInfo())
maxsessionSet.reset ()
sf_maxsession = SqglFormat ("exists(select userid from maxuser A where A.userid=userid)")
maxsessionSet.setWhere (sf_maxsession.format())

maxsessionSet.reset ()

count = maxsessionSet.count ()

index = 0

# retrieve MAXUSER.TYPE for each user in MAXSESSION table
while (index < count):

maxsessionMbo = maxsessionSet.getMbo (index)

if not (maxsessionMbo is None):

if maxsessionMbo.getString ("MAXUSER.TYPE") == "TYPE 2":
type2 = type2 + 1

# end of if - if not (maxsessionMbo is None)

index = index + 1
# end of while - while (index < count)

# end of If - if login_ user_ type=='TYPE 2'

# Ralse error condition when TYPE 2 user count is over the limit. For POC purpose, two concurrent login of “Type 2” user accounts is al

if login_user_ type=='TYPE 2' and type2 > 0:
print "Failed to login. errorkey=" + errorkey + ", errorgroup=" + errorgroup
errorkey='CUST_LOGIN'

errorgroup="'CUST_MSG'
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# end of If - if login_user_type=='TYPE 2' and type2 > 1

# end of If - 1if UIContext.getCurrentContext() is not None

Automation Scripts

Create Script with Object Launch Point ; Step 3 of 3 s

@ ‘ou can enter a script in the Source Code field, or you can import a script féie in the previous step

Launch Point: Object:
CUST_LOGN |To monkor and control the restricted user concurrent login cor LOGINTRACKI
Script:
CUST_LOGN To monitor and control the restricted user concurrent login coi |4
Source Code:
= - o
type2 = type2 + 1 =

# end of if - if not (maxsessigniibo is None)
index = index = 1
# end of while - while (index < count}
#end of if - if login_user_type==TYFE Z'

# Raise error condttion when TYPE 2 user count is over the imit. For PQC purpose, two concurrent login of “Type 2° user accounts is aliowed
if login_user_lype=="TYPE 2 and type2 > 0

print "Failed to login, errarkey="+ arrorkey « 7, SorQQup=" « SIQIOOUD

surerkey=TTY_LOGH

BO@rareup=0IY_MSG'

#end of i - if login_user_type=="TYPE 2" and type2 > 1

m

# end of If - if WConlext getCurrentContexti) is not None o

Cancel Previous Create

Figure 7: Creating automation script CUST_LOGIN, step 3 of 3

9. Click Create.
10. Close the message window.
11. Open the CUST_LOGIN automation script.
12. From the Common Actions menu, select Change Status.
13. Enter “Active” in the New Status field.
14. Click OK.

Verification

Execute the use case to complete the verification.

1. Log in as restricted user “gtsuser1” in an Internet Explorer browser.

2. Log in as restricted user “gtsuser2” in a Firefox browser (or log in from a different machine).

3. Attempt to log in as restricted user “gtsuser3” in a Chrome browser (or log in from a different machine). The login fails because maximum two concurrent restricted users can log in at
any moment into the ICD system.

See the following screen. The error message can’'t be modified as it's governed by the standard ICD login process.
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| BMXAA3851E - Connecting to the server has been temporarily .
disabled.

Welcome

Figure 8: 3rd restricted user failed to login to ICD system

4. Log in as regular user “bob” to show that a regular user can still log in.
5. Log out restricted user “gtsuser1” from the IE browser.
6. Attempt to log in as restricted user “gtsuser3” in a Chrome browser (or log in from a different machine). This time, it works because only one restricted user is logged in to the ICD

system.

Comments

1-30f 3

1

jtomko commented on August 7, 2017 Permalink

Previous = Next

Great script, thanks. We've attempted to implement and have run into a couple of issues. Note that we are running Maximo 7.5.1, which may be significant as the launch point
Ul has less options that what | am seeing in the screenshots above. Also, we are running in a clustered environment, but | don't expect that is significant.

Issue 1: When the concurrent license threshold is reached, instead of being returned to the login page with the "Connecting to the server..." message, additional users are
presented with a blank white page and a spinning hourglass. Reloading the page presents them with a logout success message.

Issue 2: Per our understanding, a user can log in multiple times from the same IP address without consuming additional licenses. From the logic in this script, it seems like the
usage counter should disregard these duplicates, but does not.

Are you able to provide any insight on the above?

Thank you,
John

sckl_at commented on August 9, 2017 Permalink

I'm using Kerberos SPNEGO web authentication on my websphere application servers. As of this, the login form is skipped because of auto-logon.
Maybe as of this, when | use your script, the userinfo of the python script is from "MAXADMIN".

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
called.

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
preSaveEventAction called.

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut

0O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [] ScriptMboEventListener eventValidate
O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [ LOGINTRACKINGScriptMboEventListener eventValidate

O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [] ScriptMboEventListener preSaveEventAction
0O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [| LOGINTRACKINGScriptMboEventListener

0O 09 Aug 2017 12:37:45:600 [INFO] [itsm901AS_UI_1] [] ScriptMboEventListener Event maximo.logintracking.add has

been fired for script CUST_LOGIN launch point CUST_LOGIN

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut

0O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] about to execute the cached compiled

script for CUST_LOGIN for launch point CUST_LOGIN

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
LOGINTRACKING

[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:600 CEST] 000001fc SystemOut
[8/9/17 12:37:45:616 CEST] 000001fc SystemOut

O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting onupdate value false
0 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting mboname value

O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting app value null

0O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting scriptName value CUST_LOGIN
O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting interactive value false

0O 09 Aug 2017 12:37:45:600 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting ondelete value false

O 09 Aug 2017 12:37:45:616 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting service value

com.ibm.tivoli.maximo.script.ScriptService@6ed01368

[8/9/17 12:37:45:616 CEST] 000001fc SystemOut

0 09 Aug 2017 12:37:45:616 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting launchPoint value CUST_LOGIN
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[8/9/17 12:37:45:616 CEST] 000001fc SystemOut O 09 Aug 2017 12:37:45:616 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting mbo value
psdi.app.signature.LoginTracking@19281cdf

[8/9/17 12:37:45:616 CEST] 000001fc SystemOut O 09 Aug 2017 12:37:45:616 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting user value MAXADMIN
[8/9/17 12:37:45:616 CEST] 000001fc SystemOut O 09 Aug 2017 12:37:45:616 [DEBUG] [itsm901AS_UI_1] [CID-MXSCRIPT-756] putting onadd value true

==> it's not possible to differ between "named" and "concurrent" users, because | cannot grab the usertype of the user trying to login. (if you have any idea how to get it, I'd be
happy to get the info how...)

Nevertheless, it's better than nothing. I've modified your script a bit to fit my needs and to get real "Concurrent User" and not "Concurrent Session". Further you do not consider
the column "ACTIVE" in MAXSESSION, so you also count inactive sessions (autologout as of timeout e.g.)

I've also added a manual system property where | can enter the number of available licenses. (--> custom.availableConcurrentUserLicenses)

here's my script

from psdi.common.context import UlContext

from java.lang import Exception as javaException

from java.lang import System as javaSystem

from java.lang import String

from psdi.util import MXApplicationException

from psdi.util import MXException

from psdi.util.logging import MXLogger

from psdi.util.logging import MXLoggerFactory

from psdi.app.ci import CIRemote

from psdi.mbo import Mbo, MboRemote,MboSet, MboSetRemote, MboConstants, SqlFormat
from psdi.server import MXServer

from java.io import IOException as javalOException
from com.ibm.json.java import JSONArray, JSONObject

prohibitLogin = 0
if UlContext.getCurrentContext() is not None:
configData = MXServer.getMXServer().getConfig()
availableCULic = configData.getProperty("custom.availableConcurrentUserLicenses")
availableCULic = int(availableCULic)
ConcCount = 99
sql = "select count(*) from (select distinct a.userid from maxsession a inner join maxuser b on a.userid=b.userid where b.type ='TYPE 2' and a.active=1)"
s = None
rs = None
conn = None
connKey = None
try:
connKey = MXServer.getMXServer().getDBManager().getSystemConnectionKey()
conn = MXServer.getMXServer().getDBManager().getConnection(connKey)
s = conn.createStatement()
rs = s.executeQuery(sql)
if (rs.next()):
ConcCount = rs.getint(1)

finally:
try:
if (rs = None):
rs.close()
if (s = None):
s.close()
if (conn != None):
MXServer.getMXServer().getDBManager().freeConnection(connKey);
except:
print "Exception Caught: ", sys.exc_info()
if ConcCount >= availableCULic:
prohibitLogin = 1
#end if

if prohibitLogin>0:
print "Failed to login"
errorkey="CUST_LOGIN'
errorgroup='CUST_MSG'
# end of If for prohibitcheck

KingYee Gan commented on December 28, 2018 Permalink

Very details steps and great to know this.

However I've tested this in IBM Control Desk VV7.5.0, and users are presented with a blank white page and reloading the page again shows the logout success message.
Also try to amend the script to allow more session, but still failed with same results.

Are you able to provide help on this?

Thanks in advanced.
KingYee Gan

25 50 items per page Previous

Next
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You are in: IBM Control Desk > Integrating

Integrating
E 1 Like | Updated February 5, 2015 by charglen | Tags: None

Use the information in this section to integrate IBM® Control Desk with other products or components:

Integrating data: How to integrate data in a process engine automation environment, including:

¢ Integrating with external systems or applications
¢ Integration between process automation engine environments
e Packaging and distribution of content across heterogeneous environments or customers

Importing data with Integration Composer: See this page for links to best practices and helpful information about
Integration Composer features

Integration Composer Hardware and Software Requirements
Discovery Tools Supported

Integrating with Rational Team Concert and Rational ClearQuest: An optional integration with Rational Team Concert 3.0
or higher and Rational ClearQuest 7.1.2 or 8.0.0 is provided, allowing you to associate Problem records with Rational
Team Concert or Rational ClearQuest defects.

Integrating with Tivoli Endpoint Manager: You can add to the capabilities of Control Desk by integrating it with Tivoli
Endpoint Manager.

Integration with IBM Software Knowledge Base Toolkit: IBM® Tivoli® Software Knowledge Base Toolkit is an optional
component that maintains an up-to-date repository of knowledge about software products and their components. Software
Knowledge Base Toolkit can receive regularly updated software knowledge base data from an IBM web site, combine this
knowledge with any optional customer-provided extensions and modifications, and then generate a software catalog.
Configuring a basic authentication in WebSEAL to access Control Desk: IBM Tivoli Access Manager WebSEAL is a
resource manager responsible for protecting web-based resources. You can use WebSEAL to enhance security in Control
Desk.

Enabling the launch-in-context feature: Learn how to enable the launch-in-context feature that lets you open products
such as Tivoli Application Dependency Discovery Manager from within Control Desk.

Integrating with IBM Tivoli Application Dependency Discovery Manager: Control Desk acts as an OSLC Consumer to let
you view data on your Cls and assets from TADDM without switching tools.

Integrating with IBM Tivoli Monitoring: Control Desk acts as an OSLC Consumer to let you view Cl and asset data from
Tivoli Monitoring without switching tools.

Integrating with Tivoli Netcool OMNIbus: Control Desk acts as an OSLC Consumer to let you view Event data for your Cls
from Tivoli Netcool/OMNIbus without switching tools.

Integrating with Orchestrator: There are several ways that Control Desk integrates with Orchestrator. Control Desk can
initiate the deployment of virtual systems in Orchestrator. And Control Desk can provide its ticket data in Orchestrator.

Amazon Web Services Integration: Learn how to integrate Control Desk with Amazon Elastic Compute Cloud (EC2) with
the optional content package that is available on the IBM Integrated Service Management Library.

Additional resources

More information about Control Desk integrations can be found here.

Comments

There are no comments.
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o The comment was deleted.

You are in: IBM Control Desk > Integrating > Integrating Data

Integrating Data

E Like | Updated 11/11/19 by Laura.Cunniffe.Aricent | Tags: None

Introduction

Tivoli's process automation engine is the cornerstone of many Tivoli Service Management products, including:

e |IBM Control Desk

¢ Tivoli Change and Configuration Management Database
e Tivoli Service Request Manager

e Tivoli Asset Management for IT

o Maximo Asset Management

¢ Industry Solutions

Each one of these products, in turn, may integrate with existing tools in your environment, like Service Desk products,
Event Management products, and so on. These external products typically are significantly customized, and thus each
integration typically needs specialized customization. This document provides best practices for data integration for
various situations or domains.

This document includes only externally available tools, that is, tools that are available to IBM customers either as part of
product offerings or through the Integrated Service Management Library. This document is focused on version 7.1 and
higher of the process automation engine and the products based on it.

Abbreviations
The following abbreviations are used in this document:

CCMDB Change and Configuration Management Database
Cl Configuration Item

MBO  Maximo Business Object

MRIU  Maximo Rapid Integration Utility

TADDM Tivoli Application Dependency Discovery Manager

Integration with External Systems or Applications

Batch Data Loading

Batch Data Loading scenarios are focused on moving a large amount of data from external systems into the process
automation engine. Typically, an initial load of objects is done as part of an implementation where the volume of data
could be significant, such as loading chart of accounts which could number in the hundreds of thousands. Beyond that
point, smaller batch loads of data may be scheduled on a periodic basis, for example weekly or monthly.

Loading Data from Discovery tools

Integration Composer Adapters

Using Integration Composer Adapters to load data from discovery tools (typically Deployed Assets and Actual Cls) is a
best practice.
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Load into Tivoli Asset Management for IT Deployed Assets

The following Integration Composer Adapters are externally available for loading Deployed Assets:

o Altiris

¢ Centennial Discover/Frontrange

¢ Maximo Asset (asset initialization)

e Microsoft SMS and SCCM

o TADDM

o Tivoli Asset Discovery for Distributed

o Tivoli Asset Discovery for zZOS®

¢ Tivoli Configuration Manager

e Tivoli Inventory

e Tivoli Monitoring

o IBM Tivoli Network Manager IP Edition
e Tivoli License Compliance Manager

¢ Tivoli License Compliance Manager for z/OS
e Tivoli Provisioning Manager

For more information about these Integration Composer Adapters, see Using IBM Tivoli Integration Composer to import
deployed asset data from discovery tools.

Load into CCMDB

A TADDM to CCMDB Integration Composer Adapter is externally available for loading Actual Cls and related information:

o TADDM CDM into Classifications and Relationships
o TADDM Cls into Actual Cls

For more information about this, please refer to CCMDB Integration Composer Adapter.

Initial asset setup at beginning of implementation

This section describes tools you can use to set up asset information when you first implement your product.

Integration Composer Asset Initialization Adapter

The Integration Composer Asset Initialization Adapter is an optional adapter that allows the creation of Assets from
Deployed Assets which have been collect by discovery tools. The adapter can be leveraged to establish an authorized
asset baseline if the customer does not have a better authorized source. More information on the Integration Composer
Asset Initialization Adapter can be found in appendix E of the Integration Composer Administrator Guide

Other ways to establish an initial baseline are by leveraging the purchasing and receiving capabilities within Tivoli Asset
Management for IT or to import an asset baseline from a legacy source using the Integration Framework. More
information on the Integration Framework can be found later in this section.

Loading master or transactional data from legacy or competitor tools

Master data refers to reference data such as vendors, organizations, chart of accounts, and location.

Transactional data refers to data that is driven by events or transactions such as approval of requisition, creation of
purchase order, creation of an invoice, It also includes existent resources that a customer may have cataloged, like
authorized assets or Cls.
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These types of data are typically loaded once in the environment. For a more real-time, synchronized integration (where
changes on each side of the environment need to be reflected on the other side), the tools listed under "Near Real time
Messaging" should be used.

Integration Framework

The Integration Framework has been part of the Maximo product for over 10 years (Maximo version 3). It initially
supported data loading and integration using interface tables and has evolved into an XML-based integration framework
that continues to support interface tables but also supports both XML and delimited files for data loading.

Batch loading of data using the Integration Framework is a common practice during a product implementation where data
is being converted from a legacy application to the the process automation engine application. This data could include
master data such as Items, Assets, Chart of Accounts as well as transactional data such as open Purchase Orders or
Work Orders.

Use of Integration Framework capabilities for Batch Data Loading is a best practice for process automation engine
environments. This capability is available in all process automation engine-based products.

This batch data loading capability of Integration Framework is primarily used for load of large data sets at customers. It is
also used for integration in a 'batch' model, ad-hoc importing. It supports Master and Transactional Data.

The batch loading of data through the Integration Framework can be scheduled or user initiated.

One typical user of Integration Framework batch data loading is IBM Services Organizations which primarily use flat files
as the data source after collecting and massaging data from customer applications using Excel or Access.

The performance of batch data loading with Integration Framework can vary widely based on server configuration (such
as clustering) and the objects being loaded, as defined by the object structure.

For Batch Data Loading, the Integration Framework Enterprise Service with XML or flat file import or interface table
(highlighted in the figure below) should be used.
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This Integration Framework option includes:

e Support of file loading, including XML files and flat files (.csv)

e Provides error correction capability using a file extraction (new in version 7.1.1.5).

e Provides record counts (processed and error)

o Provides 'preview' mode - process a sample file to view possible object validation errors related to the data being
imported.

¢ In addition, XML files support both Maximo and external XML formats. (External XML must be converted through
Enterprise Services processing capabilities.)

o Support of Integration Interface tables as a data input source in addition to XML and delimited files.
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e Use of JMS queue: Batch loading using interface tables or data import always go through JMS queues
(continuous or sequential).

¢ Optional use of Enterprise Services customization layers (Java/XSL/Processing Rules). You can either use
processing class + user exit or XSL for the mapping of external XML formats to the Maximo format, but this
typically requires coding.

o Use of Integration Framework object structures: Over 50 object structures are provided with the process
automation engine, but additional ones may be needed depending on the solution.

In addition, as explained in the Integration Framework section, all data loading is done using the MBO layer. The
Integration Framework is intended to support all MBOs, including custom attributes and objects, although currently, object
structures are not provided out of the box for all MBOs.

Integration Framework batch data loading is typically used with files and using the inbound JMS Queues. A file loading
cron task is available to configure the intervals between loads, assuming that periodic loads are needed. Another option is
to use the Data Import Ul, which is useful for single-time loads.

Tivoli Directory Integrator Based

Service Request Manager Out of Box Support for Tivoli Directory Integrator Integration

The Tivoli Service Request Manager out-of-the-box Support for Tivoli Directory Integrator Integration includes capabilities
to provide a batch based integration.

There are situations in which a single run of importing or exporting data between the process automation engine and

external systems is enough to achieve the requirements of the integration scenario. Other times, it may be required to
keep the two systems synchronized, but the information does not change frequently so long periods of time can pass
between batch loads. (This is still considered a batch mode of operation.) The frequency of Tivoli Directory Integrator-
based integrations is defined on the polling time parameter configured on Tivoli Directory Integrator assembly lines.

Deciding between using Integration Framework directly or using Tivoli Directory Integrator Integration on top of it requires
analyzing the specific scenario and weighing pros and cons.

Tivoli Directory Integrator Integrations (including use of Generic Maximo Connector) are typically used as a starting point
on solutions where a simplified integration is required. Tivoli Directory Integrator has Ul visualization mapping capability
which is an advantage compared to Integration Framework. When integrating the base artifacts supported by Generic
Maximo Connector, the Tivoli Directory Integrator integration can eliminate the need for coding the mapping process. As
explained before, Generic Maximo Connector can use Object Structure or the Enterprise Service with HTTP invoke of
Integration Framework. By default these are used without queues, but it can be configured to use queues.

Also, when using Generic Maximo Connector, normally the Integration Framework customization layer is not used, since
Tivoli Directory Integrator can take care of modifying the data format to the process automation engine format and vice
versa and of manipulating data elements to meet MBO business rules.

But the Generic Maximo Connector and Tivoli Directory Integrator out of the box integration has limitations: You may need
to extend it for a specific solution, or direct integration with Integration Framework may be necessary. Some examples are
lack of support for bundling multiple objects, that is, passing multiple objects under one object structure.

Near Real-Time Messaging

Near Real-Time messaging scenarios are focused on exchange of information in an event-based or transactional fashion,
where messages are exchanged between systems with a small set of objects flowing in each interaction, and these
exchanges are driven by some event that happened and affected the objects in one of the systems. Typical examples are
integrations of Tivoli Service Request Manager with external ticketing systems, where tickets created or updated in the
external system need to be reflected in near real-time into the Tivoli Service Request Manager/process automation engine
environment by creating and updating tickets.

Integration Framework

All the other options available in Integration Framework (not listed in Batch Data Loading domain) are applicable for near
real-time messaging. The following service types are provided by the Integration Framework for loading data into process
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automation engine product in a near real-time messaging scenario:

o Enterprise Service with or without Queue via EJB/HTTP/SOAP
e Object Structure Service via EJB/HTTP/SOAP
e Standard Service via EJB/HTTP/SOAP

The above services support data provided in an XML message format.

Maximo Adapters

The process automation engine historically supports the concept of an adapter that is used to group related integration
artifacts that together support integration to a specific external system. You can configure and deploy adapters for
enterprise connectivity with various systems. Each adapter can have its own interface and delivery mode. Pre-configured
adapters for Oracle and SAP are available as add-ons.

Maximo Adapter for SAP

The IBM Maximo Asset Management Enterprise Adapter for SAP R/3 provides a comprehensive infrastructure that
enables you to quickly connect IBM Maximo Asset Management to their mySAP. It provides an end-to-end integration
solution between IBM Maximo and mySAP, using approved integration processes on both ends.

See IBM Maximo Asset Management Enterprise Adapter for SAP for more details.

Maximo Adapter for Oracle

IBM Maximo Asset Management Enterprise Adapter for Oracle provides a comprehensive infrastructure that enables you
to quickly connect Maximo Asset Management to their Oracle E-Business Suite. It provides an end-to-end integration
solution between IBM Maximo Asset Management and Oracle E-Business Suite, using approved integration processes on
both ends. See IBM Maximo Asset Management Enterprise Adapter for Oracle for more details.

Tivoli Service Request Manager Integration with Omnibus (using Integration Framework)

The Omnibus Gateway for Tivoli Service Request Manager is a bidirectional gateway that enables you to create, update,
and close tickets (either incidents or service requests) in Tivoli Service Request Manager using the process automation
engine Integration Framework interface of XML over HTTP. The gateway enables the user to create and maintain Tivoli
Service Request Manager tickets from Netcool/OMNIbus events either manually (using a Tivoli Service Request Manager
user interface within Netcool/OMNIbus) or automatically (using scripts).

See IBM Tivoli Netcool/OMNIbus Gateway for Tivoli Service Request Manager for more details.

Web Services Based Interaction

In addition to the default Integration Framework web services capabilities, in version 7.1.1.6 of the process automation
engine a new feature has been introduced to provide seamless extension of process automation engine applications to
retrieve, display and consume external data on demand.

>The underpinning of Web Services Interaction is a synchronous web service invocation on external system. It re-uses

existing process automation engine technologies, including:

e Integration Framework: end point, invocation channel, object structure
o Data dictionary: MBO, attributes, relationships, domains
e User interface: Signature option, Ul framework

In summary, the Web Services Interaction enables a new methodology of extending process automation engine
applications using only configurations.
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The web service interaction always contains a web service invocation from the process automation engine to an external
system or other process automation engine environment. The latter is expected to expose a web service that can be
invoked from a configured interaction. One or more records may get created or updated in the process automation engine
based on the web service invocation.

The best practice is to use this capability when full-fledged synchronization can be avoided and at the same time, external
data needs to be visible in a specific business context in the native process automation engine application.

Tivoli Directory Integrator Based

Tivoli Directory Integrator integrations use mostly Integration Framework object structure services and communicate via
HTTP. Basically the same assets covered in the batch mode apply here, since internally Tivoli Directory Integrator is
typically passing a set of objects from time to time. But as this time interval becomes smaller and the number of updates
in each flow decreases, these interactions are considered to be more of a real-time integration.

The existent solutions for this domain that are Tivoli Directory Integrator based are specific to Tivoli Service Request
Manager and were created to fulfill specific market demands for this product.

Tivoli Service Request Manager Out-of-Box Support for Tivoli Directory Integrator Integration

The Tivoli Service Request Manager out-of-box Support for Tivoli Directory Integrator Integration can be used either as a
batch or near-real-time integration. The frequency of Tivoli Directory Integrator-based integrations is defined on the polling
time parameter configured on Tivoli Directory Integrator assembly lines.

The Tivoli Service Request Manager Out of Box Support for Tivoli Directory Integrator Integration includes Tivoli
Enterprise Console and Peregrine integration. These integrations are used to convert events or tickets from one Event
Management or Service desk environment to Tivoli Service Request Manager Tickets or Incidents. They are typically used
in a near real-time fashion as updates need to be synchronized between the process automation engine and the external
system in a relatively fast period.

See the Integration Guide for IBM Tivoli Service Request Manager V7.1 for more information.
Tivoli Service Request Manager-SAP Solution Manager Integration

This integration of the Tivoli Service Request Manager Service Desk with SAP Solution Manager Service Desk enables
incident management across these products. This solution includes the setup and configuration requirements as well as
how customization of specific deployments can be achieved.

Deployments with SAP System Landscapes managed using SAP Solution Manager require its service desk in order to get
access to SAP notes (Knowledge Base) and SAP personal for remote assistance.

This integration enables Tivoli Service Request Manager Service Desk to be positioned in such SAP Systems
Landscapes.

See Tivoli Incident Management integration with SAP Solution Manager for more information.

Integration between process automation engine Environments

Promotion of configuration from Development to Test to Production in a Customer environment
Migration Manager

Migration Manager is really the only tool in this space and considered a best practice for promotion of configuration from
the process automation engine to process automation engine environments. Content is currently metadata and

configuration data. In version 7.1.1.6 of the process automation engine, general master data was also added, including
Classifications and Ticket Templates.
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Packaging and Distribution of Content across heterogeneous
environments or customers

This domain covers scenarios where content must be packaged from one master environment and propagated to multiple
environments, including different customers.

Content Shipped by IBM

This sub domain relates to content shipped by IBM as samples or papers.

Content Loader

Content Loader is one of the best practices for distributing IBM content to customers outside of release cycles.

White papers from IBM Service Management use content loader to load sample content into the process automation
engine environment.

MRIU

MRIU is in essence an interface layer on top of Content Loader for the one-to-many distribution case for best-practices or
standard content definition, extract and import functions. Features were introduced at the Content Loader level. The MRIU
audience, in addition to the one-to-many distribution use case, also addressed the Maximo Essentials audience - see
below.

MRIU as part of Maximo Essentials

Maximo Essentials is a stripped down version of Maximo to target the Small Medium Business (SMB) space. MRIU has
been packaged in the Integrated Service Management Library with standard Work Process Management content defined
for Maximo Essentials. This addresses the SMB Market, where licensing and availability of Integration Framework is
restricted. It provides a simplified interface to load this content. Internally, it uses the Content Loader (not Integration
Framework) for import, and therefore only the content packaged together with MRIU has been verified as described.

Although providing the same flexibility and bulk load capability as Content Loader, any use outside of the published OPAL
package for Maximo Essentials should follow the same validation precautions as the Content Loader.

Content Catalog

Content Catalog is considered a best practice for content harvesting and distribution.
The best practice is to use Content Catalog to load packages into development or test environments, then to use
Migration Manager Applications to load from development or test to production.

Content created by customers and business partners

This sub domain relates to content created by customers and business partners who want to share it with other
constituencies.

Content Catalog

Content Catalog is the main tool in this sub domain. The proposal is that Content Catalog could be used as a tool for
customers and business partners to package and distribute their samples to other customers. This still needs to be proved
a best practice as more use is made of it.
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Also, rigorous testing and validation for content must be in place before the packages can be distributed to other
customers.

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer

Importing Data Using IBM Tivoli Integration Composer
E Like | Updated May 10, 2017 by LauraCunniffe | Tags: None

IBM Tivoli Integration Composer is an integration tool that imports hardware and software inventory data from external
data sources into the Maximo database tables for deployed assets and configuration items. With IBM Tivoli Integration
Composer, an enterprise can aggregate data collected by discovery tools and integrate it, creating a central repository for
enterprise IT asset management, reporting, and decision support.

IBM Tivoli Integration Composer is included with IBM Control Desk and does not require a separate license.
IBM Tivoli Integration Composer Hardware and Software Requirements
Discovery Tools Supported

Other useful information

e How Integration Composer creates and deletes Actual Cl relationships

e How Integration Composer marks Actual Cls for deletion

¢ How Integration Composer supports a partial execution

e How Integration Composer determines which TADDM Cls to process

e Supported properties within the ccmdb.properties file

¢ Integration Composer assets reconciliation using Alternate Keys and NRS GUID

¢ Integration Composer FAQ

¢ Integration Composer IBM Endpoint Manager and IBM Endpoint Manager SUA Adapter FAQ
e |IBM Endpoint Manager for Software Use Analysis Integrations

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer > IBM Tivoli
Integration Composer Hardware and Software Requirements

IBM Tivoli Integration Composer Hardware and Software Requirements

E Like | Updated today at 11:22 AM by BhratPatel | Tags: hw_sw_requirements, integration, integration_composer

For information about Integration Composer hardware and software requirements, select the appropriate link for your
product version:

Integration Composer 7.6.0 Hardware and Software Requirements

Comments

There are no comments.

1/1


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Integrating?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Importing%20Data%20Using%20IBM%20Tivoli%20Integration%20Composer?lang=en
javascript:;
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=hw_sw_requirements
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=integration
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=integration_composer
javascript:;

10/12/2019

IBM Control Desk : Integration Composer 7.6.0 Hardware and Software Requirements
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Requirements

Integration Composer 7.6.0 Hardware and Software Requirements
E Like | Updated October 24, 2016 by charglen | Tags: None

This page describes the the hardware and software requirements for Integration Composer version 7.6, including the
products and versions supported by this version.

Integration Composer

IBM Control Desk

Integration
Composer server

Database servers

Web browser

Comments

Integration Composer has the following minimum requirements:

8 GB memory
20 GB disk space
IBM® Java™ Software Development Kit 7.0 for the appropriate operating system

IBM Control Desk Version 7.6 is required and must be installed before you can
use Integration Composer.

A dedicated server is required for running the Integration Composer application and Java
components. Integration Composer can run on any of the following operating systems:

AIX 7.1 POWER System

Red Hat Enterprise Linux (RHEL) Server 6 POWER System
Red Hat Enterprise Linux (RHEL) Server 6 Update 5 POWER System
Red Hat Enterprise Linux (RHEL) Server 6 IBM System z
Red Hat Enterprise Linux (RHEL) Server 6 x86-64

Red Hat Enterprise Linux (RHEL) Server 7 POWER System
Red Hat Enterprise Linux (RHEL) Server 7 System z

Red Hat Enterprise Linux (RHEL) Server 7 x86-64

SUSE Linux Enterprise Server (SLES) 11 POWER System
SUSE Linux Enterprise Server (SLES) 11 SP3 POWER System
SUSE Linux Enterprise Server (SLES) 11 System z

SUSE Linux Enterprise Server (SLES) 11 x86-64

Microsoft Windows 7 Enterprise x 86-32

Microsoft Windows 7 Enterprise x 86-64

Microsoft Windows 7 Professional x 86-32

Microsoft Windows 7 Professional x 86-64

Microsoft Windows 8 Enterprise x 86-32

Microsoft Windows 8 Enterprise x 86-64

Microsoft Windows 8 Professional x 86-32

Microsoft Windows 8 Professional x 86-64

Microsoft Windows 8 Standard x 86-32

Microsoft Windows 8 Standard x 86-64

Microsoft Windows 8.1 Enterprise x 86-32

Microsoft Windows 8.1 Enterprise x 86-64

Microsoft Windows 8.1 Professional x 86-32

Microsoft Windows 8.1 Professional x 86-64

Microsoft Windows 8.1 Standard x 86-32

Microsoft Windows 8.1 Standard x 86-64

Microsoft Windows Server 2012 Datacenter Edition x 86-64
Microsoft Windows Server 2012 R2 Datacenter Edition x 86-64
Microsoft Windows Server 2012 R2 Standard Edition x 86-64
Microsoft Windows Server 2012 Standard Edition x 86-64

The customer is responsible for the database servers, which contain and manage one or
more source databases and a target (IBM Control Desk) database.

Integration Composer supports the same databases that are supported by IBM Control
Desk. For information about the databases that are supported, see the IBM Control Desk
7.6.0 System Requirements.

For information about the database server hardware requirements, see the appropriate
database documentation.

To display help information, Integration Composer requires a Web browser.
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There are no comments.
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You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer > Discovery Tools Supported

Discovery Tools Supported

|E| Like | Updated today at 12:32 PM by BhratPatel | Tags: adapters, integration_composer

The following table lists the discovery tools that are supported by IBM Control Desk (formerly IBM SmartCloud Control Desk) and
IBM Integration Composer.

Note: IBM Integration Composer includes the following mappings for Tivoli Application Dependency Discovery Manager:
e TADDMToActualCI75.fsn

e TADDMToCIType75.fsn
e TADDMToExplicitRelations75.fsn

IBM Control
Desk/Integration
Composer
Version
Data Schema H Adapter Mapping H 760 H 7601 ‘
Centennial Discovery 2006/2007 CentennialDiscovery2006_2007To[I>PA'd5.sz1 J
IBM Endpoint Manager 9.0, 9.1, 9.2 IEMO0ToDPA75.fsn J J
IBM Tivoli Endpoint Manager for Software  |[TEMSUA13ToDPA75.fsn J J
Use Analysis 1.3
IBM Tivoli Endpoint Manager for Software  |[TEMSUA20ToDPA75.fsn J J
Use Analysis 2.0
IBM Tivoli Endpoint Manager for Software  [[EMSUA2xToDPA75.fsn J J
Use Analysis 2.1
IBM Tivoli Endpoint Manager for Software  [[EMSUA2xToDPA75.fsn J J
Use Analysis 2.2
(Requires ITIC 7511 HF 3 or later)
IBM Endpoint Manager for Software Use IEMSUA2x_90ToDPA75.fsn J J
Analysis 9.0
IBM Endpoint Manager for Software Use IEMSUA2x_90ToDPA75.fsn J J
Analysis 9.1, GA release
IBM Endpoint Manager for Software Use IEMSUA91ToDPA75.fsn J J
Analysis 9.1, application update 9.0.1, 9.2
IBM Tivoli Application Dependency Discovery|[TADDM72ToDPA75.fsn J J
Manager 7.2
IBM Tivoli Application Dependency Discovery||[TADDM721_722ToDPA75.fsn J J
Manager 7.2.2
IBM Tivoli Application Dependency Discovery|[TADDM73ToDPA75.fsn J J
Manager 7.3
IBM Tivoli Asset Discovery for Distributed 7.2|[TAD4D72_75toDPA75.fsn J J
IBM Tivoli Asset Discovery for Distributed 7.5|[TAD4D72_75toDPA75.fsn J J
IBM Tivoli Asset Discovery for Distributed TAD4D7501toDPA75.fsn J J
7.5.0.1
IBM Tivoli Asset Discovery for z/OS 7.5 TAD4Z72_75toDPA75.fsn J J
IBM Tivoli Asset Discovery for z/OS 7.2 TAD4Z72_75toDPA75.fsn J J
IBM Tivoli Asset Discovery for z/OS 8.1 TAD4Z81toDPA75.fsn J J
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IBM Control
Desk/Integration
Composer
Version
Data Schema “ Adapter Mapping H 760 H 7601 |
IBM Tivoli Network Manager IP Edition 3.8  |[TNM38_39toDPA75.fsn J J
and 3.9
IBM Tivoli Network Manager IP Edition ITNM41_411toDPA75.fsn J J
4.1/4.1.1
IBM Tivoli Provisioning Manager 7.1.1 TPM711ToDPA75.fsn J J
IBM Tivoli Provisioning Manager 7.2 TPM72ToDPA75.fsn J J
Microsoft System Center Configuration SCCM2007_2012ToDPA75.fsn J J
Manager 2007/2012
(Requires ITIC 7511 HF 2 or later for SCCM
2012)
Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer > How Integration
Composer creates and deletes Actual Cl relationships

How Integration Composer creates and deletes Actual Cl relationships
E Like | Updated April 4, 2013 by alucches | Tags: None

How IBM Tivoli Integration Composer creates and deletes Actual Cl relationships

Integration Composer retrieves data from IBM Tivoli Application Discovery Dependency Discovery Manager (TADDM) for
a top-level GUID to a specific depth. Integration Composer will traverse through the ModelObject data; first, for the
primitive attributes (which are stored in the ACTCISPEC table), and then for attributes representing a relationship.

If the target classification is to be filtered out, then the relationship is ignored and the next relationship is processed.

Otherwise, the RELATIONRULES table is consulted to see if there is a rule matching the source classification,

relationship name, and target classification. If there is no rule, then the reverse is searched; target classification,
relationship name, and source classification. If a reverse rule is found, then the source and target configuration items (Cls)
are swapped to match the rule when being stored in the ACTCIRELATION table. The ACTCIRELATION.SWAPPED
column will be set to 1 if the relationship was modified from the order found in TADDM.

If a rule is not found, the relationship is still added as is to the ACTCIRELATION table.

After the relationship is saved, the target ModelObject data is traversed so that the target Actual Cl and its attributes will
be created. If the maximum depth has not been reached, the target's relationships will be pursued.

The above process is repeated for all relationships until the depth setting is reached. The top level Actual Cl processing
starts at depth one. This means that you will import Actual Cl data at the depth specified, but process relationships for
depth minus one.

For example, if you have a depth setting of two for computer systems, first the computer system Cls are imported, then
the relationships for the computer system follow, and those target Cls are also imported. But the target Cls' relationships
will not follow because depth two is reached when processing the computer system relationship targets.

ComputerSystem — OperatingSystem would represent depth two. Cls related to the operating system would not be
created.

Integration Composer deletes relationships only if both the source and target Cl were processed. Otherwise, it cannot
determine whether the relationship that exists in the database was there by following a different path and is therefore still
valid. For example, if a relationship exists between an application server and a computer system in the database, and
Integration Composer processes only the computer system, there will not be a link to the application server. But
Integration Composer should not delete that relationship unless the application server is also processed and there still is
no relationship found between the two Cls.

This behavior allows the use of smaller depth settings to still reach the same overall depth. For example, say you needed
a depth of 3 for computer system data, but your TADDM topology looked like:

Business Application — Functional Group — AppServer — ComputerSystem

In order to have three levels for computer system you would need a depth of 6 when starting from the Business
Application.

Instead, if you activated Application and set depth to 3, Integration Composer would reach AppServer. You would also
have to activate AppServer for at least a depth of 2 in order to pick up the relationship to ComputerSystem. And then
ComputerSystem would have to be activated and set to depth 3 to pick up the additional data you wanted to manage.

Trying to determine what classifications to set to ACTIVE for what depth can be difficult. If you have a TADDM GUID for
the topology Integration Composer will be importing Cls from, you can use the TADDM command line API interface to
12
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extract the type of data Integration Composer will see.

The Tivoli Application Dependency Discovery Manager api.sh and api.bat files can be located at: <taddm install
directory>/dist/sdk/bin

./api.sh —u <userid > -p <password> find -depth 4 -guid
“A9AG6F80AD02D3845BB924D7CFD26615C”

For this example, the simplified output could resemble the following:

<Application array="1" guid="ASA6F80AD02D3845BB924D7CFD26615C"
lastModified="1350562340943"
xsi:stype="coll:com.collation.platform.model.topology.app.Application">

<groups array="1" guid="284F0186EFD13A45A45B41E2C951C11D"
lastModified="1348955766545"
xsi:type="coll:com.collation.platform.model.topology.app.AppServerFunc
ionalGroup">

<members array="1" guid="C308DC3407EE347B8A47A7D32D434F22"
lastModified="1350072328679"
xsi:type="coll:com.collation.platform.model.topology.app.web.apache.Apa

cheServer">

<host guid="335F9D19025A3364A5C31FE92D93C92B"
lastModified="1350247649374"

xsi:type="coll:com.collation.platform.model.topology.sys.linux.LinuxUni

taryComputerSystem">
<type>ComputerSystem</type>

By observing the XML indentation, you can determine that there are four depths found:

Application — FunctionalGroup — AppServer — ComputerSystem

Comments

There are no comments.
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How Integration Composer marks Actual Cls for deletion
E Like | Updated April 4, 2013 by alucches | Tags: None

IBM Tivoli Integration Composer does not directly delete Actual Cls; however, you can configure it to mark Actual Cls for deletion by setting the following ccmdb.properties file
entry to true:

ccmdb.enable.actualci.deletion=true

When this property is set to true, Integration Composer checks for deleted IBM Tivoli Application Dependency Discovery Manager (TADDM) Cls prior to looking for new and
updated Cls. The MAXVARS table contains the time stamp used as the start criteria when searching for deleted Cls:

select varvalue from maxvars where varname='CCIITICDELETETS'
This value is in milliseconds. (You can use a 'date to millisecond calculator' to help convert this value to a date/time format but make sure it is 13 digits if you modify it.)
If the CCIITICDELETETS value is null, Integration Composer uses a start time stamp two months prior to the current date and time.

Integration Composer executes the TADDM getChangedClasses API to identify all TADDM classifications that have been deleted Cls since the start date defined by the
MAXVARS CCIITICDELETETS value.

For the classifications that exist in the ACTCI table and contain TADDM deleted Cls, the TADDM findChangesForDeltaSyncing API is executed to return a list of GUIDs that
were deleted since the start date.

The TADDM GUIDs that were deleted (and not rediscovered) will be added as entries to the IBM SmartCloud Control Desk database table, CCIDELETEDACTCI.
The CCIDELETEACTCI escalation has been created in the Escalations application to delete the Actual Cls found in the CCIDELETEDACTCI table.

L-l_s Service Request Catalog

= I'i‘i.'{* System Configuration
[=) Platform Configuration

System Properties
Logging
Domaine
Database Configuration
Application Designer
Communication Templates
Actions

Roles

E=calations
Workflow D% igner

Workflow Designer

If you want to see what will be deleted prior to deletion, deactivate the escalation using the Activate/Deactivate Escalation action. Otherwise, the default is to look every 5
minutes for Actual Cls to delete.

E Available Queries I I
Ezcalation: Site; Active?
Al Hecauds CCIDELETEACT | CCIDekte ActCls = & |7
All Bookmarks Applies To: Organization: Schedule:
{ __“5: Allescalations MAXVARS & & e
Condition: Create Successful Execution Entry? Calendar Orgal
%7 common Actions varname = ‘CCITICCOMPLETE" and varvalue="YES' i
IJ eV Corolatig w Last Run Time: Calendar:
Sa calation 2125M13 09:05:03
ﬂ Clear Changes 4 SueE
@ Previous Excalation
@ Next Escalation \alidation Results
g More Actions =0 ‘ E=calation Points © B Fiter > 1-1of1
Walidate Escalation Point * Elapsed Time Attribute Elapsed Time Interval |nterval Unit of Measure Organization
ActivateDeactivate Escalation | b 1 ':i r.:é“'
Duplicate Escalation
Delete E=calation e

When the Integration Composer delete process completes successfully, it updates the MAXVARS table, setting the VARVALUE to 'YES' where the VARNAME =
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'CCHTICCOMPLETE'. The escalation will not execute unless CCIITICCOMPLETE is set to YES and is in Active state.

Troubleshooting hints for delete processing:
The following entry in the Integration_Composer/data/properties/logging.properties file will log the details of the delete processing, and should be used if errors occur.

log4j.logger.fusion.provider.taddmactualci=DEBUG

If the Integration Composer delete processing hangs, receives an exception that the connection timed out, or receives an out of memory exception, it is usually because too
much data is being requested from the TADDM change history table.

1. Determine if the search time frame is reasonable and not for a larger duration than necessary.
select varvalue from maximo.maxvars where varname='CCIITICDELETETS'

Remember that this value is in milliseconds. If you decide to modify this value, make sure it is a 13 digit number. If you use an epoch converter the value will contain 10 digits;
add 3 zeros to the right of that number or use a millisecond converter instead.

2. If the timestamp is valid but for a large interval, you can partition the timestamp so that Integration Composer will do multiple searches against the change history table rather
than one. Use the

ccmdb.itic.num.of.delete.time.partitions=

property to divide the time frame days into partitions. For example, if the time duration is for a year you may want to use a partition value of 12 so that Integration Composer
requests only 1 month worth of data at a time.

When the Integration Composer delete process fails for one classification it continues looking for deleted Cls for other classifications, but the search time in the MAXVARS table
will not be updated. This means that the next time Integration Composer runs, it will unnecessarily reprocess those classifications that were already successfully processed for
deleted Cls. If you have a long search duration this could take several extra hours. If you know which classifications failed it will save you time to use the property,
ccmdb.delete.class.<SHORT.CLASSNAME=1>

For example, the following prompts Integration Composer to look for deleted Actual Cls within only the 2 specified classifications:

ccmdb.delete.class.NET.L2INTERFACE=1
ccmdb.delete.class.SYS.WINDOWS.WINDOWSSERVICE=1

Note: You must have at least Integration Composer 7.5.0.1 to use this property.

Comments

There are no comments.
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How Integration Composer supports a partial execution
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Integration Composer can be configured to process a list of GUIDs read from a file rather than going to IBM Tivoli
Application Discovery Dependency Discovery Manager (TADDM) to determine which Actual configuration items (Cls)
have changed. The GUIDs must still be of a classification that is set to ACTIVE.

The Integration Composer Actual Cl Adapter will read the system property “GuidFileForPartialRun”, and if set, will try to
open the file to read in a list of GUIDs for processing. The property should contain the fully qualified file name to read and
only one GUID per line. If the property is set and Integration Composer cannot open the file, then an exception will be
thrown and Integration Composer will stop processing. If Integration Composer successfully reads the file, a message will
be logged containing the number of GUIDs read.

The easiest way to set this property is to copy the executeMapping.bat or .sh and give the new version a name that
represents the execution of Integration Composer in this special way. Then, modify the two lines that start with “java” to
include the -D option:

-DGuidFileForPartialRun="C:\Integration Composer\partial.file"

You will continue to use executeMapping.bat/.sh for normal Integration Composer processing and the new .bat/.sh for
partial execution.

Comments

There are no comments.
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How Integration Composer determines which TADDM Cls to process
E Like | Updated April 4, 2013 by alucches | Tags: None

After the initial load, IBM Tivoli Integration Composer will want to process IBM Tivoli Application Dependency Discovery
Manager (TADDM) configuration items (Cls) that have changed, but only for the ACTIVE classifications. The IBM
SmartCloud Control Desk database table, fsnlastscan is used to determine if Integration Composer should do a full or
partial load. If there are no records in the fsnlastscan table for the mapping name being executed, then all TADDM Cls will
be processed for those activated classifications.

This means that if you want to force Integration Composer to reimport all Cls for the active classifications, simply clear the
fnslastscan table for the mapping name you are using. This can be done using the Integration Composer console with the

“Delete Mapping Last Scan History” option or by using the following SQL:

delete from maximo.fsnlastscan where mappingname='mymappingname'

Mapping Data Schema

g_:,ii Create Mews Mapping L‘g Define Mew Dat

3_:}7' Open Existing Mapping L-_-'ﬂ-; Open Existing D
[ | 4 r'ﬁ_:ﬁ

':""5( Delete Mapping '-i';;m Delete Data =ch

@ Delete Mapping Last Scan Histary

“Select Last Scan History(s) to Delete

Existing Mapping=s:

addm2comdh 7 Sactualci
addmZ2cemdb 7 Scitype

If you want Integration Composer to reprocess only one GUID, you can remove it from the fsnlastscan table:

delete from maximo.fsnlastscan where mappingname='mymappingname' and sourceid='myguidId'
Conversely, if you create a new mapping and do NOT want Integration Composer to process all Cls from TADDM, you
can use SQL to rename the old mapping name to the new mapping name so that Integration Composer will continue to

process where it left off.

update maximo.fsnlastscan set mappingname='newmappingname' where

mappingname="'oldmappingname'
Although this is helpful to know, realize that there can be beneficial reasons to have Integration Composer reprocess all of
the Actual Cls. For instance, if you have upgraded Integration Composer to a major release, there could be updates that

should be applied to all Actual Cls.

If there is even just one GUID listed in the fsnlastscan table for the mapping name being executed, Integration Composer
will check for updated TADDM Cls to process instead of processing all TADDM Cls. This is done in two steps.
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1.For the active classifications, the TADDM LastModifiedTime is compared to the LastScanDT column in the ACTCI
database table. Actual Cls that have a LastScanDT timestamp older than the TADDM LastModifiedTime are considered
updated candidates. TADDM Cls with no matching Actual Cl are considered new and will be imported.

2.The TADDM LastModifiedTime represents the last time the Cl was discovered, not the timestamp it was actually
modified. Since the Cl could have been discovered but nothing changed, Integration Composer will use the TADDM
change history table to validate that updates did take place.

As you can see, the TADDM's change history table plays an important role in this delta processing. If you delete all entries
in the change history table, then Integration Composer does not consider any existing Actual Cls as updated, and it
processes only new Cls. If the change history table is configured to track every minor update, then Integration Composer
considers every fresh discovery as having updated Cls, which causes more processing than necessary. If the change
history table contains six years of updates, it will be very slow to query for recent changes and impact Integration
Composer performance.

You can configure what TADDM stores as updates in the change history table with the file:

<taddm install directory>/dist/ect/changeserver.xml

This file already contains good examples on the syntax required to configure TADDM to ignore tracking updates to
specific attributes, classes, and packages. It is worth your time to review it.

When retrieving the TADDM GUIDs for the ACTIVE classifications, Integration Composer obtains GUIDs for all
subclasses. For example, if AppServer is activated, then Integration Composer can be expected to process
ApacheServers, WebServers, CICSRegions, DominoServers, etc. The filter setting affects which Actual Cls will be
imported.

For classification filtering (ccmdb.actualci.filtering.level=0), if a non-active classification that is set to -1 is a subclass of an
active classification, then the subclass TADDM Cls will be ignored and not imported.

For the authorized promotion scope filtering (filtering level = 2), the TADDM Cls imported must be part of a promotion
scope. Furthermore, when using the Promotion Scope filtering it is important to understand that Integration Composer will
update already existing Actual Cls only if they are linked to an Authorized Cl. An example may help clarify this:

1. Integration Composer is used for the first time to import TADDM CI data as Actual Cls into the SmartCloud Control
Desk database using Auth Scope filtering.
2. Integration Composer is executed a second time to import new TADDM CI data and to update existing Actual Cls
to match modified TADDM Cls.
1. If a Cl exists in TADDM but not the SmartCloud Control Desk database, then it will be imported.
2. If a Cl was modified in TADDM and there exists both an Actual Cl and an Authorized ClI, the Actual CI will
be updated to reflect the data found in TADDM.
3. If a Cl was modified in TADDM and there exists only an Actual ClI, then the Actual ClI will NOT be updated.
The reasoning here is that since the Actual Cl was not promoted into an Authorized Cl, it is not being
managed. And therefore, there is no need to keep the Actual Cl up-to-date until it is promoted to an
Authorized CI.

After establishing the initial list of GUIDs to process, Integration Composer uses the depth setting to import the TADDM
Cls that are related to the top level Cls. You define the depth setting within the ccmdb.properties file. The default depth is
used only if no other depth applies to the active classification. A subclass will obtain its parent depth unless explicitly
overridden. Integration Composer will log which classifications and depths will be processed, so you can review this data
in the fusion.log.

The following two DEBUG properties provide additional details of Actual Cl processing:

log4j.logger.fusion.provider.cmdbapi=DEBUG
log4j.logger.fusion.provider.taddmactualci=DEBUG

Comments
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There are no comments.
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The Integration Adapter for IBM Tivoli Application Dependency Discovery Manager (TADDM) Actual Cl Adapter reads the
Integration Composer/data/properties/provider/ccmdb.properties file to optionally modify its default
behavior. Some properties discussed here may not appear in the version of your property file because they were provided
to help work around specific situations. If a property was not available in IBM Tivoli Integration Composer 7.5.0 then the
release in which it was first made available will be listed in the description.

ccmdb.itic.status. frequency=<default value: 500>

Integration Composer can be configured to print incremental status messages to help determine how long the Actual ClI
mapping execution will take to complete. The output status message will include the total number of top level Cls to be
processed and how many of those top level Cls have been processed so far. You can determine the completion
percentage from this information.

It will also include the total number of Actual Cls processed so far as well as the number of Actual Cls processed during
that frequency interval. You can use this to determine the average number of Cis processed per top level Actual Cl. Also,
since the status message contains a timestamp, you can calculate the average amount of time Integration Composer is
spending to process each CI.

The value of this property represents the number of top level Cls for the TADDM Adapter to process prior to printing a
status message. The default value is 500 top level Cls.

If this property value is set to 0 then no status messages will be printed. If this property is deleted or commented out or the
value is set to null then the default value of 500 top level Actual Cls will be used.

Note that the numbers printed by the status message represent the Actual Cls processed from TADDM while the
Integration Composer summary outputs the number of records inserted, updated, or deleted from the target database
tables. These numbers may not match.

This property has been available prior to 7.5.0.

ccmdb.enable.actualci.deletion=<true| false>

The deletion property is used to indicate if Integration Composer should flag Actual Cls for deletion when the CI no longer
exists in TADDM. This processing occurs prior to Integration Composer's normal mapping execution. If this property does
not exist the default behavior is not to do delete processing.

This property has been available prior to 7.5.0.

ccmdb.itic.num.of.delete. time.partitions=<numeric wvalue>

This optional property was made available to work around situations where Integration Composer delete processing failed
with a TADDM timeout exception while reading the change history data. The value will be used to divide the number of
days between now and the last time Integration Composer successfully completed the deletion processing. For example,
if the last time Integration Composer marked Actual Cls for deletion was 2 months ago and the partition is set to 4 then
the duration used to search for deleted TADDM Cls would be 15 days.

This property was made available with Integration Composer 7.5.0.1 and above.

ccmdb.delete.class.<SHORT.CLASSNAME=1>

This optional property was made available to work around situations where Integration Composer delete processing
cannot complete successfully due to TADDM timeout exceptions while reading the change history data. There can be
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multiple properties starting with prefix “ccmdb.delete.class.” containing a classification name. When one or more of these
properties are set the Integration Composer delete process will only search for deleted TADDM Cls of those classification
types listed. This would be used if Integration Composer successfully processed most classifications for deletion but failed
for a few classifications. You could then use this to force only the failed classifications to reprocess while also using the
“num.of.delete.time.partitions” property to make the TADDM search duration shorter.

This property was made available with Integration Composer 7.5.0.1 and above.

ccmdb.actualci.filtering.level=<0|2>

This is a required property and must be set for Integration Composer to process the Actual Cl mapping, there is no default
setting for this property if it does not exist Integration Composer will exit. If Integration Composer 7.5.0 was a fresh install
this property value was set to 2, if Integration Composer 7.5.0 was installed as an upgrade this property value was initially
set to 0 so processing would resemble the old Integration Composer version.

A value of 0 will cause Integration Composer to search for properties in this file starting with “ccmdb.classification.depth.”.
Actual Cls will NOT be imported for those classifications set to “-1”. It's valid for this property to be set to 0 with no
classifications set to be filtered out.

The recommended value of 2 will cause Integration Composer to only import Actual Cls and attributes found in the
promotion scopes. If multiple promotion scopes exist then Integration Composer will use the super set. It is not valid for
this property to be set to 2 if no promotion scope exists.

This property was made available with Integration Composer 7.5.0 and above.

ccmdb.classification.depth.xxx.xxxx=<numeric value>
This optional property can be used as a way to filter out Actual Cls of a specific type by setting a value to “-1”.

While Integration Composer is processing a top level Cl to the max depth, when it reaches a related Cl of a type that
should be skipped it will stop processing that branch. This means Cls related to the skipped classification type will also not
be imported.

This property can also be used to override the default depth setting which is set with property:
ccmdb.classification.default.depth For example, if you normally only needed to import at a depth of 2 but for Application CI
types you required a depth of 3 you could use this property to achieve that.

Note that since 7.5.0.1 HF 2 a subclass will be processed at the super class's depth unless the subclass is specifically set
to a different depth. So if Application was set to depth 3 the subclass of VApp would also be processed at depth 3.

If Integration Composer 7.5.0 was a fresh install then the ccmdb.properties contained a default list of classifications set to
-1 so they would not be imported. If Integration Composer 7.5.0 was installed as an upgrade then the filtering will be
identical to that of the older version of Integration Composer.

The following classifications are recommended to be filtered out:

ccmdb.classification.depth.APP.CONFIGFILE=-1
ccmdb.classification.depth.APP.DB.DB2.DB2DATABASECONFIGVALUE=-1
ccmdb.classification.depth.APP.DB.DB2.DB2INSTANCECONFIGVALUE=-1
ccmdb.classification.depth.APP.DB.DB2.DB2SYSTEMCONFIGVALUE=-1
ccmdb.classification.depth.APP.PROCESSPOOL=-1
ccmdb.classification.depth.CORE.LOGICALCONTENT=-1
ccmdb.classification.depth.DEV.DISKDRIVE=-1
ccmdb.classification.depth.DEV.DISKPARTITION=-1
ccmdb.classification.depth.DEV.MEDIAACCESSDEVICE=-1
ccmdb.classification.depth.DEV.STORAGEVOLUME=-1
ccmdb.classification.depth.SYS.AIXSOFTWARECOMPONENT=-1
ccmdb.classification.depth.SYS.DATAFILE=-1
ccmdb.classification.depth.SYS.SOFTWARECOMPONENT=-1
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ccmdb.classification.depth.SYS.WINDOWS.WINDOWSSERVICE =-1
ccmdb.classification.depth.SYS.Z0S.ZREPORTFILE=-1

This property has been available prior to 7.5.0.

ccmdb.classification.default.depth=<default value: 3>

This property will be used as the depth for all active top level classifications unless overridden by the
“ccmdb.classificatlon.depth” property discussed above. If this property is missing a default depth of 3 will be used. It is
invalid to set this property to a negative number.

This property has been available prior to 7.5.0.

ccmdb . taddm.exclude. filter=0

By default, Integration Composer will query TADDM to determine if it supports the 'excluding' clause. If supported,
Integration Composer will use this as part of the query to retrieve top level Cl data when filtering out any of the default
classifications listed above. TADDM versions 7.2.1 and above support this option.

The following query is used to determine if TADDM supports the 'excluding' clause:

"select * excluding preferences from UserPreference"

Using the TADDM excluding clasuse helps performance because the excluded classifications will be excluded by TADDM
rather than by Integration Composer.

This property has been available prior to 7.5.0.

ccmdb. taddm. locationtag. filter=<format example: CustomerTagl |CustomerTag2>

This optional property will only work with TADDM release 7.2.1.1 and higher. This can be used to filter the imported Cls
based on the TADDM LocationTag attribute value. With the example above, only Cis where the top level Cl is owned by
either CustomerTag1 or CustomerTag2 will be imported. This processing assumes that any related Cl to the imported top
level Cl is also valid for these LocationTag values.

This property was made available with Integration Composer 7.5.0 and above.

ccmdb.enable.explicit.relationships=<true|false>

This property is used to import explicit relationships from TADDM. Additional TADDM API calls are required to import
these relationships which will affect Integration Composer performance. The default setting is false. If set to true the
following relationships would be imported.

core.Dependency
app.dependencies.IpDependency
app.dependencies.ServiceDependency
app.dependencies.SystemDependency
app.dependencies.TransactionalDependency
dev.BasedOnExtent

dev.RealizesExtent

Realize that these relationships will be imported based on the Actual Cis processed. If Actual Cl 'abc' is processed then
Integration Composer will search where 'abc' is either the source or target of an explicit relationship.

This property has been available prior to 7.5.0.

ccmdb.explicit.relationship.DEV.REALIZESEXTENT=1
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This optional property is used to modify the default explicit relationship list. If property
ccmdb.enable.explicit.relationships equals true then the seven explicit relationships listed above will be
imported unless this property is also found. If this property is used the default list is ignored and only explicit relationship
with the prefix “ccmdb.explicit.relationship.” will be imported. Therefore if you just wanted to add one explicit to the list you
must have a property for the original 7 plus the new one:

ccmdb.explicit.relationship.APP.DEPENDENCIES.APPLICATIONTOAPPLICATIONDEPENDENCY
ccmdb.explicit.relationship.CORE.DEPENDENCY
ccmdb.explicit.relationship.APP.DEPENDENCIES.IPDEPENDENCY

This property has been available prior to 7.5.0.

cemdb.itic.num.of.threads=<thread count:cached CI data i.e. 5:20>

By default Integration Composer will use multiple threads to retrieve the top level Cl data from TADDM. This optional
property can be used to specify the maximum number of threads to be created and how much Cl data can be cached at
any one time.

A warning message will be logged if this property is used and the NO_CACHE_LOAD option is not part of the following
lines in the fusion.properties file.

mxe.fusion.referencecache.Actual Target CI=1000,Guid,ALTERNATE KEY,NO CACHE LOAD
mxe.fusion.referencecache.Actual CI=1000,Guid, ALTERNATE KEY,NO CACHE LOAD

If the NO_CACHE_LOAD option is used and this property is not set then the default number of threads will be 10 for 64 bit
operating systems and 5 for 32 bit operating systems. The default number of cached top level Cl data will be 50 for 64 bit
and 25 for 32 bit.

(Note that system property “os.arch” is used to make this determination and since this is not always consistent a 64 bit
machine may get thread setting for a 32 bit machine but if that happens this property can be used to make the
modifications.)

This property was made available with Integration Composer 7.5.0 and above.

cemdb.itic.thread.max.wait.time=<milliseconds i.e. 600000>

This optional property controls how long Integration Composer will wait for TADDM to return data to the thread. The data
Integration Composer is waiting for would be from the executeQuery API asking for a top level Cl for a specific depth. The
default value is 600000 milliseconds (10 minutes). If this time is reached and TADDM has not returned data then
Integration Composer will stop all processing. (10 minutes is the default for Integration Composer 7.5.0.1 but the default
was just 1 minute in Integration Composer 7.5.0 making it more likely that you would need this property.)

This property was made available with Integration Composer 7.5.0 and above.

ccmdb.enable.skip.unavailable=<true| false>

This optional property can be used to stop Integration Composer from creating Actual Cls with an ACTCINUM value of
“UNAVAILABLE”. If set to true and Integration Composer processes a TADDM CI containing no value for the Label or
DisplayName attribute then a warning message will be logged and Integration Composer will skip that Cl until a Label or
DisplayName value is available.

A message will be posted containing the GUID name of those Cls skipped.
The Integration Composer Summary will contain an additional line to post the number skipped:
Number of skipped TADDM Cls: 2

Once set the ACTCINUM is never modified but the ACTCINAME will be modified to reflect the value of the Cl's Label or

DisplayName attribute. The ACTCINAME is usually what is displayed on the SCCD console but many users would prefer
to skip Cls discovered at a level 1 until they were discovered at a higher level so that they contain additional data.
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This property was made available in Integration Composer 7.5.0.1 Hot Fix 2.

ccmdb.enable.depth.for.non. top.level.classes=<true|false>
This optional property will cause Integration Composer to follow relationships for ACTIVE non-top level classifications.

Normally Integration Composer will NOT process relationships for ACTIVE non-top level classifications. This property will
modify that behavior, all ACTIVE classification will be traversed to the depth specified.

There should be very few cases where this property is required. In most situations you should start importing from a top
level class and allow the non-top level Cl classes be imported based on their relationship with a top level class. With this
property set to true if you activate a non-top level classification that is related to an ACTIVE top level classification you will

cause Integration Composer to process Actual Cls multiple times which will degrade performance. Use this property with
caution.

Comments

There are no comments.

5/5



10/12/2019 IBM Control Desk : Integration Composer assets reconciliation using Alternate Keys and NRS GUID

You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer > Integration
Composer assets reconciliation using Alternate Keys and NRS GUID

Integration Composer assets reconciliation using Alternate Keys and N
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Introduction

IBM Tivoli Integration Composer moves and transforms data from discovery tool databases into the

Maximo database as deployed assets. Integration Composer relies on designated alternate key values
to determine whether the deployed asset already exists in the Maximo database. If the deployed asset
already exists, the non key properties are updated if necessary. If the deployed asset does not exist in

the Maximo database, a new record is inserted.

The algorithm limited to alternate key values may produce multiple records of the same deployed
asset in the Maximo database. The Tivoli Naming Reconciliation Service (NRS), a component of
Data Integration Service (DIS), provides centralized control to identify these assets. Once an asset
has been processed by an application using the service, a GUID (Globally Unique Identifier) is

assigned to the asset.

Integration Composer uses the data it has about the deployed asset to register and get a GUID and
uses the GUID to determine whether the deployed asset already exists in the Maximo database. The
NRS GUID is stored as part of the deployed asset data.

NRS Attribute Descriptions

NRSHostsystem - Not a string but the GUID of the ComputerSystem that is virtualizing this one.

NRSManagedSystemName - The name used to uniquely identify the agent that manages a specific

resource.
NRSManufacturer - The manufacturer of the asset.

NRSModel - The model number of the physical computer system, as it is provided by the
manufacturer of the device.

NRSName —The value in this property is the name of the “Function” (Router and Printer) instance
like ‘myRouter’.
NRSPrimarymacaddress - The MAC address of the Network Adapter in the physical computer

system.

NRSSerialnumber - The serial number of the physical computer system, as it is provided by the

manufacturer of the device.
NRSSignature - The primary IP address, or, if there is no IP stack, then SNA HOST.
NRSSystemboarduuid - The burned-in, Globally Unique Identifier (GUID) of the computer’s

motherboard.

NRSVmid - The ID allocated to a running virtual machine by the vmkernel. This corresponds to the
VM ID in the virtual machine table.

Naming Rules
173
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NRS generates a GUID based on the Naming Rule with the highest priority provided. 0 has the
highest priority. These properties are specified in the mapping and are prefixed with NRS.

NRS Properties Priority ‘
Signature 0
(no-VM ID), manufacturer, model, serial Number 1
System board UUID 2
Primary Mac Address 3
Host System, VMID 4
Managed System Name 5
VM ID, manufacturer, model, serial Number 6
VM UUID 7

Integration Composer Reconciliation using Alternate Keys and NRS GUID
Process existing instance, instance found by alternate keys, no NRS GUID is recorded

a. An asset with the same combination of alternate keys exists in the target database. No NRS
GUID is recorded for the target instance.

b. New data may provide enough information to generate an NRS GUID.

c. Check whether the GUID belongs to another instance in the target database. If an NRS GUID
already exists, a duplicate instance of that asset exists. The existing duplicate instance and all
its child instances will be deleted from the target database.

d. Update the target instance found by alternate keys
Process existing instance, instance not found by alternate keys but found by NRS GUID

a. This means that Integration Composer sees this instance as new based on alternate keys.

b. Check whether the GUID belongs to another instance in the target database. If the GUID
already exists, the instance being processed is the same asset as the one that already exists in
the target database, but the alternate key values are different. Integration Composer will not
insert duplicate instances of the same asset in the target database. It will update the instance in

the database, including the alternate keys.
Process new instance (instance not found by alternate keys and not found by NRS GUID)
A new asset will be created in target database.
Process existing instance, found by alternate keys with an NRS GUID in the target
a. New data may cause generation of a new NRS GUID for the existing instance.
b. If the NRS GUID has changed and the new NRS GUID belongs to an existing instance, delete

the existing instance with that NRS GUID. All its child instances are deleted as well.
c. Update the target instance found by alternate keys.

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Importing Data Using IBM Tivoli Integration Composer > Integration
Composer FAQ

Integration Composer FAQ
E Like | Updated December 13, 2013 by alucches | Tags: None

Q: When | execute the mapping | get this error:
“Exception in thread "main" java.lang.NoClassDefFoundError: sun.tools.javac.Main”
What is wrong and how do | fix it?

A: Integration Composer mapping execution required IBM Java SDK to be installed and pointed at by init.bat (or .sh):
set JAVA_ HOME=C:\Program Files\IBM\Java50 (this must be actual path to the root folder of Java SDK installation)

The required versions of Java SDK are:

Integration Composer version [[Java SDK version |
lIntegration Composer 7.2.X IBM Java SDK, Version 5.0 |
lIntegration Composer 7.5.X IBM Java SDK, Version 6.0 |

Q: How can | turn on the debugging in Integration Composer to collect more diagnostic information?

A: There are many debugging options available in Integration Composer. They are listed in logging.properties file. Set the
ones you need to DEBUG. For example to turn the SQL debugging on:

log4j.logger.maximo.sql=DEBUG

Please make sure the following settings allow capturing sufficient amount of log information. The recommended values
are as follows (your actual need may require a higher MaxBackuplndex value):

log4j.appender.A2.MaxFileSize=20MB
log4j.appender.A2.MaxBackuplndex=20

Q: How can | turn the performance monitor on in Integration Composer?

A: Turn on performance monitor by uncommenting the following lines in the fusion.properties file:

perfmon.logfrequency=5
perfmon.threshold.sql=10

This will generate perfmon_*.log files that you can send to IBM for evaluation by the Integration Composer support team.

Q: What TADDM .jar files do | have to copy to Integration Composer folder to be able to run Cl adapters?

A: You have to copy the following files from TADDM server to <Integration Composer>\lib folder

<TADDM>\dist\sdk\lib\taddm-api-client.jar
<TADDM>\dist\sdk\lib\platform-model.jar

Also make sure init.bat (or .sh) contains this line and it is uncommented:

set CMDBAPI=%COLLATION_HOME%\lib\taddm-api-client.jar; % COLLATION_HOME%\lib\platform-model.jar

Q: | am getting the following error when | execute the mapping. How do | fix it?

java.lang.StringIndexOutOfBoundsException: String index out of range: 32

A: If the line in the expression contains reference to the source attribute, the line cannot include the TAB character.
(TAB)String type = "COMPUTER?"; is OK

(TAB)String type = 'Node.Node type'; is NOT OK
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Q: | see the following error in the Integration Composer log file when mapping is executed. What is wrong and how do | fix
it?

Error: SQLCODE=-407, SQLSTATE=23502, SQLERRMC=TBSPACEID=3, TABLEID=150, COLNO=10, DRIVER=4.11.69

A: To find out in what column the null value was attempted to be inserted into, run this query on Maximo database:

SELECT C.TABSCHEMA, C.TABNAME,

C.COLNAME

FROM SYSCAT.TABLES AS T,
SYSCAT.COLUMNS AS C

WHERE T.TBSPACEID = n1

AND T.TABLEID = n2

AND C.COLNO =n3

AND C.TABSCHEMA = TTABSCHEMA

AND C.TABNAME = T.TABNAME

where n1, n2 and n3 are TBSPACEID, TABLEID and COLNO from the error message.

Then correct the corresponding mapping expression to make sure it produces non-null value.

Q: How can | write messages to the console and fusion.log from within the mapping expression?

A: You can use this statement:

com.mro.fusion.util.logging.LogManager.loginfo("The record with ID=" + id + “cannot be found!”);

Q: How can | FTP files to Integration Composer support team?

A:

ftp ftp.emea.ibm.com

Login as anonymous and Use your Email Address as the password
Cd toibm/Tivoli

bin

Put <name of file>

Please see Integration Composer IBM Endpoint Manager and IBM Endpoint Manager SUA Adapter FAQ for answers
related to IEM and IEM SUA adapter questions.

Comments

There are no comments.
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Integration Composer IBM Endpoint Manager and IBM Endpoint Manag
er SUA Adapter FAQ

E Like | Updated December 13, 2013 by alucches | Tags: None
Q: How do | configure Tivoli Endpoint Manager for Software Use Analysis 1.3 for use with Integration Composer?
A: Refer to this article to configure Tivoli Endpoint Manager for Software Use Analysis 1.3
http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.sccd.doc/import_asset/r_bigfix_mapping.html

Q: How do | configure IBM Endpoint Manager for Software Use Analysis 2.X for use with Integration Composer?
A: Refer to this article to configure IBM Endpoint Manager for Software Use Analysis 2.X:

http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp?
topic=%2Fcom.ibm.sccd.doc%2Fimport_asset%2Ft_configuration_tasks_tem20.html

Q: How do | configure IBM Endpoint Manager 9.0 for use with Integration Composer?
A: Refer to this article to configure IBM Endpoint Manager 9.0:

http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp?
topic=%2Fcom.ibm.sccd.doc%2Fimport_asset%2Ft_configuration_tasks_tem20.html

Q: How do | add properties to the IBM Endpoint Manager 9.0 Integration Composer schema?

A: "additional.properties" attribute in IBM Endpoint Manager.properties file identifies the additional IBM Endpoint Manager
(IBM Endpoint Manager) properties that should be loaded into the IBM Tivoli Integration Composer IBM Endpoint
Manager schema.

This is an optional property. If the property is not set, only the out-of-the-box properties, as documented in the "Integration
adapter mapping tables" section of the SmartCloud Control Desk infoCenter, are added to the Data Source and retrieved
from IBM Endpoint Manager for each computer.

The format of this property is as follows:

propertyKey1|propertyKey?2|....

Each propertyKey identifies an additional property defined in IBM Endpoint Manager that you wish to add to the
Integration Composer IBM Endpoint Manager schema. Separate each property key with a vertical bar character (| ).

There are three forms that may be used to identify a property:
1) PID Triplet form: site-id,analysis-id,property-id

Here you specify the site ID, analysis identifier, and property identifier separated by commas. Concatenated together,
these three IDs uniquely identify a property within IBM Endpoint Manager.

Example: To add the "SCSI Devices - Windows" property from the BES Inventory and License Site using this form,
specify:

additional.properties=3093,35,17
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2) Site ID and Property Name form: site-id,property-name

Here you specify the unique identifier for the site and the name for the property.

Example: To add the "SCSI Devices - Windows" property from the BES Inventory and License Site using this form,
specify:

additional.properties=3093,SCSI Devices - Windows
3) Site Name and Property Name form: site-name,property-name
Here you specify the name for the site and the name for the property.

Example: To add the "SCSI Devices - Windows" property from the BES Inventory and License Site
using this form, specify:

additional.properties=BES Inventory and License,SCSI Devices - Windows
The following list identifies IBM Endpoint Manager Content Site Identifiers and Names.

-1 ===> ActionSite (Master Action Site)
1 ===>BES Support
3093 ===> BES Inventory and License
3107 ===> BES Asset Discovery
6013 ===> Patches for ESX3
8032 ===> BigFix DSS Software Asset Management
8344 ===> Patches for ESXi
8346 ===> Virtual Endpoint Manager
9278 ===> TAMIT Integration
11203 ===> |IBM Software Inventory

Uncomment the following line to specify the additional properties to load from IBM Endpoint Manager:
/ladditional.properties=3093,SCSI Devices - Windows |3093,17,1|BES Inventory and License,SCSI Devices - Windows
Q: | get the following error when create data source for TEM SUA 2.X. What is wrong and how can | fix this error?
Data schema retrieval failed.

com.mro.fusion.dblinterface.jdbc.JDBCConnection incompatible with

com.mro.fusion.dblinterface.temsua. TEMSUAConnection

A: Wrong connection method is being used. The following table lists the allowed connection methods:

Adapter Connection Method

TEM SUA 1.3 Microsoft SQL Server JDBC Driver

TEM SUA 2.X IBM Endpoint Manager and SUA API

IBM Endpoint Manager 9 IBM Endpoint Manager and SUA API

Q: | get the following error when create data source for TEM SUA 2.X. What is wrong and how can | fix this error?

Internal error
Server returned HTTP response code: 400 for URL: http://hostname:9081/api/schemas/computer.json

A: Refer to this SCCD Infocenter article to configure IBM Endpoint Manager for Software Use Analysis 2.X

http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp?
topic=%2Fcom.ibm.sccd.doc%2Fimport_asset%2Ft_configuration_tasks_tem20.html

2/3


http://hostname:9081/api/schemas/computer.json
http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp?topic=%2Fcom.ibm.sccd.doc%2Fimport_asset%2Ft_configuration_tasks_tem20.html

10/12/2019 IBM Control Desk : Integration Composer IBM Endpoint Manager and IBM Endpoint Manager SUA Adapter FAQ
Please see Integration Composer FAQ for answers related to general Integration Composer questions

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Integrating with Rational Team Concert and Rational ClearQuest

Integrating with Rational Team Concert and Rational ClearQuest
E Like | Updated August 4, 2015 by charglen | Tags: None

Overview

To support DevOps activities, you can optionally integrate IBM Control Desk 7.6, 7.5 (formerly IBM SmartCloud Control
Desk; the product was renamed in version 7.5.3), or Tivoli Service Request Manager 7.2.1 with Rational Team Concert
3.0 or higher and Rational ClearQuest 7.1.2 or 8.0.0.

Enabling this integration allows users to associate Control Desk Problem records with Rational Team Concert or Rational
ClearQuest defects, providing a link between your help desk, support, operations and development teams.

It is possible to associate other types of Control Desk records such as Changes, Incidents, or Work Orders to other types
of work items in Rational Team Concert such as tasks, stories, or plan items in IBM Control Desk 7.5.1 or higher. If this
behavior is required, see Integrating with other record types, before proceeding with installation and configuration of this
integration.

In IBM Control Desk 7.5.1 and higher, the integration has the following enhanced features:

e Support for more than one Service Provider per deployment.

o OAuth authentication is performed using an IBM certified Google API, as opposed to the OAuth solution
implemented in the original Tivoli Service Request Manager integration.

e Support for non-Jazz based Service Providers. The original integration supported only Jazz based tools.

o Better alignment with Open Services for Lifecycle Collaboration (OSLC) standards.

o Support for additional authentication schemes besides OAuth including basic auth, HTTPS, and single sign-on.

You can upgrade this integration if it was installed and used in Service Request Manager 7.2.1 or IBM Control Desk 7.5.
However, some manual upgrade and migration steps are required. Therefore, it is strongly recommended that you use
the integration provided in IBM Control Desk 7.5.1 or higher.

Installation

*In IBM Control Desk 7.6, this integration is installed automatically during fresh install or upgrade, but must be configured
and enabled.

*In IBM Control Desk 7.5.1, 7.5.2, and 7.5.3 this integration can be installed from the Integrations section of the product
Launch Pad, then configured and enabled.

In IBM Control Desk 7.5 and Tivoli Service Request Manager 7.2.1, the integration packages are provided on the ISM
Library.

*Recommended install scenario.

Documentation

To configure the integration in IBM Control Desk 7.5.1 or higher, see the Configuring OSLC Integrations documentation in
IBM Knowledge Center.

For earlier versions, you may consult the Configuration section of the OSLC for Change Management 2.0 Guide to
configure the integration for your environment.

Additional Information

Configuring single sign-on

This page contains additional information on how to configure the integration to use single sign-on.

Troubleshooting the Integration

This page contains additional information about troubleshooting the Rational Team Concert and Rational ClearQuest
integration.
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Custom attribute mapping configuration
This page contains information on how to map values from IBM Control Desk tickets to custom attributes in Rational Team
Concert.

Integrating with other record types

This page contains information about how to associate Change, Incident, Work Order or other types of records in IBM
Control Desk 7.5.1 to Tasks, Stories, Plan Items or other types of work items Rational Team Concert or Rational
ClearQuest.

Comments

There are no comments.
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Configuring single sign-on
|z| Like | Updated August 5, 2015 by cfjohnst | Tags: None

This page contains additional information on how to configure the Rational Team Concert integration to use single sign-on.

Note: Single sign-on is not supported in Rational ClearQuest. See Request For Enhancement RATLC01063887.

Overview

By default, IBM Control Desk uses an OAuth endpoint to connect to the Rational products in this integration. This means that users will be prompted for credentials
to Rational Team Concert or Rational ClearQuest the first time they attempt to view, select, or create a defect during their IBM Control Desk session.

If you do not want users to be prompted for credentials to Rational Team Concert after logging into IBM Control Desk, you can configure the integration to use single
sign-on (SSO).

To achieve SSO, both Rational Team Concert and IBM Control Desk must be installed on WebSphere Application Server and configured to use the same LDAP
registry. Itis recommended to use Tivoli Directory Server, which is packaged with IBM Control Desk.

Configuration

1. Any products that are not installed on WebSphere Application Server must be migrated to WebSphere Application Server.

2. You must configure all products to use the same LDAP registry for authentication.

For information about how to configure IBM Control Desk to use LDAP security, see the LDAP Authentication topic in the information center.

If you need more information about configuring IBM Control Desk to use LDAP, see these resources:

o Blog post on Configuring LDAP Federated Repositories for TPAE Maximo
« Whitepaper on Connecting TPAE to LDAP

For information about how to configure Rational Team Concert 4.0 to use LDAP security, see the Configuring Jazz applications for LDAP article on Jazz.net. See
the section starting with "Configuring the Jazz server".

Note: Users in the LDAP registry will need to be granted access to the appropriate project areas in Rational Team Concert before they will be able to view, select, or
create defects from within IBM Control Desk.

3. If both products are installed on the same WebSphere Application Server, you can skip this step. However, if your IBM Control Desk and Rational Team Concert
are installed on separate WebSphere Application Servers, some additional configuration is needed to achieve single sign-on:

Consult the Rational Team Concert information center topic on Deploying with single sign-on on WebSphere Application Server.
4. Create a new Rational Team Concert endpoint within IBM Control Desk and update the provider record to use the new endpoint:
a) Go to Integration > End Points and create a new endpoint.

b) Give it a name and description and select HTTP for the Handler.
c) Fill in the endpoint properties as show below:

Praperties for End Point RTCTEST + 1-90fd o =
Property Value Encrypted Value Alow Override?

P conneEcTTIMEOUT ' ] v

pp COOKES v

p HEADERS v

b HTTPEXT [

jp HTTPMETHOD GET v

p PASSWORD v

p READTIMEQUT 7

B URL v

b USERNAME v

d) Save the changes to the endpoint.

e) Run the following database query to update the end point to use with the Rational Team Concert Provider:
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update oslcprovider set endpointname='RTCHTTP' where providername='SCCDRTCPROVIDER';
(Replace RTCHTTP with the name of the new end point you created.)

f) Restart MXServer in the WebSphere Application Server administrator console. You should now be able to view, select, and create defects within IBM Control
Desk without being prompted for credentials to Rational Team Concert.

Comments

There are no comments.
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Troubleshooting the Integration
E Like | Updated June 1, 2013 by cfjohnst | Tags: None

This page contains additional information about troubleshooting the Rational Team Concert and Rational ClearQuest integration.
Troubleshooting SSL and Certificate Errors

If the Rational Team Concert or Rational ClearQuest server requires an SSL connection, you may see SSLHandshakeException or CertPathBuilderException
errors when attempting to configure the OSLC integration.

To resolve this issue, the SSL certificate from Rational Team Concert or Rational ClearQuest must be imported into the SmartCloud Control Desk or Tivoli Service
Request Manager server's trust store.

On Websphere Application Server:

. Login to the Websphere Application Server administrator console.

. Go to Security > SSL certificate and key management.

. Select Key stores and certificates.

. Select the trust store, usually CellDefaultTrustStore.

. Select Signer certificates.

. Select Retrieve from port.

. Enter the host, SSL port, and a name for the certificate entry for the Rational Team Concert or Rational ClearQuest server.
. Select Retrieve from port. The certificate information should appear if it was retrieved successfully.

. Select OK and choose to Save the configuration. Now you can continue with the OSLC integration configuration.

© 0 N O A WN =

On Weblogic:

1. Retrieve the certificate from the Rational Team Concert or Rational ClearQuest server, and save it on the admin workstation. Note the location of the
certificate file for the next step.

2. Run the following command on the Weblogic server: <weblogic_install_dir>\jdk160_18\jre\bin\keytool.exe -import -alias <alias> -file <certificate_file> -
keystore <weblofic_install_dir>\jdk160_18\jre\lib\security\cacerts

3. Enter the keystore password. The default password is changeit.

4. When prompted, enter y to choose to add the certificate to the trust store.

5. Restart the Weblogic server. Now you can continue with the OSLC integration configuration.

Troubleshooting OAuth Issues with Rational Team Concert
If the integration is configured with Rational Team Concert 3.0 or 3.0.1, the OAUTH_VERSION in the OSLC_DEFAULT_OAUTH End Point should be set to "1.0".

In later versions of Rational Team Concert, you may see a "parameter_rejected" error when configuring the OAuth Access Token. To fix this problem, set the
OAUTH_VERSION in the OSLC_DEFAULT_OAUTH End Point to "1.0a".

View Record List = OSLC_DEFAULT_OCAUTH

J End Paint

End Point: Handler: Consumed By;
O5LC_DEFAL | lZ::.-L'.UT en-jpcli|t'-;u.rl’|i|::h isu to implement the D.A.IJH il .__"_.'. OSLC_DEFAL ¢ ;L INTEGRATION
| Properties for End Point OSLC_DEFAULT_OAUTH ) R 1-70of7 o4 Download - =
Property Value Encrymed\ufalue-hllow Owerride’
. |[p ACCESS_TOKEN_URL http: /e 0080/ccmioauth-ace [v]
' b AUTHORIZATION_URL http:/ S o0 20/ceminauth-autl =
} CONSUMER_KEY 25816211c07a47a0b032cc1581bave1d =
b CONSUMER_SECRET ssssssssss  [J]
b OAUTH_DESCRIPTION OSLC_DEFAULT_OAUTH ™
E OAUTH_VERSION 1.05 =
' [p REQUEST TOKEN_URL hitp: I 008 0/ccmioauth-req &

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Integrating with Rational Team Concert and Rational ClearQuest > Custom attribute mapping configuration

Custom attribute mapping configuration
E Like | Updated August 5, 2015 by cfjohnst | Tags: None

This page contains information about how to map values from IBM SmartCloud Control Desk 7.5.1 or higher tickets to custom attributes in Rational Team Concert 4.0.1 or higher.
Note: This configuration cannot be done if either product is at an earlier version.

Overview

Most OSLC Providers like Rational Team Concert have shape documents which describe the resources they provide.

By default, this integration makes use of the standard Change Management 2.0 shape document to describe work items in the Rational products. In the OSLC Providers application, you can
view the Change Management shape document by using the Add/Modify Resource Types action. You can also use this application to map attributes from IBM Control Desk tickets to
properties listed in the shape document. If such a mapping is created, the defect will be pre-filled with the values you specify from IBM Control Desk when you choose to create a defect from
the Problem ticket.

This example shows how the summary of the ticket can be mapped to the summary of the defect.

1. Go to Integration > OSLC Providers.

2. Open the SCCDRTCPROVIDER.

3. Select the create interaction in the OSLC Interactions table.

4. In the Interaction Mappings table, notice that the Problem summary is mapped to the defect summary.

Interaction Mappings 1-10f1 & 2
Source Mapping Expression Target Resource Property Target Resource Property Namespace
W |.description »  title http:i/purl.org/dciterms/
Details
Source Mapping Expression: Target Resource Property:
-description » title 4

Target Resource Property Namespace:

http:ifpurl.org/dcterms/
Resource Property is URI?

This means that when you choose to Create a defect in the Problem application, the Problem description is pre-filled in the defect title.

Incident; Qriginating Record: Status:
1002 l |F'ayro|| application running slowly i |€‘¢ I:I » MEW
Qrigipating Record Class: Site-
Create Resource

Ref Type: Task V|

Summary: * |F'ayr0|| application running slowly

Filed Against | Unassigned =l 2

Owned By | Unassigned ;I

Due Date

=

Re :

Description:

OI¢YS | BI | &%~

If you add custom attributes to work items in Rational Team Concert, those attributes will not be in the standard Change Management 2.0 shape document, which means you cannot map
IBM Control Desk values to your custom attributes. If you want to map to custom attributes, you must retrieve an updated shape document from Rational Team Concert and import it into
IBM Control Desk.

Note: This approach is not recommended if you are integrating one IBM Control Desk with both Rational Team Concert and Rational ClearQuest. In that case, the common Change
Management 2.0 shape document should be used for both.

Configuration

1. After custom attributes are added in Rational Team Concert, retrieve the new shape document.

a) Go to the Service Provider catalog, typically https://<rtc_host>:9443/ccm/oslc/workitems/catalog.

b) Look for the Project Area where you added custom attributes and request the services.xml link for that provider using a tool like Firefox Poster. Set the OSLC-Core-Version header to 2.0.
c) Look for the creation factory with usage set to <oslc:usage rdf:resource="http://open-services.net/ns/cmfdefect"/>.

d) Inside that creation factory, you will see an <oslc:resourceShape> tag which points a URL that contains the shape document.

e) Request the shape document from the URL, for example, from https://<rtc_host>:9443/ccm/oslc/context/ SwuzkEkZEeKeZ KnLx0K Q/shapes/workitems/defect

f) Save the XML that is returned in a file on the IBM Control Desk administrative workstation.
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2. Rational Team Concert 4.0.1 has a defect where custom attributes always get exposed with a value-type of Resource. IBM Control Desk cannot map to properties with a value-type of
Resource, so you must change the value-type of the custom attribute in the shape document before importing it into IBM Control Desk. A fix for this defect is planned for Rational Team
Concert 4.0.4.

a) Open the shape document you saved in Step 1, Part f.
b) Find the custom attribute you added by searching for the name of the attribute. You should find an entry like this:

<oslc:property>
<oslc:Property
rdf:about="https://myserver.com:9443/ccm/oslc/context/ A OmZLODEeKUFoQTAt6IxQ/shapes/workitems/task/property/CustomAttribute">

<oslc:valueType rdf:resource="http://open-services.net/ns/core#Resource"/>
<oslc:representation rdf:resource="http://open-services.net/ns/core#Either"/>
<oslc:readOnly rdf:datatype="http://www.w3.0rg/2001/XMLSchema#boolean">false</oslc:readOnly>
<oslc:propertyDefinition rdf:resource="http://jazz.net/xmlns/prod/jazz/rtc/ext/1.0/CustomAttribute"/>
<oslc:occurs rdf:resource="http://open-services.net/ns/coref#Zero-or-one"/>
<oslc:name rdf:datatype="http://www.w3.0rg/2001/XMLSchema#string">CustomAttribute</oslc:name>
<oslc:defaultValue></oslc:defaultValue>
<dcterms:title rdf:parseType="Literal">CustomAttribute</dcterms:title>

</oslc:Property>

</oslc:property>

c) Find the <oslc:valueType> tag. Change the value of the rdf:resource to be the correct type. For example, if the custom attribute added in Rational Team Concert was a string, the line:
<oslc:valueType rdf:resource="http://open-services.net/ns/core#Resource"/>
should be replaced with:
<oslc:valueType rdf:resource="http://www.w3.0rg/2001/XMLSchema#string"/>

A list of valid value-types can be found in the OSLC Core Specification.

d) Repeat steps b and c for all custom attributes that were added in Rational Team Concert.
e) Save the changes to the shape document.

3. Import the shape document in IBM Control Desk.

a) Go to Integration > OSLC Providers.

b) Select the Add/Modify Resource Types action.

c) Expand the SCCDCR resource type.

d) Select Import.

e) Browse for the shape document file and choose OK.

4. Now you can map IBM Control Desk attributes to custom attributes in Rational Team Concert.

a) Go to Integration > OSLC Providers.

b) Open the SCCDRTCPROVIDER.

c) Select the create interaction in the OSLC Interactions table.

d) Under the Interactions Mapping table, select New Row.

e) In the Source Mapping Expression field, choose the value you want to pre-fill into the defect from IBM Control Desk.

f) In the Target Resource Property field, choose the custom attribute you want to map to.

g) Save the changes and attempt to create a new defect. You should see that the custom attribute is being pre-filled with the value you specified from IBM Control Desk.

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Integrating with Rational Team Concert and Rational ClearQuest >
Integrating with other record types

Integrating with other record types
E Like | Updated August 5, 2015 by cfjohnst | Tags: None

This page contains information about how to associate Change, Incident, Work Order or other types of records in
IBM SmartCloud Control Desk 7.5.1 or higher to Tasks, Stories, Plan ltems or other types of work items in Rational Team
Concert or Rational ClearQuest.

Note: This configuration cannot be done if IBM Control Desk is at an earlier version or if Tivoli Service Request Manager
is being used.

Overview

The Rational Team Concert and Rational ClearQuest integration delivered in IBM Control Desk 7.5.1 or higher makes it
simple to associate Problem records with Defect work items, by automatically configuring the product for you. However, it
is possible to configure IBM Control Desk to link other types of tickets or records, such as Changes, Incidents or Work
Orders to other types of Rational Team Concert or Rational ClearQuest work items, such as Tasks, Stories, or Plan Items.

If this is the desired behavior, you do not need to install this integration. You only need to follow the instructions below to
configure IBM Control Desk for your particular use case.

Configuring IBM Control Desk

This section takes you through the four steps required to configure IBM Control Desk to integrate with other record types:

1. Import the Change Request OSLC shape document into IBM Control Desk.*

2. Create a new End Point to connect IBM Control Desk to your work item provider, in this case, Rational Team
Concert or Rational ClearQuest.*

3. Create a new OSLC Provider for your work item provider.*

4. Create new Selection Dialog and Creation Dialog OSLC Interactions between IBM Control Desk and your work
item provider.

*In IBM Control Desk 7.6 or higher, the Change Request OSLC shape document is installed by default. Default end
points and OSLC Providers are installed as well. You may reuse those, or create your own by following the steps below.
If the default end points and OSLC Providers are used, you will need to update them with your environment specific
information such as host names, ports, and credentials.

Before you begin

Before proceeding with the configuration, you need to obtain the following information from the work item provider
administrator:

1. The Rational Team Concert or Rational ClearQuest administrator credentials.
2. The Access Token, Request Token, and Authorization URLs for OAuth authentication.
1. For Rational Team Concert, the typical values are (substitute <host> and <port> with your Rational Team
Concert host name and port number):
1. Access Token URL: https://<host>:<port>/ccm/oauth-access-token
2. Request Token URL.: https://<host>:<port>/ccm/oauth-request-token
3. Authorization URL: https://<host>:<port>/ccm/oauth-authorize
2. For Rational ClearQuest, the typical values are (substitute <host> with your Rational ClearQuest host
name):
1. Access Token URL: http://<host>/cqweb/oauth-access-token/7.0.0
2. Request Token URL: http://<host>/cqweb/oauth-request-token/7.0.0
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3. Authorization URL: http://<host>/cqweb/oauth-authorization/7.0.0
3. The consumer key and consumer secret to be used for OAuth authentication. The Rational Team Concert or
Rational ClearQuest administrator will need to create a new consumer key and consumer secret for you.
4. The Service Provider List and Base URL of the work item OSLC Provider.
1. For Rational Team Concert, the typical values are (substitute <host> and <port> with your Rational Team
Concert host name and port number):
1. Service Provider List URL: https://<host>:<port>/ccm/oslc/workitems/catalog
2. Base URL: https://<host>:<port>/ccm
2. For Rational ClearQuest, the typical values are (substitute <host> with your Rational ClearQuest host
name):
1. Service Provider List URL: http:/<host>/cqweb/oslc/repo/7.0.0
2. Base URL: http://<host>/cqweb

Importing the Change Request OSLC shape document

You need to import the Change Request OSLC shape document into IBM Control Desk. This document describes the
resources that are available in the work item provider.

1. Attached to this wiki page is a file called shape_cr.xml. Save this file on the IBM Control Desk administrative
workstation and note the location of the file.

. Log in to IBM Control Desk as an integration administrator.

. Go to the Integration > OSLC Providers application.

. In the left hand navigator, under More Actions, select Add/Modify Resource Types.

. Under the Resource Types table, click the New Row button.

. In the Resource Type field, enter an ID and description for the Change Request type, such as CR and Change
Request.
7. In the Resource Type URI field, enter: http://open-services.net/ns/cm#ChangeRequest
8. In the Import Shape Document field, click the Browse button, and navigate to the shape_cr.xml file you saved in

Step 1. Select the shape_cr.xml file and click Open.

9. Click the Import button. You should see the Shape Document field is now populated.

10. Click OK to close the Add/Modify Resource Types dialog.

o b WODN

Creating a new End Point

You need to create a new End Point so that IBM Control Desk knows how to connect to your work item provider.

. Log in to IBM Control Desk as an integration administrator.

. Go to the Integration > End Points application.

. Create a new End Point.

. Enter an ID and description for your work item provider, such as RTC and Rational Team Concert.

. In the Handler field, select OAUTH.

. Enter the Access Token URL, Request Token URL, and Authorization URL you obtained from the work item
provider administrator in the ACCESSTOKENURL, REQUESTTOKENURL, and AUTHORIZATION URL Value
fields.

7. Enter the consumer key and consumer secret you obtained from the work item provider administrator in the

CONSUMERKEY Value and CONSUMERSECRET Encrypted Value fields.

8. Save the record.

o b WN -
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SAC  End Point

End Point Handler: Consumed By:

RTCTEST Rational Team Concer ‘ B ownr @ wrecramon

Properties for End Point RTCTEST 1-90f9 ¥ =
Property Value Encrypted Value Allow Override?

b ACCESSTOKENURL 'hﬂps:ﬂraﬁuo.tivlab.austin.ibm.com:9443fccmfoauth-access-to:

D. AUTHORIZATIONURL hitps:/irativo fiviab.austin lom.com:3443/cemioauth-authorize

D CONSUMERKEY ac33allaftedda2dididab3sc0ciidle

b CONSUMERSECRET sassansnns

b COOKIES ¥

p HEADERS Accept-Language v

b HTTPMETHOD GET v/

D REQUESTTOKENURL https:/irativo fiviab.austinibm.com:9443/cemioauth-request-c

b URL v

Creating a new OSLC Provider

You need to create a new OSLC Provider record for your work item provider.

. Go to the Integration > OSLC Providers application.

. Create a new OSLC Provider.

. Enter an ID and description for your work item provider, such as RTC and Rational Team Concert.

. In the End Point field, select the End Point you created in the previous section.

. In the Public URI field, enter the Base URL you received from the work item provider administrator.

. In the Service Provider List URI field, enter the Service Provider List URL you received from the work item provider
administrator.

7. Save the record.

o b WN -
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SACH (51 Provider

Provider

Publc UR

RICTEST Rafional Team Concert <+ tpsiirativo 130, austinibm com 9443em

EndPaint Senvice Provider List LRI

RICTEST | 7 Ralons

Team Concert -+ tpsiirativo i3, austin om com Sd43icemlos chworktemslt

OSLC Interactions ) I-00f) =

Interaction Description Interaction Type Resource Type Usaqe URI Service Provider URI

Norows to display.

Creating a new Selection Dialog OSLC Interaction

You need to use the OSLC Interaction wizard to create a new interaction between IBM Control Desk and your work item
provider.

For the purposes of this example, we want to associate Incident records in IBM Control Desk with Task work items in
Rational Team Concert. However, you can choose any record type in IBM Control Desk or any work item type in Rational
Team Concert.

1

. In the OSLC Providers application, open the OSLC Provider you created in the previous section.
2.

In the left hand navigator, under More Actions, select Create OSLC Interaction. This will begin Step 1 of the OSLC
Interaction wizard.

. Enter Interaction field, enter an ID and Description for the new interaction, such as SELECT and Select Tasks.
. In the Interaction Type field, select SELECTIONDIALOG / Selection Dialog.
. In the Resource Type field, select the Change Request resource type that you previously imported.

1. At this step, if you are prompted to login to Rational Team Concert or Rational ClearQuest, log in as an
administrator.

2. At this step, if you receive a certificate error, you need to follow the troubleshooting steps to import the
work item provider SSL certificate.

. In the Usage URI field, select the work item type you want to use in your work item provider, in this case,

http://open-services.net/ns/cm#task.

. Click Next. This will begin Step 2 of the OSLC Interaction wizard.
. In the Association Property field, select the type of link that should be created in Rational Team Concert or

Rational ClearQuest to link back to the Incident record in IBM Control desk, in this case, affectedByDefect.

. Click Next. This will begin Step 3 of the OSLC Interaction wizard.
. In the Application field, select the record type you want to associate with Tasks, in this case, INCIDENT.
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11. In the Application tab field, select the tab of the Incident application where you want your users to be able to
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associate Tasks with Incidents, in this case, Related Records (relatedrec) tab.

12. In the Application Security Groups table, select all the security groups who should have the ability to associate

Tasks with Incidents.
13. Click Complete.

Now your users can select existing tasks in Rational Team Concert and associate them with IBM Control Desk Incidents.

If you also want your users to be able to create tasks in Rational Team Concert from IBM Control Desk, repeat Steps 1-13
above, but in Step 3, enter CREATE and Create Tasks and in Step 4, choose CREATIONDIALOG / Creation Dialog.

OSLC Interaction Wizard: Step 1

OSLC Interaction for Provider RTCTEST

Define Interaction and Select Usage URI: Step 1

0 Specify whether the interaction is for creating a resource in a provider, for assaciating data with a resource in a provider, or for querying a resource from a
provider Then, specify a resource type. Usage URIS forthe resource type are refrieved from the provider application sothat you can selecta URL for the

Interaction. More infarmation

Interaction:

TASK Rational Team Concert Tasks

Interaction Tipe:

SELECTIOND!I N Selection Dialog

Resource Type

Resource Tvpe:

(R q Change Request

Usage URI

=

Resource Type URI:

hiip:flopen-senices.netins/cm#ChangeRequest

Usage URL:

hiip:flopen-senices.netins/cmitask ‘-l.

OSLC Interaction Wizard: Step 2
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QSLC Interaction for Provider RTCTEST

Select Service Provider for OSLC Interaction TASK: Step 2

Service Provider Details

Q You can spacify that all senice providers in the provider application are available for the interaction or you can specify a URI for a single
senice provider forthe interaction. Mare information

Use All Senice Providers? Senvice Provider URL

0}

Association Property

Q To generate alink from the provider application to your application data, specify an association property. More information

Association Propenty. Association Property Namespace:

‘ affectedByDefact L-& hitp:/lopen-senvices.netinsicm#

OSLC Interaction Wizard: Step 3
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QSLC Interaction for Provider RTCTEST

Select Application for OSLC Interaction TASK: Step 3

Application Details

Q To automatically update the user interface, specify the application 1ab and the button [abel. More information

Application: Napping Object Create Interacfion Tab, Table, and Push Butian in Application?
INCIDEN '-4 Incidents INCIDENT v
Application Tal: Push Button Label
relatadrec q TRSK
Application Security Groups Authorized to Launch Interaction > ¥ 1B e & =
Security Group Description
v WMAXADMIN Waximo Administratars (Super Us...

PHRELEASEDEPLOYMENTSPECIALIST
PHRELEASEADHIN
PHRELEASEDEPLOYER

PHRELEASENGR

Using the Integration

Now when users log in and go to the Incident Application, they will see a new table where they can Select and Associate
Rational Team Concert tasks. Note that you may want to use Application Designer to change the tab, table, and button

labels.

Deployment Specialist
Release Administrator
Release Deployer

Release Manager
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sk
k| 70 0l .
Destripton Linked Resouree URL Proider
Norows o display
SELECT  CREATE
Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Enabling the launch-in-context feature

Enabling the launch-in-context feature

E Like | Updated August 30, 2013 by charglen | Tags: integration, launch-in-context, smartcloud_control_desk

IBM SmartCloud Control Desk allows you to launch in context directly to the user interfaces of other products such as
Tivoli Application Dependency Discovery Manager. You must deploy the WIM.ear file on your application server to enable
this feature.

To enable the launch-in-context feature, complete the following steps:

1. Open a command prompt on the system that hosts WebSphere Application Server, and change the directory to
WAS_HOME\bin.
2. Log on to the wsadmin shell by opening a command prompt and issuing the following command:

Windows
wsadmin.bat -username <WebSphere Admin User ID> -password <WebSphere Admin Password>

UNIX
Jwsadmin.sh -username <WebSphere Admin User ID> -password <WebSphere Admin Password>

3. Deploy the file:

wsadmin>set wimAppname "WIM"

wsadmin>set wimCell "ctgCell01"

wsadmin>set wimNode "ctgCellManager01"

wsadmin>set wimServer "dmgr"

wsadmin>set wimEar "/opt/IBM/WebSphere/AppServer/systemApps/wim.ear"

wsadmin>set attrib {}

wsadmin>append attrib "-appname $wimAppname -cell $wimCell -node $wimNode -server $wimServer -
systemApp"

wsadmin>$AdminApp install $wimEar $attrib

Note: Substitute path values where appropriate.
4. Save the configuration:
wsadmin>$AdminConfig save

5. Exit the wsadmin shell by typing exit.

Comments

There are no comments.

1/1


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Integrating?lang=en
javascript:;
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=integration
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=launch-in-context
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/index?lang=en&tag=smartcloud_control_desk
javascript:;

10/12/2019 IBM Control Desk : Integrating with IBM Tivoli Application Dependency Discovery Manager

You are in: IBM Control Desk > Integrating > Integrating with IBM Tivoli Application Dependency Discovery Manager

Integrating with IBM Tivoli Application Dependency Discovery Manager

E Like | Updated October 29, 2013 by etiberi2 | Tags: assets, cis, integrate, itsm, loosely coupled, oslc, taddm, ui_preview

SmartCloud Control Desk 7.5.1.1 can integrate with Tivoli Application Dependency Discovery Manager (TADDM) by
acting as an OSLC Consumer of data on configuration items (Cls) and assets that TADDM provides as an OSLC
Provider.

Value of the integration between SmartCloud Control Desk and TADDM

The business goal for this scenario is to provide SmartCloud Control Desk users, including service desk analysts, with
details about their configuration items and assets from other IT products such as TADDM.

The integration:

e Makes IT resource information from other products such as TADDM readily available to users in the context of
their work without having to change tools.

e Provides IT resource information in real-time.

¢ Reduces the time needed to configure and maintain large amounts of Asset and CI data within SmartCloud
Control Desk.

e The IT resource information can help with the isolation, diagnosis, and routing of incidents and problem tickets.

The technology used in the integration

The technology that makes this integration possible is Open Services for Lifecycle Collaboration (OSLC). OSLC is an
open community that is defining standards for integration between applications and tools. This section describes some of
the basics about OSLC, provides links to education material and other publicly-available information on this and related
topics. In addition, this section describes the SmartCloud Control Desk support for OSLC and how you can leverage
OSLC for your integration.

Note: As SmartCloud Control Desk and IBM Maximo Asset Management share a common process automation engine
base, some of the content in the Maximo wiki and SCCD wiki is shared. The links below go to the Maximo wiki.

OSLC Introduction
Maximo/SCCD Support for OSLC

Documentation explaining details of the OSLC integration between
SmartCloud Control Desk and TADDM

For specifics on the OSLC integration between SmartCloud Control Desk (as OSLC Consumer) and TADDM (as OSLC
Provider), see the following resources:

1. SmartCloud Control Desk product documentation: Viewing Cl and Asset Data and Event Details with OSLC
Integrations (http://ibm.co/1hxoypX). See Chapter 2.

Note: This SmartCloud Control Desk guide is referenced in the end to end guide below.

2. End to end guide on configuring SmartCloud Control Desk and TADDM for the integration in the Cross Product
Integration wiki:

Scenario 7 - OSLC Integration Scenario - How to configure and use SCCD Ul Preview

e Topology
e [nstallation process
¢ Integration process
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e Troubleshooting

Note: These resources contain information also about SmartCloud Control Desk being an OSLC Consumer of
IBM Tivoli Monitoring data.

3. Cl to OSLC resource type mappings
4. Asset to OSLC resource type mappings

Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Integrating with IBM Tivoli Application Dependency Discovery Manager >

Asset to OSLC resource type mappings

Asset to OSLC resource type mappings

E Like | Updated September 27, 2013 by etiberi2 | Tags: class, classify, configuration_item, sccd, smartcloud_control_desk

Asset to OSLC resource mapping table

The first table provides a list of Best Practice Asset Classifications and the OSLC resource types that they map to. The

second table shows a list of Asset Classifications for which no OSLC resource type mapping exists.

The Best Practice Asset Classifications are optional content. If you load the Best Practice Asset Classifications after
installing SmartCloud Control Desk 7.5.1.1, you might want to load the mappings for these classifications.

Table 1. Asset Classifications mapped to OSLC Resource Types

SmartCloud Control Desk

OSLC RESOURCE

ASSET CLASSIFICATION MBO FIELD TYPE PROPERTY
43211500: Computer manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211501: Computer servers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211502: High end computer manufacturer | ComputerSystem | manufacturer
servers
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211503: Notebook computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211504: PDAs manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211505: POS terminal manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211506: Thin client computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211507: Desktop computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
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SmartCloud Control Desk

OSLC RESOURCE

ASSET CLASSIFICATION MBO FIELD TYPE PROPERTY
43211508: Personal computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211509: Tablet computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211510: Mainframe console or manufacturer | ComputerSystem | manufacturer
dumb terminals
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber
43211512: Mainframe computers manufacturer | ComputerSystem | manufacturer
itemnum ComputerSystem | model
serialnum ComputerSystem | serialNumber

Table 2. Asset classifications for which no OSLC resource type mapping exists

SmartCloud Control Desk OSLC RESOURCE

ASSET CLASSIFICATION MBO FIELD TYPE PROPERTY
43000000: IT n/a
43200000: Components n/a
43201400: System Cards n/a
43201402: Memory Module card n/a
43201404 Network interface card n/a
43201539: Console controller n/a
mainframe
43201540: Channel converter n/a
43201541: Channel to channel n/a
interface mainframe
43201542: Control unit n/a
43201543: Coupler facility mainframe n/a
43201544 Interface bus converter or n/a
controller
43201558: Fibre channel controller n/a
43201618: Computer rack n/a
43201800: Media Storage device n/a
43201802: Hard disk array n/a
43201803: Hard disk drive n/a
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SmartCloud Control Desk OSLC RESOURCE

ASSET CLASSIFICATION MBO FIELD TYPE PROPERTY
43201806: Tape arrays n/a
43201807: Tape drive n/a
43210000: Computer equipment n/a
43211900: Display n/a
43212100: Computer printer n/a
43212105: Laser printers n/a
43222500: Network security n/a
43222501: Firewall network security n/a
equipment
43222600: Network service n/a
43222605: Network gateway n/a
43222609: Network routers n/a
43222610: Network service n/a
concentrators or hubs
43222627 Integrated services digital n/a
network ISDN access device
43223306: Network system cabinet or n/a
enclosure
43230000: Software n/a
43231500: Application Software n/a
43233000: Operating System n/a
43233002: Network operation system n/a
software
43233004: Operating system software n/a
Comments

There are no comments.
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You are in: IBM Control Desk > Integrating > Integrating with IBM Tivoli Application Dependency Discovery Manager > Cl to OSLC resource type mappings

Cl to OSLC resource type mappings

E Like | Updated September 27, 2013 by etiberi2 | Tags: class, classify, configuration_item, sccd, smartcloud_control_desk

Cl to OSLC Resource mapping table

This table provides a list of Best Practice Cl Classifications and the OSLC resource types that they map to. All classifications in the table are preloaded at product installation.

By default, only a subset of the classifications can be promoted from Actual Cls to Authorized Cls. These classifications are considered the Simple Best Practice Cl classifications, and are designated in the ClI

CLASSIFICATION column with an asterisk (*).

If you want the ability to promote any of the classifications in the table from Actual Cls to Authorized Cls, you must upgrade to the Comprehensive Best Practice Cl classifications. You should do this upgrade before you
import any data. If you upgrade to the Comprehensive set, the OSLC resource type mappings that are loaded at product installation must be reloaded. For instructions, download the guide titled "Viewing Cl and Asset
Data and Event Details with OSLC Integration" from Fix Central. Go to the topic, "Upgrading to Comprehensive Best Practice Cl Classifications" in Chapter 2.

For instructions on downloading the guide from Fix Central, see the Product Documentation section of http://www.ibm.com/support/docview.wss?&uid=swg21647115.

Table 1. Cl classifications to OSLC resource types

SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY

CILLACLFUNCTION n/a n/a

CLACTIVITY n/a n/a

*CI.LAIXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid

RELATION.VIRTUALIZES |ComputerSystem | dependsOn
*CI.AIXOS n/a n/a
Cl.LAPACHEMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CI.APACHESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.LAPACHEWEBCONTAINER n/a n/a
CI.APPSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.LAPPSERVERCLUSTER n/a n/a
*CIL.LAPPSERVERFUNCTIONALGROUP n/a n/a
CL.BIGIPVIPFUNCTION n/a n/a
CL.BIGIPVLAN n/a n/a
CI.BRIDGE n/a n/a
*Cl.BUSINESSAPPLICATION ITSYSTEM_NAME Servicelnstance |name

RELATION.CONTAINS

Servicelnstance

parentServicelnstance

ClL.LBUSINESSPROCESS

n/a

n/a

CI.BUSINESSSERVICE

n/a

n/a

*CI.BUSINESSSYSTEM

ITSYSTEM_NAME

Servicelnstance

name

RELATION.CONTAINS

Servicelnstance

parentServicelnstance

CIL.CITRIXAPPLICATION SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo

CL.CITRIXFARM

n/a

N/A
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IBM Control Desk : CI to OSLC resource type mappings

SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
CI.CITRIXSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
CIL.CITRIXZONE n/a n/a
*Cl.COMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem |ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*Cl.COMPUTERSYSTEMFUNCTIONALGROUP |n/a n/a
CI.DATABASESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
C|.DB2DATABASE DB2DATABASE_NAME Database name
RELATION.CONTAINS Database dbinstance
CI.DB2INSTANCE APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.DB2MODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName

SOFTWAREMODULE_NAME

SoftwareModule

name
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
Cl.DB2SCHEMA n/a n/a
CI.DB2SYSTEM n/a n/a
CI.DNSSERVICE n/a n/a
ClLLEXCHANGESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
*CL.LFILESYSTEM n/a n/a
ClL.LFIREWALL n/a n/a
*CI.FQDN n/a n/a
CILFUNCTION n/a n/a
*CLLFUNCTIONALGROUP n/a n/a
CL.LHMC n/a n/a
*ClL.LHPUXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*CL.LHPUXOS n/a n/a
CLIISMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CLIISWEBSERVER n/a N/A
CLIISWEBSERVICE APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
*CL.IPADDRESS IPADDRESS_STRINGNOTATION IPAddress address
*CLIPINTERFACE n/a N/A
CLIPLANETSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
CLIPLANETWEBCONTAINER n/a n/a
CLIPNETWORK n/a n/a
Cl.IPVAADDRESS IPADDRESS_STRINGNOTATION IPAddress address
ClLIPV6ADDRESS IPADDRESS_STRINGNOTATION IPAddress address
CLIVM n/a n/a
ClL.J2EEAPPLICATION SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
Cl.J2EEDOMAIN n/a n/a
Cl.J2EEMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo

Cl.J2EERESOURCE

n/a

n/a
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
Cl.J2EESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.JBOSSCLUSTER n/a n/a
Cl.JBOSSDOMAIN n/a n/a
Cl.JBOSSEJBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
Cl.JBOSSJ2EEAPPLICATION SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CI.UBOSSSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.JBOSSWEBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
Cl.L2INTERFACE n/a n/a
CI.LDAPSERVICE n/a n/a
*CL.LINUXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*CL.LINUXOS n/a n/a
CI.LOADBALANCER n/a n/a
Cl.LOTUS.DOMINOAPPLICATION DOMINODATABASE_FILENAME Database name
RELATION.PROVIDES Database dblnstance
Cl.LOTUS.DOMINODATABASE DOMINODATABASE_FILENAME Database name
RELATION.PROVIDES Database dblnstance
ClL.LOTUS.DOMINOLIBRARY DOMINODATABASE_FILENAME Database name
RELATION.PROVIDES Database dblnstance
Cl.LOTUS.DOMINOSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
ClL.LOTUS.OTHERDATABASE DOMINODATABASE_FILENAME Database name
RELATION.PROVIDES Database dblnstance
CL.LMANAGEMENT n/a n/a
ClL.MQALIASQUEUE MQQUEUE_NAME SoftwareModule |fileName
MQQUEUE_NAME SoftwareModule |name
RELATION.MANAGES SoftwareModule |deployedTo

Cl.MQCHANNEL

n/a

n/a

CI.MQCLIENTCONNECTIONCHANNEL

n/a

n/a

CI.MQCLUSTERRECEIVERCHANNEL

n/a

n/a
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
CI.LMQCLUSTERSENDERCHANNEL n/a n/a
CI.MQLOCALQUEUE MQQUEUE_NAME SoftwareModule |fileName
MQQUEUE_NAME SoftwareModule |name
RELATION.MANAGES SoftwareModule |deployedTo
CI.MQMODELQUEUE MQQUEUE_NAME SoftwareModule |fileName
MQQUEUE_NAME SoftwareModule |name
RELATION.MANAGES SoftwareModule |deployedTo
CI.MQQUEUE MQQUEUE_NAME SoftwareModule |fileName
MQQUEUE_NAME SoftwareModule |name
RELATION.MANAGES SoftwareModule |deployedTo
CI.MQQUEUEMANAGER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.MQRECEIVERCHANNEL n/a n/a
CI.MQREMOTEQUEUE MQQUEUE_NAME SoftwareModule |fileName
MQQUEUE_NAME SoftwareModule |name
RELATION.MANAGES SoftwareModule |deployedTo
CI.MQREQUESTERCHANNEL n/a n/a
CI.MQSENDERCHANNEL n/a n/a
CI.MQSERVERCHANNEL n/a n/a
CI.MQSERVERCONNECTIONCHANNEL n/a n/a
CI.MYSAPAPPSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
Cl.ORACLEAPPCLUSTER n/a n/a
Cl.ORACLEDATABASE ORACLEDATABASE_NAME Database name
RELATION.CONTAINS Database dbinstance
Cl.LORACLEINSTANCE APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.ORACLELISTENER n/a n/a
Cl.ORACLEMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
*Cl.OS n/a n/a
CL.PRINTER n/a n/a
CI.LROUTER n/a n/a
Cl.ORACLESCHEMA n/a n/a
Cl.LORACLESERVER n/a n/a
CIL.SERVICE n/a n/a
CI.SMSSITESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
*CI.SOFTWAREIMAGE n/a n/a
Cl.SOFTWAREMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
SoftwareModule |deployedTo

*CL.SOFTWAREMODULEFUNCTIONALGROUP

n/a

n/a
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OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
*CI.SOLARISOS n/a n/a
CI.SQLSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER _VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.SQLSERVERDATABASE Cl.SQLSERVERDATABASE Database name
RELATION.CONTAINS Database dbinstance
Cl.SQLSERVERMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
*CL.SUNCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
Cl.SYBASEDATABASE SYBASEDATABASE_NAME Database name
RELATION.CONTAINS Database dblnstance
ClL.SYBASEMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo

ClL.SYBASESERVER

APPSERVER_NAME

SoftwareServer

name
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OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
CIL.SYSTEMCONTROLLER n/a n/a
ClL.SYSTEMPCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*CLLUNITARYCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn

*CLLUNIXFILESYSTEM

n/a

n/a

CLVIOS

n/a

n/a

CLVIPFUNCTION

n/a

n/a
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
CLVIRTUALCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
CIL.VLAN n/a n/a
*CL.LVMWARECOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*CL.LVMWAREESX n/a n/a
ClL.LWEBCONTAINER n/a n/a
ClL.WEBLOGICADMINSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
CL.WEBLOGICCLUSTER n/a n/a
ClL.LWEBLOGICDOMAIN n/a n/a
ClL.WEBLOGICEJBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
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OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
ClL.WEBLOGICJ2EEAPPLICATION SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CL.LWEBLOGICSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
ClL.WEBLOGICWEBCONTAINER n/a n/a
ClL.WEBLOGICWEBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE_NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
Cl.LWEBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CI.WEBSERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer
ClL.WEBSERVICE n/a n/a
Cl.WEBSPHERECELL n/a n/a
Cl.WEBSPHEREDEPLOYMENTMANAGER APPSERVER_NAME SoftwareServer |name
APPSERVER _VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.WEBSPHEREEJBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
APPSERVER_VENDORNAME SoftwareServer |ame
RELATION.RUNSON SoftwareServer |runsOn
Cl.WEBSPHEREJ2EEAPPLICATION SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
CI.WEBSPHERENAMEDENDPOINT n/a n/a
CI.WEBSPHERENODE APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
CL.LWEBSPHERENODEAGENT APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.LWEBSPHERESERVER APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.WEBSPHEREWEBMODULE SOFTWAREMODULE_FILENAME SoftwareModule |fileName
SOFTWAREMODULE _NAME SoftwareModule |name
RELATION.DEPLOYEDTO | SoftwareModule |deployedTo
*CLLWINDOWSCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | fqdn
COMPUTERSYSTEM_MODEL ComputerSystem | manufacturer
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber

COMPUTERSYSTEM_SIGNATURE

ComputerSystem

ipAddress
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OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*CL.LWINDOWSFILESYSTEM n/a n/a
*CL.LWINDOWSOS n/a n/a
Cl.ZOS.CICSREGION APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.ZOS.DB2SUBSYSTEM APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
Cl.ZOS.IMSSUBSYSTEM APPSERVER_NAME SoftwareServer |name
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
*Cl.ZOS.LPAR COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
Cl.ZOS.MQSUBSYSTEM APPSERVER_NAME SoftwareServer |name
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SmartCloud Control Desk

OSLC RESOURCE

Cl CLASSIFICATION CLASS SPEC ATTRIBUTE RELATIONSHIP TYPE PROPERTY
APPSERVER_VENDORNAME SoftwareServer | manufacturer
RELATION.RUNSON SoftwareServer |runsOn
*Cl.ZOS.ZLINUXOS n/a n/a
*Cl.Z0S.Z0S n/a n/a
Cl.ZOS.ZVMGUEST COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn
*Cl.ZSERIESCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN ComputerSystem | fqdn
COMPUTERSYSTEM_MANUFACTURER ComputerSystem | manufacturer
COMPUTERSYSTEM_MODEL ComputerSystem | model
COMPUTERSYSTEM_NAME ComputerSystem | shortHostname
COMPUTERSYSTEM_SERIALNUMBER ComputerSystem | serialNumber
COMPUTERSYSTEM_SIGNATURE ComputerSystem | ipAddress
COMPUTERSYSTEM_SYSTEMBOARDUUID ComputerSystem | systemBoardUUID
COMPUTERSYSTEM_VMID ComputerSystem | vmid
RELATION.VIRTUALIZES |ComputerSystem |dependsOn

Comments

There are no comments.
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SmartCloud Control Desk 7.5.1.1 can integrate with Tivoli Monitoring by acting as an OSLC Consumer of data on
configuration items (Cls) and assets that Tivoli Monitoring provides as OSLC Provider.

Value of the integration between SmartCloud Control Desk and Tivoli
Monitoring

The business goal for this scenario is to provide SmartCloud Control Desk users, including service desk analysts, with
details about their configuration items and assets from other IT products such as Tivoli Monitoring.

The integration:

o Makes IT resource information from Tivoli Monitoring readily available to users in the context of their work without
having to change tools.

e Provides IT resource information in real-time.

¢ Reduces the time needed to configure and maintain large amounts of Asset and CI data within SmartCloud
Control Desk.

e The IT resource information can help with the isolation, diagnosis, and routing of incidents and problem tickets.

The technology used in the integration

The technology that makes this integration possible is Open Services for Lifecycle Collaboration (OSLC). OSLC is an
open community that is defining standards for integration between applications and tools. This section describes some of
the basics about OSLC, provides links to education material and other publicly-available information on this and related
topics. In addition this section describes the SmartCloud Control Desk support for OSLC and how you can leverage OSLC
for your integration.

Note: As SmartCloud Control Desk and IBM Maximo Asset Management share a common process automation engine
base, some of the content in the Maximo wiki and SmartCloud Control Desk wiki is shared. The links below go to the
Maximo wiki.

OSLC Introduction
Maximo/SCCD Support for OSLC

Documentation explaining details of the OSLC integration between
SmartCloud Control Desk and Tivoli Monitoring

1. SCCD product documentation: Viewing Cl and Asset Data and Event Details with OSLC Integrations
(http://ibm.co/1hxoypX). See Chapter 2.

Note: This SmartCloud Control Desk guide is referenced in the end to end guide below.

2. End to end guide on configuring SmartCloud Control Desk and TADDM for the integration in the Cross Product
Integration wiki:

Scenario 7 - OSLC Integration Scenario - How to configure and use SCCD Ul Preview

Topology
Installation process
Integration process
Troubleshooting

Note: These resources also contain information about SmartCloud Control Desk as an OSLC Consumer of IBM
Tivoli Application Dependency Discovery (TADDM) data.
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4. Asset to OSLC resource type mappings

Comments

There are no comments.
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SmartCloud Control Desk can integrate with IBM Tivoli Netcool/OMNIbus by acting as an OSLC Consumer of data on
configuration items (Cls) that Tivoli Netcool/OMNIbus provides as an OSLC Provider.

Value of the integration between SmartCloud Control Desk and Tivoli
Netcool/OMNIbus

The business goal for this scenario is to provide SmartCloud Control Desk users, including service desk analysts, with
monitoring event details about their Cls from Tivoli Netcool/OMNIbus.

The integration:

o Makes event information available to ticket analysts in the context of their SmartCloud Control Desk work without
having to switch tools.

o Supplements the ticket analyst’s view to help them route tickets more quickly, reducing mean time to resolution.

e The IT resource information can help with the isolation, diagnosis, and routing of incidents and problem tickets.

The technology used in the integration

The technology that makes this integration possible is Open Services for Lifecycle Collaboration (OSLC). OSLC is an
open community that is defining standards for integration between applications and tools. This section describes some of
the basics about OSLC, provides links to education material and other publicly-available information on this and related
topics. In addition this section describes the SmartCloud Control Desk support for OSLC and how you can leverage OSLC
for your integration.

Note: As SmartCloud Control Desk and IBM Maximo Asset Management share a common process automation engine
base, some of the content in the Maximo wiki and SmartCloud Control Desk wiki is shared. The links below go to the
Maximo wiki.

OSLC Introduction
Maximo/SCCD Support for OSLC

Documentation explaining details of the OSLC integration between
SmartCloud Control Desk and OMNIbus

For specifics on the OSLC integration between SmartCloud Control Desk (as OSLC Consumer) and OMNIbus (as OSLC
Provider), see the following resources:

1. SmartCloud Control Desk product documentation: Viewing Cl and Asset Data and Event Details with OSLC
Integrations (http://ibm.co/1hxoypX) See Chapter 3.

Note: This SmartCloud Control Desk guide is referenced in the end to end guide below.

2. End to end guide on configuring SmartCloud Control Desk and Tivoli Netcool/OMNIbus for the integration in the Cross
Product Integration wiki:

Scenario 8 - OSLC Integration Scenario - How to configure SCCD to view OMNIbus event details
e Topology
¢ Installation Process

¢ Integration Process
e Troubleshooting
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3. Cls to OMNIbus event mappings

4. Using custom event properties from Tivoli Netcool OMNIbus

Additional configuration for Tivoli Netcool/OMNIbus 7.4 fix pack 3

By default, the OSLC integration with Tivoli Netcool/OMNIbus offered in SmartCloud Control Desk 7.5.1.1 is configured to
integrate with Tivoli Netcool/OMNIbus v7.4 fix pack 2. If you are using Tivoli Netcool/lOMNIbus v7.4 fix pack 3 or later,
and you have configured Tivoli Netcool/OMNIbus to register event collection identifier patterns in JazzSM Registry
Services, then the following additional configuration steps are required in SmartCloud Control Desk to integrate with
Tivoli/Netcool OMNIbus. These steps are in addition to the documentation in step 1 above.

Remove the CCIEVENTS interaction from the SCCDCIGRP query interaction group

1. Go to Integration > OSLC Providers.

2. Select the Add/Modify Interaction Group action.

3. In the Interaction Groups table, make sure the SCCDCIGRP row is selected.

4. In the Interactions in Interaction Group SCCDCIGRP table, select the delete icon to delete the Interaction called
CCIEVENTS.

5. Click OK to close the dialog.

Uncheck the option Generate Preview Dialog? in the SCCDOMNIBUS OSLC Provider

1. Go to Integration > OSLC Providers.

2. Open the SCCDOMNIBUS OSLC Provider.

3. Uncheck the option, Generate Preview Dialog.
4. Click Save.

Comments

There are no comments.
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Cl to Tivoli Netcool/OMNIbus Event mapping table

This table provides a list of Cl classifications and the Tivoli® Netcool/OMNIbus Event types that they map to.
Table 1. Cl classifications to Event resource types

SmartCloud Control Desk RESOURCE
CI CLASSIFICATION CLASS SPEC ATTRIBUTE TYPE | PROPERTY

CIL.LAIXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CIL.AIXOS OPERATINGSYSTEM_FQDN Event | node

CI.COMPUTERSYSTEM COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CI.LHPUXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CI.LHPUXOS OPERATINGSYSTEM_FQDN Event | node
CL.IPADDRESS IPADDRESS_STRINGNOTATION | Event | nodeAlias
CL.IPV4AADDRESS IPADDRESS_STRINGNOTATION | Event | nodeAlias
CL.IPV6ADDRESS IPADDRESS_STRINGNOTATION | Event | nodeAlias

CI.LINUXCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CIL.LINUXOS OPERATINGSYSTEM_FQDN Event | node

Cl.OS OPERATINGSYSTEM_FQDN Event | node

CI.SOLARISOS OPERATINGSYSTEM_FQDN Event | node

CI.SUNCOMPUTERSYSTEM COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CI.SYSTEMPCOMPUTERSYSTEM | COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CLLUNITARYCOMPUTERSYSTEM |COMPUTERSYSTEM_FQDN Event | node
COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CL.VIRTUALCOMPUTERSYSTEM |COMPUTERSYSTEM_FQDN Event | node
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SmartCloud Control Desk RESOURCE
CI CLASSIFICATION CLASS SPEC ATTRIBUTE TYPE | PROPERTY

CLVMWARECOMPUTERSYSTEM |COMPUTERSYSTEM_FQDN Event | node

COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CLLWINDOWSCOMPUTERSYSTEM | COMPUTERSYSTEM_FQDN Event | node

COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

CLLWINDOWSOS OPERATINGSYSTEM_FQDN Event | node

ClL.ZOS.LPAR COMPUTERSYSTEM_FQDN Event | node

COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

Cl.ZOS.ZLINUXOS OPERATINGSYSTEM_FQDN Event | node
Cl1.ZOS.Z0S OPERATINGSYSTEM_FQDN Event | node
Cl.ZOS.ZVMGUEST COMPUTERSYSTEM_FQDN Event | node
ClL.ZSERIESCOMPUTERSYSTEM |COMPUTERSYSTEM_FQDN Event | node

COMPUTERSYSTEM_SIGNATURE | Event | nodeAlias

Comments

There are no comments.
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Using custom event properties from Tivoli Netcool OMNIbus
E Like | Updated October 17, 2013 by cfjohnst | Tags: None

Overview

By default, Tivoli Netcool/OMNIbus provides an event definition which contains only the core columns and the
Netcool/OMNIbus required properties. Often, additional event properties are available inside Netcool/OMNIbus, and it is
possible to modify the event definition in Netcool/OMNIbus to expose these additional event properties to SmartCloud
Control Desk.

You may want to display these additional event properties in SmartCloud Control Desk or configure SmartCloud Control
Desk to query for events using additional event properties that you have defined. This page explains how this can be
accomplished.

Pre-Requisites

You have already configured the Tivoli Netcool/OMNIbus integration in SmartCloud Control Desk and are able to view
event details for Cls.

See Integrating with Tivoli Netool OMNIBus for information on how to configure the Tivoli Netcool OMNIbus integration.

Configuration

Follow the steps below to update the event definition in Tivoli Netcool/OMNIbus with your additional properties and import
the updated event definition into SmartCloud Control Desk.

1. Edit the event definition in Tivoli Netcool/OMNIbus to expose the additional event properties you want to display or
query in SmartCloud Control Desk. See the following references in the Tivoli Netcool/OMNIbus Infocenter for
additional information on how to edit the event definition:

1. See the default event definition for a list of properties Netcool/ OMNIbus exposes by default.

2. The event resource definition is contained in the resourcecfg.json file under SOMNTHOME /etc/restos.

3. See the default content of the resourcecfg.json file.

4. After the resourcecfj.json file is updated, restart the ObjectServer for the changes to take effect.

2. Once the event definition is updated in Netcool/OMNIbus, you need to obtain the updated definition from
Netcool/OMNIbus in RDF/XML format.

1. Using a tool such as a web browser or a REST client, request the event definition using this URL from
Netcool/OMNIbus, replacing <host> and <port> with your specific Netcool/lOMNIbus host name and port
number: http://<host>:<port>/objectserver/oslc/shape?type=Event&create=false

2. Save the RDF/XML to a file on your local workstation. Note the location of the file for step 3.

3. In SmartCloud Control Desk, import the RDF/XML file you obtained in step 2.

1. Login to SmartCloud Control Desk and go to Integration > OSLC Providers.

2. Under More Actions, choose Add/Modify Resource Types.

3. Expand the EVENT resource type.

4. Under Import Shape Document, choose Browse... and point to the RDF/XML file you obtained in step 2.

5. Choose Import.

Your event definition is now updated in SmartCloud Control Desk.

Displaying additional event properties in SmartCloud Control Desk
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Now that you have updated the event definition, you can configure SmartCloud Control Desk to display the additional
event properties when viewing the details of an event for a Cl.

A WODN -~

5.

. Login to SmartCloud Control Desk and go to Integration > OSLC Providers.

. Open the SCCDOMNIBUS OSLC Provider.

. Expand the CCIEVENTS OSLC Interaction.

. In the Select clause field, enter a comma-separated list of the event properties that you want to display from

Netcool/OMNIbus. By default the summary, severity, and event creation date are displayed using this select
clause: oslcem:summary,oslcem:severity,dcterms:created. For example, if you wanted to display a
new property called oslcem:customattribute, you would use this select clause:
oslcem:summary,oslcem:severity,dcterms:created, osclem:customattribute.

Save the changes.

Now you can open a Cl, choose View Federated Details to obtain the events associated with the CI, and choose to view
event details. The Related Resource dialog will now contain the additional event properties you specified.

Querying on additional event properties in SmartCloud Control Desk

You may also configure SmartCloud Control Desk to query on the additional event properties in order to find events that
are associated with a CI.

1.

2.

3.

Analyze your Cl data model in SmartCloud Control Desk to determine how it matches with the additional event
properties you have added in Tivoli Netcool/lOMNIbus. For example, you may determine that for Cls classified as
CI.COMPUTERSYSTEM, the Cl's COMPUTERSYSTEM_CUSTOMATTRIBUTE spec value matches the event's
oslcem:customattribute value in Netcool/OMNIbus.

Set up a new mapping from your SmartCloud Control Desk attribute to the Tivoli Netcool/OMNIbus event property.

1. Go to Integration > OSLC Providers.

2. Under More Actions, select Configure OSLC Resource Mapping.

3. In the Resource Types and Classifications table, filter on the event resource type and the Cl
classification which has the attribute you want to map. For example, EVENT and
CI.COMPUTERSYSTEM. If a mapping from your classification to the EVENT resource type does not
exist, click New Row to create a new one.

4. Under the Resource Properties and Attributes table, click New Row.

5. Use the lookup next to the OSLC Resource Property Name field, and select your event property. For
example, oslcem:customattribute.

6. Use the lookup next to the Attribute field, and select your CI classification attribute name. For example,
COMPUTERSYSTEM_CUSTOMATTRIBUTE.

7. Choose OK to save the changes.

Set up a query on the event property.

1. Go to Integration > OSLC Providers.

2. Open the SCCDOMNIBUS OSLC Provider.

3. Click the CCIEVENTS OSLC Interaction.

4. Under the Queries table, choose New Row. Chose Query Type CUSTOM, and in the Query Class field
enter: com.ibm.ism.cci.app.ci.CClOslcQueryClause.

5. (Optional) Enter an event property to use to order the event results in the Order By field. For example, the
events can be ordered by their creation date, with the latest events displayed first, using: -dcterms:created.

6. Under the Query Parameters table, choose New Row.

. Use the lookup next to the Property field, and select the event property you want to query on.
8. Save the changes.

~

Now you have a new query configured which will take the COMPUTERSYSTEM_CUSTOMATTRIBUTE value from your
Cl and use it to find events whose oslcem:customattribute value matches it.

You might also choose to add additional parameters to your new query. For example, if you only want events with a
severity greater than 3, add a new query parameter to your query, select the oslcem:severity property, select the operator
GREATERTHAN, and enter a mapping expression of 3.
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You can add as many query parameters as desired to a query, but keep in mind that an event must match all the
parameters specified in the query in order to be found and displayed in SmartCloud Control Desk.

Comments

There are no comments.
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Integrating with Tivoli Provisioning Manager
E Like | Updated November 22, 2013 by alucches | Tags: None

Deploying Software: An example of SmartCloud Control Desk Integration with Tivoli

Provisioning Manager. This article describes how to integrate SmartCloud Control Desk with Tivoli Provisioning Manager
so you can automatically deploy software in SmartCloud Control Desk.

Comments

There are no comments.
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virtual, vm

SmartCloud Control Desk 7.5.1.1 integrates with IBM SmartCloud Orchestrator in the following ways:

IRole |Use case
Deploy virtual system patterns in IBM SmartCloud Orchestrator
OSLC Consumer directly from the SmartCloud Control Desk Self Service Center
OSLC Provider Provide ability to create SmartCloud Control Desk tickets within
SmartCloud Orchestrator

Comments

There are no comments.
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Deploying SmartCloud Orchestrator virtual system patterns from the Se

If Service Center
E Like | Updated December 31, 2013 by etiberi2 | Tags: deployment, provision, software, vms

You can deploy virtual systems from the Self Service Center of IBM SmartCloud Control Desk 7.5.1.1. In this integration
scenario, SmartCloud Control Desk is an OSLC Consumer and IBM SmartCloud Orchestrator is the OSLC Provider.

Value of integration

The business goal for this scenario is to provide SmartCloud Control Desk self-service users with the ability to deploy
applications in the cloud. SmartCloud Control Desk 7.5.1.1 provides a content package that gives users the ability to
trigger the deployment of virtual system patterns in the cloud.

The content package provides an offering that is designed to:

e Enable the SmartCloud Control Desk user to trigger the deployment of virtual system patterns in the cloud directly
from the Self Service Center to without having to change tools. IBM SmartCloud Orchestrator 2.3 fulfills the
service request for deployment.

¢ Enable the user and administrator to manage the Virtual System Instance and its associated VMs through the Cls
and assets.

e Enable the SmartCloud Control Desk user to start, stop, and delete the virtual systems and virtual machines that
the user owns from the Self Service Center.

¢ Enable the SmartCloud Control Desk user to submit additional service requests for the virtual systems and VMs
that the user owns.

You can customize the offering to:
e Deploy your own virtual system patterns

These pages provide guidance on configuring your environment so that you can deploy the default offering, an
IBM WebSphere Application Hypervisor virtual system pattern, from the SmartCloud Control Desk Self Service
Center.

The technology used in the integration

The technology that makes this integration possible is Open Services for Lifecycle Collaboration (OSLC). OSLC is an
open community that is defining standards for integration between applications and tools. This section describes some of
the basics about OSLC, provides links to education material and other publicly-available information on this and related
topics. In addition this section describes the SCCD support for OSLC and how you can leverage OSLC for your
integration.

Note: As SmartCloud Control Desk and IBM Maximo Asset Management share a common process automation engine
base, some of the content in the Maximo wiki and SCCD wiki is shared. The links below go to the Maximo wiki.

OSLC Introduction
Maximo/SCCD Support for OSLC

Documentation explaining details of the OSLC integration

For specifics on the OSLC integration between SmartCloud Control Desk (as OSLC Consumer) and SmartCloud
Orchestrator (as OSLC Provider), see the following resources:
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1. SmartCloud Control Desk product documentation: Content Package: Catalog Offerings for IBM SmartCloud
Orchestrator (http://ibm.co/1ghEvo3).

Note: This guide is referenced in the end to end guide below.
2. End to end guide for configuring SmartCloud Control Desk and SmartCloud Orchestrator for the integration:

Scenario 9 - OSLC Integration Scenario - Deploy virtual systems from SmartCloud Control Desk Self Service Center

e Topology
o Installation process
e Integration process

Comments

There are no comments.
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Create IBM Control Desk tickets from within IBM Cloud Orchestrator

E Like | Updated December 11, 2014 by Fidelma_Frahill | Tags: None

You can create and view IBM Control Desk incidents and Service Requests directly within other applications such as IBM
Cloud Orchestrator.

Value of integration

Administrators can use this capability to aid in detecting, isolating, and diagnosing problems.

The technology used in the integration

The ability to link to Control Desk ticket data within other applications is accomplished by using Open Services for
Lifecycle Collaboration (OSLC) standard.

OSLC is an open community that is defining standards for integration between applications and tools. This section
describes some of the basics about OSLC, provides links to education material and other publicly-available information on
this and related topics. In addition this section describes the Control Desk support for OSLC and how you can leverage
OSLC for your integration.

Note: As IBM Control Desk and IBM Maximo Asset Management share a common process automation engine base,
some of the content in the Maximo wiki and Control Desk wiki is shared. The links below go to the Maximo wiki.

OSLC Introduction
Maximo/SCCD Support for OSLC

Documentation

For specifics on this integration point, see the Control Desk user guide,
Providing ticket data to applications by using OSLC.

Comments

There are no comments.
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SmartCloud Control Desk Version 7.5.1.1 users can install an optional content package that integrates the product with
Amazon Elastic Compute Cloud (EC2).

The components and documentation for this optional feature are available as a content package that can be downloaded
from the IBM Integrated Service Management Library: http://www.ibm.com/software/brandcatalog/ismlibrary/details?
catalog.label=1TW10COOl.

Amazon Elastic Compute Cloud is a public cloud where users can purchase computing services that are based on the
amount of capacity that they need. Users can create, stop, start, and delete the virtual machine (VM) instances as
required and pay an hourly rate for services that they use.

The integration package lets administrators manage virtual machine deployments in Amazon EC2 through the
SmartCloud Control Desk user interface. Administrators can configure SmartCloud Control Desk to provide catalog
offerings for virtual machine deployment in Amazon EC2. Users can then request deployment of a virtual machine
instance in the cloud and use the VM to run software applications. When the requests are routed through SmartCloud
Control Desk, you can apply standard business processes, such as approval requirements, to the deployment work flow.

The content package integrates change and configuration management with cloud management. When an instance is
successfully deployed to the cloud, a configuration item (Cl) is created, and you can use SmartCloud Control Desk
functions to manage problems, incidents, and changes.

After you install and configure the package, SmartCloud Control Desk provides the following features:

o Administrators can create offerings for VM deployments to Amazon EC2 and make these offerings available to
SmartCloud Control Desk users.

¢ In the Activities and Tasks application, administrators can monitor deployments and resolve incidents that are
related to deployments.

¢ In the Configuration Items application, administrators can view data about the VMs that are deployed and use that
information to manage computing resources.

¢ In the Self Service Center or Offering Catalog application, users can request VM deployments to Amazon EC2.

¢ In the My Resources navigator in the Self Service Center, users can view the status of their requests for VM
deployment. After VMs are deployed, users can also use the My Resources navigator to start, stop, and delete the
VMs as needed.

The SmartCloud Control Desk Amazon EC2 integration is supported only on WebSphere® Application Server.

For more information, see the
IBM SmartCloud Control Desk Amazon Web Services Elastic Compute Cloud Integration Guide.

Comments

There are no comments.
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IBM Endpoint Manager for Software Use Analysis Integrations
E Like | Updated September 23, 2015 by charglen | Tags: None

The following topics in this wiki provide information about integrations with IBM Endpoint Manager for Software Use
Analysis:

Best practices for IBM Endpoint Manager for Software Use Analysis

IBM Endpoint Manager for Software Use Analysis 9.1 and higher database to schema information

You can find more information in IBM Knowledge Center:

Configuration for IBM Endpoint Manager for Software Use Analysis 1.3 adapter

Configuration for IBM Endpoint Manager for Software Use Analysis 2.x adapter

Configuration for IBM Endpoint Manager 9.0 adapter

IBM Endpoint Manager for Software Use Analysis 1.3 mapping table

IBM Endpoint Manager for Software Use Analysis 2.x/9.0 mapping table

IBM Endpoint Manager for Software Use Analysis 2.x database information to schema information

IBM Endpoint Manager for Software Use Analysis 9.1 or higher database information to schema information

Comments

There are no comments.

1/1


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Integrating?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/IBM%20Endpoint%20Manager%20for%20Software%20Use%20Analysis%209.1%20and%20higher%20database%20to%20schema%20information
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/t_configuration_tasks.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/t_configuration_tasks_tem20.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/t_configuration_tasks_iem.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/r_bigfix_mapping.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/r_bigfix20_mapping.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/r_bigfix20_map_sourcedbtoschema.html
http://www-01.ibm.com/support/knowledgecenter/SSWT9A_7.6.0/com.ibm.sccd-adv.doc/import_asset/r_iem91_map_sourcedbtoschema.dita.html
javascript:;
javascript:;

10/12/2019 IBM Control Desk : Best practices for IBM Endpoint Manager for Software Use Analysis

You are in: IBM Control Desk > Integrating > IBM Endpoint Manager for Software Use Analysis Integrations > Best
practices for IBM Endpoint Manager for Software Use Analysis

Best practices for IBM Endpoint Manager for Software Use Analysis
E Like | Updated July 31, 2014 by charglen | Tags: endpoint_manager_for_software_use_analysis, integration,

integration_composer

Import Software Catalogs into SmartCloud Control Desk before you import data with Integration
Composer

Before you run the Integration Composer adapter for IBM Endpoint Manager for Software Use Analysis, it is very
important to import the Canonical 2.0 IBM Software Catalog into SmartCloud Control Desk. If you do not import the
software catalog first, Integration Composer creates the software catalog entries, but the software hierarchy will be
missing, which can affect the reports and license calculations.

For information about importing software catalogs, see Importing software catalogs in the SmartCloud Control Desk
Knowledge Center.

Avoid concurrent imports of IBM Endpoint Manager for Software Use Analysis into SmartCloud
Control Desk and ETL imports

In environments where large amounts of data are processed, avoid running ETL imports on the SUA server at the same
time that Integration Composer imports data from IBM Endpoint Manager for Software Use Analysis into SmartCloud
Control Desk. Accessing the same data can result in performance issues and data lock.

To avoid concurrent runs, when scheduling ETL imports, IBM Endpoint Manager for Software Use Analysis administrators
can leave at least a 24-hour period available for Integration Composer imports.

Integration Composer administrators can also specify a property in the fusion.properties file (sua.check.etl.status=true)
that prevents execution of the IEM SUA integration adapter when an ETL import is detected.

Run multiple adapters in the appropriate sequence

If you run multiple Integration Composer adapters to import data into SmartCloud Control Desk, the order in which you run
the adapters affects the data in SmartCloud Control Desk.

To retrieve complete information about your environment, first run the IBM Endpoint Manager adapter to create deployed
assets for your hardware inventory, and then run the Software Use Analysis adapter to import your software inventory.

Although deployed assets in SmartCloud Control Desk are not deleted by Integration Composer, information about the
hardware and software installed on the asset is updated.

For example, you run an adapter and it reports additional physical disks or a different number of installed software
products for a deployed asset that already exists in SmartCloud Control Desk. Integration Composer adds the new data
for the deployed asset, updates the existing data, and deletes the information about hardware and software inventory that
exists in SmartCloud Control Desk but is not reported by the adapter that you just ran.

Because IBM Endpoint Manager for Software Use Analysis adapters often import more extensive data about software
inventory than the Tivoli Asset Discovery for Distributed adapter, run the Tivoli Asset Discovery for Distributed adapter
first. You do not want the more extensive IBM Endpoint Manager for Software Use Analysis deleted because it is not
included in Tivoli Asset Discovery for Distributed.

The following order is recommended when you run multiple adapters:

1. Tivoli Asset Discovery for Distributed (if applicable)
2. IBM Endpoint Manager (to import hardware data)
3. IBM Endpoint Manager SUA (to import software data)
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Troubleshooting hints and tips

Investigating REST API errors

If errors occur when running IBM Endpoint Manager or IBM Endpoint Manager for Software Use Analysis adapters, you
can find the most complete information about the error in the fusion.log file.

If errors are related to REST API calls, the log file includes the error message as reported by SUA and the URL that was
used to access the data:

"error"; "Don't know how to report on column software_guid"
and
REQUEST_URL: http://<host_name>:<port>/api/schemas/computer.json

You can execute the URL in a web browser to determine whether the REST API call also fails outside of Integration
Composer.

The following are the errors that occur most often and their causes:
e |[EM APIHTTP 401 error
This error is usually caused by one of the following situations:

e User ID or password is incorrect
e User ID does not have required Master Operator privileges

e "The page you were looking for doesn't exist" error

This error occurs when the IBM Endpoint Manager for Software Use Analysis version that you used is not
supported. For more information see Discovery Tools Supported by SmartCloud Control Desk.

Discrepancies between IBM Endpoint Manager for Software Use Analysis and SmartCloud
Control Desk

Discrepancies between software inventory in the IBM Endpoint Manager for Software Use Analysis user interface and
SmartCloud Control Desk are possible because IBM Endpoint Manager for Software Use Analysis reports the
components of software products but SmartCloud Control Desk reports software releases.

For example, suppose you have a product bundle such as SmartCloud Control Desk that includes multiple components:
SmartCloud Control Desk, WebSphere Application Server, DB2, and Integration Composer. IBM Endpoint Manager for
Software Use Analysis reports that you have 4 instances of installed software. Integration Composer considers that all 4
components belong to one software instance: SmartCloud Control Desk.

The tally for software counts in IBM Endpoint Manager for Software Use Analysis will not match the tally for software
counts in SmartCloud Control Desk because of the difference in the way that the software management tools capture
software product instances.

Duplicate records for deployed assets

Sometimes data imported from different inventory tools can produce duplicate deployed asset records in SmartCloud
Control Desk. Duplication can occur if not enough data exists to reconcile the duplicates using Naming Reconciliation
Services.

Duplicate records can be created in the following scenarios:

1. If a computer host name or domain changes and there is no accurate serial number or other unique information
that identifies the deployed asset, a duplicate record is created with the new host name or domain name.

2. If the same computer is imported from IBM EndPoint Manager and Tivoli Asset Discovery for Distributed and there
is no accurate serial number or other unique information that identifies the deployed asset, a duplicate record is
created with the same host name and domain name.

3. If the same computer is imported from multiple inventory tools with different host name or domain name and there
is no accurate serial number or other unique information that identifies the deployed assets, duplicate records are
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created with the same host name and domain name.

Comments

There are no comments.
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To retrieve complete information about your environment, first use the IBM® Endpoint Manager adapter to retrieve your hardware inventory and then the Software Use Analysis
adapter to retrieve your software inventory and usage.

Prerequisite

Before you use the IBM Endpoint Manager for Software Use Analysis 9.1 or 9.2 adapter, you must download and install Integration Composer Version 7.5.1.2 or higher.

Hardware inventory

To import data for your hardware inventory, use the IBM Endpoint Manager 9.0 adapter to import data directly from IBM Endpoint Manager. To retrieve complete data, ensure
that all action sites listed in the IBM Endpoint Manager mapping table are enabled and that the corresponding analyses are activated. For more information, see
IBM Endpoint Manager 9.0 db information to schema information.

Software inventory

To import data for your software inventory from Software Use Analysis, use IBM Endpoint Manager for Software Use Analysis 9.1 or 9.2 adapter that is available for Control
Desk 7.5.1.2 and higher.

Note: The adapters do not process computers that have a Device Type of "Plugin”. Computers with this type are not loaded into the data source or mapped into Deployed
Assets.

The application requires additional configuration of computer properties and session settings so that all relevant data can be retrieved:

« In the Session Settings of Software Use Analysis, increase the session timeout value. For large amounts of data, you might need to increase the value to 8 hours.
o For each property listed in the following table, a computer property must be created in the Software Use Analysis web user interface.
« If you want to retrieve any additional computer properties, retrieve them directly from IBM Endpoint Manager.

The following table lists computer properties that must be created in Software Use Analysis:

Database information Schema information
Integration Composer
Site Analysis Property Name Class Integration Composer field

Master Action Device Type Device Type Computer Device Type

BES Inventory and | Virtual Machine Guest Virtual IDs of VM Computer Virtual ids of vm guests
License Information Guests

BES Inventory and Network Information MAC Addresses - Network Adapter Mac address

License (Windows) Windows

BES Inventory and Network Information (UNIX) [MAC Addresses - Unix | Network Adapter Mac address

License
Comments

There are no comments.
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The following links provide information about the reporting features of IBM Control Desk.

IBM Control Desk Standard Reports

The following spreadsheets provide information about the standard, out-of-the-box reports for IBM Control Desk, including
report file names, descriptions, applications, and report types.

Version 7.6.0 BIRT reports

Version 7.6.0 Cognos reports

Additional Resources

Reporting: This page on the Maximo Asset Management wiki applies to IBM Control Desk and all other products that are
based on Tivoli's process automation engine.

Cognos reporting for IBM Control Desk: This wiki page describes how to integrate IBM Control Desk with Cognos reports.
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With IBM® Control Desk v7.6.1, you have access to the Cognos® 11 which includes Cognos Connection, Workspace,
Workspace Advanced, Report Studio, and Cognos Administration.

For information about integrating Cognos with IBM Control Desk v7.6.1, see
the Cognos information in the Maximo Asset Management wiki.

Downloading Cognos files

Importing and viewing Cognos reports in Control Desk v7.6.1
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The following table describes the files for the Cognos components that are provided with IBM Control Desk Version 7.6.1.
Download the files that are appropriate for the platform and components that you use in your environment. These files are
available to customers on Passport Advantage.

[Part Number |Description

CNSQ9ML IBM Cognos Analytics Server Ltd Use 11.0.11 AIX Multilingual

CNSROML IBM Cognos Analytics Server Ltd Use 11.0.11 Linux on System p
(Multilingual

CNSR1ML IBM Cognos Analytics Server Ltd Use 11.0.11 Linux on System p LE
(Multilingual

CNSR2ML IBM Cognos Analytics Server Ltd Use 11.0.11 Linux on System z
[Multilingual

CNSR3ML IBM Cognos Analytics Server Ltd Use 11.0.11 Linux x86 Multilingual

CNSR4ML IBM Cognos Analytics Server Ltd Use 11.0.11 Oracle Solaris
(Multilingual

CNSR5ML IBM Cognos Analytics Server Ltd Use 11.0.11 Microsoft Windows
[Multilingual

CNSPOML IBM Cognos Analytics Samples 11.0.11 AIX Multilingual

CNSQOML IBM Cognos Analytics Samples 11.0.11 Linux on System p Multilingual

CNSQ1ML IBM Cognos Analytics Samples 11.0.11 Linux on System p LE
[Multilingual

CNSQ2ML IBM Cognos Analytics Samples 11.0.11 Linux on System z Multilingual

CNSQ3ML IBM Cognos Analytics Samples 11.0.11 Linux x86 Multilingual

CNSQ4ML IBM Cognos Analytics Samples 11.0.11 Oracle Solaris Multilingual

CNSQ5ML IBM Cognos Analytics Samples 11.0.11 Microsoft Windows
[Multilingual

CNSP8ML IBM Cognos Framework Manager 11.0.11 Microsoft Windows
[Multilingual

CNSQ7ML IBM Cognos Dynamic Query Analyzer 11.0.11 Linux x86-64
(Multilingual

CNSQ8ML IBM Cognos Dynamic Query Analyzer 11.0.11 Windows Multilingual
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The following instructions explain how to import and view IBM Control Desk reports in Cognos.

Prerequisite: Integrate IBM Control Desk with Maximo and integrate Cognos v11 with your env according to
these instructions.

Complete the following steps to import the IBM Control Desk reports into Cognos:

1.

0 N O O~ W

Access the Db2 console with the admin user and grant the Cognos user access to the following tables:
o MAXIMO.WOCHANGE
o MAXIMO.SITEFILTER
o MAXIMO.SR
o MAXIMO.ORGFILTER
o MAXIMO.CI
o MAXIMO.INCIDENT
o MAXIMO.MULTIASSETLOCCI
o MAXIMO.PROBLEM
o MAXIMO.CLASSSTRUCTURE

. In the Control Desk packet, locate the folder cognos_reporting including the archive

ICD_Cognos_Reports_761.zip and copy these files to your Cognos directory: %COGNOS_HOME %\
analytics\deployment

. Access http://yourCognosHost:yourCognosPort/bi/?perspective=home.

. Click Manage > Administration console and allow the popup dialog if necessary.

. Click the Configuration tab.

. On the left side of the page, select Content Administration and click the New Import icon on the upper right.
. Select the ICD_Cognos_Reports_761 package and click Next.

. In the next import screens, select the two content folders to import:

o PUBLIC (Report Object Structure templets)
o publiclICD761 (ICD Cognos reports)

. Click Next until you get to the Select an Action page.
10.
11.
12.
13.
14.

Select Save and Run Once. Click Finish.

Select the Now radio button and click Run.

Click View the details of this import after closing this dialog.

Refresh to confirm the import completed successfully.

Return to the Cognos User Home and click Team Content on the left side. You see the folders PUBLIC and
publiclCD761. This last one contains your new Cognos reports.
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Use the following information to successfully integrate IBM Control Desk with Cognos.

For users who do not use the "MAXIMO" database schema

IBM Control Desk Version reports that are shipped for Cognos are built from the Report Object Structure (ROS) based on
the database schema "MAXIMQ".

If your IBM Control Desk database schema is not "MAXIMO", you must republish the ROS and use Report Studio to
reload and save the Cognos reports.

If the imported Cognos reports cannot be run correctly, always try to republish the ROS and reload the report using Report
Studio tool.

Note: The datasource connection must be MXDB both in the Control Desk and the Cognos configurations.

For more information, see the Cognos information on the Maximo Asset Management wiki.
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With IBM® Control Desk 7.6, you have access to the Cognos® 10.2.1 Bl Server products. These powerful enterprise tools include
Cognos Connection, Workspace, Workspace Advanced, Report Studio, and Cognos Administration.

For information about what's new for Cognos in IBM Control Desk 7.6, see New in Cognos reporting in Control Desk documentation
in IBM Knowledge Center.

Integrating IBM Control Desk Version 7.6 with Cognos is a process that involves several tasks:

¢ installing Cognos
¢ integrating Cognos with IBM Control Desk
e importing reports and workspaces for IBM Control Desk into Cognos and/or creating your own Cognos reports

Use the following resources to help you install Cognos and integrate it with IBM Control Desk.

Learn about Cognos reports

IResource |Description |

Download this Excel spreadsheet to view a listing of
Cognos Reports for [BM Control Desk 7.6 Cognos Reports for IBM Control Desk 7.6.

Provides an overview of Cognos reporting features, the
Maximo 76 Cognos Feature Guide integration architecture, and other information that can
help you as you plan your integration.

Provides a document that details the content in the
Maximo Bl Packs, including the application workspaces
and reports, and how you can best apply them in your
unique environment.

This page links to Maximo videos on YouTube. The videos
Maximo 76 Cognos Bl Recordings provide information that is also useful for IBM Control
Desk.

Maximo (Tpae)_Cognos Content - Bl Packs

Install Cognos

Before you can integrate IBM Control Desk with Cognos, you must install Cognos.

IBM Control Desk 7.6 includes a limited use license of IBM Cognos Business Intelligence V10.2. Customers can log in to
Passport Advantage and download the Cognos files for IBM Control Desk.

Download the files that are appropriate for the platform and components that you use in your environment. For information about the
specific files that are available, see Downloading_ Cognos files.

For information about installing Cognos, see Cognos Business Intelligence in IBM Knowledge Center.

Integrate Cognos with IBM Control Desk

After you install Cognos, you must integrate it with IBM Control Desk. After you complete the integration installation process, you
can import the reports that are available for Control Desk into Cognos, and you can create your own reports. The following checklist
summarizes the integration tasks that are needed.

[Step| Task Description |
Integrate Cognos . . , , . : . L
1 |lwith IBM Control The instructions for the integration are provided in the following guide:
Desk Maximo 7.6 Cognos Bl Server Integration Installation Instructions
2 |[Download the Cognos reports for IBM Control Desk 7.6 are provided in a reports
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package in the ISM Library.
You can download the Cognos reports from the ISM Library here:
IBM Control Desk 7.6 Cognos Reports

For information about the files that you need to download, see
Downloading Cognos files.

Import the IBM
3 |[|Control Desk reports
into Cognos

To import the reports, follow the instructions in Importing_Control Desk
reports into Cognos.

Import the Maximo
4 ||Asset Management
reports into Cognos

Maximo Asset Management reports can be used for products based on
Tivoli's process automation engine, including IBM Control Desk.

You can download Maximo Asset Management reports/workspaces from
the ISM Library here:

Maximo Asset Management Cognos offerings in ISM Library

Additional wiki pages

Downloading Cognos files

Importing Control Desk reports into Cognos

Guidance for Cognos integrations

Comments
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The following table describes the files for the Cognos components that are provided with IBM Control Desk Version 7.6. Download the files
that are appropriate for the platform and components that you use in your environment. These files are available to customers on

Passport Advantage.

Part Number |[File Name Description

CIM1LML bi svr 10.2.1 aix_ml.tar.gz IBM Cognos Business Intelligence Server 10.2.1 AIX Multilingual

CIP34ML bi svr 10.2.1 hpit ml.tar.gz IIBM Cognos Business Intelligence Server 10.2.1 HP-UX Itanium Multilingual

CIMINML bi_svr 10.2.1_Ixp_ml.tar.gz IIBM Cognos Business Intelligence Server 10.2.1 Linux on System p Multilingual

CIM1PML bi_svr 10.2.1_Ixz_ml.tar.gz IIBM Cognos Business Intelligence Server 10.2.1 Linux on System z Multilingual

CIM1QML bi_svr 10.2.1_186_ml.tar.gz IIBM Cognos Business Intelligence Server 10.2.1 Linux x86-64 Multilingual

CIM1RML bi_svr 10.2.1_sol ml.tar.gz IIBM Cognos Business Intelligence Server 10.2.1 Oracle Solaris Multilingual

CIM1SML bi svr 32b 10.2.1 win ml.tar.gz |IBM Cognos Business Intelligence Server 32-bit 10.2.1 Microsoft Windows Multilingual

CIM1TML bi svr 64b 10.2.1 win ml.tar.gz |IBM Cognos Business Intelligence Server 64-bit 10.2.1 Microsoft Windows Multilingual

CIM1UML fm_10.2.1 win_ml.tar.gz |IBM Cognos Framework Manager 10.2.1 Microsoft Windows Multilingual

CIM23ML bi smps 10.2.1 mp ml.tar.gz IIBM Cognos Business Intelligence Samples 10.2.1 Multiplatform Multilingual

CIM1VML bi_gsg_10.2.1_ml.tar.gz IIBM Cognos Business Intelligence Quick Start Guide 10.2.1 Multilingual

CIM24ML Islp_10.2.1_mp_ml.tar.gz IIBM Cognos Supplementary Languages Documentation 10.2.1 Multiplatform Multilingual

CIM1YEN lcmgr_10.2.1_win_en.tar.gz IIBM Cognos Lifecycle Manager 10.2.1 Microsoft Windows English

CIPW7ML coninst_insight 10.2.1_aix_ml.tar.gz IIBM Cognos Connection Installer for Cognos Insight 10.2.1 AIX Multilingual

CIPW8ML coninst_insight 10.2.1 hpit ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 10.2.1 HP-UX Itanium Multilingual

CIPWOML coninst_insight 10.2.1 Ixp_ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 10.2.1 Linux on System p Multilingual

CIPXOML coninst_insight 10.2.1 Ixz_ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 10.2.1 Linux on System z Multilingual

CIPX1ML coninst_insight 10.2.1 186 _ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 10.2.1 Linux x86-64 Multilingual

CIPX2ML coninst_insight_32b_10.2.1_win_ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 32-bit 10.2.1 Microsoft Windows
Multilingual

CIPX3ML coninst_insight_64b_10.2.1_win_ml.tar.gz [IBM Cognos Connection Installer for Cognos Insight 64-bit 10.2.1 Microsoft Windows
Multilingual

CIPX4ML coninst _insight 10.2.1 sol _ml.tar.gz |IBM Cognos Connection Installer for Cognos Insight 10.2.1 Oracle Solaris Multilingual

CINZOML linsight se 32b 10.2.1 win _ml.tar.gz |IBM Cognos Insight Standard Edition 32-bit 10.2.1 Microsoft Windows Multilingual

CIPOOML Iinsight se 64b 10.2.1 win_ml.tar.gz IIBM Cognos Insight Standard Edition 64-bit 10.2.1 Microsoft Windows Multilingual

CIM21ML qua 10.2.1_mp_ml.tar.gz IIBM Cognos Dynamic Query Analyzer 10.2.1.1 Multiplatform Multilingual
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The following instructions explain how to import IBM Control Desk reports into Cognos.

Prerequisite: Download the IBM Control Desk 7.6 Cognos Reports package.

Complete the following steps to import the IBM Control Desk reports into Cognos:

1

o b WN

oo}

10.

. Copy the file that you download to your Cognos directory: for example, < CognosLocation

>\cl0\deployment>.

. Launch to Cognos Administration and select the Configuration tab.

. Select Content Administration in the navigation pane.

. Click New Import.

. Select the ICD_Cognos_Reports package and click Next.

. In the import screens that follow, select the two contents folders to import:

PUBLIC (Report Object Structure templates).
publiclCD76 (IBM Control Desk Cognos reports).

. On the action screen, select Save and Run Once. Then, click Finish.
. Select Run the report now.
. Select View the details of this import after closing this dialog and confirm that the import is completed

successfully.
Go to My Home. Navigate to the newly created folder publicICD76. The 8 sub folders under publicICD76
contain all the IBM Control Desk Cognos reports.
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There are no comments.

1/1


https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Reporting?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Cognos%20reports?lang=en
https://www.ibm.com/developerworks/community/wikis/home/wiki/IBM%20SmartCloud%20Control%20Desk/page/Cognos%20v10.2.x%20archive?lang=en
https://www-304.ibm.com/software/brandcatalog/ismlibrary/details?catalog.label=1TW10CO10D
javascript:;
javascript:;

10/12/2019 IBM Control Desk : Guidance for Cognos v10.2 integrations

You are in: IBM Control Desk > Reporting > Cognos reports > Cognos v10.2.x archive > Guidance for Cognos v10.2
integrations

Guidance for Cognos v10.2 integrations
E Like | Updated October 30, 2018 by Laura.Cunniffe.Aricent | Tags: None

Use the following information to successfully integrate IBM Control Desk with Cognos.

For users who do not use the "MAXIMO" database schema

IBM Control Desk Version 7.6 reports that are shipped for Cognos are built from the Report Object Structure (ROS) based
on the database schema "MAXIMO".

If your IBM Control Desk database schema is not "MAXIMO", you must republish the ROS and use Report Studio to
reload and save the Cognos reports.

If the imported Cognos reports cannot be run correctly, always try to republish the ROS and reload the report using Report
Studio tool.
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Documentation for BIRT reporting is provided on the BIRT reporting page in the Maximo Asset Management wiki. That
documentation applies to products that are based on Tivoli's process automation engine including IBM Control Desk.
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This section contains information about products and solutions that include SmartCloud Control Desk.
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Welcome to the Data Center Infrastructure Management (DCIM) wiki, a collaborative repository of
technical information.

IBM and Emerson Network Power have partnered to provide a complete Data Center Infrastructure
Management (DCIM) solution

that brings together the ITSM Expertise and Experience from IBM Tivoli and Data Center Infrastructure
Management capablities

from Emerson Network Power.

The partnership provides for a DCIM solution where ITSM and Data Center Infrastructure Management
are brought together

« Tivoli components for ITSM for asset management, process management, event correlation,
business service management and more...

« Emerson components for Data Center infrastructure monitoring and management, hardware
planning, power and cooling dependencies and more...

The IBM / Emerson DCIM solution doesn’t require that you rip/replace what you currently have or eat the
elephant at one time

The solution will fit where you have current gaps and you can grow the solution as your organization
needs grow

Information about the IBM / Emerson DCIM Solution

IBM and Emerson DCIM Solution Components

Demo Recording of SCCD-Trellis integration

This multi-part recording shows how SCCD could be configured to control the processes that support
Data Center activity where users of both solutions are needed. The recording also hi-lights the
integration of Asset data between SCCD and Trellis.

SCCD_Trellis_1_3min.mp4
SCCD_Trellis_2_6min.mp4
SCCD_Trellis_3_8min.mp4
SCCD _Trellis_4 4min.mp4
SCCD_Trellis_5 5min.mp4

Quick Links to other resources
DCIM Brochure
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You are in: IBM Control Desk > Related Products > Data Center Infrastructure Management > IBM and Emerson DCIM Solution Components

IBM and Emerson DCIM Solution Components

=l

IT Monitoring (ITM) L,‘ Eve?é mﬂgggrent Request

Like | Updated May 20, 2013 by WayneRiley | Tags: None

The IBM / Emerson DCIM partnership utilizes these components to provide a holistic DCIM
solution:

IBM® SmartCloud™ Control Desk provides a common control center for managing business processes for
both digital and physical assets. It gives you an efficient service desk for handling service requests and managing
incidents; it provides advanced impact analysis and automated change procedures designed to reduce risk and
support integrity of services; and it provides inventory management and software license compliance capabilities.
It also helps to manage assets throughout their lifecycle, optimizing usage of digital and physical assets and
minimizing compliance risks.

Emerson Trellis™ offers real-time visibility into the data center infrastructure, providing context for all of the

information collected so that data centers might gain an accurate understanding of performance. The Trellis™
platform gathers and aggregates millions of data points from infrastructure devices, filtering and presenting
relevant and meaningful data in ways best-suited to the individual data center user while providing accurate, real-
time information for inventory, energy consumption and infrastructure dependencies. It is modular, scalable and
purpose built to manage all IT & Facilities resources in an efficient manner.

IBM® Tivoli® Netcool®OMNIbus delivers near real-time, consolidated event management across business
infrastructure, data centers, complex networks and IT domains. The software provides full management and
automation to help you deliver continuous uptime of business services and applications
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You are in: IBM Control Desk > Control Desk on Cloud

Control Desk on Cloud
E Like | Updated 6/27/19 by Laura.Cunniffe.Aricent | Tags: None

IBM Control Desk on Cloud is a software as a service offering (SaaS) available through Service Engage. Itis an
integrated service management solution that helps you manage a comprehensive range of IT processes, services, and
assets. The product enables a business to optimize the performance of the infrastructure and workforce in alignment with
the overall business objectives.

To learn more about IBM Control Desk on Cloud, see Service Desk on Service Engage.

This section of the wiki provides additional information for IBM Control Desk on Cloud users.
Let's get started!: Use the Project Start and Project Configure workbooks to get started.

IBM Control Desk on Cloud is functionally equivalent to IBM Control Desk. For IBM Control Desk documentation, see:
https://www.ibm.com/support/knowledgecenter/en/SSWT9A

Comments

There are no comments.
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Let's get started!

E Like | Updated March 20, 2015 by bienfam1 | Tags: None

Contributors: Melody Bienfang, Meredith Edgerton and Wayne Halverson
Let us help you get started with IBM Control Desk on Cloud.
You want to do your work only once; not waste time doing work over again.

Too many times, we say, “If | had only known...” when we find our self in a place which does not make sense, or does not
allow us to move forward and make progress.

That is why you are here. The following links will minimize or negate the “If | had only known...” statements. We are
going to give you the information you need so you DO know what to do; when to do it; and how to make smart decisions
regarding your journey using IBM Control Desk.

Face it. This is a new product for you and that can be both frightening and a challenge. These links will minimize the
fright and challenge and speed your time to production and value. Most of all, these links and the information you will get
from them will guide you to success. This is not all sugar on a spoon, so we expect you to engage and own the
knowledge you are about to see.

We start simply, with the intent of getting some value from your investment quickly, and then provide you with the
knowledge to utilize the functionality you need just as your needs grow for your business.

Success to you and don’t hesitate to ask for guidance when you may have a question.
Project Start - Use this workbook as your guide to getting started with IBM Control Desk on Cloud.

Project Configure - Use this workbook as your guide to configuring the IBM Control Desk on Cloud.

Comments
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|§| Like | Updated June 15, 2017 by LauraCunniffe | Tags: None

This is a list of all the assets originally published in the ISM Library.

IBM Control Desk : Content from ISM Library

[Title

IBM Control Desk Process Content Pack - Configuration
Management

IBM Control Desk ConfigDiff 76

IBM Control Desk Process Content Pack - Change
Management

IBM Control Desk 7.5.3 - IBM Endpoint Manager for
Software Distribution

IBM Control Desk Process Content Pack - Hardware Asset
Management

IBM Control Desk Process Content Pack - Service Desk

IBM Control Desk Process Content Pack - Service Catalog

IBM Control Desk Process Content Pack - Software Asset
Management

IBM Control Desk 7.6 Cognos Reports

IBM Control Desk Service Portal on Cloud

Genesys Computer Telephony Integration for IBM Control
Desk 7.5.3.1

Genesys Computer Telephony Integration for SmartCloud
Control Desk

Comments
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IBM Control Desk Process Content Pack - Configuration Management
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production ready configurations to support Configuration Management. This includes roles,
security groups, start centers and workflows related to the management of configuration. The content has been tested
with other Process Content Packs, but may not operate with other content

Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Configuration Management Guide for additional
information and setup instructions.
This package can be installed in the following versions of Control Desk:

- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas
- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not provided for this
download.

Append a comment to provide feedback and questions. You can also use the IBM Control Desk Forum to post a question or view
questions on this item.

Requirements

¢ IBM SmartCloud Control Desk 7.5.x, 7.6.x

Note: Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

Version

7.6.0.0
Reference Number
1TW10CO10H
IBM Products integration works with

e |IBM Control Desk
e |IBM SmartCloud Control Desk

Content type

e |ISM Content Installer Pack
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Solution area

¢ Business Service Management
o |IT Service Management

Industries applied
¢ None specified.

Download License

L-JROZ-72S5LA

Download

Last Content Update: October 17, 2016

Comments

There are no comments.
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IBM Control Desk ConfigDiff - 76

E Like | Updated yesterday at 12:08 PM by BhratPatel | Tags: integrations, ism_library
Description
The following package generates a comparison report of different versions of the same database object structure.
Additional Information
Extract the contents of the package on top of the Control Desk install directory:

Windows: c:/ibm/smp/maximo
Linux: /opt/ibm/smp/maximo

Read this guide for additional info on how to use the tool.

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk forum or community links under the related product resources to reach the Service
Management Connect area for the indicated product.

Version
1.0

Reference Number
1TW10C0O107

Requirements

e |IBM SmartCloud Control Desk from version 7.2.1 and later

IBM Products integration works with
e |IBM Control Desk

Content type
o Utility

Solution area
e |T Service Management

Industries applied

¢ None specified

Download License
L-JROZ-72S5LA
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Download

Last Content Update: May 17, 2016

Comments

There are no comments.
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You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Process Content Pack - Change
Management

IBM Control Desk Process Content Pack - Change Management
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production ready configurations to support Change Management. This includes roles, security
groups, start centers and workflows related to the management of changes. The content has been tested with other
Process Content Packs, but may not operate with other content.

Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Change Management Guide for additional

information and setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version
7.6.0.0

Reference Number
1TW10C0O108

Requirements

e |IBM SmartCloud Control Desk 7.5.x, 7.6.x

Note: Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

IBM Products integration works with

e |BM Control Desk
¢ IBM SmartCloud Control Desk

Content type

e ISM Content Installer Pack
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Solution area

¢ Business Service Management
o |IT Service Management

Industries applied

o None specified.

Download License
L-JROZ-72S5LA

Download

Last Content Update: September 19, 2016

Comments

There are no comments.
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IBM Control Desk 7.5.3 - IBM Endpoint Manager for Software Distributi

on
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This Content Package provides the ability to integrate IBM Endpoint Manager with IBM Control Desk to facilitate licensed
software deployment to assets and the creation of deployable software offerings.

Click to see more.

There are three packages in this content package. The first two packages when installed together provide the ability to
integrate IBM Control Desk and IBM Endpoint Manager, in addition to providing several options for deploying licensed
software to assets.

The third package IBM Endpoint Manager Integration Configuration package contains a configuration tool that will ease
the configuration of the integration with IBM Endpoint Manager. It also enables you to build an IBM Control Desk Service
Catalog offering to distribute a specified software product in your enterprise app store.

The 3 packages are:

1. Content Installer package containing Offerings and catalog (IBM_Endpoint_Manager_Software_Distribution.zip).
This package contains a set of offerings that allow you to distribute software to multiple assets, distribute multiple
software packages to a single asset, and re-image an asset. This is installable through the ISM Content Installer
application.

2. The IBM Endpoint Manager Integration Enablement package contains artefacts that are required for the
integration, including classifications, job plans, automation scripts, workflows, actions, escalations, endpoints,
signature options (iem_swd_base.zip). This PMP package is installable through the ISM Solution Installer
command.

3. The IBM Endpoint Manager Integration Configuration package helps simplify the setup of the integration with IEM
and facilitates software deployment in an enterprise app store (iemcfg_pmp.zip). This PMP package is installable
through the ISM Solution Installer command.

Note: This is an English-only package.
Additional Information

Download the accompanying PDF guide (iemswd_integ_guide.pdf), which contains instructions for installing, configuring,
and using the content package.

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version

1.0
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Reference Number
1TW10C0O106
Requirements

¢ IBM Endpoint Manager for Mobile Devices 9.1
¢ IBM Tivoli Integration Composer 7.5.3.0 (delivered as a component of IBM Control Desk 7.5.3)

IBM Products integration works with

e |IBM Control Desk
e |IBM Endpoint Manager
e |IBM SmartCloud Control Desk

Content type
e ISM Content Installer Pack
Solution area

e Business Service Management
¢ IT Service Management

Industries applied
o None specified.

Download License

L-JROZ-72S5LA
Download

Last Content Update: January 12, 2015

Comments

There are no comments.
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You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Process Content Pack - Hardware Asset
Management

IBM Control Desk Process Content Pack - Hardware Asset Manageme

nt
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production ready configurations to support Hardware Asset Management. This includes roles,
security groups, start centers and sub processes related to hardware management. The content has been tested with
other Process Content Packs, but may not operate with other content.

Click to see more.

This content pack provides production ready configurations to support Hardware Asset Management. This includes roles,
security groups, start centers and sub processes related to hardware management. The content has been tested with
other Process Content Packs, but may not operate with other content. Features include:

o Clearly defined roles for management of the asset life cycle, supported by start centers, security groups and the
process flows to enable these roles to effectively work and manage the assets throughout the asset life cycle.

¢ Integration with service request and incident processes when the Service Catalog and/or Service Desk packs are
also installed.

e Asset utilization and inventory monitoring to ensure efficient asset acquisition decisions.

o A full life cycle for asset refresh capability to ensure currency of assets to meet the demands of the business.
Planning to Refresh.

o New asset request process.
o Asset break fix process.

o A robust asset disposal process to ensure that assets are efficiently taken out of services and properly disposed of
to meet financial, security and regulatory requirements.

¢ Quick and easy hardware asset management implementation to realize a more rapid time to value.
Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Hardware Asset Management Guide for additional
information and setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Description

This content pack provides production ready configurations to support Hardware Asset Management. This includes roles,
security groups, start centers and sub processes related to hardware management. The content has been tested with
other Process Content Packs, but may not operate with other content.
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Click to see more.

This content pack provides production ready configurations to support Hardware Asset Management. This includes roles,
security groups, start centers and sub processes related to hardware management. The content has been tested with
other Process Content Packs, but may not operate with other content. Features include:

o Clearly defined roles for management of the asset life cycle, supported by start centers, security groups and the
process flows to enable these roles to effectively work and manage the assets throughout the asset life cycle.

¢ Integration with service request and incident processes when the Service Catalog and/or Service Desk packs are
also installed.

o Asset utilization and inventory monitoring to ensure efficient asset acquisition decisions.

o A full life cycle for asset refresh capability to ensure currency of assets to meet the demands of the business.
Planning to Refresh.

o New asset request process.
o Asset break fix process.

o A robust asset disposal process to ensure that assets are efficiently taken out of services and properly disposed of
to meet financial, security and regulatory requirements.

¢ Quick and easy hardware asset management implementation to realize a more rapid time to value.

Click to see less.

Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Hardware Asset Management Guide for additional

information and setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Be the first to post a comment or review.

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version

7.6.0.0
Reference Number

1TW10CO109
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Hardware Asset Management

Requirements

e |BM Control Desk 7.5.0 and 7.6

Note: Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

IBM Products integration works with

e |IBM Control Desk
e |IBM SmartCloud Control Desk

Content type
o ISM Content Installer Pack
Solution area

e Business Service Management
e IT Service Management

Industries applied

o None specified.

Download License

L-JROZ-72S5LA
Download

Last Content Update: May 17, 2016

Comments

There are no comments.
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Service Catalog

You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Process Content Pack - Service Catalog

IBM Control Desk Process Content Pack - Service Catalog
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production ready configurations to support the creation of a Service Catalog. This includes
roles, security groups, start centers, workflows, catalogs and offerings to enable users to request offerings, approvals to
be managed and the offering fulfilment to be managed. The content has been tested with other Process Content Packs,
but may not operate with other content.

Click to see more.

This content pack provides production ready configurations to support the creation of a Service Catalog. This includes
roles, security groups, start centers, workflows, catalogs and offerings to enable users to request offerings, approvals to
be managed and the offering fulfilment to be managed. The content has been tested with other Process Content Packs,
but may not operate with other content.

The service catalog content included in this content pack for IBM Control Desk provides:
o Sample catalogs to present to user populations.

e Sample offerings for typical requests like system access and requests for new assets like desktops and laptops.
o Workflow to support approval of requests by line managers and/or fulfillment managers.

Content to manage the fulfillment of requests by appropriate groups.
Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Service Catalog Guide for additional information
and setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version

7.6.0.0
Reference Number

1TW10CO10B
Requirements
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e |BM Control Desk 7.5.4

Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

IBM Products integration works with

e |BM Control Desk
¢ IBM SmartCloud Control Desk

Content type
e ISM Content Installer Pack
Solution area

¢ Business Service Management
e |IT Service Management

Industries applied
¢ None specified.

Download License

L-JROZ-72S5LA
Download

Last Content Update: May 17, 2016

Comments

There are no comments.
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Service Desk

You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Process Content Pack - Service Desk

IBM Control Desk Process Content Pack - Service Desk
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production ready configurations to support Service Desk processes for service request and
incident management. This includes roles, security groups, start centers and workflows related to service request and
incident processes. The content has been tested with other Process Content Packs, but may not operate with other
content.

Click to see more.

This content pack provides production ready configurations to support Service Desk processes for service request and
incident management. This includes roles, security groups, start centers and workflows related to service request and
incident processes. The content has been tested with other Process Content Packs, but may not operate with other
content.

The service desk content included in this content pack is for IBM Control Desk and provides:

e A Service Desk analyst role with supporting security group, start center and process workflow to manage service
requests, including a hand off to incident management.

¢ An Incident Analyst role with supporting security group, start center and process workflow to manage incidents,
including hand off to problem management, and incident and work order management processes.

o A Service Desk Manager/Incident Manager role with supporting security group, start center and content to oversee
and manage the service request and incident management processes.

Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Service Desk Guide for additional information and
setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version

7.6.0.0

Reference Number
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Service Desk
1TW10CO10A

Requirements

e |IBM Control Desk 7.5.4

Note: Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

IBM Products integration works with

e |BM Control Desk
e |IBM SmartCloud Control Desk

Content type
e ISM Content Installer Pack
Solution area

e Business Service Management
¢ IT Service Management

Industries applied
¢ None specified.

Download License

L-JROZ-72S5LA

Download

Last Content Update: May 17, 2016

Comments

There are no comments.
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Software Asset Management

You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Process Content Pack - Software Asset
Management

IBM Control Desk Process Content Pack - Software Asset Management
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: None

Description

This content pack provides production-ready configurations to support Software Asset Management. This includes start
centers, work queues, license management, and service catalog offerings related to software management. The content
has been tested with other Process Content Packs, but may not operate with other content.

Click to see more.

The software asset management content included in this content pack is for IBM Control Desk, and designed to provide
configurations for visibility and work order management to effectively manage and fulfill software requests.

It includes security groups and start centers for software asset managers and IMAC specialists to view and work
entitlements through work orders. Most importantly, this pack will save time compared with configuring the product from
scratch.

The pack also provides the ability to quickly fulfill software asset management requests originating from users or the
business. The documentation outlines the use cases and processes to take advantage of this content and can be used
as user training materials as well as other process content packs.

Additional Information

Reference the IBM SmartCloud Control Desk Process Content Pack - Software Asset Management Guide for additional
information and setup instructions.

This package can be installed in the following versions of Control Desk
- SmartCloud Control Desk 7.5.1.1

- SmartCloud Control Desk 7.5.2 Saas

- IBM Control Desk 7.5.3

- IBM Control Desk 7.5.4 Saas

- IBM Control Desk 7.6

- IBM Control Desk 7.6 Saas

- IBM Control Desk 7.6.0.1

- IBM Control Desk 7.6.0.1 Saas

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Append a comment and rate this item to provide feedback and questions directly to the content submitter. You can also
use the IBM Control Desk Forum or community links under the related product resources to reach the Service Management
Connect area for the indicated product.

Version

7.6.0.0
Reference Number
1TW10CO10C

Requirements
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10/12/2019 IBM Control Desk : IBM Control Desk Process Content Pack - Software Asset Management
e |BM Control Desk 7.5.4, 7.6

Complete the product installation post-install steps as defined in the product installation guide. The pack will use the
organization, item set, and site created as part of the post-installation steps.

IBM Products integration works with

e |BM Control Desk
¢ IBM SmartCloud Control Desk

Content type
e ISM Content Installer Pack
Solution area

¢ Business Service Management
e |IT Service Management

Industries applied
¢ None specified.

Download License

L-JROZ-72S5LA
Download

Last Content Update: May 17, 2016

Comments

There are no comments.
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11/12/2019 IBM Control Desk : IBM Control Desk 7.6 Cognos Reports

You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk 7.6 Cognos Reports

IBM Control Desk 7.6 Cognos Reports

E Like | Updated yesterday at 12:19 PM by BhratPatel | Tags: None

Description

This Content Package provides the new IBM Control Desk Cognos reports which can be imported and run in IBM Control
Desk 7.6. This Integration provides an additional suite of Business Intelligence (Bl) tools.

Click to see more.

This Content Package provides the new IBM Control Desk Cognos reports which can be imported and run in IBM Control
Desk 7.6. This Integration provides an additional suite of Business Intelligence (Bl) tools.

Use the following steps to import the reports:
1.Download ICD Reports for Cognos package from this page;
2.Copy the file to your Cognos directory: < CognosLocation >\c10\deployment
3.Launch to Cognos Administration and click on the Configuration tab;
4 .Select "Content Administration" on the left side of the page;
5.Select the "New Import" icon;
6.Select the "ICD_Cognos_Reports" package and click Next;
7.In the next import screens, select the two contents folders to import:
a) PUBLIC (Report Object Structure templets).
b) publiclCD76 (ICD Cognos reports).
8.0n the action screen, select Save and Run Once. Then, click Finish;
9..Select "Run the report now";
10. Click the button to ‘View the details of this import after closing this dialog’ and confirm the import is successfully
completed;
11.Go to My Home. Drill down on the newly created folder "publiclCD76", there are 8 sub folders under it which contains
all the ICD cognos reports.

Additional Information

Visit our wiki page which contains instructions for installing, configuring, and using the content package.

Support Information

This package is subject to the terms and conditions displayed upon download.

This download has been prepared and reviewed by IBM. It is offered "AS IS" to existing customers. Support is not
provided for this download.

Version

1.0
Reference Number

1TW10CO10D
Requirements

¢ |IBM Control Desk 7.6
¢ IBM Cognos BI Server 10.2.1

IBM Products integration works with
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11/12/2019
e |IBM Control Desk

Content type
o None specified
Solution area

e Analytics
e Business Service Management
o |IT Service Management

Industries applied

¢ None specified

Download License

L-JROZ-72S5LA
Download

Last Content Update: August 3, 2016

Comments

There are no comments.

IBM Control Desk : IBM Control Desk 7.6 Cognos Reports

212


http://www14.software.ibm.com/cgi-bin/weblap/lap.pl?la_formnum=&li_formnum=L-JROZ-72S5LA
https://www-01.ibm.com/marketing/iwm/iwm/web/preLogin.do?source=tivopal&S_PKG=1TW10CO10D

10/12/2019 IBM Control Desk : IBM Control Desk Service Portal on Cloud

You are in: IBM Control Desk > Content from ISM Library > IBM Control Desk Service Portal on Cloud

IBM Control Desk Service Portal on Cloud

E Like | Updated June 23, 2017 by Francesco Carteri | Tags: integrations, ism_library

Description

Service Portal on Cloud is a simplified, streamlined IBM-hosted interface for on-premises IBM Control Desk to manage
self-service and tickets. Client data remains in the IBM Control Desk “System of Record” on-premises.

Support Information

This package is subject to the terms and conditions displayed upon download.

To report a problem with deploying the download file from this entry, entitled customers may contact the country specific
IBM / Tivoli support channel listed at IBM Directory of worldwide contacts.

To open a support request, use the product listed under the "IBM Products integration works with" section of the "Details"
tab that indicates the main product the integration works with. Inform the solution integration was downloaded from the
ISM Library providing the title of the integration and the related product.

You can also append a comment and rate this item to provide feedback and questions directly to the content submitter.
You can also use the IBM Control Desk Forum or community links under the related product resources to reach the IBM
Service Management Connect area for the indicated product.

Specific support information for this integration may follow:

Version

1.0
Reference Number
1TW10CO10E
Requirements
e |IBM Control Desk 7.5.3
IBM Products integration works with

e |BM Control Desk
e |IBM SmartCloud Control Desk

Content type
e Trial Solution
Solution area

e Business Service Management
¢ IT Service Management

Industries applied
¢ None specified.

Download License

L-JROZ-72S5LA

Download
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Last Content Update: August 3, 2016

Comments

There are no comments.
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10/12/2019 IBM Control Desk : Genesys Computer Telephony Integration for IBM Control Desk 7.5.3.1

You are in: IBM Control Desk > Content from ISM Library > Genesys Computer Telephony Integration for IBM Control
Desk 7.5.3.1

Genesys Computer Telephony Integration for IBM Control Desk 7.5.3.1

E Like | Updated June 23, 2017 by Francesco Carteri | Tags: integrations, ism_library

Description

This offering enables integration between IBM Control Desk (ICD) 7.5.3.1 and Genesys CTI (Computer Telephony
Integration)

Support Information

This package is subject to the terms and conditions displayed upon download.

To report a problem with deploying the download file from this entry, entitled customers may contact the country specific
IBM / Tivoli support channel listed at IBM Directory of worldwide contacts.

To open a support request, use the product listed under the "IBM Products integration works with" section of the "Details
tab that indicates the main product the integration works with. Inform the solution integration was downloaded from the
ISM Library providing the title of the integration and the related product.

You can also append a comment and rate this item to provide feedback and questions directly to the content submitter.
You can also use the IBM Control Desk Forum or community links under the related product resources to reach the IBM
Service Management Connect area for the indicated product.

Specific support information for this integration may follow:

Version

7.5.3.1
Reference Number

1TW10CO10G
Requirements

e SmartCloud Control Desk 7.5.3.1
¢ Genesys Voice Platform and the Genesys Platform SDK version 7.1+, including the Agent Interaction Library
o Genesys Agent Interaction Library version 7.6.618.00 is required for Genesys 8.1+

IBM Products integration works with
e |IBM Control Desk

Content type
o Utility

Solution area

e Enterprise Asset Management
e |IT Service Management

Industries applied
o None specified.

Download License

L-JROZ-72S5LA
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Download

Last Content Update: January 6, 2016

Comments

There are no comments.
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10/12/2019 IBM Control Desk : Genesys Computer Telephony Integration for SmartCloud Control Desk

You are in: IBM Control Desk > Content from ISM Library > Genesys Computer Telephony Integration for SmartCloud
Control Desk

Genesys Computer Telephony Integration for SmartCloud Control Desk
E Like | Updated June 23, 2017 by Francesco Carteri | Tags: integrations, ism_library

Description

This offering enables integration between IBM SmartCloud Control Desk (SCCD) 7.5.1.3 and Genesys CTI (Computer
Telephony Integration).

Support Information

This package is subject to the terms and conditions displayed upon download.

To report a problem with deploying the download file from this entry, entitled customers may contact the country specific
IBM / Tivoli support channel listed at IBM Directory of worldwide contacts.

To open a support request, use the product listed under the "IBM Products integration works with" section of the "Details"
tab that indicates the main product the integration works with. Inform the solution integration was downloaded from the
ISM Library providing the title of the integration and the related product.

You can also append a comment and rate this item to provide feedback and questions directly to the content submitter.
You can also use the IBM Control Desk Forum or community links under the related product resources to reach the IBM
Service Management Connect area for the indicated product.

Specific support information for this integration may follow:

Version

7.51.3

Reference Number
1TW10CO10F

Requirements

e SmartCloud Control Desk 7.5.1.3
o Genesys Voice Platform and the Genesys Platform SDK version 7.1+, including the Agent Interaction Library

IBM Products integration works with

e |IBM Control Desk
e |IBM SmartCloud Control Desk

Content type
o Utility
Solution area

o Enterprise Asset Management
e IT Service Management

Industries applied
o None specified.

Download License
L-JROZ-72S5LA
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Download

Last Content Update: December 10, 2016

Comments

There are no comments.
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